Notice
While reasonable efforts were made to ensure that the information in this document was complete and accurate at the time of printing, Avaya Inc. can assume no liability for any errors. Changes and corrections to the information in this document may be incorporated in future releases.

Documentation Disclaimer
Avaya Inc. is not responsible for any modifications, additions, or deletions to the original published version of this documentation unless such modifications, additions, or deletions were performed by Avaya.

Link Disclaimer
Avaya Inc. is not responsible for the contents or reliability of any linked Web sites referenced elsewhere within this Documentation, and Avaya does not necessarily endorse the products, services, or information described or offered within them. We cannot guarantee that these links will work all of the time and we have no control over the availability of the linked pages.

License
USE OR INSTALLATION OF THE PRODUCT INDICATES THE END USER’S ACCEPTANCE OF THE TERMS SET FORTH HEREIN AND THE GENERAL LICENSE TERMS AVAILABLE ON THE AVAYA WEBSITE AT http://support.avaya.com/LicenseInfo/ (“GENERAL LICENSE TERMS”). IF YOU DO NOT WISH TO BE BOUND BY THESE TERMS, YOU MUST RETURN THE PRODUCT(S) TO THE POINT OF PURCHASE WITHIN TEN (10) DAYS OF DELIVERY FOR A REFUND OR CREDIT.

Avaya grants End User a license within the scope of the license types described below. The applicable number of licenses and units of capacity for which the license is granted will be one (1), unless a different number of licenses or units of capacity is specified in the Documentation or other materials available to End User. “Designated Processor” means a single stand-alone computing device. “Server” means a Designated Processor that hosts a software application to be accessed by multiple users. “Software” means the computer programs in object code, originally licensed by Avaya and ultimately utilized by End User, whether as stand-alone Products or pre-installed on Hardware. “Hardware” means the standard hardware Products, originally sold by Avaya and ultimately utilized by End User.

License Type(s): Designated System(s) License (DS).
End User may install and use each copy of the Software on only one Designated Processor, unless a different number of Designated Processors is indicated in the Documentation or other materials available to End User. Avaya may require the Designated Processor(s) to be identified by type, serial number, feature key, location or other specific designation, or to be provided by End User to Avaya through electronic means established by Avaya specifically for this purpose.

Copyright
Except where expressly stated otherwise, the Product is protected by copyright and other laws respecting proprietary rights. Unauthorized reproduction, transfer, and or use can be a criminal, as well as a civil, offense under the applicable law.

Third-Party Components
Certain software programs or portions thereof included in the Product may contain software distributed under third party agreements (“Third Party Components”), which may contain terms that expand or limit rights to use certain portions of the Product (“Third Party Terms”). Information identifying Third Party Components and the Third Party Terms that apply to them is available on Avaya’s web site at: http://support.avaya.com/ThirdPartyLicense/

Avaya Fraud Intervention
If you suspect that you are being victimized by toll fraud and you need technical assistance or support, call Technical Service Center Toll Fraud Intervention Hotline at +1-800-643-2353 for the United States and Canada. Suspected security vulnerabilities with Avaya Products should be reported to Avaya by sending mail to: securityalerts@avaya.com. For additional support telephone numbers, see the Avaya Support web site (http://www.avaya.com/support).

Trademarks
Avaya and the Avaya logo are registered trademarks of Avaya Inc. in the United States of America and other jurisdictions. Unless otherwise provided in this document, marks identified by “©,” “™” and “SM” are registered marks, trademarks and service marks, respectively, of Avaya Inc. All other trademarks are the property of their respective owners.

Documentation information
For the most current versions of documentation, go to the Avaya Support web site (http://www.avaya.com/support) or the IP Office Knowledge Base (http://marketingtools.avaya.com/knowledgebase/).

Avaya Support
Avaya provides a telephone number for you to use to report problems or to ask questions about your contact center. The support telephone number is 1 800 628 2888 in the United States. For additional support telephone numbers, see the Avaya Web site: http://www.avaya.com/support.
Chapter 1.
Voicemail Pro
1. Voicemail Pro

The diagram illustrates a Voicemail Pro system with some of the setup options. Full details on the installation options available are covered in the Installing Voicemail Pro section.

- **IP Office Control Unit**
  The IP Office Voicemail Pro licenses are entered into the configuration of the IP Office system. The licenses are required to activate Voicemail Pro features. An unlicensed Voicemail Pro service will run for two hours to allow demonstration and testing. License keys are issued against and validated against the unique serial number of the feature key dongle used by the the IP Office. For USB and parallel port feature key dongles, the dongle must be installed on a PC running the IP Office Feature Key Server application.

- **Voicemail Pro Server**
  The Voicemail Pro Service is installed on the Voicemail Pro server PC. This becomes the PC where messages and other data are stored for the mailboxes and services provided by Voicemail Pro.

- **Voicemail Pro Client**
  The Voicemail Pro Client is used to manage and configure the Voicemail Pro service. It can be installed on the Voicemail Pro server PC or on a separate PC. Only one client can connect to the server at any time.

- **Telephone Extension**
  For internal extensions, the voicemail server can be configure to send message waiting indication. By default this is automatically done when the extension users own mailbox contains new messages.

- **User’s PC**
  The following applications can be used on a user’s PC to access their messages:

  - **Phone Manager**
    IP Office Phone Manager can be used to display the number of new messages in a mailbox and to access that mailbox. The Pro version of Phone Manager can also control the playback of the individual messages once a mailbox has been accessed.

  - **Web Browser**
    If the Voicemail Pro server PC is also running Microsoft’s IIS web server, users can access voicemail features.

      - **Web Campaigns**
        The web campaigns option can be used to collect spoken and key press responses to question from callers and then display those responses to internal agents.

      - **Web Voicemail**
        For Voicemail Pro 4.2+, licensed users can be configured to access their own mailbox using a web browser.

  - **Email Options**
    The voicemail server can interact with email systems in a number of ways:
**Voicemail Email**
Using either a MAPI client such as Outlook on the server PC or a connection to an SMTP email server, Voicemail Pro can send email messages when a user has a new message. The email can be a simple alert or can include an attached copy of the message. This option does not support synchronization of messages between the users email program and their voicemail mailbox.

**IMAP**
IP Office 4.2+ supports licensed users accessing their mailbox from an IMAP compatible email program such as Outlook. This option includes synchronization between the voicemail messages in the email client and the voicemail mailbox.

**Integrated Messaging Systems (IMS)**
IMS allows the voicemail server to interact with a Microsoft Exchange Server. Users require an IMS client component to be installed into their copy of Outlook.

**ContactStore Server**
The current IP Office Voice Recording Library (VRL) application is Avaya IP Office ContactStore. The application can be installed on the Voicemail Pro Server in a separate hard disk partition or on a separate server. The diagram illustrates the option of installing ContactStore on a separate server.

Voicemail Pro is supplied on two CDs. The first CD contains the Voicemail Pro software. The second CD contains Avaya IP Office ContactStore.

- The standard Voicemail Pro CD includes the software components for generic Text To Speech (TTS). Voicemail Pro ScanSoft TTS is supplied on a separate set of 5 CDs. For more information, see the [Installing Text to Speech](#) section.
1.1 What is New

The following are summaries of the new features in IP Office Voicemail Pro releases.

Voicemail Pro 4.2

- **IP Office Unified Messaging Service (UMS)**
  Two new methods for users to access their mailbox are now supported. The methods are mailbox access using email applications that support IMAP (Internet Message Access Protocol) and mailbox access via web browsers. The use of these requires the IP Office configuration to contain **UMS Web Services** licenses for the number of required users.

- **IMAP Service**
  The Voicemail Pro now includes an IMAP server. Users can then access their voicemail messages using email clients such as Outlook and Lotus notes that support an IMAP Client. When connected, the IMAP client and Voicemail Pro will synchronize messages in the mailbox with message files in the IMAP client. Playback is through the sound facilities of the user PC.

- **Web Voicemail Service**
  The Voicemail Pro web service allows users to access their mailbox using a web browser. This has been tested with the Internet Explorer 7, Firefox 2 and Opera 9.10 PC browsers. This method of access requires Voicemail Pro to be installed on a PC already running Microsoft's IIS web server. Users can select to have message playback via an IP Office extension or through their PC’s sound facilities.

- **Test Variable Action**
  The existing **Check Digits** action has been replaced by a **Test Variable** action. This, in addition to offering the capabilities of the **Check Digits** action, provides significant enhancements. In addition to being able to match the user’s DTMF input against a specified string offered by the **Check Digits** action, the **Test Variable** action allows the testing of the contents of any system variable against known user extensions, hunt-groups, mailboxes and the contents of another variable. This will allow callers to enter numbers via a menu action, that can be verified as matching an existing extension or hunt groups prior to attempting to carry out transfers to otherwise potentially non-existent numbers.

- **Menu Action Invalid Input Handling**
  The **Menu** action has been enhanced. It now includes a control for the number of retries for the caller to make a valid entry and an **Invalid Input** result for connection to following call flow actions. Also prompts can be selected for playback whenever an invalid entry or entry timeout occurs.

- **License and Service Status Display**
  When the Voicemail Pro client is connected to a Voicemail Pro server, the Help | About screen displays a list of the licenses being used by the Voicemail Pro server. This license details include the validation status and capacity of those licenses. The status of related services, for example the UMS IMAP server, are also listed.

- **System Variable Length Increase**
  Previously the length of values stored by system variables has been limited to 64 characters. That maximum length has been increased to 512 characters.

- **Outcalling Configuration**
  In conjunction with Phone Manager 4.2, Voicemail Pro 4.2 allows users to adjust their outcalling settings through using a visual menu within Phone Manager.

  - Using the Phone Manager interface, users can now apply a delay between each notification call in an escalation list.
Voicemail Pro 4.1

In conjunction with IP Office 4.1, Voicemail Pro 4.1 supports the following new features:

- **Windows Vista Support**
  Those components of Voicemail Pro previously supported on Windows XP Pro are now also supported on Windows Vista (excluding Vista Home Basic and Vista Home Premium). The Voicemail Pro client is supported on Vista. The Voicemail Pro server is supported on Vista but not with IMS or Web Campaigns.

- **Automatic Recording Mailbox for Hunt Groups**
  By default automatic recordings for hunt groups are routed to the hunt group mailbox. Previously this could not be changed except through customized call flows on the Voicemail Pro. An alternate mailbox destination can now be specified through the **Hunt Group | Voice Recording** tab.

- **Automatic Recording Mailbox for Account Codes**
  By default automatic recordings for account codes are routed to the mailbox of the user making the call. Previously this could not be changed except through customized call flows on the Voicemail Pro. An alternate mailbox destination can now be specified through the **Account | Voice Recording** tab.

- **Call Data Tagging on Transfer Actions**
  The Transfer action now supports fields for setting the transfer source and description to display on phones receiving the transfer. The ability to associate call data for MS-CRM via **Assisted Transfer** actions is now also supported on **Transfer** actions.

- **Call Transfer Announcements**
  The **Transfer** and **Assisted Transfer** actions can be configured to announce the transfer to the caller. The announcement uses the recorded name of the mailbox associated with the transfer if available or the number if otherwise.

- **LIFO/FIFO Mailbox Operation**
  The default message playback order of First In-First Out (FIFO) can now be changed to Last In-First Out (LIFO). This is separately adjustable for new, old and saved messages. These are set through the **System Preferences | Housekeeping** tab (Administration | Preferences | General).

- **Time in Queue and Time on System Variables**
  Two new variables can be used in Queued and Still Queued call flows. They are **$TimeQueued** for the time in the queue and **$TimeSystem** for the time the call has been on the IP Office system.

- **Castelle Fax Server Support**
  The Voicemail Pro can be configured to recognize faxes of this type left in user's email mailboxes and include announcement of there presence in the user's mailbox prompts.

- **Hunt Group/Account Code Call Recording Destination**
  Previously the destinations for automatic call recording triggered by hunt groups or account codes could not be changed except through a custom Voicemail Pro call flow. The IP Office 4.1 configuration now allows the required destination for the call recording to be specified.

- **$DDI System variable for DDI Numbers**
  This variable is available on DDI calls passed from the IP Office to the Voicemail Pro.

- **Variable Routing (replaces the CLI Routing Action)**
  The existing CLI Routing action has been replaced by the **Variable Routing** action. This action allows the call routing to be based on matching specified values to system variables such as **$CLI** and **$DDI**. The numbers to which matching is performed can include wildcards such as ? for a single digit and * for any digits.

Voicemail Pro 4.0

In conjunction with IP Office 4.0, Voicemail Pro 4.0 supports the following new features:

- **Upgrade**
  You can now upgrade without having to remove previous versions of the software.

- **Outcalling**
  When a new voice message is left in a user's mailbox, notification can be automatically sent to a selected external number. Notification can be sent for all new messages or only messages marked as priority. If there is no response to the first notification there is an escalation capability. A user can configure their outcalling settings using their telephone handset. Details on how to configure outcalling for individuals can be found in the Intuity Mailbox guide.

- **Personal & Hunt Group Announcements**
  Personal announcements can be recorded. A caller will hear the user's personal announcement before being transferred to voicemail, if available.

- **Channel Reservations**
  Specific functions can have voicemail channels reserved for their use. The channels are reserved in IP Office Manager. By default there are no reserved channels.

- **Automatic Recording**
  Incoming call routes can be configured to be automatically recorded.
1.2 Features of Voicemail Pro

Voicemail Pro provides voicemail for every telephone on the system. Messages can be retrieved from a user’s own extension or from another telephone. Voice messages can also be forwarded to other voice mailboxes. Using Voicemail Pro call flows can be created that can, for example, guide a caller to the correct extension.

Listed below are some of the differences between Embedded Voicemail, Voicemail Lite and Voicemail Pro. For a fuller comparison, see the product description.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Embedded Voicemail</th>
<th>Voicemail Lite</th>
<th>Voicemail Pro</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integration with Phone Manager Pro.</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Create personal greetings.</td>
<td>✓ 1 only</td>
<td>✓ 1 only</td>
<td>✓ 9 max</td>
</tr>
<tr>
<td>Selection of voicemail transfer numbers</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Play a greeting continuously.</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Forward or copy a message to Email.</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Listen to an Email using Text To Speech.</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
</tr>
<tr>
<td>Send Email Notification.</td>
<td>✓*</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Forward a voice message to another mailbox or multiple mailboxes.</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Forward a voice message to multiple mailboxes using a Personal Distribution List.</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
</tr>
<tr>
<td>Forward a voice message with a header</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Rewind Message</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Fast forward a message</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Skip a message</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Pause a message</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Skip Message</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Set message priority</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
</tr>
<tr>
<td>Control when old messages are automatically deleted.</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
</tr>
<tr>
<td>Alphanumeric data collection</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
</tr>
<tr>
<td>Give callers a choice of transfer options.</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Call recording</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
</tr>
<tr>
<td>Create Campaigns</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
</tr>
<tr>
<td>Receive message notification at destinations configured by the user (known as Outcalling).</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
</tr>
<tr>
<td>Transfer to Fax</td>
<td>✓</td>
<td>✗</td>
<td>✓</td>
</tr>
<tr>
<td>Reply to a message if CLI is available</td>
<td>✓</td>
<td>Internal Only</td>
<td>✓</td>
</tr>
</tbody>
</table>

*Added in IP Office 4.2.
1.3 Supported Languages

The voicemail system provides prompts to callers and mailbox users based on the Locale that is set in the System form of IP Office Manager.

If the necessary set of language prompts is not available, the nearest available match is used. The list shows the first choice language prompts that Voicemail Pro will try to use, followed by the second choice and so on. For example, if prompts for users with their locale set to French Canadian are not available, Voicemail Pro looks for French prompts instead, then English US and finally English UK. The abbreviations shown in the table indicate the language prompt folder used in order of precedence.

Voicemail Pro server prompts can be installed in the following languages:

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Turkey(1): trk &gt; tr &gt; enu &gt; en.</td>
</tr>
</tbody>
</table>

1. Turkish prompts are not provided or installed but the Turkish locale is recognized. English (US) prompts are used if installed, otherwise English (UK). Fallback route added as part of Voicemail Pro 4.2.

- **TTY (Teletype Textphone)** is included in the list of installable languages even though it is not a language. TTY is a text-based system that is used to provide service to users with impaired hearing or vision. For more information, see Support for Callers with Impaired Hearing: Overview.

Individual users can have their own Locale setting. Voicemail then provides them with the appropriate language prompts if they are available. This is set either through the IP Office Manager User form or through the language choice on some telephones. For more information, see the appropriate telephone User Guide.

The availability of a language in voicemail does not necessarily indicate support for IP Office in a country that uses that language. Contact your local Avaya office for details of which countries support IP Office.
1.4 Number of Simultaneous Voicemail Users

All connections between the voicemail server and the IP Office are via the LAN using data channels. The maximum number of data channels that can be used for voicemail operation at any moment are shown below. Specific functions can have voicemail channels reserved for their use. For more information, see Voicemail Channel Reservations.

<table>
<thead>
<tr>
<th>IP Office</th>
<th>Maximum for Voicemail Lite</th>
<th>Maximum for Voicemail Pro</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP406 V2</td>
<td>4</td>
<td>20</td>
</tr>
<tr>
<td>IP412</td>
<td>4</td>
<td>30</td>
</tr>
<tr>
<td>IP500</td>
<td>4</td>
<td>30</td>
</tr>
<tr>
<td>Small Office Edition</td>
<td>4</td>
<td>10</td>
</tr>
</tbody>
</table>

- **Voicemail Pro Licenses**
  The actual number of ports available on Voicemail Pro is controlled by license keys entered through IP Office Manager. For more information, see Voicemail Pro Licenses.
  - The Voicemail Pro license enables 4 ports.
  - Additional Voicemail Pro licenses can be added to enable further ports up to the maximum shown in the table.

- **VoIP/VCM Channels**
  Though linked to the IP Office via a LAN connection, voicemail does not use VoIP VCM channels. The Voicemail Server is seen as a device on the IP Office’s TDM telephony interface.
  - Calls to/from voicemail involving non-IP trunks and extensions do not use VCM channels.
  - Calls to/from voicemail from IP trunks and extensions do use a VCM channel.
Chapter 2. Installing Voicemail Pro
Voicemail Pro 4.2 can be installed with the following IP Office systems:

- **Small Office Edition.**
- **IP406 V2.**
- **IP412.**
- **IP Office 500**
  Voicemail Pro is not supported on an IP Office 500 running in IP Office Standard Edition mode. To use this application an **IP500 Upgrade Standard to Professional** license is required.

There are a number of different types of Voicemail Pro installation that can be performed. Ensure that you have read the appropriate section for the installation required before attempting the actual installation. Each type of installation may have specific pre-requisites that must be completed before the Voicemail Pro software installation.

### 2.1 General Installation Requirements

Here is a list of general requirements for all types of installation.

- A PC with IP Office Manager and Microsoft .NET Framework versions 2.0 installed on it. If .NET 2.0 is not detected, you will be prompted to install it before the Voicemail Pro installation proceeds.
- An IP Office Feature Key and if necessary (ie. for parallel and USB feature keys) a PC running the IP Office Feature Key Server application. Refer to the IP Office Installation Manual for details.
- Licenses based on the serial number of the IP Office Feature Key. This should include:
  - A license for Voicemail Pro and any additional ports is required. If Voicemail Pro Server is installed without a license it will run for 2 hours and then shut down. For more information,
  - For IP500 systems an Upgrade Standard to Professional license.
  - Licenses for any other Voicemail Pro components being installed, see Voicemail Pro Licenses.
- The IP Office Voicemail Pro CD.

**Tips**

- Before you start to install Voicemail Pro it is advisable to check that the PC that you are using can connect to the IP Office unit and that you can load and save a configuration file using IP Office Manager.
- Switch off any PC and hard disk sleep, power down, suspend, hibernation modes.
- The Voicemail Pro software needs to be installed using an account with full administrator rights on the PC. The service subsequently runs under that account. We recommend that a specific account is created for this purpose and set so that its password does not expire.
2.1.1 PC Specification

The PC specification given below are the absolute minimum. To avoid replacing the server when adding new applications we recommend that at least a Pentium 4 2.8GHz or higher is used wherever possible.

This application requires various licenses entered into the IP Office configuration to control the features it offers and the number of simultaneous connections, up to 30 on the IP412 and IP500 control units. The operation of Voicemail Pro can be customized to provide special services.

The Voicemail Pro software can be installed as separate Voicemail Pro client and server parts. This allows the remote administration of the Voicemail Pro server from a PC with just the Voicemail Pro client installed. A copy of the client is automatically installed locally with the Voicemail Pro server.

Source

<table>
<thead>
<tr>
<th>CD</th>
<th>IP Office Voicemail Pro 4.2 CD's (700459357)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ScanSoft TTS CD's (700293921)</td>
</tr>
<tr>
<td>DVD</td>
<td>IP Office 4.2 Applications DVD (700459340)</td>
</tr>
<tr>
<td>Languages</td>
<td>Chinese (Mandarin and Cantonese), Danish, German, Greek, English (UK), English (US), Spanish, Latin Spanish, Finnish, French, French Canadian, Hungarian, Italian, Korean, Dutch, Norwegian, Polish, Portuguese, Brazilian, Swedish.</td>
</tr>
<tr>
<td>License</td>
<td>✓ See below.</td>
</tr>
</tbody>
</table>

The Voicemail Pro server part of the software consists of several components in addition to the core server software, these are:

- **Campaigns**
  The Voicemail Pro can be configured to run a campaign. This consists of a series of questions for which the Voicemail Pro records the callers answer or key presses. The resulting recordings can then be played back by users. The web aspect of campaigns allows user to perform this playback and processing of campaign recordings via their web browser. This requires an IIS web server to be run on the same PC as the Voicemail Pro software.

- **Text to Speech (TTS)**
  Through adding additional licenses, the Voicemail Pro is able to use the TTS functions of Windows to speak text and numbers to callers in addition to recording prompts. This is intended mainly for scenarios where the Voicemail Pro is obtaining text and number values from a customer database.

- **UMS Web Voicemail**
  UMS allows users to access their voicemail mailbox using either an IMAP compatible email program or through their web browser. UMS Web Voicemail requires the Voicemail Pro service to be installed on a server PC that has IIS already present. It also installs PHP if not detected as already present.

- **Integrated Messaging Service (IMS)**
  IMS allows synchronization between the users voicemail mailbox and their Microsoft Outlook via Microsoft Exchange. IMS is not supported with UMS and vice versa.

Notes:

1. Use of the Large Fonts setting is not supported. Use of this option may cause options on some screens to become inaccessible.
2. A 100Mbps network card is strongly recommended.
3. Free disk space requirements are also subject to the message storage required. For more information, see Disk Space Requirements.
4. IMS and Web Campaigns options within Voicemail Pro are only supported on Windows Servers. Aspects of operation such as Voicemail to Email, Integrated Messaging Pro (IMS), Web Campaigns, etc, are subject to further requirements as listed in the relevant sections.
### Basic Voicemail Pro

**Minimum PC Requirements**

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAM</td>
<td>256MB</td>
</tr>
<tr>
<td>Hard Disk Free Space</td>
<td>2GB*</td>
</tr>
<tr>
<td>Processor:</td>
<td></td>
</tr>
<tr>
<td>- Pentium</td>
<td>P4 1.4GHz</td>
</tr>
<tr>
<td>- Celeron</td>
<td>Any 1.7GHz</td>
</tr>
<tr>
<td>- AMD</td>
<td>Any 1.4GHz</td>
</tr>
</tbody>
</table>

*Also allow 1MB per minute for message and prompt storage.

**Operating System Support**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Client OS:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2000 Professional</td>
<td>×</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XP Professional</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vista Business/Enterprise</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vista Ultimate</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Voicemail Pro plus UMS Web Voicemail and/or Campaigns

**Minimum PC Requirements**

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAM</td>
<td>512MB</td>
</tr>
<tr>
<td>Hard Disk Free Space</td>
<td>2GB*</td>
</tr>
<tr>
<td>Processor:</td>
<td></td>
</tr>
<tr>
<td>- Pentium</td>
<td>P4 2.8GHz</td>
</tr>
<tr>
<td>- Celeron</td>
<td>Not tested.</td>
</tr>
<tr>
<td>- AMD</td>
<td>Athlon XP 3000+, Athlon 64</td>
</tr>
</tbody>
</table>

*Also allow 1MB per minute for message and prompt storage.

**Operating System Support**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Client OS:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2000 Professional</td>
<td>×</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XP Professional</td>
<td>×</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vista Business/Enterprise</td>
<td>×</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vista Ultimate</td>
<td>×</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Both Web Campaigns and UMS Web Voicemail require the IIS web server on the voicemail server PC to be enabled.
- UMS Web Voicemail will install PHP is not detected as already installed.
- UMS (IMAP or Web Voicemail) cannot be installed if IMS is installed and vice versa.

### Voicemail Pro plus IMS

Note that IMS is not supported with UMS.

**Minimum PC Requirements**

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAM</td>
<td>512MB</td>
</tr>
<tr>
<td>Hard Disk Free Space</td>
<td>2GB*</td>
</tr>
<tr>
<td>Processor:</td>
<td></td>
</tr>
<tr>
<td>- Pentium</td>
<td>P4 2.8GHz</td>
</tr>
<tr>
<td>- Celeron</td>
<td>Not tested.</td>
</tr>
<tr>
<td>- AMD</td>
<td>Athlon XP 3000+, Athlon 64</td>
</tr>
</tbody>
</table>

*Also allow 1MB per minute for message and prompt storage.

**Non OS Applications**

<table>
<thead>
<tr>
<th>Application</th>
<th>IMS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Exchange 2000</td>
<td>Yes</td>
</tr>
<tr>
<td>Microsoft Exchange 2003</td>
<td>Yes</td>
</tr>
<tr>
<td>Microsoft Exchange 2007</td>
<td>Yes</td>
</tr>
<tr>
<td>Microsoft Outlook 2003</td>
<td>Yes</td>
</tr>
<tr>
<td>Microsoft Outlook 2007</td>
<td>No</td>
</tr>
</tbody>
</table>
Voicemail Pro plus IVR and or TTS

<table>
<thead>
<tr>
<th>Minimum PC Requirements: Basic Voicemail Pro</th>
<th>Operating System Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAM</td>
<td>512MB</td>
</tr>
<tr>
<td>Hard Disk Free Space</td>
<td>20GB*</td>
</tr>
<tr>
<td>Processor:</td>
<td></td>
</tr>
<tr>
<td>- Pentium</td>
<td>P4 2.8GHz</td>
</tr>
<tr>
<td>- Celeron</td>
<td>Not tested.</td>
</tr>
<tr>
<td>- AMD</td>
<td>Athlon XP 3000+, Athlon 64</td>
</tr>
</tbody>
</table>

Also allow 1MB per minute for message and prompt storage.

- If the database being queried is located on the VM Pro server the query speed of the database will be affected by the amount of memory available. Please take into account the memory requirements of the database being queried.

Voicemail Pro plus Compact Call Center

<table>
<thead>
<tr>
<th>Minimum PC Requirements: Basic Voicemail Pro</th>
<th>Operating System Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAM</td>
<td>512MB</td>
</tr>
<tr>
<td>Hard Disk Free Space</td>
<td>10GB*</td>
</tr>
<tr>
<td>Processor:</td>
<td></td>
</tr>
<tr>
<td>- Pentium</td>
<td>P4 2.8GHz</td>
</tr>
<tr>
<td>- Celeron</td>
<td>Not tested.</td>
</tr>
<tr>
<td>- AMD</td>
<td>Athlon XP 3000+, Athlon 64</td>
</tr>
</tbody>
</table>

Also allow 1MB per minute for message and prompt storage.

- VM Pro and CCC can be run on the same server up to a maximum of 25 agents, 8 ports of VM Pro. Any Dual Core CPU of 2.4Ghz and higher is supported.

Ports

<table>
<thead>
<tr>
<th>Component</th>
<th>Location - %ProgramFiles%\Avaya\IP Office\</th>
<th>Ports</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voicemail Pro Service</td>
<td>Voicemail Pro\VM\vmprov5svc.exe</td>
<td>UDP 50791, UDP 50795, ALL 50801, ALL 8089.</td>
</tr>
<tr>
<td>VMPro Database</td>
<td>Voicemail Pro\VM\VMPDBSvc.exe</td>
<td></td>
</tr>
<tr>
<td>VPIM Client</td>
<td>Voicemail Pro\VPIM\VPIMClient.exe</td>
<td></td>
</tr>
<tr>
<td>VMPro VPIM DBSVR</td>
<td>Voicemail Pro\VPIM\vpimdbsvr.exe</td>
<td></td>
</tr>
<tr>
<td>VMPro VPIM Receiver</td>
<td>Voicemail Pro\VPIM\VPIMReceiver.exe</td>
<td></td>
</tr>
<tr>
<td>VMPro VPIM Server</td>
<td>Voicemail Pro\VPIM\VPIMServer3.exe</td>
<td></td>
</tr>
<tr>
<td>IMS Admin</td>
<td>Voicemail Pro\IMS\IMSAdmin.exe</td>
<td></td>
</tr>
<tr>
<td>IMS Service Restart</td>
<td>Voicemail Pro\IMS\IMSServiceRestart.exe</td>
<td></td>
</tr>
<tr>
<td>IMS Gateway Service</td>
<td>Voicemail Pro\IMS\UMServer.exe</td>
<td>TCP 445, TCP 593, UDP 445, UDP 593</td>
</tr>
<tr>
<td>IMS Voice Service</td>
<td>Voicemail Pro\IMS\VMServer.exe</td>
<td></td>
</tr>
<tr>
<td>IMS Security</td>
<td>Voicemail Pro\VM\IMSSec.exe</td>
<td></td>
</tr>
<tr>
<td>IMS Client for Outlook</td>
<td>%ProgramFiles%\Avaya\IMS Client\UMSForm.exe</td>
<td>TCP 445, TCP 593, UDP 445, UDP 593.</td>
</tr>
</tbody>
</table>
2.1.2 Network Requirements

The PC should be configured and tested for TCP/IP networking.

We strongly recommend that the voicemail server PC is connected to the IP Office Control Unit directly or via a LAN switch.

If directly connected, changing the settings of the PC network card to match the IP Office control unit can resolve some issues. This should be done according to the PC or network card manufacturer's instructions. The options for IP Office LAN ports are:

- **IP412**: Use LAN1 and half duplex.
- **Small Office Edition, IP406 (V2) and IP500**: Full duplex.
- All IP Office LAN ports are 10Mbps/100Mbps auto sensing.

If not directly connected, using any of the above settings must be supported and matched by the intervening network equipment.

- The PC should have a fixed IP address. Although PCs in a DHCP network may retain the same IP address between reboots this is not guaranteed.
- If the IP Office is acting as a DHCP server, it defaults to using 192.168.42.2 to 192.168.42.201 for DHCP clients. This leaves 192.168.42.202 to 192.168.42.254 for devices that require fixed IP addresses.
2.1.3 Disk Space Requirements
The following are only approximations:

- At least 2GB of free disk space is required on the operating system drive (by default c:\), regardless of to which drive Voicemail Pro is actually installed.
- A compact Voicemail Pro installation requires 130MB.
- A typical installation requires approximately 255MB.
  - A custom installation, including VPNM and IMS requires up to 2GB of disk space. However, prompts and recorded messages consume an additional 1MB of disk space per minute.
    - For Avaya IP Office Small Office Edition, you can expect to require at least 200 minutes of message recording space, that is 200MB.
    - For a busy environment you can expect to require at least 1000 minutes of message recording space, that is 1GB.
- If you are installing the Client only, you can expect to require at least 170MB.

2.1.4 Web Server Operation
If web browser access is required, the Microsoft IIS Web Server must be installed on the server PC before Voicemail Pro is installed:

- Microsoft web server products run as services and require Voicemail Pro to also run as a service. This applies on Windows 2003 or XP.
- Internet Information Server 5.0 or higher is required.

2.1.5 Voicemail Email Connection
Voicemail Email operation is supported using either MAPI or SMTP. MAPI requires the Voicemail Pro server PC to have a MAPI-compliant email client installed. For information, see Installing Voicemail Email:Overview. If Text to Speech is installed, email text to speech is supported using MAPI. For more information, see Setting up Text to Speech to Read Email.

In both of the above cases, full email sending from the server PC to a user PC should be configured and tested before Voicemail Pro is installed. Testing should use the same PC user account under Voicemail Pro is to be installed.

2.1.6 ContactStore Operation
The current IP Office Voice Recording Library (VRL) application is Avaya IP Office ContactStore. This application and its installation are documented separately.

However:

- IP Office ContactStore should be installed after Voicemail Pro has been installed and its operation verified.
- IP Office ContactStore must use a separate hard disk partition for its message archiving from that used by Voicemail Pro for current mailbox messages. Use of a separate hard disk or installation onto a separate server PC are alternatives.
- The use of RAID 1 or RAID 5 are recommended.
- The use of a DVD recorder for long-term archiving is recommended.
- A figure of 7.2MB per hour for archived recordings is given.
- The archived messages held by IP Office ContactStore are accessed via web browser using the port address 8888. This port address is not configurable and so it is necessary to ensure that it does not conflict with any other web server service running on the same server PC.
2.1.7 Voicemail Pro Licenses

The following License Keys can be used with Voicemail Pro. The license keys are entered into the IP Office configuration using the IP Office Manager. If the Voicemail Pro server is installed without a license, it will run for 2 hours and then shutdown.

- **Voicemail Pro (4 ports)**
  This is the basic license for all Voicemail Pro operation and must be present. It also enables 4 ports.

- **IP500 Upgrade Standard to Professional**
  The IP Office 500 does not support Voicemail Pro unless this license is present.

### Additional Port Licenses

The port licenses control the number of ports (simultaneously connected calls into/from the Voicemail Pro server). Note: The maximum number of ports supported for voicemail operation is set by the type of IP Office control unit. For more information, see Number of Simultaneous Voicemail Users.

- **Additional Voicemail Pro (2 ports)**
  Enables 2 additional Voicemail Pro ports.

- **Additional Voicemail Pro (4 ports)**
  Enables 4 additional Voicemail Pro ports.

- **Additional Voicemail Pro (8 ports)**
  Enables 8 additional Voicemail Pro ports.

- **Additional Voicemail Pro (16 ports)**
  Enables 16 additional Voicemail Pro ports.

### Voicemail Pro Feature Licenses

These licenses enable the use of specific features within Voicemail Pro.

- **Integrated Messaging**
  Enables operation of IMS with Voicemail Pro.

- **VMPro VB Script**
  Enables use of VB Scripting through the VB Script action.

- **VMPro Database Interface**
  Enables database integration within call flows.

- **VMPro TTS (Generic)**
  Enables use of text to speech facilities using the default Windows and third party TTS engines. One license per simultaneous instance of TTS usage.

- **VMPro TTS (ScanSoft)**
  Enables use of text to speech facilities using Avaya supplied TTS (ScanSoft) engines. One license per simultaneous instance of TTS usage.

- **Networked Messaging**
  Enables the use of Voicemail Pro Network Messaging.

- **VMPro Recording Administrators**
  Allows call recordings to be transferred to a VRL (Voice Recording Library) application. The currently supported application is ContactStore for IP Office.

  - For centralized voicemail operation, a VMPro Recording Administrators license is required in each IP Office system for which VRL support is required.

- **UMS Web Services (IP Office 4.2+)**
  Allows the voicemail server to run IMAP and Web Voicemail services. The number of UMS Web Services licenses set the number of users who can be configured to access either of those services.
2.1.8 User and Group Mailboxes

The voicemail server creates mailboxes based on the user and hunt group names that are entered in the IP Office Manager application. Whenever the Voicemail Pro is restarted or the IP Office configuration is changed, new mailboxes are created for any new names that are found.

This method of operation has the following consequences:

- **Mailboxes are based on names**
  For all users and groups, if their name is changed or deleted, they are no longer associated with their former mailbox and any associated Voicemail Pro start points.

- **Voicemail is case sensitive**
  If a mailbox or start point name is entered incorrectly in IP Office Manager or Voicemail Pro, the intended operation will not occur and the call may be disconnected.

- **Voicemail removes spaces at the end of mailbox names**
  If spaces are left at the end of a mailbox user's name in IP Office Manager, when the mailboxes are created, the space at the end of the name is dropped. When this occurs the mailbox cannot be found as there is a mismatch between the user name and directory.
2.2 Basic Voicemail Installation

When you complete a full Voicemail Pro installation you install the Voicemail Pro Server and Client together. With this option you can select some or all Voicemail Pro features to install. You can choose a compact, typical or custom installation.

Compact Installation
Choose the Compact option to install the minimum set of Voicemail Pro features. If only English language prompts are required, this is the quickest way to install Voicemail Pro. For more information, see Installing Compact Voicemail Pro Server and Client. The features installed are:

- The Voicemail Pro Client.
- The Voicemail Pro Server (installed as a Service on Windows 2003/XP Professional).
- Help files and .wav files for the Voicemail Prompts in English.
- Help files and .wav files for the Voicemail Prompts in the Language closest to that of the target machine locale.

Typical Installation
Choose the Typical option to install the most commonly used Voicemail Pro features. This option is recommended for most users.

- Everything in the compact installation.
- Voicemail Pro Campaign Web Component.
- All languages.

Custom Installation
Choose the Custom option if you would like to choose the Voicemail Pro features to install. This option is recommended for advanced users only. The following features are pre-selected and will be installed unless you choose not to install them:

- Voicemail Pro Client.
- Voicemail Pro Server (installed as a Service on Windows 2003/XP Professional).
- Voicemail Pro Campaign Web Component.
- Help files and .wav files for the Voicemail Prompts.
- Help files and .wav files for the Voicemail Prompts in the Language closest to that of the target machine locale.
- Other supported language options.
2.2.1 Installing Compact Voicemail Pro Server and Client

If you are upgrading an existing Voicemail System, see Upgrading a Voicemail Pro System.

The compact (basic) installation of Voicemail Pro provides:

- The Voicemail Pro Client.
- The Voicemail Pro Server (as either an executable program or service according to the Windows version).
- Appropriate prompts for the selected installation language.
- Help files and .wav files for Voicemail Prompts in English.
- Help files and .wav files for Voicemail Prompts in the language closest to that used by the locale of the target machine.

This is the minimum set of components that you need to run Voicemail Pro. Of all the setup types, compact Voicemail Pro is likely to take up the smallest amount of space but this depends on the language selections.

The process for installing a compact Voicemail Pro Server and Client comprises the following key steps:

1. Completing the pre-installation steps described in this section.
2. Installing the Voicemail Pro software as described in this section.

Before you begin:

1. Log on to the server PC using the account under which you intend the Voicemail Pro server or service to run. This account must have full administrator rights to the local PC.
   - **Recommendation**: Create a new user account called **Voicemail** and give it full administrator rights on the PC. This will help to identify the purpose of the account. Set the account password so that it does not expire.
2. In IP Office Manager, check that the correct licenses for Voicemail Pro are installed and show a status of Valid. For basic Voicemail Pro, the licenses required are:
   - **Voicemail Pro (4 ports)** plus **Additional Voicemail Pro (X ports)** licenses up to the total number of ports required or supported by the IP Office.
To install compact Voicemail Pro Server and Client:

1. Insert the IP Office Voicemail Pro CD. The installation should auto-start. If it does not auto-start, click Browse to locate Setup.exe on the CD and then run it. The Choose Setup Language window opens.

2. Select the installation language. This language is used for the installation and for the default language prompts.

3. Click OK. Installation preparation begins.

4. Voicemail Pro 4.2+ requires Microsoft .NET 2.0 Framework. If this version is not detected, you are prompted to install it. Click Yes to install Microsoft .NET 2.0 Framework.

If the following window opens, Voicemail Pro is already installed. You need to upgrade rather than install a new version. For more information, see Upgrading a Voicemail Pro System. Otherwise the IP Office Voicemail Pro installation starts and the Welcome window opens.

5. In the Welcome window, click Next. The Customer Information window opens.

6. In the Customer Information window, type a user name and the company name or use the default names that are proposed. These settings do not affect Voicemail Pro when it is installed.

7. In the same window, choose the option that determines who should be able to use Voicemail Pro when it has been installed. The recommended option is Anyone who uses this computer (all users).

8. In the Customer Information window, click Next. The Choose Destination Location window opens.

9. In the Choose Destination Location window, click Browse and locate the folder where the Voicemail Pro files are to be installed. Otherwise, Next to use the proposed folder. The Messaging Components window opens.

10. In the Messaging Components window, highlight Voicemail Pro (Full).

11. Click Next. The Setup Type window opens.

12. In the Setup Type window, select Compact.

13. Click Next. The Service Account Name window opens. Details of the default administrator account are already filled in.

14. In the Service Account Name window, type the User Name and Password for the user account under which the Voicemail Pro service should log on and run. This should be the Voicemail account created previously on the domain and Exchange server. Alternatively, click Browse and select from the list of available PC or network accounts.

15. Click Next. The Select Program Folder window opens. By default, the program folders are created in a folder called IP Office. You can specify a different folder or select one from the list of existing folders. To specify a different folder, type the folder name in the Program Folders box. Alternatively, to use an existing folder, highlight a name in the list of existing folders.

16. Click Next. The account details that you have entered are verified.

17. If you entered a new user name, a message is displayed to ask if you want to create a new PC user account with the specified name and password. Click Yes.

18. Click Next. A summary of the components that are about to be installed is shown. Check that this list is as expected. If for any reason the details are not what you expect, click Back and make the necessary changes.
When you are satisfied that the details are correct, click **Next** to start copying the files.

19. The Setup Status window opens to keep you informed while the installation takes place.

20. When the installation is complete you are prompted to restart the computer. Choose **Yes I want to restart my computer now**.

21. Click **Finish** to restart now.

22. When the computer restarts, log back in.

23. The IP Office Voicemail Pro - ACM Gateway Settings window opens. In the Mail Server box, type the name of the mail server to use.

24. Choose Message Networking/Interchange to use Interchange or Modular Messaging to use Modular Messaging.

25. Click **Next**. The IP Office Voicemail Pro - Email Settings window opens.

26. Enter the name of the email account to use or click Browse and select an account to use.

27. Click **Next**. The IP Office Voicemail Pro SMTP Email Settings window opens.

28. In the **Mail Server** box, type the name of the SMTP mail server or use the name that is proposed. This should be the fully qualified domain name.

29. In the **Port Number** box, type the number of the receiving port on the SMTP mail server. The default is 25.

30. To enforce server authentication, check the **Server Requires Authentication box**. This is optional. If you check it you also need to provide the Account Name and Password that need to be entered. You can also choose whether or not to set the **Use Challenge Response Authentication** option.

31. Click **Finish**. An attempt is made to validate the email settings. An error message is displayed when the attempt to connect with an SMTP server fails.

32. Click **OK** to acknowledge the message. You have now finished installing the Voicemail Pro Server and Client software. See **Starting the Voicemail Pro Server**, page 33.
2.2.2 Installing Typical Voicemail Pro Server and Client

If you are upgrading an existing voicemail system, see Upgrading a Voicemail Pro System.

This typical installation of Voicemail Pro provides:

- The Voicemail Pro Client.
- The Voicemail Pro Server (as either an executable program or a service).
- Web campaign components, including the IIS web server if it is not already installed.
- Options to install Help files and .wav files for the Voicemail Prompts in all supported languages.

The process for installing a typical Voicemail Pro comprises the following key steps:

1. Completing the pre-installation steps described in this section.
2. Installing the Voicemail Pro software as described in this section.
3. Configure Window 2003 to work with Web Campaigns. For more information, see Configuring Windows 2003 to Work with Web Campaigns.

Before you begin:

1. Log on to the server PC using the account under which you intend the Voicemail Pro server or service to run. This account must have full administrator rights to the local PC.
   - We recommend that a new user account called Voicemail is created and given full administrator rights on the PC. This will help identify the account's purpose. We also recommend that the account is set so that its password does not expire.
2. Check that the web server has been installed and is operating correctly. Test that its home page can be viewed from other PCs on the customer's network, that is the PCs of users who will want to access campaign messages.
3. In IP Office Manager, check that the correct licenses for Voicemail Pro are installed and show a status of Valid. For Voicemail Pro with Web Campaigns, the licenses required are:
   - Voicemail Pro (4 ports) plus Additional Voicemail Pro (X ports) licenses up to the total number of port required or supported by the IP Office control unit.
To install typical Voicemail Pro Server and Client:

1. Insert the IP Office Voicemail Pro CD. The installation should auto-start. If it does not auto-start, click Browse to locate Setup.exe on the CD and then run it. The Choose Setup Language window opens.
2. Select the installation language. This language is used for the installation and for the default language prompts.
3. Click OK. Installation preparation begins.
4. Voicemail Pro 4.2+ requires Microsoft .NET 2.0 Framework. If this version is not detected, you are prompted to install it. Click Yes to install Microsoft .NET 2.0 Framework.

   If the following window opens, Voicemail Pro is already installed. You need to upgrade rather than install a new version. For more information, see Upgrading a Voicemail Pro System. Otherwise the IP Office Voicemail Pro installation starts and the Welcome opens.

5. In the Welcome window, click Next. The Customer Information window opens.
6. In the Customer Information window, type a user name and the company name or use the default names that are proposed. These settings do not affect Voicemail Pro when it is installed.
7. In the same window choose the option that determines who should be able to use Voicemail Pro when it has been installed. The recommended option is Anyone who uses this computer (all users).
8. In the Customer Information window, click Next. The Choose Destination Location window opens.
9. In the Choose Destination Location window, click Browse and choose the folder where the Voicemail Pro files are to be installed. Otherwise, click Next to use the proposed folder. The Messaging Components window opens so that you can choose the components that you want to install.
10. In the Messaging Components window, highlight Voicemail Pro (Full).
11. Click Next. The Setup Type window opens.
12. In the Setup Type window, select Typical.
13. Click Next. The Select the Web Server root directory window opens so that you can specify the folder where the web campaign web pages are to be stored.
14. The default folder is C:\inetpub\wwwroot. To use the default folder, click Next. To specify a different folder, type the path to the preferred folder location. Alternatively, click Browse and locate the folder to use.
15. Click Next. The Destination of the Web Script Directory window opens so that you can specify the folder where the web campaign components are to be stored.
16. The default folder is C:\inetpub\scripts. To use the default folder, click Next. To specify a different folder, type the path to the preferred folder location. Alternatively, click Browse and locate the folder to use.
17. The Service Account Name window opens. Details of the default administrator account might already be filled in.
18. In the Service Account Name window, type the User Name and Password for the user account under which the Voicemail Pro service should log on and run. This should be the voicemail account created previously on the domain and Exchange server. Alternatively, click Browse and select from the list of available PC or network accounts or click Next to use the proposed account details. The Select Program Folder window opens.
19. By default the program folders are created in a folder called IP Office. You can specify a different folder or select...
one from the list of existing folders. To specify a different folder, type the folder name in the Program Folders box. Alternatively, to use an existing folder, highlight a name in the list of existing folders.

20. Click Next. The account details that you have entered are verified. If you entered a new user name, a message is displayed to ask if you want to create a new PC user account with the specified name and password. Click Yes. The Select Program Folder window opens.

21. Select the program folder where you would like the icons for the Voicemail Pro components to be added. By default the program icons are added to IP Office.

22. Click Next. A summary of the components that are about to be installed is shown. Check that this list is as expected. Check that the required languages are listed. English is always listed in addition to the selected installation language.

23. If for any reason the details are not what you expect, click Back and make the necessary changes. When you are satisfied that the details are correct, click Next to start copying the files. The Setup Status window opens to keep you informed while the installation takes place.

24. When the installation is complete you are prompted to restart the computer. Choose Yes, I want to restart my computer now.

25. Click Finish to restart.

26. When the computer restarts, log back in.

27. When the server PC has restarted, the IP Office Voicemail Pro - Email Settings window opens so that you can specify the name of the email account to use for outgoing SMTP e-mails from the Voicemail Pro server. In the Accounts Details box, type the name of the email account to use. Alternatively, click Browse and select an account to use.

28. Click Next. IP Office Voicemail Pro - SMTP Email Settings window opens so that you can specify details of the SMTP server to which the Voicemail Pro server should send messages. A proposed server name might already be filled in.

29. In the Mail Server box, leave the proposed name unchanged or type the name of the server to use. This should be the fully qualified domain name.

30. In the Port Number box, type the number of the receiving port on the SMTP mail server. The default is 25.

31. To enforce server authentication, check the Server Requires Authentication box. This is optional. If you check it you also need to provide the Account Name and Password that need to be entered. You can also choose whether or not to set the Use Challenge Response Authentication option.

32. Click Finish. An attempt is made to validate the email settings. An error message is displayed when the attempt to connect with an SMTP server fails.

33. Click OK to acknowledge the message. You have now finished installing the Voicemail Pro Server and Client software. See Starting the Voicemail Pro Server.

34. If you are using IIS version 6 under Windows 2003 server, some configuration changes are required. For more information, see Configuring Windows 2003 to Work with Web Campaigns.
2.2.3 Installing Custom Voicemail Pro Server and Client

If you are upgrading an existing voicemail system, see Upgrading a Voicemail Pro System. A custom installation of Voicemail Pro provides everything that is included in a typical installation plus:

- The opportunity to install software features in addition to those included in the typical installation, for example Integrated Messaging or Networked Messaging. For more information, see:
  - Installing Voicemail Email:Overview
  - Installing Centralized Voicemail Pro:Overview
  - Installing Text to Speech Features:Overview
  - Installing Integrated Messaging:Overview
  - Installing Networked Messaging:Overview
- The opportunity to choose not to install all of the components that are in a typical installation. For more information, see Removing Software Features from a Voicemail Pro Installation.
- The opportunity to select the languages to use for the wav and help files.
- The opportunity to select the TTY prompts and install them. For more information, see Installing Voicemail Pro TTY Prompts.
- The opportunity to select any languages that are not required and therefore to exclude them from the installation or remove them if they have already been installed. This can save disk space.

If you install the Web campaign component, you need to configure Window 2003 to work with Web Campaigns. For more information, see Configuring Windows 2003 to Work with Web Campaigns.

2.2.4 Removing Software Features from a Voicemail Pro Installation

When you choose to install a custom version of Voicemail Pro you can select additional features to install, for example IMS. You can also select any features that you do not want to install or actually want to remove. For example, if a feature has already been installed, you can select it for removal.

To remove a software feature from a Voicemail Pro Installation:

1. Complete the steps for installing custom Voicemail Pro Server and Client. For more information, see Installing Custom Voicemail Pro Server and Client.
2. When the Select Features window opens, uncheck any features that you do not want to install or that you want to remove.
   - Important - If you uncheck a feature that is already installed, it will be removed (uninstalled).
3. Continue the installation process as you would for installing custom Voicemail Pro Server and Client. For more information, see Installing Custom Voicemail Pro Server and Client.
2.2.5 Configuring Windows 2003 to Work with Web Campaigns

The following configuration changes are required for IIS version 6 running on a Windows 2003 server.

To configure Windows 2003:

1. Open the Windows Control Panel.
2. Select Administrative Tools > Computer Management.
3. Go to Services and Applications > IIS Manager > Web Sites > Default Web Site.
5. Select the Home Directory tab.
6. Under Application Settings section, set the Execute Permissions to Scripts and Executables.
7. Press OK twice.
8. Go to Web Service Extensions section under Web Sites.
9. Right-click and select Add a new web service extension....
10. In new web service extension, set the following values:
   - Extension Name: campaigns.
   - Required files: Click Add. Select the file type as CGI exe files and browse to the campaign.exe file location specified during installation. This is usually c:\InetPub\wwwroot\scripts\campaign.exe or c:\InetPub\scripts\campaign.exe.
   - Set extension status to Allowed: Enable this option.
11. Press OK.
2.2.6 The Voicemail Pro Services

If Voicemail Pro has been installed successfully, if the server PC has been rebooted then the voicemail service is started automatically. However it is useful to check the services and to know how to stop-start the services manually.

To check/restart the Voicemail Pro Service:

1. Open the Windows Control Panel.
2. Select Administrative Tools > Services.

3. The Voicemail Pro Service should be visible. Its Status should be Started and the Startup Type should be set to Automatic.

- Other services will be present depending on the Voicemail Pro options installed. The services are:
  - **Voicemail Pro Service**
    This is the main Voicemail Pro service. Normally this is the only service that needs to be stopped and restarted. It will stop and restart the other services that it uses.
  - **VMProDBService**
    This service is used for the Voicemail Pro database connectivity if licensed.
  - **IMS(Gateway), IMS(Voice) and IMS(Restart)**
    These services are used by the IMS components of Voicemail Pro if installed and licensed.
  - **VPNM Database Server, VPIM Receiver and VPNM Server**
    These services are used by the VPNM components of Voicemail Pro if installed and licensed.


To Initialize the Voicemail Pro Call Flow:

1. Select Start > Programs > IP Office > Voicemail Pro. The Voicemail Pro Client starts and the main window opens.
2. Click the Save and Make Live icon.
3. Select Yes. The file root.vmp is created and made available to the Voicemail Pro server. This is the compiled non-editable version of the editable call flow.
4. Voicemail operation can now be tested from an extension by dialing *17.

Setting the Voicemail Services or PC to Restart Automatically

The following action is optional. If there is some fault causing the Voicemail Pro service to halt, that fault should be investigated and fixed, however having the service or PC automatically restarted if possible will minimize the disruption to the Voicemail Pro users.

1. Use the Windows control panel to select the Voicemail Pro Service.
2. Right-click on the service and select Properties.
3. Select the Recovery tab.
4. Use the options presented to either restart the service and or restart the PC should the operating system detect that the Voicemail Pro service has halted.
**Using a Batch File to Start Services**

In some instances, certain computers might not respond quickly enough in order to start all of the Avaya services in the correct order. In this circumstance, it can be advisable to create a batch file which will delay the start of these services until the PC is fully running.

Avaya IP Office Services can be started successfully at system start-up using a scheduled task that initiates the batch file below. This batch file ensures that the services will start successfully and in the proper order.

1. Set all Avaya services listed below to **Manual** start. Do not include Key Server.

2. Create the batch file below and save it to `%SYSTEMROOT%`. Only include lines for the services which are installed.

   ```bash
   @echo off
   rem Wait 60 seconds before execute.
   timeout /t 60
   net start VMProDBService
   net start Voicemail Pro Service
   net start IMS(Restart)
   net start IMS(Voice)
   net start IMS(Gateway)
   ```

3. Create a scheduled task to start the batch file at system start-up.
2.3 Client Only Installation

You can install the Voicemail Pro Client without the Voicemail Pro Server. This is known as a partial installation.

There is only one type of installation for the Voicemail Pro Client. Therefore you are not offered the choice of custom, compact or typical during the installation process.

For information about Installing the Voicemail Pro Client only, see Installing the Voicemail Pro Client Only. For information about installing the Voicemail Pro Client and Server together, see Installing Compact Voicemail Pro Server and Client, or Installing Typical Voicemail Pro Server and Client.
2.3.1 Installing the VoiceMail Pro Client Only
You can install the Voicemail Pro Client on its own and use it to connect to a remote Voicemail Pro server.

To install the Voicemail Pro Client only:
1. Insert the IP Office Voicemail Pro CD. The installation wizard should auto-start. If it does not auto-start, browse to and run Setup.exe on the CD. The Choose Setup Language window opens.
2. Select the installation language. This language is used for the installation and for the default language prompts.
3. Click OK. Installation preparation begins.
4. Voicemail Pro requires Microsoft .NET 2.0 Framework. If this version is not detected, you are prompted to install it. Click Yes to install Microsoft .NET 2.0 Framework.

If the following window opens, Voicemail Pro is already installed. You need to upgrade rather than install a new version. For more information, see Upgrading a Voicemail Pro System . Otherwise the IP Office Voicemail Pro installation starts and the Welcome window opens.

5. In the Welcome window, click Next. The Customer Information window opens.
6. In the Customer Information window, type a user name and the company name or use the default names that are proposed. These settings do not affect Voicemail Pro when it is installed.
7. In the same window choose the option that determines who should be able to use Voicemail Pro when it has been installed. The recommended option is Anyone who uses this computer (all users).
8. In the Customer Information window, click Next. The Choose Destination Location window opens.
9. In the Choose Destination Location window, click Browse and choose the folder where the Voicemail Pro software is to be installed. Otherwise, click Next to use the proposed folder. The Messaging Components window opens so that you can choose the components that you want to install.
11. Click Next.
12. By default the program folders are created in a folder called IP Office. You can specify a different folder or select one from the list of existing folders. To specify a different folder, type the folder name in the Program Folders box. Alternatively to use an existing folder, highlight a name in the list of existing folders.
13. Click Next. The Start Copying Files window opens. Before any copying starts, you are presented with a summary of the settings that you have chosen so far.
14. Review the settings to make sure that they are what you expect. Scroll down if necessary.
15. If the details are not what you expect, click Back and make the necessary changes.
16. When you are satisfied that the details are correct, click Next to start copying the files.
The Setup Status window opens to keep you informed while the installation takes place.
17. When the installation is complete you are prompted to restart your computer. Click Yes to restart now.
18. Click Finish.

19. When the computer restarts, log back in. You have now finished installing the Voicemail Pro Client software. You can now start the Client and log in so that you start configuring remote Voicemail Pro servers. For more information, see Starting the Voicemail Pro Client. If required, you can then add one or more administrator users so that other administrators can work with the Voicemail Pro Client.
2.4 Upgrading Voicemail Pro

This section describes how to upgrade Voicemail Pro. The options available are:

- Upgrading from Voicemail Lite to Voicemail Pro. For information, see Upgrading from Voicemail Lite.
- Upgrading a Voicemail Pro version below 3.2 with the new version of software. For information, see Upgrading a Voicemail Pro System.
- Upgrading a Voicemail Pro version 3.2 or higher with the new version of the software. For more information, see Upgrade from 3.2 or higher.

2.4.1 Upgrade from below version 3.2

It is important that the settings of an existing Voicemail Pro are exported before any upgrade. Although folders that contain prompts and messages are not affected by the upgrade process, the editable version of a customer call flow is lost.

To upgrade from below version 3.2 to version 4.x+:

1. Export the Database
   Before removing Voicemail Pro as part of an upgrade, you must create a backup copy of the call flow database. This will contain any customizations made to the default call flow.
   1. Start the Voicemail Pro Client.
   2. From the **File** menu, select the option **Import or Export**.
   3. Select the option **Export call flows** and click **Next**.
   4. Enter a file path and file name ending in .mdb, for example C:\temp\backup.mdb. Click **Next**.
   5. Click **Finish** to start the export then click **Close** to complete the export procedure.
   6. Close the Voicemail Pro Client.

2. Back up the Registry
   Any registry settings that are associated with Voicemail Pro need to be backed up.
   1. Insert the Voicemail Pro CD for the new Voicemail Pro and cancel the install wizard that auto runs.
   2. Right-click the CD drive and select Open.
   3. Locate the file backupreg.bat and double-click it to run the application.
   4. Check that the registry settings have been backed up. The batch file should have created 3 backup files in the Windows Temp directory. Make sure that the following 3 files exist in that location:
      - VMPro.arf
      - NetAly.arf
      - IMS Gateway.arf

3. Remove Voicemail Pro
   Any previous versions of Voicemail Pro must be removed before you start to install the new version.
   1. Open the Windows Control Panel.
   2. Select **Add/Remove Programs**.
   3. Select **IP Office Voicemail Pro** and click **Add/Remove**.
   4. From the options offered, select **Remove** and click **Next**.
   5. Follow the prompts that you see on the screen during the removal process.
   6. When the process has been completed, select the option **Yes, I want to restart my computer now** and click **Finish**.

4. Restore the Registry
   The Voicemail Pro registry settings that were backed up in step 2 needs to be restored.
   1. Right-click the CD drive that contains the Voicemail Pro CD and select **Open** (reinsert the CD if necessary and cancel the install wizard).
   2. Locate the file restorereg.bat and double-click it to run the application. This restores the registry settings previously associated with Voicemail Pro.

5. Install the New Software
   For more information see Installing Voicemail Pro:Overview and then refer to the sections that relate to the type of Voicemail Pro that you intend to install.
6. Restore the Database
The copy of the call flow database that contained any customizations made to the default call flow needs to be restored.

1. Start Voicemail Pro.
2. From the File menu, select Import or Export. The Import or Export Call Flows window opens.
4. Click Next.
5. Click the Browse button and locate the file that contains the backed up call flows.
6. Select the file and click Open.
7. In the Import or Export Call Flows window, click Next.
8. Click Finish to start importing the database.
9. Click Close to complete the import process.
10. Click on Save and Make Live to save the Call flows.

The new version of Voicemail Pro has been installed. Test that the system is running by dialing *17 from any extension. You should hear the mailbox announcement.

2.4.2 Upgrade from Version 3.2+
You can directly upgrade versions of Voicemail Pro from Voicemail Pro 3.2 upwards. However we still recommend that you follow the procedure for backing up the database before upgrading.

To upgrade from version 3.2 or higher:
1. Insert the new IP Office Voicemail Pro CD. The installation should auto-start. If it does not auto-start, click Browse to locate Setup.exe on the CD and then run it. The Choose Setup Language window opens.
2. Select the installation language. The language selected is used for the installation.
3. Click OK. You are asked 'This setup will perform an upgrade of IP Office Voicemail Pro'. Do you want to continue?
4. Click Yes. The Upgrading the IP Office Voicemail Pro window opens.
5. Click Next to start the upgrade. The setup status window opens. The progress of the upgrade is indicated by a time bar. When the InstallShield Wizard complete window opens.
6. Click Finish. The Email settings window opens.
7. Enter your email account details and click Next. The SMTP Email settings window opens.
8. Enter your SMTP Email details and click Finish. The SMTP settings entered will be validated. If an error occurs, the validating configuration window opens containing the error. For more information, see SMTP Errors.
9. Click Yes when asked if you want to start the Voicemail Pro service.

The new version of Voicemail Pro has been installed. Test that the system is running by dialing *17 from any extension. You should hear the mailbox announcement.
2.4.3 Upgrade to Voicemail Pro

You can upgrade from Voicemail Lite to Voicemail Pro. The process described here assumes that Voicemail Pro is being installed onto the same PC that previously hosted Voicemail Lite. The steps described here will remove Voicemail Lite but will not remove the existing mailbox messages and greetings.

To upgrade from Voicemail Lite to Voicemail Pro:

1. Remove Voicemail Lite
   1. Make sure that Voicemail Lite is not running. It might be necessary to close the Voicemail Lite server program.
   2. Open the Windows Control Panel and select Add/Remove Programs.
   4. Click Next. The Program Maintenance window opens.
   5. Select Modify and click Next.
   6. In the list of selected Features, click the option Voicemail Lite and select This feature will not be available. The feature Voicemail Lite will have a red cross by the name.
   7. Click Next. The Ready to Modify the Program window opens.
   8. Click Install. The Voicemail Lite program will be removed, which may take several minutes.
   9. Click Finish to exit the InstallShield Wizard.
   10. Click Close to close the Add/Remove Programs window.
   11. Remove any shortcuts to VMLite.exe from Start > Programs > Startup.

2. Install the New Software
   The next step is to install the Voicemail Pro software. For more information see Installing Voicemail Pro:Overview and then refer to the sections that relate to the type of Voicemail Pro that you intend to install.

3. Move the Voicemail Lite Folders
   This must be done before users start to use Voicemail Pro. As part of the upgrade procedure you need to move the Voicemail Lite folders that contain any existing voicemail messages and mailbox greetings. This stage copies the existing Voicemail Lite messages and greetings over the newly installed Voicemail Pro set.
   4. Using Windows Explorer or My Computer, locate the folder C:\Program Files\Avaya\IP Office\Voicemail Server.
   5. Copy all sub-folders and files in that folder.
   6. Paste the sub-folders and files in the folder C:\Program Files\Avaya\IP Office\Voicemail Pro\VM. Replace any existing folders.

7. Select the Mailbox Mode.
   Voicemail Lite runs in IP Office mailbox mode. By default Voicemail Pro installs in Intuity mailbox mode. If required by your users, you can set Voicemail Pro back to IP Office mailbox mode.
   1. Start the Voicemail Pro Client.
   2. Click the Preferences icon and select General.
   3. On the General tab, change the Default Telephony Interface from Intuity to IP Office.
   4. Click OK.
   5. Click Save & Make Live.

The new version of Voicemail Pro has been installed. Test that the system is running by dialing *17 from any extension. You should hear the mailbox announcement.
2.5 Voicemail Email Installation

Voicemail Email sends mailbox users who have been configured with an email address, an email whenever their mailbox contains a new message. The notification email can contain an alert about the message or an attached copy of the message.

- Although they are similar in concept, Voicemail Email and Integrated Messaging Service (IMS) are two different components of Voicemail Pro and should not be confused.

Voicemail Email requires the voicemail server to be running under a user account that has access to either a MAPI enabled email client program on the server PC or access to an SMTP email server.

SMTP: Simple Mail Transfer Protocol
This protocol allows the Voicemail Pro server to send outgoing emails to a specified SMTP server. Microsoft Exchange and most commercial email servers support SMTP to receive emails. SMTP for Voicemail Pro is therefore easy to implement in any business that has its own email server. For more information, see Installing Voicemail Pro for SMTP Voicemail Email.

MAPI: Microsoft Windows Messaging Application Program Interface
This is a set of API's that allow MAPI applications to share information and messages. MAPI requires a MAPI compliant email client program to be installed on the Voicemail Pro server. It also requires the Voicemail Pro service to be run using a user account that is able to send emails via that MAPI client. Supported MAPI clients are:

  MAPI Voicemail Email can be used with Voicemail Lite and Voicemail Pro. For Voicemail Pro installed as a service (the default on Windows 2000/2003/XP Professional), emails can be sent without having to open and run the MAPI email client program. For Voicemail Pro installed as a server program, the email client program may have to be left open for mail transfers to take place.

The exact method of integration between the voicemail server and the MAPI email client depends on whether the voicemail server is part of a work group or a domain. This guide contains examples for both approaches.

The MAPI process described in this guide was based on Microsoft Windows 2000 Professional with Microsoft Outlook 2000 and Microsoft Outlook Express 5.5. Steps may differ depending on the version of Windows and email client used.

2.5.1 Installing VoiceMail Pro for SMTP Voicemail Email

To install VoiceMail Pro for SMTP Voicemail Email

1. Obtain details of an email account that the Voicemail Pro service can use from whoever administers the customer's email server. The details required are:
   - Email address.
   - Server SMTP address.
   - Account user name and password.
2. Install the Voicemail Pro software as required.
3. After the server PC restart, enter the Voicemail Pro SMTP email account settings when requested.
4. Configure the appropriate user accounts with the user's email address. For more information, see Configuring Email Users and Groups for Voicemail Email.
2.5.2 Domain Member

2.5.2.1 Installing VoiceMail Pro for MAPI VoiceMail Email as a Domain Member

Before you start to install the Voicemail Pro software, you must:
1. Create a voicemail domain account. For more information, see Creating a Voicemail Domain Account.
2. Configure Outlook. For more information, see Configuring Outlook for Internet Mail.

You are then ready to install Voicemail Pro for MAPI Voicemail Email as a Domain Member. This involves the following key stages:
1. Install the Voicemail Pro software. For more information, see Installing the Voicemail Pro Software.
2. Change the SMTP settings, which are installed by default, to MAPI. For more information, see Switching Voicemail Pro to MAPI.

2.5.2.2 Creating a Voicemail Domain Account

To create a Voicemail Domain Account
1. Make sure that the PC that will be running the voicemail server is a member of the domain. To join the domain you will need the use of a log account with administrative permissions on the domain as well as the server PC, consult the domain administrator.
   - Windows 2000
     Right click My Computer and select Properties. Select the Network Identification tab.
2. On the Exchange server:
   - Create an account called Voicemail on the domain and an associated mailbox.
   - Provide a secure password.
   - Check the User Cannot Change Password and Password Never Expires boxes.
3. Log on to the voicemail server PC using a domain administrator account.
4. From the Control Panel, select Administrative Tools.
5. Select Computer Management | Local Users and Groups | Groups.
6. Double-click Administrators and select Add.
7. From the Look In list select the domain name.
8. In the Name window, locate and highlight Voicemail. Click Add followed by OK and OK to close.
2.5.2.3 Configuring Outlook for VoiceMail Email

To configure Outlook for Voicemail Pro email

1. On the desktop, right-click the Outlook icon and select Properties.
2. On the General tab, select Add.
4. Click Next.
5. In the Server field, enter the name of the Exchange Server.
6. In the Mailbox field, enter Voicemail.
7. Click Next.
8. When you are asked if you travel with this computer, select No.
9. Click Next.
10. Click Finish.
11. Highlight the MS Exchange Settings and click Properties.
13. Click Check name and ensure that the name is resolved.
14. If the name is resolved, select Apply.
15. Click OK, OK and Close to shut the mail settings.
16. Do not continue until the name has been resolved correctly with the Exchange Server. If the name is not resolved, check the account details with the Exchange Administrator.
17. Open Outlook and select Yes to register Outlook as the default email application.
18. Select Tools > Options.
19. Click the Preferences tab.
20. Click Email Options.
21. Uncheck Save copies of messages in Sent Items folder.
   - You might want this option selected during initial setup to aid troubleshooting. However due to the size of wav file message attachments you should uncheck it after installation testing is complete.
22. Log on to the Voicemail Pro Server PC using the voicemail account.
23. From Outlook, send a message direct to an extension user.
24. If this message is received correctly, you can continue installing the Voicemail Pro software. For more information, see Installing the Voicemail Pro Software.
2.5.2.4 Installing the VoiceMail Pro Software

To install the Voicemail Pro software

1. Log off and log back on using the Voicemail account and password.
2. Install the required Voicemail Pro software. For more information, see Installing Compact Voicemail Pro Server and Client or Installing Typical Voicemail Pro Server and Client.
3. When the installation process requests a User Name and Password for the Voicemail Pro service, enter the Voicemail account details.
4. Restart the server PC when requested and log on using the Voicemail account.
5. When SMTP email details are requested, enter no values and ignore the error message following the SMTP check.
6. Start the Voicemail Pro server service. For more information, see Starting the Voicemail Pro Service.
7. Check that the basic voicemail services start and operate correctly.
8. The next step is to switch the Voicemail Pro to MAPI operation. For more information, see Switching Voicemail Pro to MAPI.
2.5.2.5 Switching VoiceMail Pro to MAPI
2.5.3 Work Group Member

2.5.3.1 Installing VoiceMail Pro for MAPI VoiceMail Email as a Work Group Member

Before you start to install the Voicemail Pro software, you must:

1. Create a voicemail user account. For more information, see Creating a Voicemail User Account.
2. Configure Outlook Express for Internet Mail. For more information, see Configuring Outlook Express for Internet Mail.
3. Configure Outlook for internet mail. For more information, see Configuring Outlook for Voicemail Email.
4. Configuring Outlook for exchange server. For more information, see Configuring Outlook for Exchange Server.

The user name and password created are requested as part of the installation of the Voicemail Pro service. The process described here assumes that Outlook is installed but has not been previously used or configured.

You are then ready to install the Voicemail Pro software. For more information, see Installing the Voicemail Pro Software.

By default, Voicemail Pro is set to use SMTP for emails. You need to change this to MAPI. For more information see, Switching Voicemail Pro to MAPI.

You also need to set the SMTP Email Account settings on the Voicemail Pro so that they match those of the customer's email server. For more information, see Changing SMTP Email Account Settings.

2.5.3.2 Creating a Voicemail User Account

To create a Voicemail User Account

1. Log on to the server PC as the local administrator and create a new user. For this example the name of the user account created used is Voicemail.
2. Set a secure password.
3. Clear User must change password at next logon and check Password never expires.
4. Click Create and then Close.
5. Right-click the New Account, and select Properties.
6. Select the Member Of tab.
7. Click Add.
8. In the Select Groups window, highlight Administrators and click Add. Click OK.
9. Continue with one of the following as appropriate to the installed MAPI client and method for sending email.
2.5.3.3 Configuring Outlook Express for Internet Mail

To configure Outlook Express for Internet Mail

1. Click the Outlook Express icon to start the Configuration wizard.

2. In the **Display name** box enter **Voicemail**.

3. Click **Next**.

4. Select **I already have an e-mail address that I'd like to use** and enter the address in E-mail address, eg. voicemail@your_domain_name. Click **Next**.

5. Enter the name or address of the Incoming mail server and the Outgoing mail server. Note, if you enter the name, you must ensure that the voicemail PC has the correct IP address of the DNS Server configured.

6. Click **Next**.

7. Enter the email account name and password, for example Voicemail. Select **Remember password**.

8. Click **Next**.

9. Click **Finish** to complete the wizard.

10. Open Outlook Express and select **Tools > Options**.

11. Click the **General** tab.

   - Uncheck **Send and Receive messages at Start up**.
   - Uncheck **Check for new messages every**.

12. Select the **Send** tab.

   - Uncheck **Save copy of sent messages in the 'Sent Items' folder**.
   - Check **Send messages immediately**.
   - Under **Mail Sending Format** select **Plain Text**.

13. Click **OK**.

14. Log on to the server PC using the account that will be used for the Voicemail Pro server.

15. From Outlook or Outlook Express, send a message direct to an extension user.

16. If this message is received correctly, continue with installing the Voicemail Pro software.
2.5.3.4 Configuring Outlook for Internet Mail

For the installation of Outlook to work correctly, the following setup process must be followed. Outlook can be configured in two ways. Using the Wizard, prior to completing the steps below will cause Outlook not to send the messages correctly.

To configure Outlook for Internet Mail:
1. Right-click the Outlook icon on the desktop and select Properties.
2. Select Add.
3. Select Internet Email and click OK.
4. For the Mail Account, enter Voicemail.
5. For User Information enter Voicemail as the Name and for the Email address enter your address, for example: voicemail@your_domain_name.
6. Select the Servers tab. Enter the name or IP address of the Outgoing mail server and Incoming mail server.
7. The Incoming Mail Server details can be left blank as Outlook does not need to check for mail. Otherwise, enter the account name and password for example, Voicemail. Select Remember password.
8. Select the Connection tab. Select Connect using my local area network (LAN). Click Next.
9. Click OK.
10. Click Next.
11. Accept the default path for file creation.
12. Select Next, then Finish and then Close.
13. Open Outlook.
14. On the Email Service Option Screen, select Internet Only.
15. Click Next.
16. Select Yes to register Outlook as the default email application.
17. Select Tools > Options.
18. Click the Preferences tab.
19. Click Email Options.
20. Uncheck Save copies of messages in Sent Items folder.
   - You might want this option selected during initial setup and troubleshooting. Due to the size of wav file message attachments it is advisable to uncheck it after installation is complete.
21. Log on to the server PC using the account that will be used for the Voicemail Pro server.
22. From Outlook or Outlook Express, send a message direct to an extension user.
23. If this message is received correctly, continue with installing the Voicemail Pro software.
To configure Outlook for Exchange Server:

1. Create a new mailbox on the Exchange Server, for example Voicemail, and assign it the same password as has been configured on the voicemail PC.
2. Clear User must Change password at Next Logon and select Password Never Expires.
3. On the voicemail PC, logon with the Voicemail account.
4. Right-click the Outlook icon on the desktop and select Properties.
5. Select Add.
6. Highlight Microsoft Exchange Server and click OK.
7. Type in the Microsoft Exchange Server name and enter Voicemail in the Mailbox field.
8. Highlight the MS Exchange Settings, Click Properties.
10. Click Check name and ensure the name is resolved.
11. If the name is resolved, select Apply. Click OK, OK and Close to shut the Mail settings.
12. Do not continue until the name has been resolved correctly with the Exchange Server. If the name is not resolved, check the account details with the exchange administrator.
13. Open Outlook and select Yes to register Outlook as the default email application.
15. Choose the Preferences tab. Click Email Options.
16. Uncheck Save copies of messages in Sent Items folder.
   • You may want this option selected during initial setup and troubleshooting. Due to the size of wav file message attachments deselect it once installation is complete.
17. Log on to the server PC using the account that will be used for the Voicemail Pro server.
18. From Outlook or Outlook Express, send a message direct to an extension user.
19. If this message is received correctly, continue with installing the Voicemail Pro software.
2.5.3.6 Installing the VoiceMail Pro Software

To install the VoiceMail Pro software

1. Log off and log back on using the Voicemail account and password.
2. Install the required Voicemail Pro software. For more information, see Installing Compact Voicemail Pro Server and Client or Installing Typical Voicemail Pro Server and Client.
3. When the installation process requests a User Name and Password for the Voicemail Pro service, enter the Voicemail account details.
4. Restart the server PC when requested and log on using the Voicemail account.
5. When SMTP email details are requested, enter no values and ignore the error message following the SMTP check.
6. Start the Voicemail Pro server service. For more information, see Starting the Voicemail Pro Service.
7. Check that the basic voicemail services start and operate correctly.
8. The next step is to switch the Voicemail Pro to MAPI operation. For more information, see Switching Voicemail Pro to MAPI.
2.5.3.7 Switching VoiceMail Pro to MAPI
2.5.3.8 Changing SMTP Email Account Settings

To change SMTP Email Account Settings:

1. Open the Windows Control Panel.

2. Select IP Office Voicemail Pro.

3. Select the SMTP Email Settings tab.

   - SMTP Server
     - Mail Server: [Server]
     - Port Number: 25
     - Mail Drop: C:\notpub\mailroot\Drop
   - Server requires authentication
     - Account Name:
     - Password:
     - Use Challenge Response Authentication (CHAP-MD5)

4. Enter the settings to match the customer's email server and the email account configured on that server for the Voicemail Pro service.

5. Click the Email Settings tab.

   - Account Details
     - server [server]
     - Browse
   - Message Parameters
     - The following settings are used to control whether the Voicemail message is sent as a wave file within the email message.
       - Transmit Wave File
         - Attach wave file to message
         - Embed wave file in message

6. Enter the email address for the account setup on the customer's email server for the Voicemail Pro service.

7. Click Check to test the connection to the specified email account.

8. Click OK.
2.5.4 Operation
2.5.4.1 Configuring Email Users and Groups for Voicemail Email

Voicemail Email can be used with user mailboxes and hunt group mailboxes.

User or group email addresses can be specified only through IP Office Manager. The remaining settings, for example email alert, can be set using any of the following methods:

- Through IP Office Manager.
  For more information, see the IP Office Manager help or user guide.

- By logging in to the mailbox (for IP Office mode mailboxes).
  Voicemail Lite or Voicemail Pro users who have an IP Office mode mailbox can switch Voicemail Email on/off and select the mode of Voicemail Email operation. The exact method for doing this depends on the type of telephone being used. Mailbox owners can find more information in the IP Office Mailbox User Guide.

- Through a Voicemail Pro call flow that uses a Play Configuration Menu action.
  For Voicemail Pro systems, the Play Configuration Menu action can be used to allow a caller set a user or group's Voicemail Email alert mode. Note however that this action is not aware whether the user or group has an email address set for the service. For more information, see Play Configuration Menu Action.

Other Phone Types and External Call Access

If no email address has been set for the user or group, the voicemail server responds with the message "Email is not enabled for this mailbox".

After they log in to their mailbox, mailbox owners have the following options:

- *01 - Sets the Voicemail Email mode to Forward.
- *02 - Sets the Voicemail Email mode to Alert.
- *03 - Sets the Voicemail Email mode to Off.

Mailbox owners can find out more in the user guide for their type of mailbox.
### 2.5.4.2 IP Office Manager Settings

The voicemail email settings are found on the Voicemail tab of the user.

<table>
<thead>
<tr>
<th>Voicemail</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Voicemail Code</td>
<td></td>
</tr>
<tr>
<td>Confirm Voicemail Code</td>
<td></td>
</tr>
<tr>
<td>Voicemail Email</td>
<td><a href="mailto:barry.shear@acme.com">barry.shear@acme.com</a></td>
</tr>
<tr>
<td>Voicemail Email</td>
<td></td>
</tr>
<tr>
<td>Off</td>
<td>Copy</td>
</tr>
</tbody>
</table>

The voicemail email settings are also on the voicemail tab of the hunt group.

<table>
<thead>
<tr>
<th>Voicemail</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Voicemail Code</td>
<td></td>
</tr>
<tr>
<td>Confirm Voicemail Code</td>
<td></td>
</tr>
<tr>
<td>Voicemail Email</td>
<td><a href="mailto:sales@acme.com">sales@acme.com</a></td>
</tr>
<tr>
<td>Voicemail Email</td>
<td></td>
</tr>
<tr>
<td>Off</td>
<td>Copy</td>
</tr>
</tbody>
</table>

#### Voicemail Email
The user’s or group’s email address.

#### Voicemail Email

- **Off**
  Switches off the use of Voicemail Email. Note that other services using the email address such as Email TTS can still operate.

- **Copy**
  Send a copy of each new message as a wav file attachment to the email. The original message remains in the mailbox. Forward and Copy should be used with care. Each 1 minute message will result in a 1MB wav file. This may impact on the performance of the network and email connection.

- **Forward**
  Send a copy of each new message as a wav file attachment to the email and delete the original message from the mailbox. Note, this settings overrides all other actions such as message waiting indication and voicemail ringback.

- **Alert**
  Send an email alert for each new voicemail message but do not attach a copy of the message.

- **Voicemail Email Reading**
  This is part of TTS operation but uses the same email address as set for Voicemail Email.
2.5.4.3 How Voicemail Email Messages Look

Messages sent by a user or group’s voicemail email settings contain the following:

- **To**
  The user/group email address.

- **From**
  The name and address setting of the email client account.

- **Subject**
  Voicemail Message ('calling number' > 'user name') From:'calling number'.

- **Body**
  If the user or group’s Voicemail Email mode is set to Copy or Forward, the message body will contain "IP Office Voicemail redirected message".

- **Attachment**
  When using Copy or Forward mode, the message is attached as a wav file.

Messages sent via a Voicemail Pro eMail action are configurable, see [The Voicemail Pro eMail Action](#).
The **eMail** action in Voicemail Pro can be used to send messages via email in response to caller actions in the voicemail call flow. The action can also attach a wav file.

In the example above, the **eMail** action follows a **Voice Question** action. The $ in the eMail action’s **Attach file to email** field instructs it to use the file recorded by the preceding **Voice Question** action.

The same method can be used with a **Leave Mail** action. Note however that the **Leave Mail** action must be set to a valid target mailbox which will then have a copy of the message.

Alternatively, the **eMail** action can attach a prerecorded wav file by specifying the file name. That named file can be created by an **Edit Play List** action.
2.5.4.5 SMTP Errors

SMTP error logging can be enabled to generate a log of SMTP activity. For a default Voicemail Pro installation the activity is logged in a file in \Program Files\Avaya\IP Office\Voicemail Pro\logs. The file name includes a date stamp for the day on which it is generated.

Enabling SMTP Error Reporting:
1. Stop the Voicemail Pro service
2. Start the Registry Editor.
3. Locate the key HKEY_LOCAL_MACHINE\SOFTWARE\Network Alchemy\Voicemail\Directories.
4. From the menu bar select Edit.
5. Select New and then String Value.
6. Enter SMTPLogging.
7. Right-click on the new registry key SMTPLogging and select Modify.
8. Set the value to 1.
9. Close the Registry Editor.

<table>
<thead>
<tr>
<th>Value</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>An exception has occurred.</td>
</tr>
<tr>
<td>3</td>
<td>The process has run out of memory.</td>
</tr>
<tr>
<td>4</td>
<td>An error has occurred due to a problem with the message body or attachments.</td>
</tr>
<tr>
<td>5</td>
<td>There was a problem initiating the conversation with the mail server. Ensure the setting of the Domain property is correct.</td>
</tr>
<tr>
<td>6</td>
<td>There was an error terminating the conversation with the SMTP mail server.</td>
</tr>
<tr>
<td>7</td>
<td>The &quot;From&quot; address was not formatted correctly or was rejected by the SMTP mail server. Some SMTP servers will only accept mail from particular addresses or domains. SMTP mail servers may also reject a from address if the server can not successfully do a reverse lookup on the from address.</td>
</tr>
<tr>
<td>8</td>
<td>An error was reported in response to receipt address. The SMTP server may refuse to handle mail for unknown recipients.</td>
</tr>
<tr>
<td>9</td>
<td>There was an error connecting to the SMTP mail server.</td>
</tr>
<tr>
<td>10</td>
<td>There was an error opening the file. If you have specified file attachments, ensure that they exist and that you have access to them.</td>
</tr>
<tr>
<td>11</td>
<td>There was an error reading a file. If you have specified file attachments, ensure that they exist and that you have access to them.</td>
</tr>
<tr>
<td>15</td>
<td>No mail server specified.</td>
</tr>
<tr>
<td>16</td>
<td>There was a problem with the connection and a socket error occurred.</td>
</tr>
<tr>
<td>17</td>
<td>Could not resolve host.</td>
</tr>
<tr>
<td>18</td>
<td>Connected but server sent back bad response.</td>
</tr>
<tr>
<td>19</td>
<td>Could not create thread.</td>
</tr>
<tr>
<td>20</td>
<td>Canceled as a result of calling the Cancel method.</td>
</tr>
<tr>
<td>21</td>
<td>The operation timed-out while the host was being resolved.</td>
</tr>
<tr>
<td>22</td>
<td>The operation timed-out while connecting.</td>
</tr>
<tr>
<td>24</td>
<td>ESMTP Authentication failed.</td>
</tr>
<tr>
<td>25</td>
<td>The selected ESMTP Authentication mode is not supported by the server.</td>
</tr>
<tr>
<td>26</td>
<td>ESMPT Authentication protocol error.</td>
</tr>
<tr>
<td>27</td>
<td>Socket Timeout error.</td>
</tr>
<tr>
<td>105</td>
<td>Invalid license key.</td>
</tr>
</tbody>
</table>
2.6 Centralized Voicemail Pro

A single Voicemail Pro server on a central IP Office system can be used to provide voicemail services for other remote IP Office systems. This is called Centralized Voicemail Pro.

Centralized Voicemail Pro requires the IP Office systems to be linked by an IP Office Small Community Network (SCN). To avoid the likelihood of two Voicemail Pro servers answering for the same user, only one centralized Voicemail Pro server can be installed on a single Small Community Network (SCN). For more information about restrictions that need to be considered before installing Centralized Voicemail, see Restrictions.

Notes
- For information about small community networking and setting up VoIP lines, see the IP Office Manager User Guide.
- By default each IP Office is set to use a broadcast IP address to locate a voicemail server. It can therefore appear that centralized voicemail is operating before the remote system is set to the Voicemail Type of Line.
- Leaving the systems in this arrangement rather than setting the remote system’s Voicemail Type to Line can cause problems and is not supported.
2.6.1 Planning Requirements

The following factors must be remembered during planning of the Centralized Voicemail Pro system:

- The voicemail Server PC is attached to the central system.
- A Feature key and Voicemail Pro license key are required for the central system hosting the Voicemail Pro.
- Small Community Networking (SCN) is required between the central system and remote systems. This document assumes that this has already been set up and tested.
- On networked IP Office systems, it is possible for centralized voicemail to appear operational without Small Community Networking. However, this operation tends to be unpredictable and so we support Centralized Voicemail Pro only when using Small Community Networking.
- VCM modules or VoIP channels are required in the remote and central systems.
- The extension and group **numbering** on all systems must be unique.
- The extension and group **names** on all systems must be unique.
- We also recommend that all names and numbers (groups, line, services, etc) on the separate IP Office systems are kept as unique as possible. This will reduce potential maintenance confusion.

2.6.2 Restrictions

- **Voicemail Support - Centralized Voicemail using Voicemail Pro**
  Within a Small Community Network, a single Voicemail Pro can be used to provide voicemail services for all the IP Office systems. For full details of installation and setup refer to the Voicemail Pro documentation. The Voicemail Pro is licensed and hosted by a chosen central IP Office system and provides full operation for that system. The voicemail features supported for the other remote IP Offices are listed below:
    - For IP500 system, centralized voicemail does not require the remote systems to be running in IP500 Professional mode. Only the IP500 hosting the Voicemail Pro server is required to be IP500 Professional.

- **User mailboxes.**
- **Call recording.**
  Recording of incoming call routes is only supported for destinations on the same IP Office system, not for remote SCN destinations.
- **Dial by Name.**
- **Auto Attendants.**
- **Breakout**
  Requires that the numbers used are routable by the system hosting the voicemail server.
- **Announcements**
  Using IP Office 4.0 announcements. Pre-4.0 announcements are only supported for queues on the system hosting the voicemail server.
- **ContactStore**
  This application is supported but requires each individual IP Office to have a **VMPRO Recordings Administrator** license.
- **UMS Web Services**
  Users for UMS Web Services (IMAP and or web voicemail) are licensed through the **UMS Web Services** license on their host IP Office system. This applies even if the user remote hot desks to another system in the Small Community Network.
2.6.3 Configuring the Remote System Voicemail Settings
After you have installed the centralized Voicemail Pro, you are ready to configure the remote system settings.

To configure the remote system Voicemail settings:
1. Start IP Office Manager and receive the configuration of the remote system.
2. Set the License Server IP Address to the address of the PC acting as the remote system's Feature Key Server PC.
   - This cannot be the same PC as the central system's Feature Key Server PC.
   - If the remote system does not use any licenses, enter 0.0.0.0.
3. Double-click the System icon.
4. Select the Voicemail tab and set the following:
   - Set the Voicemail Type to Line.
   - Set the Voicemail Destination to the Outgoing Group ID set on the VPN line to the central system.
5. Load the configuration and reboot the remote IP Office.
6. Dial *17 at an extension on the remote IP Office. The call should ring the Voicemail Pro server and then access the extensions mailbox.

2.6.4 Fax Configuration
When fax detection is required in a small community network (SCN) there are some specific settings required in IP Office Manager.

To setup fax detection for a small community network:
1. Open IP Office Manager.
2. In the Navigation pane click Line and select the IP Line.
3. View the VoIP Settings tab.

2.6.5 Licensing
The most commonly seen problem in Centralized Voicemail Pro is misunderstanding the licensing requirements.
- The voicemail licenses are entered on the central IP Office and validated against its Feature Key.
- The remote IP Office systems do not need any voicemail licenses except that for .
- By default each IP Office uses a broadcast address to locate a Feature Key Server PC and validate its licenses.
- Once a Feature Key Server has validated licenses with one IP Office it will not do validation for another IP Office unless rebooted.

Given the above, we strongly recommend that in any multiple IP Office network, the License Server IP Address (System form -> System tab) on each IP Office is set to the specific address of its Feature Key server or blank if using a serial port Feature Key. If a remote IP Office does not have a Feature Key Server (because it is not using any licenses) enter 0.0.0.0.

It is important to note also that the Voicemail Pro server will operate for 2 hours without license validation. This can cause Voicemail Pro and Centralized Voicemail Pro to appear operational following installation and to then stop.
2.7 Text to Speech (TTS) Install

The Voicemail Pro server is able to use the Text to Speech (TTS) feature to:

- Speak text in call flows using the **Speak Text** action. The text can include variables passed from other actions including database actions.
- Support Email Text to Speech. This requires MAPI based Voicemail Email to have been set up and tested.

Voicemail Pro TTS requires the server PC to have a Microsoft SAPI 5 compatible TTS engine installed and a valid license entry. Two IP Office licenses exist to enable Voicemail Pro support for TTS operation. These are:

- **VM Pro Generic TTS**
  This license enables the Voicemail Pro server to use either Microsoft’s own SAPI 5 compatible TTS engines. The Microsoft TTS engines (Microsoft Sam, Mike, Mary and Simplified Chinese) are installed by default as part of the Microsoft Windows installation. One license is required for each simultaneous instance of TTS usage.

- **VM Pro ScanSoft TTS**
  This license enables the Voicemail Pro server to use Avaya supplied TTS engines. These engines currently provide better voice quality than the Microsoft TTS engines and support a wider range of languages. They are supplied on a set of 5 CDs separate from the Voicemail Pro software CD. One license is required for each simultaneous instance of TTS usage.

**Installation of Windows Server Operating Systems**

TTS requires the PC to have Windows Audio enabled. On many server PC, while the Windows Audio components are present as standard they are not enabled. In order to use TTS ensure that the server PC has Windows Audio enabled. Note that this does require the PC to have a sound card installed.

1. Ensure that you have full administrator rights for the PC. This process will also require the PC to be restated.
2. In the Windows Control Panel select **Sounds and Audio Devices**.
3. If Windows Audio has not been enabled, select the **Enable Windows Audio** check-box.

TTS licenses are enabled on a per port basis. This means that a four port voicemail could have two licenses enabled. If both the Generic and ScanSoft TTS licenses are enabled in Manager, both of the TTS engines will be used by all four voicemail ports on a first-come first-served basis. Due to this, the TTS engine used by a particular port for a particular call cannot be guaranteed. To have one consistent engine used for all calls, make sure that there is only one valid TTS license in Manager.

**Tip**

For a customer demonstration, sales staff can use the Microsoft Speech SDK 5.1 which includes a TTS playback application that enables you to play and compare different TTS engines without requiring Voicemail Pro. For example you can compare the Avaya-ScanSoft TTS engine with the Microsoft TTS engine. If you install the application on a sales laptop PC that has the ScanSoft TTS installed on it, you can then choose a TTS engine and produce a WAV file for the specified TTS engine. The Microsoft Speech SDK is available from http://www.microsoft.com/speech/download/sdk51/.

The following languages are supported by the Avaya TTS engines:

- Chinese.
- Dutch.
- English (UK).
- English (US).
- French.
- German.
- Italian.
- Korean.
- Norwegian.
- Brazilian Portuguese.
- Russian.
- Spanish.
- Latin Spanish.

**Multiple Language TTS Support**

More than one language can be installed. A **Select System Prompt Language** action can then be used to switch TTS to a different language from the selected default.

**Email Reading**

When installed in parallel with Voicemail Email, Voicemail Pro TTS can be used to provide email reading to selected mailbox users. For more information, see Voicemail Email:Overview and Setting Up Text To Speech to Read Email.
2.7.1 Installing Generic Text to Speech

To install Text to Speech:

1. Install and test Voicemail Pro as normal.

2. Using IP Office Manager, add the **VMPro TTS (Generic)** license into the IP Office configuration. Send the new configuration to the IP Office system.

3. Reload the IP Office configuration into IP Office Manager and check that the status of the license has changed to **Valid**.

4. The Voicemail Pro installation includes the default Microsoft TTS engines (Microsoft Sam, Mike, Mary and Simplified Chinese) as standard. If another third-party SAPI 5 compatible TTS engine is going to be used, install that software.

5. If the system is licensed for generic TTS, Voicemail Pro will automatically discover any SAPI 5 installed engine. If there is no 3rd party engine installed then the Microsoft 3rd party engine is used.

2.7.2 Installing Avaya Text to Speech

The Avaya TTS engine for Voicemail Pro is supplied on a set of CDs. Each CD contains a different set of languages. However, in each case CD 1 is required to start the TTS engine installation process.

To install Avaya Text to Speech:

1. Install and test Voicemail Pro as normal.

2. Using IP Office Manager, add the **VM Pro TTS (ScanSoft)** license into the IP Office configuration. Send the new configuration to the IP Office system.

3. Reload the IP Office configuration into IP Office Manager and check that the status of the license has changed to **Valid**.

4. Insert the first Avaya TTS CD. The installation should auto-start.

5. Follow the prompts and install the required languages. Depending on the languages that you select, instructions to insert the other CDs in the set may follow.

6. If the system is licensed for Avaya TTS, the ScanSoft engine is automatically used.

2.7.3 Using the Speak Text Action

One method of employing TTS is through adding a Speak Text action to a call flow. The text to be spoken is entered in the action’s **Specific** tab. This text can include combinations of:

- Typed text sentences.
- Voicemail Pro System Variables. For example:
  - Entering `$KEY` would be replaced when spoken by the last digits dialed within the call flow by the caller.
  - If using database interaction, entering `$DBD[x]` would be replaced by the current value of that database field.
  - Entering `$CLI` would speak the caller’s CLI, if available, back to them.
- **SAPI 5 XML** tags can be added to alter how the text is spoken. For example when 123 needs to be spoken as one two three rather than "one hundred and twenty-three", enter `<spell>123</spell>`.
2.7.4 Text to Speech SAPI Controls

Windows TTS engines use Microsoft’s SAPI (Speech Application Program Interface). This includes the use of XML tags in the text to change how the text is spoken. For example, in the text *This is the <volume level="90">text</volume>* to speak the items within < > brackets are XML tags used to change how the speech is spoken.

The following are samples of the SAPI XML controls supported by Voicemail Pro TTS. Further information on SAPI 5 can be obtained from Microsoft support websites.

- **Volume**
  Change the speech volume.

- **Rate**
  Change the speech rate.

- **Pitch**
  Change the speech pitch.

- **Emph**
  Add emphasis to words.

- **Spell**
  Spell out words and numbers literally.

- **Silence**
  Add a period of silence.

- **Partofsp**
  Change the usage of words.

**Entering XML Tags**

XML tags can be used in two ways, either nested or empty.

- **Nest Tags:** Example = `<volume level="90">text</volume>`
  Nested tags consist of:
  - An opening XML tag, in the example above `<volume level="90">`.
  - The text to which the opening tag command should be applied.
  - A closing XML tag. The closing tag use the same command as the opening tag, prefixed with / and no other settings. In the example above this is `</volume>`.

- **Empty Tags:** Example = `<volume level="90"/>`
  An empty tag is not nested, its command and settings apply to all the following text. Empty tags are recognizable by the / before the tags closing >.
Example SAPI XML Tags

**Volume**
Controls the volume of the speech. This tag can be nested or empty.

- **Attributes:**
  - `level=`
    Supports values between 0 and 100, being percentages of the system's set volume.

- **Examples:**
  - `<volume level="50"/>` Speak allow following text at level 50.
  - `<volume level="50">` Speak this text at level 50`</volume>` and this as normal.

**Rate**
Controls the speed at which the text is spoken. This tag can be empty or nested.

- **Attributes**
  Only one attribute may be applied within a tag.

  - `absspeed=`
    Sets the absolute speed for the speech in a range between -10 and 10 with 0 being normal speech.

  - `speed=`
    Sets a speed change that is added to the current speed.

- **Examples:**
  - `<rate absspeed="5">` Speak this text at rate 5`</rate>` and this text as normal.
  - `<rate absspeed="5"/>` Speak all following text at rate 5.
  - `<rate speed="-5"/>` Drop the current speech speed by 5.

**Pitch**
Controls the pitch at which the text is spoken. This tag can be empty or nested.

- **Attributes**
  Only one attribute may be applied within a tag.

  - `absmiddle=`
    Sets the absolute pitch for the speech in a range between -10 and 10 with 0 being normal speech.

  - `middle=`
    Sets a pitch change that is added to the current speed.

- **Examples:**
  - `<rate absmiddle="5">` Speak this text at pitch 5`</rate>` and this text as normal.
  - `<rate absmiddle="5"/>` Speak all following text at pitch 5.
  - `<rate middle="-5"/>` Drop the current speech pitch by 5.

**Emph**
Applies emphasis to a word or section of text. This tag must be nested.

- **Attributes:**
  This tag has no attributes.

- **Example:**
  - Say `<emph>boo</emph>`.
Spell
Spell forces the engine to speak any nested text literally rather than applying any speech rules. This is useful for numbers where rather than saying 3001 as three thousand and one for 3001, the speech required is three zero zero one. This tag must be nested.

- **Attributes**
  - This tag has no attributes.

- **Example:**
  - The telephone number is `<spell>555 3468</spell>`.

Silence
Inserts a period of silence. This tag must be empty.

- **Attributes**
  - `msec=`
    - Sets the duration in milliseconds.

- **Example:**
  - A short silence `<silence msec="500"/>` of half a second.

Partofsp
Forces the pronunciation of a word according to its usage if not correctly determined by the TTS speech engine or to override the engine. This tag must be nested.

- **Attributes:**
  - `part=`
    - Takes a value from noun, verb, modifier, function or interjection.

- **Example:**
  - To `<partofsp part="verb">record</partofsp>` that `<partofsp part="noun">record</partofsp>` press 1.
2.7.5 Setting Up Text To Speech to Read Email

It is not possible to parse email without a license for TTS. Therefore, it is not possible to forward emails without a valid TTS license.

In conjunction with MAPI email clients and Exchange server, TTS can be used to read new e-mails in a user’s email inbox when they access their voicemail mailbox.

This feature is supported only for Intuity mode. Users hear their new voicemail messages and then the number of "Messages with text". Before each email is spoken, details of who it is from, when the message was sent and the size are given. This allows large or non-urgent e-mails to be skipped.

- Email reading cannot be used for e-mails in HTML format. If HTML messages are received, all of the code will be read out as a message.

To set up text to speech to read email:

1. Install and test Voicemail Pro for MAPI-based Voicemail Email operation with an Exchange Server.
2. To perform email reading, the Voicemail account created on the Exchange server for Voicemail Email must be able to access the individual users email mailboxes. This can be achieved by either:
   - On the Exchange Server, ensure that Voicemail user account is granted rights to access all user email boxes, or;
   - Within each user’s Outlook:
     - Select Tools > Options.
     - Select Delegates.
     - Add the voicemail account as a delegate.
3. If you have not already done so, install and test TTS operation using a Speak Text action.
4. Using IP Office Manager, load the IP Office configuration and open the settings for each user.

5. In Voicemail Email, enter the user's email address. The same address is used for both Voicemail Email and Email Reading services.
6. Select Voicemail Email Reading.
7. For systems upgraded from 2.0, where a + sign was used in front of the users email address to indicate Email TTS usage, the + sign is automatically removed and the Voicemail Email Reading box is selected.
8. Click OK and merge the new configuration back to the IP Office system.
9. Send the user a test email. Then log into the user's voicemail mailbox and check whether following the voice messages a new "message with text" is announced.
2.8 UMS Web Services

Voicemail Pro 4.2+ adds support for two UMS (Unified Messaging Service) options:

- **IMAP Client Support**
  Users can then access their voicemail messages using email clients such as Outlook and Lotus notes that support an IMAP Client. The Voicemail Pro server PC acts as the IMAP server.

- **Web Voicemail Access**
  This option allows users to access the contents of their mailbox using a web browser. They can then playback messages to their phone or through their PC. Web voicemail requires the voicemail service to also run IIS and PHP.

Use of either of these services requires UMS Web Service licenses in the IP Office configuration. The license sets the number of users who can be configured as users of either UMS service in the IP Office configuration.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Web Voicemail</th>
<th>IMAP Client</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synchronization in realtime.</td>
<td>X</td>
<td>✓</td>
</tr>
<tr>
<td>Playback via PC.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Playback via User Extension.</td>
<td>✓</td>
<td>X</td>
</tr>
<tr>
<td>Save message Wav to PC.</td>
<td>X</td>
<td>✓</td>
</tr>
<tr>
<td>Forward messages to other voicemail mailbox.</td>
<td>✓</td>
<td>X</td>
</tr>
<tr>
<td>Forward messages to other email mailbox.</td>
<td>X</td>
<td>✓</td>
</tr>
<tr>
<td>Undelete manually deleted messages.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Mark message as unread.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Change voicemail password.</td>
<td>✓</td>
<td>X</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Show Message Types</th>
<th>Web Voicemail</th>
<th>IMAP Client</th>
</tr>
</thead>
<tbody>
<tr>
<td>- New (Unread).</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>- Old (read).</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>- Saved.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>- Priority.</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>- Private.</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>- Deleted.</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

**UMS or IMS**

UMS services are a replacement for IMS. IMS is still supported but only on existing OS’s as per Voicemail Pro 4.1. Installation of UMS services and IMS on the same system is not supported.
2.8.1 IMAP Installation

Voicemail Pro 4.2+ support mailbox synchronization with email clients that can support IMAP (Internet Message Access Protocol) accounts. Examples are Outlook, Outlook Express and Lotus Notes. Using this interface, users can view the contents of their voicemail mailbox and play those messages through their computers audio facilities.

IMAP is supported for user mailboxes only. It cannot be used for hunt group mailboxes. The number of users that can be configured for IMAP and/or web access is controlled by licenses.

Once configured, the IMAP folder and the user mailbox are synchronized whenever the IMAP folder is opened. The method of indication of the different message types will depend on the email client being used and is not controlled by the Voicemail Pro.
Installing the Voicemail Pro IMAP Server
The IMAP server is installed as a standard part of the Voicemail Pro service installation. It uses the IP address of the Voicemail Pro server PC and runs on the standard IMAP port 143.

The only special consideration is to avoid having any other IMAP server running on the same PC.

Configuring the IP Office for IMAP
1. Start IP Office Manager.
2. Receive the configuration from the IP Office associated with the Voicemail Pro server.
3. In the **Licenses** section add the **UMS Web Services** license.
4. Merge the configuration back to the IP Office and then receive the configuration again.
5. In the **Licenses** section check that the **License Status** of the **UMS Web Services license** is now shown as **Valid**.
6. Start the Voicemail Pro client
7. Select **Help | About**.
8. The screen should list the **IMAP Server as Started** and should show the number of UMS licenses.

Configure IP Office Users for UMS.
1. Start IP Office Manager.
2. Receive the configuration from the IP Office system hosting the user.
3. UMS can be enable in two ways:
   - **Through Individual User Settings:**
     1. Select **User** and then select the required user.
     2. Select the **Voicemail** tab.
     3. Enable **UMS Web Services**. Click **OK**.
   - **Through Licenses:**
     1. Select **Licenses**.
     2. In the Manager navigation pane, double click on the **UMS Web Services** license.
     3. The **Select Web Service Users** menu is shown.
     4. Select the users for which UMS Web Services are required. Click **OK**.
4. Merge the configuration back to the IP Office.
Configuring a User Email account

The exact method of configuration of an IMAP account depends on the IMAP client being used by the user. For example it may be necessary to enable some field with dummy data in order for the email client to accept the account even though those settings are not used by the Voicemail Pro IMAP server.

The general details that are required are:

<table>
<thead>
<tr>
<th>IMAP Account Setting</th>
<th>IP Office Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incoming Server</td>
<td>Voicemail Pro server IP address or domain</td>
</tr>
<tr>
<td></td>
<td>name address.</td>
</tr>
<tr>
<td>Account Name</td>
<td>User name or extension number.</td>
</tr>
<tr>
<td>Password</td>
<td>User voicemail code.</td>
</tr>
</tbody>
</table>

**Example: Outlook**

1. Select **Tools** and then **Options**.
2. Select **Mail Setup** and then click **E-mail Accounts**.
3. Select **Add a new e-mail account**.
4. Select **IMAP** as the server type.
5. In **Server Information for Incoming mail server** and **Outgoing mail server** enter the IP address or domain name address of the Voicemail Pro server PC.
6. In **Logon Information** enter the users extension number and voicemail code as the **User Name** and **Password**.
7. Click **Next**.

**Example: Outlook Express**

1. Select **Tools** and then **Accounts**.
2. Select **Add** and then **Mail**.
3. Enter a descriptive name such as **Voicemail** and click **Next**.
4. Enter an email address. This is not used but a value must be entered to move to the next screen. Click **Next**.
5. Set **My incoming mail server is a** to **IMAP**.
6. In the **Incoming server** field enter the IP address or domain name address of the Voicemail Pro server PC.
7. Enter a value in the **Outgoing mail server** field. This is not used but a value must be entered to move to the next screen. Click **Next**.
8. For **Account Name** enter the user’s extension number or name in the IP Office configuration.
9. For **Password** enter the user’s Voicemail Code.
10. Click **Next** and then **Finish**.
2.8.2 Web Voicemail Installation

Voicemail Pro 4.2+ support web access to user mailboxes. Users are then able to play their messages, mark them as saved or deleted, or forward messages to another mailbox. Playback is through the users own associate extension on the IP Office system or through the audio facilities of the PC.

Web Voicemail Installation Requirements

The Web Voicemail component is selectable as part of a custom Voicemail Pro installation. Note the pre-requisites below before doing the Web Voicemail installation.

- **IIS Web Server**
  Must be installed on the voicemail server PC before the Voicemail Pro 4.2 Web Voicemail component is installed.
  - **PHP**
    Web Voicemail uses PHP. If an existing PHP is not detected, the Voicemail Pro installation will install its own PHP.

- **UMS Web Services License**
  The use of Web Voicemail and the number of users who can be configured to access it are controlled by the UMS Web Services license entered in the IP Office configuration.

- **Computer Name\URL**
  The computer name is used as part of its URL on the network. Ensure that the name is set to something that appropriately indicates its purpose and that can be used as part of the URL for the web server within the customers domain.

- **Remove IMS**
  Voicemail Pro UMS is not supported on systems that are using Voicemail Pro IMS. IMS must be removed before UMS can be selected for installation.

User and Browser Requirements

For users to access Web Voicemail they require a web browser that meets the following requirements:

- **Javascript Enabled Web Browser**
  Web Voicemail is tested against the following browsers. Other browser may work so long as they support javascript and CSS.
  - Internet Explorer V6 SP1 or higher.
  - Internet Explorer V7 or higher.
  - Mozilla Firefox V2.0.0.2 or higher.
  - Opera V9.10 or higher.
- **User Name and Password**
  Once enabled for UMS Web Services in the IP Office configuration, to log on using Web Voicemail, the user will need to know their **Name** and **Voicemail Code** as set in the IP Office configuration. Note that this is the Name and not the **Full Name**.
Voicemail Pro Software Installation with Web Voicemail Component
The Web Voicemail component is installed as part of a Custom Voicemail Pro installation. From the list of
1. Verify that IIS is installed and running on the voicemail server PC. Check that it can be browsed from user PC’s.
   - While the server can be browsed by IP address, the URL used by users will be based on the server’s computer
     name within the customer domain. Check that web server can be browsed from user PC’s using the server’s
     computer name as part of the URL. If necessary change that name to accurate indicate its function.
2. Insert the Voicemail Pro CD.
3. When asked for the type of Voicemail Pro install to perform select **Voicemail Pro (Full)**.
4. On the next screen select **Custom**.
5. In the list of components scroll down and select Web Voicemail. Do not change any of the other selections unless you
   understand the requirements for those components.
   - UMS Web Voicemail is not supported in conjunction with IMS. If one is selected for installation the other cannot be
     selected.
6. Follow the remainder of the installation process and allow the voicemail server to reboot when required.

Configuring the IP Office for Web Services
1. Start IP Office Manager.
2. Receive the configuration from the IP Office associated with the Voicemail Pro server.
3. In the **Licenses** section add the **UMS Web Services** license.
4. Merge the configuration back to the IP Office and then receive the configuration again.
5. In the **Licenses** section check that the **License Status** of the **UMS Web Services license** is now shown as **Valid**.
6. Start the Voicemail Pro client
7. Select **Help | About**.
8. The screen should list the **Web Services** as **Started** and should show the number of UMS licenses.

Configure IP Office Users for UMS.
1. Start IP Office Manager.
2. Receive the configuration from the IP Office system hosting the user.
3. UMS can be enable in two ways:
   - **Through Individual User Settings:**
     1. Select **User** and then select the required user.
     2. Select the **Voicemail** tab.
     3. Enable **UMS Web Services**. Click **OK**.
   - **Through Licenses:**
     1. Select **Licenses**.
     2. In the Manager navigation pane, double click on the **UMS Web Services** license.
     3. The **Select Web Service Users** menu is shown.
     4. Select the users for which UMS Web Services are required. Click **OK**.
4. Merge the configuration back to the IP Office.
2.8.3 Using Web Voicemail

The URL will be that of the voicemail server PC plus /voicemail. This will display the web voicemail login page.

1. Logon using your user name and voicemail code as set on the IP Office system. The System Administrator can change these if necessary.
   - Note: This is the user name set in the IP Office and used by Voicemail Pro. It is not the full name that is shown on phones and used by IP Office Phone Manager and SoftConsole if set.

2. Note that multiple failures to login correctly can cause your access to Web Voicemail to be locked for 1 hour. If necessary Web Voicemail access can be unlocked using the Voicemail Pro administration client (select Users, right click on the user marked as Account Locked in the Web Voicemail column, enter a new password for the user and click OK).

The interface shows the messages in your mailbox. Note that it is not updated in real-time. To check if new messages have arrived in your mailbox since starting Web Voicemail, refresh the browser view using the browser controls.

The columns can be sorted by clicking on the column title. The currently selected sort column is shown by a ▼ symbol next to it.

Message Types

The following icons are used for different types of messages:

- ✉️ Unread message

- 📭 Read message
  Note that by default a read message is permanently deleted from the mailbox after 30 days unless changed to a saved message.

- 🗑️ Deleted message
  Manually deleted messages are automatically moved to the Trash folder. Deleted messages remain visible there at least 24 hours after they were marked as deleted.

  - Deleted messages are not accessible through the voicemail spoken prompts interface or Visual Voice.
  - Deleted messages can be undeleted by marking them as saved, read or unread. They can then be moved back out of the Trash folder. Moving a deleted message out of the Trash folder automatically changes it to read.

- 🗑️ Saved message
  Setting a message as saved stops it being automatically deleted after a period of time.

- 🚨 Priority message
  This icon is added to the message icon to indicate that the caller has set the message as a priority message.
Controls

- **Select**
  Before performing many actions such as saving, deleting or forwarding, you can select the messages to which the action should be applied.
  - The select box at the top of the list of messages can be used to select/deselect all messages on the currently displayed page.

- **Put in Folder**
  Move the selected messages into a folder. When clicked the list of available folders is shown. Note that moving messages into the Trash folder automatically marks those messages as deleted.

- **Save**
  Change the status of the selected messages to saved.

- **Mark as read**
  Change the status of the selected messages to read. Changing the status of a message will override its previous status including those marked as saved.

- **Mark as unread**
  Change the status of the selected messages to unread. Changing the status of a message will override its previous status including those marked as saved.

- **Forward**
  Forward a copy of the selected message to another mailbox. When clicked, the type of mailbox (user or hunt group) can be selected. The list of mailboxes is then shown and allows selection of multiple target mailboxes.

- **Delete**
  Delete the selected messages. Manually deleted messages remain visible until the voicemail server next performs its mailbox housekeeping. See the deleted message description above.

- **Change password**
  This option allows you to change your voicemail mailbox code.

Playing Messages

To play a message just click on it. The message menu is displayed. The appearance of this will vary depending on whether you select playback via the default media player on your computer or through an extension on the telephone system.
2.8.4 Using IMAP

Most email clients that support IMAP display IMAP messages in a separate folder. The contents of that folder are synchronized when the folder is viewed.

Note that the types of icons used and whether different icons are supported for different message statuses depends on the email client used.

The following should be noted about the IMAP folder view:

- New messages are presented as a closed envelope.
- Read messages are presented as an open envelope.
- Priority messages are indicated as such.
- Private messages are not indicated as such.
- Saved messages are not indicated as such.
- Deleted messages are indicated as deleted but remain visible.
  - The voicemail server does not actually delete messages until at least 24 hours after it was marked as deleted.
  - Deleted messages are not accessible through the voicemail spoken prompts interface or Visual Voice.
  - Deleted messages can be undeleted. Those messages are then available through all the mailbox interfaces.
- Moving a message in the IMAP folder to another folder in the Email client will cause the email to be copied to the new folder and the original message is shown as deleted in the IMAP folder.
- The Voicemail Pro housekeeping settings for automatic deletion of different message types (New, Read, Saved) are still applied.
- IMAP cannot be used to send or forward messages to other voicemail mailboxes.
2.9 Troubleshooting

2.9.1 Checking the Voicemail Pro Service

If Voicemail Pro has been installed successfully, if the server PC has been rebooted then the voicemail service is started automatically. However it is useful to check the services and to know how to stop-start the services manually.

To check/restart the Voicemail Pro Service:

1. Open the Windows Control Panel.
2. Select Administrative Tools > Services.
3. The Voicemail Pro Service should be visible. Its Status should be Started and the Startup Type should be set to Automatic.
   - Other services will be present depending on the Voicemail Pro options installed. The services are:
     - **Voicemail Pro Service**
       This is the main Voicemail Pro service. Normally this is the only service that needs to be stopped and restarted. It will stop and restart the other services that it uses.
     - **VMProDBService**
       This service is used for the Voicemail Pro database connectivity if licensed.
     - **IMS(Gateway), IMS(Voice) and IMS(Restart)**
       These services are used by the IMS components of Voicemail Pro if installed and licensed.
     - **VPNMDatabase Server, VPIM Receiver and VPNM Server**
       These services are used by the VPNM components of Voicemail Pro if installed and licensed.

To Initialize the Voicemail Pro Call Flow:

1. Select Start > Programs > IP Office > Voicemail Pro. The Voicemail Pro Client starts and the main window opens.
2. Click the Save and Make Live icon.
3. Select Yes. The file root.vmp is created and made available to the Voicemail Pro server. This is the compiled non-editable version of the editable call flow.
4. Voicemail operation can now be tested from an extension by dialing *17.

Setting the Voicemail Services or PC to Restart Automatically

The following action is optional. If there is some fault causing the Voicemail Pro service to halt, that fault should be investigated and fixed, however having the service or PC automatically restarted if possible will minimize the disruption to the Voicemail Pro users.

1. Use the Windows control panel to select the Voicemail Pro Service.
2. Right-click on the service and select Properties.
3. Select the Recovery tab.
4. Use the options presented to either restart the service and or restart the PC should the operating system detect that the Voicemail Pro service has halted.
Using a Batch File to Start Services
In some instances, certain computers might not respond quickly enough in order to start all of the Avaya services in the correct order. In this circumstance, it can be advisable to create a batch file which will delay the start of these services until the PC is fully running.

Avaya IP Office Services can be started successfully at system start-up using a scheduled task that initiates the batch file below. This batch file ensures that the services will start successfully and in the proper order.

1. Set all Avaya services listed below to Manual start. Do not include Key Server.
2. Create the batch file below and save it to %SYSTEMROOT%. Only include lines for the services which are installed.

```plaintext
@echo off
rem Wait 60 seconds before execute.
timeout /t 60
net start VMProDBService
net start Voicemail Pro Service
net start IMS(Restart)
net start IMS(Voice)
net start IMS(Gateway)
```
3. Create a scheduled task to start the batch file at system start-up.
2.9.2 The Voicemail Console

The server program provides a console window that enables you to see messages between the voicemail server and the IP Office. The nature of the messages may be useful in diagnosing problems. The Voicemail Pro Service can be run in console mode if required for testing and diagnostics purposes.

- IMS and MAPI email activity is not supported when running the Voicemail Pro service in this way.

To run the service as a console:

1. Open the Windows Control Panel.
2. Select Administrative > Services.
3. Locate the Voicemail Pro Service.

4. Double-click the service to display its properties.
5. Click the Log On tab.
6. Under Log on as:, select Local System Account and then select Allow service to Interact with desktop.
7. Click OK.
8. Stop and restart the service using the icon. After the service restarts the Voicemail Professional Server console window opens.
9. Click Run.

At an extension dial *17. Details of the Voicemail Pro activity should be displayed in the console window. To return to normal operation, repeat the above process and set the Voicemail Pro Service back to its specific user account.
The console provides a number of commands. These commands affect only the display of messages within the console window and do not alter the voicemail server operation in any way.

<table>
<thead>
<tr>
<th>Freeze</th>
<th>Run</th>
<th>Clear</th>
<th>Campaigns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Freeze</td>
<td>Run</td>
<td>Clear</td>
<td>Campaigns</td>
</tr>
</tbody>
</table>

- **Freeze**
  Halt the display of further messages. This is the default condition of the console when started.

- **Run**
  Start the display of messages.

- **Clear**
  Clear the display of messages.

- **Campaigns**
  Displays messages relating to campaigns.
2.9.3 Voicemail Pro User Log

User authentication failures are logged in the event viewer, under VMPro User Log. The following details are logged:

- UserID
- Tool name
- IP address of the Client trying to log in.

To view the log details:

2. In the System Tool directory, view the Event Viewer.
3. Click VMPro User Log to view the details.
2.9.4 Tracing in Debug

Many applications, including Voicemail Pro and IMS, output activity messages that are viewable in Debug View (DbgView). This application can be downloaded from http://marketingtools.avaya.com/tools/debug.

Installation

1. Download the zip file.
2. Unpack the files into a folder such as c:\debug on the server PC.
3. Run DbgView.exe.
4. Events are shown in the DbgView window. These can be logged to a file if required. The level of detail shown can be filtered to show more or less activity.

Logging

1. Run DbgView.exe.
2. Select File | Log Preferences.
3. Set the logging details as required and click OK.
4. While DdbgView is running the viewable trace is also copied to the specified file.
5. The debug log files can be opened in programs such as Wordpad.
Installing Voicemail Pro: Troubleshooting

Filtering

1. Select View | Debug Filters.

2. Select the module for which you want to increase/decrease reporting.

3. In the right hand panel adjust the level of reporting.

4. Close the Configure Debug Filters window.

IMS Tracing

IMS tracing is enabled through a number of registry keys. The IMS server keys are set through HKEY_LOCAL_MACHINE registry values. The IMS client keys are set through HKEY_CURRENT_USER. All the keys are all REG_DWORD values and are disabled if not set or set to 0.

<table>
<thead>
<tr>
<th>IMS</th>
<th>HKEY_LOCAL_MACHINE\SOFTWARE\AVAYA\Integrated Messaging</th>
</tr>
</thead>
<tbody>
<tr>
<td>EnableTracing</td>
<td>This key must be enabled to allow tracing using the other keys below.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Voicemail</th>
<th>HKEY_LOCAL_MACHINE\SOFTWARE\AVAYA\Integrated Messaging</th>
</tr>
</thead>
<tbody>
<tr>
<td>EnableTracing</td>
<td>This key must be enabled to allow tracing using the other keys below.</td>
</tr>
<tr>
<td>ConstructorTracing</td>
<td>This provides some tracing for when certain COM objects are constructed. As a whole it is not required for diagnostics.</td>
</tr>
<tr>
<td>DestructorTracing</td>
<td>This provides some tracing for when certain COM objects are destructed. As a whole it is not required for diagnostics.</td>
</tr>
<tr>
<td>EnableConnectionTracing</td>
<td>Provides diagnostic for when a connection occurs (server to server or client to server).</td>
</tr>
<tr>
<td>EnableRefTracing</td>
<td>This indicates when the reference count for certain COM objects is changed (through AddRef, Release).</td>
</tr>
<tr>
<td>Gateway</td>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\AVAYA\Integrated Messaging\Gateway</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>Debugging</td>
<td>This key must be enabled to allow tracing using the other keys below.</td>
</tr>
<tr>
<td>ChannelEvtSinkTracing</td>
<td>Provide tracing about speech channel events received.</td>
</tr>
<tr>
<td>ConstructorTracing</td>
<td>This provides some tracing for when certain COM objects are constructed. As a whole it is not required for diagnostics.</td>
</tr>
<tr>
<td>DestructorTracing</td>
<td>This provides some tracing for when certain COM objects are destructed. As a whole it is not required for diagnostics.</td>
</tr>
<tr>
<td>EnableConnectionTracing</td>
<td>Provides diagnostic for when a connection occurs (server to server or client to server).</td>
</tr>
<tr>
<td>EnableFunctionTracing</td>
<td>Generally used by the client software to trace out information about the functions that are being executed.</td>
</tr>
<tr>
<td>EnableObjectTracing</td>
<td>Allows certain created COM objects to be traced.</td>
</tr>
<tr>
<td>EnableProxyTracing</td>
<td>When a client connects to a server, it connects through a proxy. This settings allows information from the proxy to be traced.</td>
</tr>
<tr>
<td>EnableRefTracing</td>
<td>This indicates when the reference count for certain COM objects is changed (through AddRef, Release).</td>
</tr>
<tr>
<td>EnableTagTracing</td>
<td>When certain internal objects are created, such as a channel object for speech playback, this information is tracked. Using this setting every minute a trace occurs of the object list.</td>
</tr>
<tr>
<td>FireEventTracing</td>
<td>Provide tracing about events that are sent from the server to its clients.</td>
</tr>
<tr>
<td>MailboxEvtSinkTracing</td>
<td>Provide tracing about mailbox events received.</td>
</tr>
<tr>
<td>MessageEvtSinkTracing</td>
<td>Provide tracing about message events received.</td>
</tr>
</tbody>
</table>
### IMS Client Keys

<table>
<thead>
<tr>
<th>Key</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>EnableTracing</td>
<td>This key must be enabled to allow tracing using the other keys below.</td>
</tr>
<tr>
<td>ConstructorTracing</td>
<td>This provides some tracing for when certain COM objects are constructed. As a whole it is not required for diagnostics.</td>
</tr>
<tr>
<td>DestructorTracing</td>
<td>This provides some tracing for when certain COM objects are destructed. As a whole it is not required for diagnostics.</td>
</tr>
<tr>
<td>EnableFunctionTracing</td>
<td>Generally used by the client software to trace out information about the functions that are being executed.</td>
</tr>
<tr>
<td>EnableObjectTracing</td>
<td>Allows certain created COM objects to be traced.</td>
</tr>
<tr>
<td>EnableProxyTracing</td>
<td>When a client connects to a server, it connects through a proxy. This settings allows information from the proxy to be traced.</td>
</tr>
<tr>
<td>EnableRefTracing</td>
<td>This indicates when the reference count for certain COM objects is changed (through AddRef, Release).</td>
</tr>
<tr>
<td>EnableTagTracing</td>
<td>When certain internal objects are created, such as a channel object for speech playback, this information is tracked. Using this setting every minute a trace occurs of the object list.</td>
</tr>
<tr>
<td>MAPIEventTracing</td>
<td>Allow tracing of MAPI events received from MAPI.</td>
</tr>
<tr>
<td>MessageProcessingTracing</td>
<td>Used for tracing what server commands the extension is using.</td>
</tr>
<tr>
<td>UMSEventTracing</td>
<td>Allow tracing of events received from the IMS server.</td>
</tr>
<tr>
<td>TimeAndTrace</td>
<td>Used for tracing how long certain MAPI events took to process.</td>
</tr>
</tbody>
</table>

All the keys are based on the component as follows:

- **IMS (Voice) Server** – "SOFTWARE\Avaya\Integrated Messaging\Voicemail" (e.g. "HKLM\SOFTWARE\Avaya\Integrated Messaging\Voicemail")
- **IMS (Gateway) Server** – "SOFTWARE\Avaya\Integrated Messaging\Gateway"
- **IMS Administration** – "SOFTWARE\Avaya\Integrated Messaging\Admin"
- **IMS Client** – "SOFTWARE\Avaya\Integrated Messaging\Client" (e.g. "HKCU\SOFTWARE\Avaya\Integrated Messaging \Client").

**VM Server Specific**

- "CtiNotifyTracing" – Provide tracing to indicate that a Cti event has occurred.
- "VmsNotifyTracing" – Provide tracing to indicate that a VMS API event has occurred.
Chapter 3.
Configuring Voicemail Pro
3. Configuring Voicemail Pro

3.1 IP Office Configuration

3.1.1 Overview

The default IP Office configuration settings allow almost immediate voicemail operation as soon as a voicemail server is running on the LAN. Those default settings are:

- Voicemail running on a PC accessible using a broadcast address of 255.255.255.255.
- Voicemail on for each user and hunt group on.
- No Voicemail Code set for any mailboxes. Until a code is entered for a mailbox, it can only be accessed from the user's own extension.
- No Voicemail Email or Voicemail Help operation.
- No Voicemail Reception numbers set for user mailboxes.
- Hunt group mailboxes are created and used by default but there is no default message waiting indication or method for collecting messages. A method for accessing each hunt group mailbox should be programmed. For more information, see Hunt Group Voicemail:Overview.

Before you start to configure and customize Voicemail Pro you need to provide the IP Office Manager with details of the Voicemail Pro server PC. For more information see Identifying the Voicemail Server PC and also the IP Office Manager help. The rest of the sections that follow describe how to configure settings in Voicemail Pro.

3.1.2 Identifying the Voicemail Server PC

By default the IP Office connects to the Voicemail Pro server by broadcasting on its own subnet.

To identify the Voicemail Server PC:

1. In IP Office Manager, select System.
2. Click the Voicemail tab.
3. The default Voicemail Type is Voicemail Lite/Pro. Make sure that this has not been changed.
4. Leave the Voicemail Destination box blank as this is not used with Voicemail Pro.
5. In the Voicemail IP Address box, change the default address (255.255.255.255) to the IP address of the PC on which the voicemail server is running. If there is only one voicemail server on the network, you do not need to change this.
6. Click OK to save any changes.

By default there are no Voicemail Channel Reservations. Specific functions can have voicemail channels reserved for their use. For more information, see Voicemail Channel Reservations in the appendix.
3.1.3 Configuring Voicemail for Individual Users

Voicemail can be configured for each individual user in IP Office Manager.

To change voicemail configuration for an individual:

1. Open IP Office Manager.
2. In the Navigation pane, click User and select the individual user.
3. View the Voicemail tab.

4. (Optional) Enter a voicemail code between 1-15 digits in the Voicemail Code field. This is required when users retrieve voicemail messages remotely, for example from another user's extension or from an external telephone.
   - The Voicemail Code must be retyped in the Confirm Voicemail Code field to ensure it has been correctly entered.
5. (Optional) Voicemail can be turned off by unchecking the Voicemail On option. When on, the mailbox is used to answer the user's unanswered or busy calls.
6. (Optional) When a user collects their messages they can hear an additional prompt if the Voicemail Help option is checked. The prompt is 'For help at any time press 8'.
   - If Voicemail Help is not selected, users can still press 8 at any time and hear the list of Voicemail features. This setting turns on/off the audible help message. It does not disable the actual feature.
7. (Optional) When a new message is received, the voicemail server can call the user's extension whenever the extension returns from off-hook to on-hook. The voicemail server will not ring the extension more than once every 30 seconds. Check the Voicemail Ringback option to enable this feature.
8. (Optional) Voicemail email can be configured for an individual user. When a new message is received, the WAV file created can be sent to an email account either by user selection or according to the set Voicemail Email Mode. The sending of .wav files across a network creates a high loading on the network and networks servers. A one-minute message requires a 1MB .wav file. The option Voicemail Email Reading is unavailable in Voicemail Lite.
   - Voicemail Email - Enter the email address of the user.
   - Select the Voicemail Email Mode from:
     - Off: Voicemail messages or notifications are not automatically sent.
     - Copy: A copy of the message is sent to the email account.
     - Forward: Voicemail messages are sent to the email account and deleted from the Voicemail server.
     - Alert: Notification that a new Voicemail message has been received is sent to the email account.
9. (Optional) When a caller reaches voicemail they can be given the option to be transferred to a different extension. The greeting message needs to be recorded telling the caller the options available. The extension numbers that they can be transferred to are entered in the fields:
   - Reception/Breakout (DTMF 0)
     - The number to which callers are to be transferred if they are directed to voicemail and press 0. Usually this is the reception number.
- **Breakout (DTMF 2)**
  The number to which callers are to be transferred if they are directed to voicemail and press 2. This number might be, for example, the number of a colleague of the mailbox owner whose extension was originally dialed.

- **Breakout (DTMF 3)**
  The number to which callers are to be transferred if they are directed to voicemail and press 3. This number might be, for example, the mobile or cell number of the mailbox owner whose extension was originally dialed.

10. Click **OK** to save the voicemail changes for the user.

11. Amend any other user details, then save and merge the configuration changes.
### 3.1.4 Configuring User Source Numbers

The Source numbers can be changed for individual users in IP Office Manager. The Source Numbers tab gives a list of Dial In Source Numbers. Several of these numbers can relate to voicemail operation. The source number settings that can be used for Voicemail Lite are:

- **V<Caller's ICLID>** = Voicemail Trusted Source Access. Strings prefixed with a v indicate numbers from which access to the user’s mailbox is allowed without requiring entry of the mailbox’s voicemail code.

  - When in Intuity mode users will still have to enter their voicemail code if they use the Messages button on their telephone. However, if they have a button programmed to collect voicemail they can access their mailbox without entering their voicemail code.

- **H<Group Name>** = Hunt Group Voicemail Indication. Allows the user to receive message waiting indication of new group messages. Enter H followed by the group name, e.g. HMain. For more information, see Hunt Group Message Waiting Indication.

- **P<Telephone Number>** = Voicemail Ringback Number. This entry sets the destination for callback (outbound alert) calls from voicemail. Enter P followed by the telephone number including any necessary external dialing prefix, eg. P917325559876. This facility is only available when using Voicemail Pro through which a default Callback or a user specific Callback start point has been configured. This feature is separate from voicemail ringback which alerts the user's own extension.

To add a source number:

1. Open IP Office Manager.
2. In the Navigation pane, click **User** and select the individual user.
3. View the **Source Numbers** tab.
4. Click **Add**.
   
   ![Source Numbers Window](image)

   5. Enter the number in the **Source Number** field at the bottom of the window.
5. Click **OK** and save the configuration file.
### 3.1.5 Setting Up Voicemail Transfer Options for a User

After a caller has been routed to a mailbox to leave a message, the mailbox owner can offer the option of transferring to a different number, for example:

- To speak to a receptionist callers can dial 0.
- To speak to a secretary callers can dial 2.
- To connect to an external number such as the user's mobile or cell phone, callers can dial 3.

Before a mailbox owner can use this feature, you must set up the numbers that they want to use for their transfer options.

**To set up voicemail transfer options for a user:**

1. In IP Office Manager, display the user's **Voicemail** tab.

2. (Optional) Enter an internal or external number in the field **Reception/Breakout (DTMF 0)**. When connected to a user's voicemail, the caller can press 0 to be transferred to either an internal or external number. The user should announce this facility in their greeting message, for example, "John Smith is not available today, you may leave a message or press 0 for Reception".

3. (Optional) Enter an internal or external number in the field **Breakout (DTMF 2/3)**. When Voicemail Pro is running in Intuity mode, a user can select to have two further breakout numbers in addition to the reception number. These two additional breakout numbers are triggered by the caller pressing either 2 or 3. These additional numbers allow a simple user attendant to be created. The options setup should be included in the user's mailbox greeting.

4. Click **OK**.

5. Ask the mailbox owner to record a new greeting message to inform callers that they can press **0, 2 or 3** for different transfer options.

When a Leave Mail action is used in a custom call flow to access the mailbox, operation differs.

- For IP Office mode, the call follows Leave Mail action's Failure or Success results depending on whether the caller presses 0 before or after the record tone.
- For Intuity mode, pressing 0 always follows the mailbox user's Voicemail Reception setting.
3.1.6 Voicemail Channel Reservations

By default there are no reserved channels. Specific functions can have voicemail channels reserved for their use. IP Office manager is used to reserve channels. For more information, see IP Office Manager help.

Voicemail channel reservations can be made for:

- Auto Attendant
- Announcements
- Voice recording
- Mailbox access
- Mandatory voice recording
- Outcalling.

It is worth checking the voicemail channel reservations if there are problems. If insufficient voicemail channels are available:

- Internal calls to an auto attendant are queued. The call will queue until a resource becomes available.
- Announcements are not heard by the caller, but the call is routed correctly.
- Manual voice recording is activated but no recording is made. The call will continue.
- Users are placed in a queue when trying to access their mailbox access.
- A user with mandatory recording on outgoing calls (internal and external) gets a busy tone.
- A call on a line with mandatory recording set will be barred.
- A delay in Outcalling. The Outcalling notification is postponed until there are sufficient resources available.

To change voicemail channel reservations:

1. Open IP Office Manager and the load the configuration.
2. In the Navigation pane click System and select the system.
3. Click the Voicemail tab.

<table>
<thead>
<tr>
<th>System</th>
<th>LAN</th>
<th>DNS</th>
<th>Voicemail</th>
<th>Telephony</th>
<th>LDAP</th>
<th>System Alarms</th>
<th>Twinning</th>
<th>CDR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voicemail Type</td>
<td>Voicemail Lite/Pro</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Voicemail Destination</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Voicemail IP Address</td>
<td>192.168.42.2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Amend the channel reservations as required. By default the values are 0. For more information, see IP Office Manager help.

To view the utilisation of voicemail channels:

1. Open the System Status Application.
2. Click Resources. The System Resources summary is displayed. The following details are displayed:
   - The number of voicemail channels available.
   - The number of channels in use.
   - Congestion information

For more information about the system resources, see the System Status Application guide.
3.1.7 Using Voicemail to Give Error Messages

Voicemail can be used to give out messages when certain numbers are dialed. For example, if users are barred from making international calls, rather than giving users the busy tone a recording similar to "International calls are not permitted" could be played instead.

To create an International Calls are not Permitted error message:

1. In IP Office Manager create a virtual user. Complete the User tab with the following details:
   - **Name**: Barred.
   - **Full Name**: Internal Calls Error Message.
   - **Extension**: 403.

2. You need access to the virtual user's extension from any telephone extension attached to the system. A voicemail code needs to be added.
   - Select the user Barred.
   - Click the Voicemail tab.
   - Add a Voicemail Code.
   - Click OK.

3. Add a short code to access the virtual user's voicemail.
   - **Code**: *95
   - **Feature**: Voicemail Collect
   - **Telephone Number**: "?Barred" (include quote marks)
   - **Line Group ID**: 0

4. Save the configuration file.

5. You can now use the virtual user's voicemail to record a greeting message stating that international calls are not permitted.
   - Dial *95 from any telephone connected to the system.
   - Enter the extension number 403.
   - Enter the voicemail access code. The first time you enter the mailbox for extension 403 you will be asked to change the password and record a user name.
   - Press 3 to record a greeting.
   - Press 1 to change the message.
   - Press 1 to record greeting 1.
   - Speak the new message. In this case it would be similar to "International calls are not permitted"
   - Press # to end the recording.
   - Press 1 to save for all calls.
   - Replace the telephone handset.

6. A short code needs to be created in IP Office Manager so that when a user dials an international call they will be played the error message.
   - **Code**: 00N
   - **Feature**: Voicemail Collect
   - **Telephone Number**: ",Barred" (include quote marks)
   - **Line Group ID**: 0

7. Save the configuration file.

8. Test the error message by trying to dial an international number from any telephone. You should be played the message that you have just recorded.
3.2 Voicemail Pro Preferences

There are two main areas through which Voicemail Pro system preferences are set and configured. These are within the Voicemail Pro Client and through the server PC’s Windows Control Panel.

To change the Voicemail Pro Client preferences:

1. Click the Preferences icon and then choose General or VPNM. Alternatively, from the Administration menu, select Preferences and then choose General or VPNM.
2. Select the System Preferences tab required.
   - General - For more information, see Changing the General System Preferences.
   - Directories - For more information, see Setting the Location of Voicemail System Folders.
   - Housekeeping - For more information, see Setting the Message Deletion Times.
   - MAPI - For more information, see Setting MAPI Email Preferences.
   - SNMP Alarm - For more information, see Setting the SNMP Alarm.
   - Outcalling - For more information, see Changing the Outcalling Preferences.
   - VPNM - For more information, see Configuring VPNM Preferences.

A number of Voicemail Pro server options are set through the Windows Control Panel.

To change the Voicemail Pro Server preferences:

1. Open the Windows Control Panel.
2. Select IP Office Voicemail Pro.
3. The tabs and options within the tabs will vary according to the installed Voicemail Pro components. Possible tabs are:
   - Email Settings - For more information, see Configuring Email Settings.
   - Path Setting - For more information, see Specifying the Name of the Host Server PC for IMS.
   - SMTP Email Settings - For more information, see Configuring SMTP Email Settings.
   - System Settings - For more information, see Specifying the Level of IMS Service Logging.
3.2.1 System Preferences

3.2.1.1 General

Although the default IP Office configuration settings allow voicemail to start operating almost immediately, as soon as a voicemail server is running on the LAN, there are some general system preferences that you can set or change.

To set up general system preferences:

1. Display the main Voicemail Pro window.
2. From the Administration menu, select Preferences > General.

   Client/Server Connection Timeout (mins)
   
   Default Telephony Interface
   - IP Office

   Voicemail Password:

   Max. Message Length (secs): 3

   Max. Call\VRL Record Length (Secs): 3

   Play Advice on Call Recording

   System Fax Number (feature is disabled when empty)

   Use as Prefix

   Enable Fax Sub-Addressing

3. In the Client/Server Connection Timeout (mins) box, type the number of minutes for the inactivity timeout. Alternatively use the increment or decrement buttons. After the number of minutes that you specify, an inactive administrator user of the Voicemail Pro Client will receive a message to warn them that they might be automatically logged out if they remain inactive. This enables another administrator user to log in and use the Voicemail Pro Client instead.

4. From the Default Telephony Interface select IP Office or Intuity to control the way in which mailbox access works for mailbox owners. For more information, see Changing Mailbox Operation Mode.

5. In the Voicemail Password box, type the password to use for protecting voicemail access. A Voicemail Password is optional. If you leave it blank, no password is required for voicemail access. If you set a password here, it must match the Voicemail Password configured on the IP Office. For more information, see Identifying the Voicemail Server PC.

6. In the Max. Message Length (secs) box, type the maximum length in seconds of any messages/recordings taken by Voicemail Pro. The default message length is 120 seconds. The maximum message length is 3600 seconds (60 minutes). 1 minute equals approximately 1MB of disk space.

7. In the Max. Call\VRL Record Length (secs), type the maximum recording time for calls that are being recorded for VRL (Calls recorded to a third party call archiving system). The default length is 3600 seconds (60 minutes). This is also the maximum.

8. If voice calls are to be recorded, check the Play Advice on Call Recording box so that callers hear a message to advise them that their call is being recorded. This is a legal requirement in some countries.

9. In the System Fax Number box, type the number of the general fax machine to which all incoming faxes are to be directed. If a fax board is being used, this number must match the number of the extension that is connected to the fax board of the fax server PC. For more information, see Setting the Voicemail Pro System Fax Number.

   Intuity mailbox owners have the additional option to define their own personal fax number instead of the system fax number. As the system administrator, you still need to set a system fax number to enable mailbox owners to override it with their preferred personal fax number. Incoming calls are directed to Voicemail Pro and then Voicemail Pro redirects fax calls to the mailbox owner’s personal fax number, if one has been set. For information mailbox owners should read the Intuity Mailbox User Guide.
If your fax system requires prefix addressing, for example the C3000 fax server, do not type a fax number in the System Fax Number box. Instead type the number to use as a prefix so that a fax message can be identified and forwarded to the extension number of the intended recipient. For example, if the prefix were 55, a fax message for extension 201 would have the prefix of 55 automatically added so that the complete number would become 55201.

The System Fax Number box, is used to:

10. Enable fax detection.
   By default fax detection is not enabled when Voicemail Pro is first installed. When fax detection is enabled, any fax calls that are left in a voicemail mailbox, are redirected to the defined system fax number.

11. Define the default destination for fax calls that arrive in a voicemail mailbox and which are to be redirected to a fax machine.

12. To use the specified prefix, check the Use as a Prefix box so that the number that you typed in to the System Fax Number box is used. If your fax system does not use prefix addressing, leave this box unchecked.

13. For this feature to work, you also need to set up a short code.
   - Most fax servers perform fax forwarding based on DTMF signalling received with the fax call. Check the Enable Fax Sub-Addressing box so that the DTMF signal is passed to the fax server after the call has been answered so that the fax can be forwarded to the email address of the intended recipient.

14. Click OK.

15. Click Save and Make Live and select Yes.
3.2.1.2 Directories

When Voicemail Pro is installed some default folder locations are used. You can change these if required.

To set the location of Voicemail system folders:

1. Display the main Voicemail Pro window.
2. From the Administration menu, select Preferences > General.
3. Click the Directories tab.

   ![Directories Tab]

4. In the Voicemail Server Directory box, type the path to the folder where the voicemail server program is to be stored. This is the folder where the file Root.vmp is saved when the Save & Make Live option is used. Alternatively click the browse button and select a folder to use.

5. In the Voicemail Server Speech Directory box, type the path to the folder where the libraries of speech prompts are to be stored. Alternatively click the browse button and select a folder to use.

6. In the Remote Campaign Directory box, type the path to the folder where the campaign files are to be stored. Alternatively click the browse button and select a folder to use.

7. Click OK.

8. Click Save and Make Live and select Yes.
3.2.1.3 MAPI

Email services are used for voicemail email and email text to speech. Therefore, these settings should not be adjusted without first confirming that all other steps appropriate to whichever of those services is being used have been followed. These settings are not used for IMS.

To set MAPI email preferences:

1. Display the main Voicemail Pro window.
2. From the Administration menu, select Preferences > General.
3. Click the MAPI tab.

   ![Configuration tab](image)

   - **MapiProfile**: Indicates the name of a particular MAPI profile to use if necessary.
   - **MapiPassword**: Represents the password to use. If not using a MAPI profile, leave the MAPI Password box blank.
   - **Use Email Protocol**: Offers the option to use SMTP or MAPI for voicemail email, email TTS. For more information, see Voicemail Email: Overview.
     - **Important**: If the protocol is changed, the Voicemail Pro service must be stopped and restarted.

4. In the MAPI Profile box, type the name of a particular MAPI profile name to use if necessary.
5. If you specify a MAPI profile to use, you can also set a password. In the MAPI Password box, type the password to use. If you are not using a MAPI profile, leave the MAPI Password box blank.
6. Select the Email Protocol to use. Choose SMTP to send voicemail email alerts only or choose MAPI for voicemail email, email TTS. The MAPI option requires further email configuration and setup. For more information, see Voicemail Email: Overview.

7. Click **OK**.
8. Click **Save and Make Live** and select **Yes**.
### 3.2.1.4 Housekeeping

This tab is used to set the Voicemail Pro settings for automatically deleting messages and for the default playback order of messages.

After messages have been played they are automatically deleted from the voicemail server after a specified period of time. This includes messages played via a user's IMS email client. You can set the same time delay for all messages or you can adjust the period of time before different types of message are deleted.

Automatically deleting messages is performed after any two hour idle period. This means a period during which there are no calls to or from the voicemail server.

The playback order options are FIFO (first in-first out) or LIFO (last in-first out). Separate settings can be applied to different message types is required. The default for all types is FIFO (first in-first out).

#### To set message housekeeping rules:

1. From the Administration menu, select Preferences > General.
2. Click the Housekeeping tab.

   ![Housekeeping Tab]

   - **Automatic message deletion**
     Sets the time, in hours, after which messages of various types automatically deleted at the next Voicemail Pro housekeeping. A value of 0 disables automatic deletion.

   - **Message playback order (System Setting)**
     Sets the order of playback used for different message types. The options are first in-first out (FIFO) and last in-first out (LIFO). FIFO is the default.

3. Click OK.

4. Click Save and Make Live and select Yes.
3.2.1.5 SNMP Alarm

The IP Office system can be configured to send Simple Network Management Protocol (SNMP) alarms or Simple Mail Transfer Protocol (SMTP) emails. When this is configured, the Voicemail Pro server can tell the IP Office system when to send SNMP alarms about available disk space and remaining recording time.

To set up disk space and recording time alarms:

1. Display the main Voicemail Pro window.
2. From the Administration menu, select Preferences > General.
3. Click the SNMP Alarm tab.

4. Choose the Alarm Threshold Unit either Disk Space Left (MB) or Recording Time left (minutes).
5. In the Alarm Threshold Level box, type the number of units (minutes or MB) left at which SNMP alarms are to be triggered. The minimum is 11. This value also sets two further SNMP alarm levels which are:
   - **Space OK Alarm**
     This alarm is triggered when the amount of available space returns to above a level set at Alarm Threshold Level plus 30.
   - **Critical Alarm**
     This alarm is set at 30 or, when the Alarm Threshold Level is less than 40, at Alarm Threshold Level minus 10. Currently the critical alarm value will decrease in accordance with the above rule. Note however that it does not increment upwards when the Alarm Threshold is increased again. To reset the critical alarm back to 30, click Default Settings.
6. To return to the default alarm settings, click Default Settings. The Alarm Threshold Level is reset to 60. The Space OK level is reset to 90. The Critical Alarm level is reset to 30.
7. Click OK.
8. Click Save and Make Live and select Yes.
3.2.1.6 Outcalling

The preferences in Voicemail Pro are set for global operation. Mailbox owners can configure their outcalling options from their telephone, for example, create their own time profile. Details on how users can configure outcalling is found in the Intuity Mailbox guide.

To set the global outcalling preferences:

1. Display the main Voicemail Pro window.

2. From the Administration menu, select Preferences > General.

3. Click the Outcalling tab.

   - **Prime Times** - The time period that outcalling is to be active as default for the system.
   - **Peak Times** - The busiest working hours.

4. Select the times that outcalling is active in the System Times section.
   - **Prime Times** - The time period that outcalling is to be active as default for the system.
   - **Peak Times** - The busiest working hours.

5. Set the retry settings in the System Retry Settings section.
   - The Number of Retries can be between 0 and 10. If the message is not collected after the last retry, no notification is sent until another new message is delivered in the user's mailbox.
   - The Retry Interval are set for each retry attempt. The interval is the length of time between each attempt to ring to targeted number again. The 6th to 10th retries use the default retry interval.
   - Double-click a selected retry time to edit the interval between retries. The New interval number window opens where the length of time between each attempt to ring the target number can be changed. Click OK to save the change and return to the Outcalling window.

6. Click OK.

7. Click Save and Make Live and select Yes.

A timeout value can be set by a user. This is how long outcalling will attempt to call a number before giving up. For more information, see the Intuity Mailbox guide.
3.2.1.7 VPNM

This option is active only if VPNM was selected during installation and is licensed. VPNM servers can be added and then users added to the servers.

To open the VPN window:

1. Start the Voicemail Pro Client.
2. From the Administration menu, select Preferences > VPNM. The VPNM window opens.

To add a VPNM server:

1. In the VPNM Server(s) section, click Add.
2. Enter the fully qualified domain name of the remote VPNM destination (the remote Voicemail Pro server PC or Avaya Interchange).
3. Enter the two digit access prefix, if these are being used.
4. Click OK.

To delete a VPNM server:

1. In the VPNM Server(s) section, select the server that you need to delete.
2. Click Delete. When a server is deleted, all of the users associated with that server are also deleted.
To add a user to VPNM server:

1. In the Users for VPNM Server(s) section, click Add. The Adding a new user window opens.

2. Enter details for the user. All of these details MUST be completed before the user can be added.
   - Select the VPIM server from the listing.
   - Enter the user's full name. The user's full name is used by the local Voicemail Pro's dial by name feature.
   - Enter the user's extension. The local extension number is used as the local mailbox number and so should not conflict with any existing local number.
   - Enter the user's remote extension. The remote extension number should be the user's real extension number. Typically this and the 'local extension number' are kept the same using a unique extension number dial plan for the linked systems.
   - Enter the user's full telephone number. The full telephone number should be a dialable number that is routed to the user's extension or mailbox.

3. Click OK to save the details and return to the VPNM configuration window.
To add a group of users:

1. (Optional) Check the option **Enable WildCard**. When this option is selected you can use the question mark symbol (?) to represent any number.

2. In the **Users for VPNM Server(s)** section, click **Add Range**. The Adding a range of users window opens.

   ![Adding a range of users window](image)

   - Which VPNM Server do these users belong to?
   - Input extension range:
     - Start
     - Number of Users
   - Enter local prefix
   - Enter remote prefix

3. Enter details for the users. All of these details MUST be completed before the users can be added.
   - Select the VPNM server to which you want to add the users.
   - Enter the start number of the extension range.
   - Enter the local prefix.
   - Enter remote prefix.

4. Click **OK** to save the details and return to the VPNM configuration window.

To change details of a VPNM user:

1. In the **Users for VPNM Server(s)** section, select the name of the user whose details need to be changed.

2. Click Modify. You can change the user’s full name, the local extension number and the full telephone number.
3.2.2 Control Panel Options

3.2.2.1 IMS Logging Level

If IMS is installed the Systems Settings tab is available. You can specify the level of service logging for the IMS Gateway Server service and the IMS Voice Server service. Four levels of logging are available, with increasing level of detail.

Typically logging is required only if IMS problems are being experienced and diagnosis is required. The information is logged in the Event Viewer application.

**To specify the level of IMS service logging:**

1. Open the Windows Control Panel.
3. Click the **System Settings** tab.

![System Settings tab](image)

4. In the **Logging Level** boxes, select the level to use for each of the IMS services.
   - **None** - No logging recorded.
   - **Some** - A low level of logging recorded where only errors are logged.
   - **Most** - A medium level of logging where errors and warnings are recorded.
   - **All** - All errors, warnings and information are logged.

5. Click **Check** to validate the changes that you have made.
6. Click **OK**. You are prompted to restart the affected services so that your changes are enabled.
7. Choose **Yes**. The services that are affected by your changes are automatically stopped and restarted.
### 3.2.2.2 IMS Host Server Name

If IMS is installed the Path Settings tab is available. You need to specify the computer name of the server PC that is hosting the IMS Voice Service. Typically, this is installed on the same server PC as the Voicemail Pro Server.

**To specify the name of the host server PC for IMS:**

1. Open the Windows Control Panel.
2. Select **IP Office Voicemail Pro**. The IP Office Voicemail Pro window opens.
3. Click the **Path Settings** tab.

   ![Path Settings Tab](image)

   **Enter the name of the computer on which the Integrated Messaging Voice Service has been installed.**

4. Type the name of the computer on which the IMS Voice Service has been installed.
   - Alternatively, click **Browse** and select the name of the computer.
5. Click **Check** to validate the changes that you have made.
6. Click **OK**. You are prompted to restart the affected services so that your changes are enabled.
7. Choose **Yes**. The services that are affected by your changes are automatically stopped and restarted.
3.2.2.3 Configuring Email Settings

You can configure certain email settings such as the account to use for email and the way in which .wav files are transmitted.

To configure email settings:

1. Open the Windows Control Panel.
2. Select **IP Office Voicemail Pro**. The IP Office Voicemail Pro window opens.
3. Click the **Email Settings** tab.

   ![Email Settings Tab](image)

4. In the **Account Details** box, type the name of the MAPI email account to use for email messages. Alternatively, select **Browse** to display a list of available email accounts.
   - If you are setting the account details when using SMTP, it is advisable that the full domain name is entered, for example admin@test.com.
5. Click **Check** to validate the changes that you have made.
6. Click **OK**.

The **Message Parameters** options are only available if you have installed IMS. For IMS you can specify the way in which the .wav files of voicemail messages are to be sent in emails. Sending .wav files across a network creates a high loading on the network and networks servers. A one-minute message requires a 1MB .wav file.

To set the message parameters:

1. To transmit .wav files, check the **Transmit Wave File** box.
2. Choose the option for transmitting the .wav files. Choose either:
   - **Attach wave file to message** to allow a recipient to copy a .wav file for use elsewhere.
   - **Embed wave file in message** to allow a recipient to embed a file in a message. An embedded file is compressed and therefore smaller than an attached file.
3. Click **Check** to validate the changes that you have made.
4. Click **OK**. You are prompted to restart the affected services so that your changes are enabled.
5. Choose **Yes**. The services that are affected by your changes are automatically stopped and restarted.
### Configuring SMTP Email Settings

For SMTP email, you need to define connections to external SMTP Email Servers. You can define your connections in the SMTP Email settings tab. Details in the tab vary according to whether IMS or Voicemail Pro Networked Messaging (VPN) is installed.

**To configure SMTP email settings:**

1. Open the Windows Control Panel.
2. Select **IP Office Voicemail Pro**. The IP Office Voicemail Pro window opens.
3. Click the **SMTP Email Settings** tab.

   ![SMTP Email Settings Tab]

4. In the **Mail Server** box, type the name of the SMTP mail server. This should be the fully qualified domain name.
5. In the **Port Number** box, type the number of the receiving port on the SMTP mail server. The default is 25.
6. In the **Mail Drop box**, type the name of the destination folder for outgoing emails on the SMTP Server. This is required if VPN is installed. Alternatively click the browse button and select the folder to use.
7. (Optional) To enforce server authentication, check the **Server Requires Authentication box**. If you check it you also need to provide the Account Name and Password that need to be entered. You can also choose whether or not to set the **Use Challenge Response Authentication** option.
8. Click **Check** to validate the changes that you have made.
9. Click **OK**. You are prompted to restart the affected services so that your changes are enabled.
10. Choose **Yes**. The services that are affected by your changes are automatically stopped and restarted.
3.3 Fax Server Configuration

With an IP Office system, fax machines and servers can process fax messages in a number of ways.

- **Fax calls can be handled without the use of Voicemail Pro**
  In IP Office a fax machine can be set up to direct faxes to individual extensions or hunt groups. Faxes can be directed to the fax machines or servers based on the DDI or DID numbers of the incoming calls. For more information, see the IP Office Manager help and guide.

- **Fax calls detected by Voicemail Pro**
  When a fax message is left in a voicemail mailbox, Voicemail Pro can detect that the call is a fax call, and redirect the call to a fax machine or fax server to receive the fax. The incoming call can be routed to a system fax number or, in Intuity Mode, a fax number that the mailbox owner has specified.

- **Fax calls can be sent to a system-wide fax number**
  If Voicemail Pro detects a fax tone, it passes the call to the number that is set as the system fax number. This number can be an analog extension that is connected to a fax board in the fax server. For more information about configuring an analog extension, see Configuring an Analog Extension Number for Fax Use.

- **Fax calls can be sent to a user defined mailbox number**
  If Voicemail Pro detects that the incoming call is a fax and if a system fax number has been specified, Voicemail Pro checks to determine whether the target destination is a user defined fax number. If it is, the system fax number is overridden and the incoming call is redirected to the user defined fax number.
  
  If no user defined fax number has been set, the fax is sent to the system fax number. When a system fax number is set, any fax calls that are received in user or hunt group mailboxes are directed to this number. This applies to both IP Office and Intuity Mailboxes. For more information, see Setting the Voicemail Pro System Fax Number.

  Intuity mailbox owners have options available through their telephone handset so that they can forward a fax to a preferred fax machine or send a fax to a printer. Intuity mailbox owners can find out how to set a mailbox fax number in the IP Office Intuity Mailbox User Guide.

  If a fax system, such as a C3000, requires prefix addressing the system fax number is not used. Instead a prefix is specified so that a fax message can be identified and forwarded to the extension number of the intended recipient. For example if a prefix of 54 is being used, a fax message for extension 201 would have the prefix of 54 automatically added so that the complete number would become S4201. The fax server then removes the system prefix and uses the extension number to determine the target destination for the fax. For more information, see Setting the Voicemail Pro System Fax Number.

- **Fax calls can be redirected using a call flow Menu action instead of a system fax number**
  If a system fax number is not set up, a menu action can be used instead. The F character can be used as one of the touch tone choices of a Menu action to specify the actions that should be applied to fax calls. For more information, see Routing Fax Calls Using a Menu Action.

- **Important**
  By default, Voicemail Pro fax detection is disabled. To enable fax detection, you must define a system fax number. For more information, see Setting the Voicemail Pro System Fax Number.
3.3.1 Fax Server Configuration

Here is an illustration to show how a fax server can be configured to work with an IP Office system. The illustration applies to the following popular fax server applications:

- Gfi FAXMaker
- Fenestrae Faxination
- Equisys Zetafax
- Captaris RightFax

The fax server is configured to distribute faxes to exchange server mailboxes based on the original (DTMF) fax sub address that is passed by Voicemail Pro. For the fax server and Voicemail Pro to interact, specific user rights are needed.

If the PC that is being used as the fax server uses an analog fax board, the fax board must be connected to an IP Office analog extension (POT) port.

The sections that follow explain how to configure a fax server to work with Voicemail Pro. The information provided assumes that:

- The fax server software is installed.
- The hardware is installed and connected to an IP Office.
- The Exchange Connector is installed and configured.

For details of system requirements and information about installing a fax server, refer to the manufacturer documentation or visit the manufacturer web site.

The process for configuring a fax server to work with Voicemail Pro involves the following key steps:

1. Set the system fax number. For more information, see Setting the Voicemail Pro System Fax Number.
2. If prefixed numbers are being used you can set up a short code so that fax calls are routed to prefixed numbers.
3. If the chosen mailbox mode is Intuity, inform all mailbox owners that they can set up their own preferred fax destinations if they like. For more information, see Setting Up a User Defined Fax Number.
4. If a system fax number is not being used, you can set up a menu action to route fax calls. For more information, see Routing Fax Calls Using a Menu Action.
5. If the fax server PC uses an analog fax card, configure the extension number to use for faxes. For more information, see Configuring an Analog Extension Number for Fax Use.
3.3.2 Setting the VoiceMail Pro System Fax Number

The System Fax Number is used to:

- Enable fax detection.
- Define the default destination for fax calls that arrive in a voicemail mailbox and which are to be redirected to a fax machine.

By default fax detection is not enabled when Voicemail Pro is first installed. When fax detection is enabled, any fax calls that are left in a voicemail mailbox, are redirected to the defined system fax number.

Intuity mailbox owners have the additional option to define their own personal fax number instead of the system fax number. Incoming calls are directed to Voicemail Pro and then Voicemail Pro redirects fax calls to a mailbox owner’s personal fax number, if one has been set. For information mailbox owners should read the Intuity Mailbox User Guide.

To set the Voicemail Pro system fax number:

1. From the Administration menu, select Preferences. The System Preferences window opens.
2. Click the General tab.

3. In the System Fax Number box, type the number of the general fax machine to which all incoming faxes are to be directed. This number must match the number of the analog extension that is connected to the fax board of the fax server PC.
   - Intuity mailbox owners can receive fax messages into their mailboxes and set a preferred fax number to use instead of the system fax number. As the administrator you still need to set up a system fax number to enable mailbox owners to set their own numbers. A personal mailbox fax number overrides the system fax number. Mailbox owners can find out more in the Intuity Mailbox User Guide.
   - If your fax system requires prefix addressing, for example the C3000 fax server, do not type a fax number In the System Fax Number box. Instead type the number to use as a prefix so that a fax message can be identified and forwarded to the extension number of the intended recipient. For example if the prefix were 54, a fax message for extension 201 would have the prefix of 54 automatically added so that the complete number would become 54201.

4. To use the specified prefix, check the Use as a Prefix box so that the number that you typed in to the System Fax Number box is used. If your fax system does not use prefix addressing, leave this box unchecked.
   - Important
     For this feature to work, you also need to set up a short code.

5. Most fax servers perform fax forwarding based on DTMF signalling received with the fax call. Check the Enable Fax Sub-Addressing box so that the DTMF signal is passed to the fax server after the call has been answered. This is so that the fax can be forwarded to the email address of the intended recipient.

6. Click OK.
7. Click Save & Make Live.
If prefixed numbers are being used, the next step is to up a short code so that fax calls are routed to prefixed numbers.

If the chosen mailbox mode is Intuity, you should then inform all mailbox owners that they can set up their own preferred fax destinations if they like. For more information, see Setting Up a User Defined Fax Number.

If a system fax number is not being used, you can set up a menu action to route fax calls. For more information, see Routing Fax Calls Using a Menu Action.

If the fax server PC uses an analog fax card, you need to configure the extension number to use for faxes. For more information, see Configuring an Analog Extension Number for Fax Use.
3.3.3 Setting up Fax Forwarding

Voicemail Pro is set up to forward faxes when users dial *1. Faxes are forwarded as follows:

- Gfi FAXMaker faxes are sent to <faxnumber>@faxmaker.com
- Fenestrae Faxination faxes are sent to <faxnumber>@faxination.com
- Equisys Zetafax faxes are sent to <faxnumber>@zfconnector.com
- Captaris RightFax faxes are sent to <faxnumber>@rightfax.com

Example

For example, if a Gfi FAXMaker user dials *1 and enters the fax number to use followed by # to end the fax number and # to confirm, the fax is forwarded to <faxnumber>@faxmaker.com. Therefore if the user dials *1 followed by 201# and # to confirm, the fax is forwarded to 201@faxmaker.com.

- It is the responsibility of the fax server administrator to ensure that exchange connectors are configured to receive such messages.

3.3.4 Setting Up a User Defined Fax Number

If you enable the feature for them, Intuity mailbox owners can set up a preferred personal fax number that is more convenient to their location, for example if they are out of the office.

To set up a user defined fax number:

1. Complete the steps for setting up the system fax number. For more information, see Setting the Voicemail Pro System Fax Number.
2. Inform the mailbox owner that they can go ahead and set their preferred fax number. Refer the mailbox owner to the IP Office Intuity Mailbox User Guide.
3. If it has not already been done and the fax server PC is using an analog fax card, the next step is to configure the analog fax number to use. For more information, see Configuring an Analog Extension Number for Fax Use.
3.3.5 Routing Fax Calls Using a Menu Action

When an incoming call is routed to the auto attendant, the Menu action has the facility to detect and redirect fax calls. This capability is enabled by including a number in the system fax number field via the Voicemail Pro Client, and adding 'F' as the tone to detect in the Menu action. From the Menu action, incoming calls presenting a fax tone will then follow the 'F' call flow route, which could be a transfer call to a fax server extension or hunt group.

You can add the F character to the touch tone options of a Menu action to specify the actions that should be applied to fax calls. The corresponding result can then be routed as required for fax calls received by the associated call flow. The following example module call flow is using F to redirect incoming fax calls to a specific transfer number.

The F result was added to the Menu action Touch Tones tab using the icon.
3.3.6 Configuring an Analog Extension Number for Fax Use

If the PC that is being used as the fax server uses an analog fax card, it must be connected to an IP Office analog extension (POT) port. You are then ready to configure the analog extension for fax use.

To configure an analog extension number for fax use:

1. In IP Office Manager, display the extension details for the extension that you are using for the fax.

2. View the Ext tab.

3. In the Caller Display Type field, select DTMFF.

3. View the Analogue tab.

4. Set up the incoming DDI routing of calls to specific users as required.

- **Tip**
  If the fax board can support multiple lines, you can configure them as a group. The group number can then be used as the fax destination instead of an individual extension number.

The next step is to set the Voicemail Pro system fax number. For more information, see Setting the Voicemail Pro System Fax Number.
3.3.7 Castelle Fax Server
Voicemail Pro 4.1 added support for Castelle FaxPress products. This uses SMTP rather than MAPI to exchange fax emails with the Voicemail Pro server.

In order for the Voicemail Pro to recognize emails received from the fax server, the From name used must start with FaxPress. This is configured through the FaxPress client software as follows:

1. Login to the FaxPress client software as a supervisor.
2. Expand the Administration section on the left.
4. Select Email Gateway. Right-click on this and select Configuration.
5. Select the Email to Fax tab.
6. In the Return address used in emails sent from the SMTP gateway section, in the Name field enter a name in beginning with FaxPress.
Chapter 4. Administration
4. Administration
4.1 Starting the Voicemail Pro Client

You can start the Voicemail Pro Client from the IP Office Voicemail Pro folder.

To start the Voicemail Pro Client:

1. From the **Start** menu, select **Programs > IP Office > Voicemail Pro Client**. The main Voicemail Pro Client window opens.

If the Client and Server are installed on the same machine, you do not need to log in. If you are using the Client to work on a remote server, you do need to log in. For more information, see [Logging in to the Voicemail Pro Server](#).

- **Tip**
  
  Alternatively, as with any other Windows application, you can add a shortcut to your desktop and start the Voicemail Pro Client from there.

4.1.1 Logging in to the Voicemail Pro Server

You can run the Voicemail Pro Client in offline mode and you can also use it to connect to a Voicemail Pro Server. To connect to a Voicemail Pro Server with the Voicemail Pro Client, you need to log in for authentication purposes.

By default, the Voicemail Pro Server does not have any user accounts defined. Therefore no remote Voicemail Pro Clients can connect. You can use a local Voicemail Pro Client, to add administrator or standard administrator users who can then connect using remote Voicemail Pro Clients. For more information, see [Adding an Administrator](#).

To log in to the Voicemail Pro Server:

1. From the **File** menu, select **Login**. The Voicemail Pro Login window opens.

2. In the **User Name** field, type a user name. This is the name that the workstation software will use. This should already be defined on the Voicemail Pro Server.

   - If the Voicemail Pro Server and Client are on the same computer, you do not need to enter a user name to connect to the Voicemail Pro Server and perform administration tasks.

3. In the **Password** field, enter the password.

4. In the **Unit Name/IP Address** field, type the name or the IP address of the server you want to connect to. By default the IP address or name that was last used is already filled in.

   - If you are logging in to a different server and do not know the name or IP address, click **Browse**. Select from the list of available Voicemail Pro servers.

   - If you are logging in across a WAN, you must type in the IP address and not the server name.

5. Click **OK**. The main Voicemail Pro Client window opens. For more information, see [The Main Voicemail Pro Window](#).
4.1.1.1 Changing Between Offline and Online Mode

It can be useful to connect to a system to get the current system configuration and then disconnect and make changes offline. You can then test configuration changes offline before applying them to a live system. If the Voicemail Pro Client and Server are on the same machine, you can switch between online and offline mode without having to log out.

To switch between online and offline mode:

1. From the File menu, select Select Mode. The Select Voicemail Pro Client Mode window opens.
2. Select Offline to work offline or Online to connect to the server and work online. If you select Online, the VoicemailProLogin window opens.
3. Log in as usual.

The next time you run the Voicemail Pro Client, it will start up in the mode that you used previously. When you are ready to connect to a server you need to log in.

4.1.1.2 Continue Offline Message Window

If your session expires you will be notified that the session has expired. You are then able to continue working in offline mode or to close the application. If you select to work in offline mode, you can switch to working online. For more information, see Changing Between Online and Offline Mode.

- Yes - Select to continue working in offline mode.
- Exit - Select to close Voicemail Pro.
4.1.1.3 Logging Out

It can be useful to connect to a system to download the current system configuration and then disconnect and make changes offline. You can then test configuration changes offline before applying them to a live system.

To log out:

1. From the File menu, select Log Out.
   You are logged out of the Voicemail Pro server and placed in offline mode. You can either make configuration changes offline and then log back in when you are ready or log on to a different server to work. For more information see Logging in to the Voicemail Pro Server.

Notes

- Logging out is not the same as closing down with the Exit option. For more information, see Closing Down.
- If the Client and Server are installed on the same machine, the Log Out option is not available.

4.1.1.4 Closing Down

When you have finished working, you can close down the Voicemail Pro Client. This is not the same as logging out. For more information, see Logging Out.

To close the Voicemail Pro Client down:

1. From the File menu, select Exit.
   If you have not made any changes, the Voicemail Pro Client closes and you are returned to the desktop. If you have made changes, a message is displayed to ask whether you want to save them.

2. If you do not want to save your changes, click No. No changes are saved. If you want to save your changes, click Yes. Your changes are saved but not yet made live.

3. If you are ready to make your changes live, click Save & make Live. For more information, see Saving Configuration Changes and Making them Live.
4.2 Administrator Configuration

You can use Voicemail Pro Client remotely in offline mode. If you want to connect to a Voicemail Pro Server you need to log in. By default, the Voicemail Pro Server does not have any User accounts defined, therefore no Remote Voicemail Pro Clients can connect.

If you are an administrator you can add other users as administrators. You can give them the authority to carry out standard or more powerful administration tasks using the Voicemail Pro Client. There are two types of administrator:

- **Standard Client user**
  A standard administrator can perform administration of call flows using the Voicemail Pro Client. A standard administrator can change their own password but cannot add or remove Client users or change passwords.

- **Administrator Client user**
  A more powerful administrator who can add and remove Client users and set and change passwords.

**To add an Administrator:**

1. In the Start Points Navigation pane, select **Voicemail Pro Administrators**. The name, type and status of any existing Voicemail Pro administrators are displayed in the details pane.

2. Right-click anywhere in the details pane.

3. Select **Add**. The Add Administrator window opens.

   ![Add Administrator](image)

   4. In the **User Name** field, type the name that you want to assign to the administrator.
      - The name must be at least 5 characters long and must not contain spaces or any of the following characters: \\ / : * ? < > | , ;

   5. In the **New Password** field, type a password for the administrator.
      - A password must be at least 5 characters long and must not contain spaces or any of the following characters: \ / * ? < > | , ;

   6. In the **Confirm New Password** field, type the password again for confirmation purposes.

   7. In the **Type** field, click the type of user that you want.

   8. Click **OK**.

   9. Click **Save and Make Live** to save the changes. The user created can now log into the Voicemail Pro Client Server. For more information, see **Logging in to the Voicemail Pro Server**.

By default new users are created as **Inactive**. Their status changes to **Active** when they connect to a Voicemail Pro server.
4.2.1 Changing Administrator Details

If you are an administrator user, you can change details of a standard administrator or another administrator user. You can change the user name, user type and status. You can also reset the password of other administrator users.

You can change the authority level of a standard user to an administrator and vice versa.

To change the authority level of a user:

1. In the Start Points Navigation pane, select **Voicemail Pro Administrators**. The name, type and status of any existing Voicemail Pro administrators are displayed in the details pane.
2. Right-click the name of the administrator user whose details you need to change.
3. Select **Modify**. The Modify Administrator window opens.

![Modify Administrator Window](image)

4. (Optional) Edit the name of the administrator user.
5. (Optional) Change the password and inform the user. For more information, see [Resetting a Password](#).
6. (Optional) In the **Type** field select the type of user. Choose either Administrator or Standard. By default new users are created as Inactive. Their status changes to Active when they connect to a Voicemail Pro server.
7. Click **OK**.
8. Click **Save and Make Live** to save the changes.

4.2.2 Deleting an Administrator

For security it is good practice to delete administrator users as soon as they are no longer required.

To delete an administrator:

1. In the Start Points Navigation pane, select **Voicemail Pro Administrators**. The name, type and status of any existing Voicemail Pro administrators are displayed in the details pane.
2. Right-click the name of the administrator user whose details you need to delete.
3. Click **Delete**. A message is displayed to confirm whether you want to delete. If not, for example if you have chosen the wrong name, click **Cancel**. If you are sure that you want to delete the selected administrator, click **Yes**. The selected administrator is deleted.
4. Click **Save and Make Live** to save the changes.
4.2.3 Resetting a Password

If you are an administrator you can reset the password of another administrator or standard Voicemail Pro Client user.

To reset a password:

1. In the Start Points Navigation pane, select **Voicemail Pro Administrators**. The name, type and status of any existing Voicemail Pro administrators are displayed in the details pane.
2. Right-click the name of the administrator user whose details you need to reset.
3. Select **Modify**. The Modify Administrator window opens.
4. In the **Password** box, type the new password.
5. In the **Confirm Password** box, type the new password again.
6. Click **OK**.
7. Click **Save and Make Live** to save the changes.

4.2.4 Releasing a Locked Administrator Login

If an administrator tries unsuccessfully to log in to the Voicemail Pro Client 3 times consecutively, their user ID is locked and cannot be used for 1 hour. As an administrator you can release a locked ID so that the other person does not need to wait.

To release a locked login:

1. Display the main Voicemail Pro window.
2. In the navigation pane, highlight **Voicemail Pro Administrators**. The name, type and status of every current VoicemailPro administrator user are displayed in the details pane.
3. Right-click the name of the administrator user whose ID has been locked.
4. Select **Modify**. The Modify Administrator window opens.
5. Click the **Status** arrow and select the status **Inactive**.
6. Click **OK**.
7. Click **Save and Make Live**.
4.3 General Administration

4.3.1 Changing the Inactivity Timeout

While a user is logged in using the Voicemail Pro Client, other users cannot log in. By default a timeout is set so that users are sent a warning message and logged out automatically if they have not been active for 5 minutes.

When the user receives the warning message they can reset the inactivity timeout so that they are not logged out. This is provided that they have not already been logged out and another Voicemail Pro Client has not already connected to the Voicemail Pro Server.

As an administrator user you can change the timeout to a period of between 1 and 60 minutes.

To change the inactivity timeout:

1. From the Administration menu, select Preferences > General. The General tab is displayed.

2. From the Client/Server Connection Timeout list, select the number of minutes after which an inactive user of the Voicemail Pro Client will receive a warning message and then be automatically logged out.

3. Click OK.
4.3.2 Changing Mailbox Operation Mode

The features available in Voicemail Pro mailboxes depend on whether the mailbox is working in IP Office mode or Intuity mode. As an administrator you can switch between modes. The title bar of the main Voicemail Pro window shows the current mode (telephony interface) in parentheses.

To change the mailbox operation mode:


2. Select the General tab.

3. Click the Default Telephony Interface arrow and select Intuity or IP Office. The change takes effect immediately, there is no need to restart.
4.3.3 Confirm Call Flow Download Window

When you connect to a server across a LAN or WAN to view or modify the call flow on the server, a check is made to see if the call flow that is stored locally on the Client machine is the same. The call flow on the server might be different to the call flow on the Client because:

- The local call flow is older than the version on the server, for example if the call flow on the server has been modified by another Client connection.
- The local call flow is newer than the version on the server, for example if the call flow on the server has been worked on while the local Client was being used in offline mode.
- The local call flow is from a different server, for example if you are connecting to a different server to the one from which the call flow was previously downloaded.

If the call flow is the same no data will need to be copied back from the server to the Client. If the call flow is different you can chose to download the call flow from the server or to use the local call flow.

- **Download**
  Click to download the call flow from the server.

- **Cancel**
  Click this if you do not want to download the call flow from the server.

To upload the local call flow to the server, use the Save or Save and Make Live options from the File menu. For more information, see [Saving Changes and Making them Live](#).

4.3.4 Changing your Password

If you are a standard user, you can change your own password when you are working in online mode. If you are working offline, the Change Password option is not available.

**To change your password:**

1. From the **File** menu, select **Change Password**. The Change Password window opens.
2. In the **New Password** box, type the new password.
3. In the **Confirm Password** box, retype the new password.
4. Save the changes.
4.4 Routing Calls to Voicemail

There are different methods by which callers can be transferred to voicemail. The transfer can be used to route the caller to a specific mailbox to leave or collect messages or to a particular Voicemail Pro start point.

The sections that follow describe the use of Voicemail Collect short codes and VM: paths as telephone numbers. These can then be applied to dialing, DSS keys SoftConsole and Phone Manager buttons.

An example Voicemail Pro module is included which allows the transferred caller to select the extension to which they want to talk or leave a message.

**VM: versus Short Codes?**
The VM: method is easier to deploy. In fact for SoftConsole and Phone Manager it can be used without the need to access and change the Manager configuration. However, the disadvantage is that VM: cannot be dialed from a physical phone.

Short codes have the advantage that they can be dialed at any extension once set up through IP Office Manager.
4.4.1 Routing Calls to Voicemail

If a user has voicemail switched on, calls will be automatically routed to voicemail if either:

1. The extension is busy and call waiting has not been enabled.
2. The user has do not disturb set or the extension is not answered within the No Answer Time as set in IP Office Manager program (default 15 seconds).

The caller hears the standard greeting message ‘Your call is being answered by IP Office. <Name> is not available. To leave a message wait for the tone,’. A user can record their own standard greeting message if required.

When new messages are received, the user’s telephone call display or IP Office Phone Manager application is updated to show the number of new messages waiting.

If Voicemail Ringback is enabled, the Voicemail Server calls the user’s extension to attempt to deliver new messages when the user next uses the telephone.

All messages are stored until they have been listened to and are then automatically deleted after a set time period. The default time period for IP Office mode is 36 hours. In IP Office mode users can designate a message as saved so that it is not automatic deleted.

A mailbox owner can turn voicemail and voicemail ringback on or off using Phone Manager. The default short codes can also be used. The default short codes are:

- **18** - To turn voicemail on.
- **19** - To turn voicemail off.
- **48** - To turn voicemail ring back on.
- **49** - To turn voicemail ring back off.

4.4.2 Transferring Calls to Voicemail

The facility to transfer a call directly to a user’s voicemail is available using the SoftConsole or Phone Manager applications. For users who are not using these applications, you can create a short code for them.

For example:

<table>
<thead>
<tr>
<th>Field</th>
<th>Contains...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>*201</td>
</tr>
<tr>
<td>Feature</td>
<td>Voicemail Collect</td>
</tr>
<tr>
<td>Telephone Number</td>
<td>&quot;#Extn201&quot;</td>
</tr>
<tr>
<td>Line Group Id</td>
<td>0</td>
</tr>
<tr>
<td>Locale</td>
<td>[Leave blank]</td>
</tr>
<tr>
<td>Force Account Code</td>
<td>[Leave blank]</td>
</tr>
</tbody>
</table>

When creating short codes for use with voicemail, the ? indicates "collect voicemail" and the # indicates "deposit voicemail". The telephone number entry must also be enclosed by quotation marks as shown in the example.
4.4.3 Using Short Codes to Access Voicemail

The short code Voicemail Collect feature can be used to route callers to voicemail. The voicemail service they receive is set by the telephone number field which should be enclosed in quote marks. For more information, see Voicemail Telephone Numbers.

- The examples use *80 but any available short code could be used.

Example 1: Access to the Mailbox Main

The following short code will access the mailbox for Main. The ? indicates that it is to collect messages. A # is used to indicate leave a message in the mailbox.

<table>
<thead>
<tr>
<th>Field</th>
<th>Contains...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>*80</td>
</tr>
<tr>
<td>Feature</td>
<td>Voicemail Collect</td>
</tr>
<tr>
<td>Telephone Number</td>
<td>&quot;?Main&quot;</td>
</tr>
<tr>
<td>Line Group Id</td>
<td>0</td>
</tr>
<tr>
<td>Locale</td>
<td>[Leave blank]</td>
</tr>
<tr>
<td>Force Account Code</td>
<td>[Leave blank]</td>
</tr>
</tbody>
</table>

Example 2: Access a Voicemail Pro Module

If a Voicemail Pro module has been created and called TimeCheck, the following short code could be used to access it.

<table>
<thead>
<tr>
<th>Field</th>
<th>Contains...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>*80</td>
</tr>
<tr>
<td>Feature</td>
<td>Voicemail Collect</td>
</tr>
<tr>
<td>Telephone Number</td>
<td>&quot;TimeCheck&quot;</td>
</tr>
<tr>
<td>Line Group Id</td>
<td>0</td>
</tr>
<tr>
<td>Locale</td>
<td>[Leave blank]</td>
</tr>
<tr>
<td>Force Account Code</td>
<td>[Leave blank]</td>
</tr>
</tbody>
</table>

The Voicemail Node short code feature can also be used to access short code start points. It uses the short code start point name as the telephone number without surrounding brackets.
4.4.4 Using VM: to Access Voicemail

Another method for accessing voicemail is the **VM:** option, where VM: is followed by the name of the mailbox or Voicemail Pro start point required.

This can be used in the telephone number field of IP Office applications such as SoftConsole, Phone Manager and Manager.

- **Example 1: SoftConsole access to the mailbox Main**
  The user wants single click access to check for messages in the hunt group mailbox Main (extension ID 200).
  2. Click one of the BLF panel tabs.
  3. Right-click and select **New > BLF Group Member**.
  4. Type a **Name**, for example **Messages**.
  5. Type a **Number**, in this case enter **VM:Main** or **VM:200**.
  6. Click **OK**. The operator can now check for messages in that group mailbox with a single click.

- **Example 2: Accessing a Module from Phone Manager**
  The user wants to access a particular Voicemail Pro module, for this example one called **TimeCheck**.
  1. Start Phone Manager.
  2. Click the **Speed Dials** tab.
  3. Right-click and select **New**.
  4. Type a **Name**, for example **Time Check**.
  5. Type a **Number**, in this case enter **VM:TimeCheck**.
  6. Click **OK**.

- **Example 3: Incoming Call Routing**
  The VM notation can be used in the **Destination** field of a Manager Incoming Call Route. This enables you to route calls that match the Incoming Call Route’s criteria to a particular mailbox or Voicemail Pro module.
4.4.5 Voicemail Telephone Numbers
This section describes the options that can be used with VoicemailCollect short codes and with VM: to access a mailbox or Voicemail Pro start point.

Voicemail Lite and Pro
In this example we have used a mailbox called Main with extension number 200.

<table>
<thead>
<tr>
<th>Short Code</th>
<th>Application Number Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collect Messages</td>
<td>?200 VM:?200</td>
</tr>
<tr>
<td></td>
<td>&quot;?Main&quot; VM:?Main</td>
</tr>
<tr>
<td>Leave Messages</td>
<td>#200 VM:#200</td>
</tr>
<tr>
<td></td>
<td>&quot;#Main&quot; VM:#Main</td>
</tr>
</tbody>
</table>

A user attempting to collect mail from user mailboxes will be prompted for the voicemail PIN code if not accessing from a trusted source. For more information, see Creating a Trusted Location.

Voicemail Pro Start Points
The following only apply when a matching start point has been set up.

If a short burst of ringing is required then # should be inserted before the start point name. This is useful if transferring callers as it allows the transfer to be completed before the Voicemail Prompts begin.

<table>
<thead>
<tr>
<th>Short Code</th>
<th>Application Number Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Start Points</td>
<td>for examples a user called Extn205.</td>
</tr>
<tr>
<td>Collect</td>
<td>&quot;Extn205.Collect&quot; VM:Extn205.Collect</td>
</tr>
<tr>
<td>Leave</td>
<td>&quot;Extn205.Leave&quot; VM:Extn205.Leave</td>
</tr>
<tr>
<td>Callback</td>
<td>&quot;Extn205.Callback&quot; VM:Extn205.Callback</td>
</tr>
<tr>
<td>Queued</td>
<td>- VM:Extn205.Queued</td>
</tr>
<tr>
<td>Still Queued</td>
<td>- VM:Extn205.Still Queued</td>
</tr>
<tr>
<td>Group Start Points</td>
<td>for example a group called Main.</td>
</tr>
<tr>
<td>Collect</td>
<td>&quot;Main.Collect&quot; VM:Main.Collect</td>
</tr>
<tr>
<td>Leave</td>
<td>&quot;Main.Leave&quot; VM:Main.Leave</td>
</tr>
<tr>
<td>Queued</td>
<td>- VM:Main.Queued</td>
</tr>
<tr>
<td>Still Queued</td>
<td>- VM:Main.Still Queued</td>
</tr>
<tr>
<td>Default Start Points</td>
<td></td>
</tr>
<tr>
<td>Collect</td>
<td>&quot;Default.Collect&quot; VM:Default.Collect</td>
</tr>
<tr>
<td>Leave</td>
<td>&quot;Default.Leave&quot; VM:Default.Leave</td>
</tr>
<tr>
<td>Queued</td>
<td>- VM:Default.Queued</td>
</tr>
<tr>
<td>Still Queued</td>
<td>- VM:Default.Still Queued</td>
</tr>
<tr>
<td>Short Code Start Points</td>
<td>for example a shortcode start point called DVM.</td>
</tr>
<tr>
<td></td>
<td>&quot;Short Codes.DVM&quot; VM:Short Codes.DVM</td>
</tr>
<tr>
<td>Module Start Points</td>
<td>for these examples a module called Attend...</td>
</tr>
<tr>
<td></td>
<td>&quot;Attend&quot; VM:Attend</td>
</tr>
<tr>
<td>Campaigns</td>
<td>for example a campaign called Catalogue.</td>
</tr>
<tr>
<td>Leave</td>
<td>- VM:Catalogue</td>
</tr>
<tr>
<td>Collect</td>
<td>- VM:Catalogue.Collect</td>
</tr>
</tbody>
</table>
The **Voicemail Node** short code feature can also be used to access short code start points. It uses the short code start point name as the telephone number without surrounding brackets.
4.4.6 Example Call Flow

This example creates a Voicemail Pro module that allows callers to select the extension to which they want to be connected. If that extension is busy or does not answer they can then leave a message in the target mailbox.

The Voicemail Pro Module

1. In Voicemail Pro, a module was added named **SelfSelect**.

2. A **Menu** action was added. The properties were set as:
   - On the **Touch Tones** tab the **Wait for a key press for** option was set to 5 seconds. This gives the action a **Timeout** result which can be used if the caller does nothing or does not have DTMF dialing.
   - Our IP Office has extensions and groups numbered in the 200 to 299 range. The touch tone sequence **2??** was added to match any dialing in that range.
   - In **Entry Prompts** a prompt was recorded along the line of “Dial the number you want or wait for reception”.

3. A **Transfer** action was added. In its properties, on the **Specific** tab the **Destination** was set to **Main**, the hunt group containing our receptionists.

4. A connection was added from the **Menu** action’s **Timeout** result to the **Transfer** action.

5. An **Assisted Transfer** action was added. In its properties, on the **Specific** tab **$KEY** was added in the **Mailbox** field.

6. A connection from the **Menu** action’s **2??** result to the **Assisted Transfer** action was added.

7. A **Leave Mail** action was then added. In its properties, on the **Specific** tab **$KEY** was again added in the **Mailbox** field.

8. The **Assisted Transfer** action’s **No Answer** and **Busy** result was connected to the **leave Mail** action.

9. Connections were then added from the **Assisted Transfer** action’s **Next** result and the **Leave Mail** action’s **Success** and **Failure** results back to the **Menu** action.
   - The **Success** and **Failure** results in a **Leave Mail** action are only used if the caller presses **0** when in the mailbox.

10. The call flow was then saved and made live.
Creating a Matching Short Code
A short code was needed that could be used to route callers to the SelfSelect module.

1. Start IP Office Manager and receive the configuration.

2. A new system short code was added so that it would be available to all callers. The short code *80 was set up as shown in the table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Contains...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>*80</td>
</tr>
<tr>
<td>Feature</td>
<td>Voicemail Collect</td>
</tr>
<tr>
<td>Telephone Number</td>
<td>&quot;#SelfSelect&quot;</td>
</tr>
<tr>
<td>Line Group Id</td>
<td>0</td>
</tr>
<tr>
<td>Locale</td>
<td>[Leave blank]</td>
</tr>
<tr>
<td>Force Account Code</td>
<td>[Leave blank]</td>
</tr>
</tbody>
</table>

3. The entry "#SelfSelect" indicates the name of the Voicemail start point for the call, in this case the VoicemailProSelfSelect module.

4. For a module start point the # is optional. Using it provides a short period of ringing before the module actions start. This is useful if manually transferring a caller as otherwise they may miss the start of the module's entry prompts.

5. The new configuration was merged.

6. At any extension the routing can be tested by dialing *80. We can then wait to be transferred to reception or dial the extension or group that we want.

Using the Module
The short code *80 can now be assigned or the path VM:SelfSelect to whichever method the user wants to transfer callers to the voicemail service.

A further suggestion is to provide a system short code to deal with callers who dial an invalid extension number. For our example, a short code 2??/./"SelfSelect"/VoicemailCollect would reroute such callers back to the SelfSelect module.
4.5 User Voicemail Access

By default, a user can dial *17 to access their voicemail from their own extension.

A user mailbox cannot be accessed from any other location (internal or external) until a voicemail code has been set for the mailbox. This access code is set in the IP Office Manager. Voicemail can be configured for each individual user in IP Office Manager. For more information, see Configuring Voicemail for Individual Users.

If IP Office Manager has been configured, users can also collect their voice messages by using one the following methods.

- **Using the Messages button on their telephone**
  If their extension is a trusted extension they can access their messages without entering a voicemail code by pressing the Messages button. For more information, see Creating a Trusted Location.

- **Using a Voicemail Collect button**
  A button can be programmed to allow a user to collect voice messages from their telephone. If their extension is a trusted extension they can access their messages without entering a voicemail code. For more information, see Giving Users Button Access to Voicemail.

- **Using Visual Voice**
  A user can be given a display menu to user for access to their mailbox. The menu provides the user with options to listen to messages, send messages, change their greetings and password. For more information, see Giving Users Button Access to Voicemail.

- **Using a short code.**
  Short codes can be created so a user can be given access to their mailbox from locations other than their office desk. When they call the mailbox, they will be prompted to enter the access code. For more information, see Giving Users Access from Any Extension and Voicemail Telephone Numbers.

If direct access is required a specified location can be set up as a trusted location. The caller then does not need to enter an access code. Access can be from the users own extension or another location. For more information, see Creating a Trusted Location.

If users need to access their voicemail messages when they are away from the office, you can set up an Incoming Call Route in IP Office Manager with the destination as Voicemail. Giving Users Access from an External Location.

Users can also receive notification of new voicemail messages at either their own extension or at another location. To receive notification of new messages a user needs to configure their outcalling. For more information, see Outcalling: Overview.
4.5.1 Giving Users Button Access

A user’s telephone can have buttons programmed to allow access to voicemail. Not all telephones support this feature, refer to the relevant guide for more information.

Buttons can be programmed for:

- Visual Voice
- Voicemail Collect

**Voicemail Collect Button**

Users can collect their voice messages from their own extension using a button programmed for voicemail collect. If their extension is a trusted extension they will not need to enter their voicemail code. For more information, see [Creating a Trusted Location](#).

A button on the user’s telephone will display the label VMCol. The extension number or voicemail code do not need to be entered if the extension is a trusted extension.

**To add a voicemail collect button:**

1. Start IP Office Manager and receive the IP Office configuration.
2. Click **User** to display the list of existing users.
3. Click the required user.
4. Click the **Button Programming** tab.
5. Click the button line that you want to change.
6. Right-click in the **Action** field.
7. Select **Advanced** > **Voicemail** > **Voicemail Collect**.
8. Click **OK** to save the button details for the selected user.
9. Repeat for any other users.
10. Click to merge the changes back to the IP Office system.

**Visual Voice Button**

A Voicemail Pro user can be given a display menu for access to their mailbox. The menu provides the user with options to listen to messages, send messages, change their greetings and password.

- The Visual Voice feature is not available on all telephones. Please refer to the user’s telephone guide for more information.
- Visual voice is only available when in Intuity mode.
- For IP Office 4.2+, the MESSAGES button on phones can be set to access visual voice. This is done using the **Messages Button Goes to Visual Voice (System | Voicemail)** option in IP Office Manager.

**To give a user access to Visual Voice:**

1. Start IP Office Manager and receive the IP Office configuration.
2. Click **User** to display the list of existing users.
3. Click the required user.
4. Click the **Button Programming** tab.
5. Click the button line that you want to change.
6. Right-click in the **Action** field.
7. Select **Emulation** > **Visual Voice**.
8. Click **OK** to save the button details for the selected user.
9. Repeat for any other users.

10. Click to save the changes back to the IP Office system.
4.5.2 Giving Users Access from Any Extension

Access to voicemail from any extension can be given to either:

- **An individual user**
  So that a specified user can log in to their voicemail from any extension, you need to set up a short code and associate it with the user's extension number. For example, a short code *90 could be associated with extension number 201. The user with extension 201 can then dial *90 from any extension and enter their voicemail code to collect their voicemail messages.

**To give a specific user access from any extension:**

1. Open IP Office Manager.
2. Set up a short code, for example *90.

<table>
<thead>
<tr>
<th>Field</th>
<th>Contains...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>*90</td>
</tr>
<tr>
<td>Feature</td>
<td>Voicemail Collect</td>
</tr>
<tr>
<td>Telephone Number</td>
<td>*?Extn201&quot;</td>
</tr>
<tr>
<td>Line Group ID</td>
<td>0</td>
</tr>
<tr>
<td>Locale</td>
<td>[Leave blank]</td>
</tr>
<tr>
<td>Force Account Code</td>
<td>[Leave blank]</td>
</tr>
</tbody>
</table>

- **All users**
  To give all users access to voicemail from any extension you need to set up a short code. When a user dials the short code from any extension they will be prompted for their mailbox number (extension number) and voicemail code.

**To give all users access from any extension:**

1. Open IP Office Manager.
2. Set up a short code, for example *98:

<table>
<thead>
<tr>
<th>Field</th>
<th>Contains...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>*98</td>
</tr>
<tr>
<td>Feature</td>
<td>Voicemail Collect</td>
</tr>
<tr>
<td>Telephone Number</td>
<td>?Anonymous</td>
</tr>
<tr>
<td>Line Group ID</td>
<td>0</td>
</tr>
<tr>
<td>Locale</td>
<td>[Leave blank]</td>
</tr>
<tr>
<td>Force Account Code</td>
<td>[Leave blank]</td>
</tr>
</tbody>
</table>
4.5.3 Giving Users Access from an External Location

If users need to access their voicemail messages when they are away from the office, you can set up an Incoming Call Route in IP Office Manager with the destination as Voicemail. For more information, see the IP Office Manager help or guide.

To give users access from an external location:

1. Open IP Office Manager.

2. In the Navigation pane, click **Incoming Call Route** and add a new call route.

3. In the destination field, select the option **Voicemail**. When an incoming call is matched the call is passed to voicemail to enable remote mailbox access. Callers are asked to enter the extension ID of the mailbox required and then the mailbox access code.

4. Click **OK** to save the changes.

5. Click **[ ]** to merge the configuration back to the IP Office.

4.5.4 Creating a Trusted Location

If a user regularly accesses their voicemail messages from another extension or a number that presents a CLI, such as their mobile or home number, this extension or number can be set up as a trusted location.

To configure a trusted location:

1. Open IP Office Manager.

2. In the Navigation pane, click **User** and select the individual user.

3. View the **Source Numbers** tab.

4. Add a V source number.

   - Enter the users extension number.
     For example, a user whose extension number is 214 wants to be able to collect their voicemail without entering their voicemail code. A source number **V214** would be entered.

   - Enter a different extension number.
     For example, a user whose extension is 214 wants to be able to collect their voicemail from extension 204. A source number **V204** would be entered. From now on when the user of extension 214, dials a short code from extension 204 they will not be prompted for their voicemail code. Not supported for Intuity mailbox users.

   - Add a V source number containing the external telephone number.
     For example, **V01923 38383** would be entered if the external number was 01923 38383. When the user dials the number set up as the Incoming Call Route to Voicemail from the "trusted location", they will not be prompted for their mailbox number or Voicemail Code. For more information, see Giving Users Voicemail Access from an External Location. Not supported for Intuity mailbox users.

5. Click **OK** to save the changes.

6. Click **[ ]** to merge the configuration back to the IP Office.
4.6 Mailbox Access Controls

With IP Office mailbox owners can control their mailbox and messages in a number of ways after they have logged in to the mailbox.

- **Standard IP Office Mailbox Mode**
  This is the only mode for Voicemail Lite. Voicemail Pro can also be set to run in this mode. For more information, see the IP Office Mailbox User Guide.

- **Intuity Mailbox Mode**
  This is the default mode for Voicemail Pro. It provides an IP Office emulation of many of the Avaya Intuity features. For more information, see the Intuity Mailbox User Guide. For information about switching between IP Office and Intuity mailbox mode, see Changing Mailbox Operation Mode.

- **Phone Manager**
  The Phone Manager application enables a user to switch voicemail and voicemail ringback on/off. Phone Manager Pro also provides full visual access to a user’s voicemail and allows messages to be played back and controlled through their PC. For more information, see the Phone Manager User Guide or help.

If a mailbox does not have a recorded name greeting, when that mailbox is accessed to collect messages, the caller is asked to record their name before proceeding to collect messages. The name greeting is used for functions such as Dial by Name actions and Intuity mode name lookup (**6**).

**Tip:** As Voicemail Pro system administrator, you should ensure that mailbox owners have the help and user guide for their type of mailbox available to them. There is an IP Office User Guide and an Intuity Mailbox User Guide. Both are available in PDF and online help formats. You can find them on the IP Office Documentation CD or you can download them from the Avaya knowledge base at [www.avaya.com/ipoffice/knowledgebase](http://www.avaya.com/ipoffice/knowledgebase).

4.6.1 Telephony Operation Mode

All users should be made aware that messages may be automatically deleted after a period of time. If a user does not want a message to be automatically deleted the message can be saved. Mailbox owners can find out about saving messages in the user guide for their type of mailbox.

After a user has logged into their mailbox, the Voicemail Pro Server offers two sets of mailbox controls.

- **IP Office**
  This is the default mode used and matches the features of Voicemail Lite.

- **Intuity**
  This is IP Office Intuity emulation mode. Intuity is a mailbox interface used on a range of Avaya voicemail systems. In Intuity emulation mode, Voicemail Pro supports a range of Intuity features but not all Intuity features. For full details of those Intuity features supported by Voicemail Pro, refer to the IP Office Intuity Mailbox User Guide.

  If the **Regional Setting** of the server onto which Voicemail Pro is installed is "English (United States)", Voicemail Pro defaults to Intuity mailbox operation.

The prompts provided to a mailbox user are determined by the user’s Locale setting as set through the IP Office Manager. Note that on some phones users can change their language setting themselves. Mailbox owners should refer to the user guide for their type of mailbox. For information about supported languages, see Supported Languages.

All users can use the following default short codes:

- **17** - Access their mailbox from their own extension.
- **18** - Turn voicemail on.
- **19** - Turn voicemail off.
- **48** - Turn voicemail ringback on.
- **49** - Turn voicemail ringback off.

For information about changing to Intuity or IP Office mailbox operation mode, see Changing Mailbox Operation Mode.
4.6.2 Automatic Message Deletion

Messages are automatically deleted from the voicemail server after being played (including those played via the users IMS email client) after a set delay. This delay can be adjusted for different message types.

The process of housekeeping is performed after any two hour idle period, that is a period with no call into or from the voicemail server.

1. Click the preferences icon.
   - Alternatively, from the Administration menu, select Preferences and then choose General.

2. Select the Housekeeping tab.

   ![Housekeeping Tab]

3. Adjust the settings as required for the different message types.
4. Click OK.

5. Click Save and Make Live and select Yes.

4.6.3 Personal Distribution Lists

Personal distribution lists (also known as mailing lists) are available to mailbox users when the system is in Intuity mode.

Each mailbox can accommodate up to 20 lists. Each list can contain up to 360 mailbox numbers. Lists can then be used orforwarding or sending messages from the mailbox.

Each list can be marked as private or public. Public lists can be used by other mailbox users when forwarding or sending messages. A user can also import the contents of a public list into one of their own lists.

If Voicemail Pro Networked Messaging (VPN) is installed, lists can include mailboxes on remote systems. The only difference in presentation is that, where the mailbox user name is used to identify local mailboxes in a list, remote mailboxes are listed by number only.

Lists are maintained either through the mailbox or through Phone Manager Pro version 3.0 or higher. Lists cannot be viewed or controlled from the Voicemail Pro Client. For more information about mailing lists, mailbox owners can refer to the Intuity Mailbox User Guide.
4.7 Hunt Group Voicemail

Hunt groups must first be set up in IP office. You can then use Voicemail Pro to configure the way in which voicemail works for a hunt group.

Voicemail provides a number of services for hunt groups.

- **Announcements**
  If a caller is waiting to be answered, queuing or the hunt group is in out-of-hours mode, the voicemail server can provide appropriate greetings to callers. These greetings can be changed through the normal mailbox controls. Mailbox users can find out more in the IP Office or Intuity Mailbox user guides. For more information, see Out of Hours Operation. For more information, see Configuring Announcements.

- Voicemail Pro allows the actions available to a queued caller to be customized as well as the greeting messages.

- Voicemail Pro does not control the queuing of calls. Queuing is controlled by the IP Office switch that presents queued and still queued calls at the appropriate times and provides the queue position and ETA data.

- **Messaging**
  If voicemail for a hunt group is on (the IP Office default), calls to the hunt group are automatically routed to voicemail if all available extensions have been called for the number of seconds defined in the IP Office No Answer Time parameter. The default time setting is 15 seconds.

- **Message Waiting Indication**
  By default there is no indication on the handset when a hunt group mailbox contains messages and no direct access method to a hunt group mailbox.

  - For hunt group members to receive message indication, an appropriate H source number entry needs to be added. For more information, see Configuring Hunt Group Message Waiting Indication.

  - For access by other users an access short code can be used. For more information, see Enabling Access to Hunt Group Voicemail with a Short Code.
4.7.1 Hunt Group Configuration in IP Office

Voicemail can be configured for each hunt group in IP Office Manager.

To change voicemail configuration for a hunt group:

1. Open IP Office Manager.

2. In the Navigation pane, click HuntGroup and select the hunt group.

3. View the Voicemail tab.

4. (Optional) Enter a voicemail code between 1-15 digits in the Voicemail Code field. This is required when users retrieve voicemail messages for the hunt group remotely, for example from an extension that is not a member of the hunt group or from an external telephone.
   - The Voicemail Code must be retyped in the Confirm Voicemail Code field to ensure it has been correctly entered.

5. (Optional) Messages for the hunt group can be sent to an email account.
   - **Voicemail Email** - Enter the email address of the user.
   - Select the Voicemail Email Mode from:
     - **Off**: Voicemail messages or notifications are not automatically sent.
     - **Copy**: A copy of the message is sent to the email account.
     - **Forward**: Voicemail messages are sent to the email account and deleted from the voicemail server.
     - **Alert**: Notification that a new voicemail message has been received is sent to the email account.

6. (Optional) Voicemail can be turned off by un-checking the Voicemail On option. When on, the mailbox is used to answer the hunt groups unanswered or busy calls.

7. (Optional) For voicemail systems running in IP Office Mode, this option controls whether users hear an additional prompt when they retrieve messages. The prompt is 'For help at any time press 8'.
   - This option does not affect Intuity emulation mailbox mode where the prompt "For help at any time press *4" is played.
   - Even if voicemail help is set to off, IP Office Mode users can still press 8 at any time and hear the list of voicemail features. This setting turns on/off the audible help message. It does not disable the actual feature.

8. (Optional) Select the option Broadcast if you want any voicemail messages left for the hunt group forwarded to the mailboxes of the individual group members. The original message in the hunt group mailbox is deleted.

9. Click OK and save the configuration.
4.7.2 Configuring Message Waiting Indication

By default no message waiting indication (MWI) is provided for hunt groups. If required indication can be enabled for specific users including users who do not belong to the hunt group. If the user is not a member of the hunt group, a voicemail code is also required. This is entered in the Voicemail Code field on the Hunt Group > Voicemail tab in the IP Office's configuration. Alternatively the user can be made a member or the group but have their membership set to disabled. This allows them to access the group mailbox without receiving group calls.

Depending on the type of telephone phone or IP Office application they are using, users who receive hunt group message waiting indication can choose any of the following methods to collect messages.

- **Phone Manager**
  If Phone Manager is used, the group name and number of new messages is displayed in the Messages tab. Users click the Messages tab to access the group mailbox.

- **4400 Series Phones**
  On phones with a Menu button, press Menu | Menu | Msgs | Voice. The group name is shown along with the number of new messages. Press the display button to access the group mailbox.

- **Voicemail Ringback**
  If a user has voicemail ringback enabled, ringback will occur for new group messages as well as new personal messages. Ringback for personal messages takes place before any ringback for new group messages.

This method of configuring hunt group message waiting indication allows individuals, including users who are not members of the group, to receive hunt group message waiting indication.

**To configure message waiting indication:**

1. Open IP Office Manager.

2. In the Navigation pane, click User and select the individual user.

3. View the Source Numbers tab.

4. Click Add.

5. In the Source Number field, enter H followed by the hunt group name. For example, to receive message waiting indication from a hunt group called Main, enter HMain.

6. Click OK.

7. Click to merge the configuration change back to the IP Office.
4.7.3 Configuring Group Broadcast

If the Broadcast option is enabled, a message for a hunt group is copied to the individual user mailboxes of each hunt group member. A call flow can be created that includes the Generic Action. For more information, see [Generic Action](#). If messages need to be forwarded to the same group a Personal Distribution List could be created. For more information, see [Personal Distribution Lists](#).

To configure Group Broadcast:

1. Open IP Office Manager.

2. In the Navigation pane, click **HuntGroup** and select the required group.

3. Click the **VoiceMail** tab.

4. Check **Broadcast**.

5. Click **OK**.

6. Click **Save** to merge the configuration change back to the IP Office.
4.7.4 Using a Short Code to Collect Voicemail

To access messages for a hunt group, a short code can be created. For example, for a group called **Main** a short code can be added with the following properties.

<table>
<thead>
<tr>
<th>Field</th>
<th>Contains...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>*99</td>
</tr>
<tr>
<td>Feature</td>
<td>Voicemail Collect</td>
</tr>
<tr>
<td>Telephone Number</td>
<td>&quot;+Main&quot;</td>
</tr>
<tr>
<td>Line Group Id</td>
<td>0</td>
</tr>
<tr>
<td>Locale</td>
<td>[Leave blank]</td>
</tr>
<tr>
<td>Force Account Code</td>
<td>[Leave blank]</td>
</tr>
</tbody>
</table>

For systems running in Intuity mode, the above will work only if the user is a member of the group and a custom call flow has also been set up for the collect start point to that hunt group.

Members of the hunt group Main can now dial **99** from their own extensions to access hunt group messages. In IP Office mode, to use this short code for access from an extension that is not a member of the hunt group, a voicemail code should be configured for the group.
4.7.5 Out of Hours Operation

Voicemail provides a number of greetings for groups. One of these is an Out of Hours Greeting.

Through IP Office Manager or using a short code a hunt group can be taken in or out of service. When the group is Out of Service, callers are played the group’s "Out of Hours" greeting and can then leave a message. Alternatively, if an Out of Service Fallback Group has been configured, callers are passed to that group.

Similarly, a group can be taken in or out of Night Service by using Manager, short codes or an associated time profile. When the group is in Night Service, callers are played the group’s "Out of Hours" greeting and can then leave a message. Alternatively, if an Out of Hours Fallback Group has been configured, callers are passed to that group.
4.7.6 Configuring Announcements

When a caller is waiting to be answered or queuing, announcements can be played to the caller. The announcements are activated in IP Office Manager.

The standard announcement used is “I am afraid all the operators are busy at the moment but please hold and you will be transferred when somebody becomes available.” This can be replaced by separate recordings for the 1st and 2nd announcements if required (see Recording the Announcements below) or by custom call flows (see Customizing Announcements).

Enabling Announcements
1. Open IP Office Manager and receive the configuration from the IP Office system.

2. In the Navigation pane, click HuntGroup and select the hunt group.

3. View the Announcements tab.

4. Check Announcements On. Announcements will be played to a caller who is in a queued or waiting for the hunt group.

5. Select the amount of time for the caller to be queued or waiting before they hear the first announcement. The Wait before 1st announcement (seconds) default is 10.

6. Select the Post announcement tone. The options are Ringing, Music on Hold or Silence. The default selection is Music on hold.

7. (Optional) Check 2nd announcement to play another message to the caller.

8. (Optional) Select the amount of time between the first and second announcements. The default time is 20 seconds.

9. (Optional) If the second announcement is to be repeatedly played to the caller until their call is answered, check Repeat last announcement.

10. Click OK to save the changes.

11. Click to merge the configuration back to the IP Office.
Recording the Announcements
The standard announcement used is “I am afraid all the operators are busy at the moment but please hold and you will be transferred when somebody becomes available.” This can be replaced in a number of ways, depending on the

The maximum length for announcements is 10 minutes. New announcements can be recorded using the following methods:

- **Voicemail Pro - IP Office Mode**
  Access the hunt group mailbox and press 3. Then press either 3 to record the 1st announcement for the hunt group or 4 to record the 2nd announcement for the hunt group.

- **Voicemail Pro - Intuity Emulation Mode**
  There is no default mechanism within the Intuity telephony user interface to record hunt group announcements. To provide one a custom call flow containing an Edit Play List action should be used. In the file path enter 
  `[GREETING]<hunt_group_name>_Queued` or `[GREETING]<hunt_group_name>_StillQueued` where
  `<hunt_group_name>` is replaced by the hunt group name.
  - `[GREETING]` is a variable that points to the current location of the voicemail servers greeting folder (by default `c:\Program Files\Avaya\IP Office\Voicemail Pro\VM\Greetings`).
4.7.7 Customizing Announcements

The announcements and actions provided to a caller can be customized using the Queued and Still Queued start points.

- The Queued start point replaces the default Announcement 1.
- The Still Queued start point replaces the default Announcement 2.

It is important to note that unconnected results in Queued and Still Queued call flows will return the caller to the queue rather than disconnect them. An attempt to return the caller using a Transfer or similar action places the caller at the back of the queue as a new call.

- Use of customized start point call flows for Queued and Still Queued is not recommended if the Synchronize Calls option is enabled for the hunt group in the IP Office configuration. If this is the case, the only options supported by Voicemail Pro is the playing of prompts.

To customize announcement 1 for a specific group:

1. In the Start Points Navigation pane, select Groups. If necessary add a Queued start point for the required group.
2. Select the group’s Queued start point.
3. Add the required actions to the call flow and link them. To just play a message use a Generic action.
   - Use of customized start point call flows for Queued and Still Queued is not recommended if the Synchronize Calls option is enabled for the hunt group in the IP Office configuration. If this is the case, the only options supported by Voicemail Pro is the playing of prompts.
4. Double on the actions added and on the Entry Prompts tab add the prompts required using the Wave Editor.
5. Click OK to save the changes.
6. Click Save and make live.
7. Any caller queuing for the selected group will hear the new announcement when they first join the queue.

To customize announcement 2 for a specific group:

1. As above but use the Still Queued start point.
4.7.8 Hunt Group Queuing

If hunt group queuing options are enabled, a call will be held in a queue when all available extensions in the hunt group are busy. Using Voicemail Pro you can define custom actions and prompts for the queuing sequence.

- The Still Queued message is not played if the hunt group name exceeds 13 characters.

To configure queuing for a hunt group:

1. Open IP Office Manager.

2. In the Navigation pane, click **HuntGroup** and select the hunt group.

3. View the **Queuing** tab.

   - **Queuing On**: Default = On
     If selected, queuing will be available for the hunt group.

   - **Queue Length**: Default = No Limit
     This feature sets the number of calls that will be held in the queue at any one time. If this number is exceeded the caller will receive the busy tone or be passed to voicemail.

   - **Normalize Queue Length**: Default = Blank
     This facility selects whether to include calls that are ringing but not answered in the queue length.

When queuing is selected, announcements can be played to the queued caller. For more information, see Configuring Queue Announcements.
4.7.9 Customizing a Hunt Group Call Flow

Voicemail Pro allows for customization of queuing operation through the use of Queued and Still Queued start points, either specific to a particular hunt group or default for all groups.

The Queue ETA and Queue Position actions can be used to provide callers with queue information and then place them back in the queue. Within a Queue or Still Queued start points call flow, the default action for any unlinked results is to place the caller back in to the queue rather than disconnect the caller.

- **Incoming Call Route ‘Priority’**
  The IP Office supports a configurable Priority setting (1, 2 or 3) on Incoming Call Routes. Calls assigned a high priority are moved up any call queue ahead of those with a lower priority. The use of this feature is not compatible with Queue ETA and Queue Position messages as the spoken queue positions and ETA for some callers may be overridden by calls with a higher priority. For example, a caller might hear that their queue position is 5. If a call is received on an Incoming Call Route with a higher priority, the next time the queue position is heard their queue position could be 6, further back in the queue.

- **Synchronized Announcements**
  If the option Synchronize Calls is enabled for the hunt group announcements within the IP Office configuration, actions other than speaking recorded prompts are not supported in custom Queued and Still Queued start points.

Further customization can be applied using actions such as a Menu action to let the caller select, for example, to leave a message, be transferred to another number or return to the queue.

The Voicemail Pro variables, $QTIM, and $POS, can be used to further customize the Queued and Still Queued call flows.

- **$QTIM: Queued Callers Estimated Time to Answer**
  If used in a prompt list, will speak the callers' estimated time to answer (ETA). For example, "Your estimated time to answer is 5 minutes." If used elsewhere, such as in a condition, returns the ETA in minutes as a simple numeric value.

- **$POS: Queued Callers Queue Position**
  If used in a prompt list, will speak the caller’s queue position, for example, "You are in queue position 2." If used elsewhere, such as in a condition, returns the caller’s queue position as a numeric value.

- **$TimeQueued**
  IP Office 4.1+ and Voicemail Pro 4.1+. Holds the length of time, in seconds, that the call has been part of a particular hunt group queue. Only available when using Queued and Still Queued start points.

- **$TimeSystem**
  IP Office 4.1+ and Voicemail Pro 4.1+. Holds the length of time, in seconds, since the call was presented to the IP Office system. Only available when using Queued and Still Queued start points.
The importance of these variables is that, instead of or in addition to customizing the queue call flow for all queued callers, you can customize the actions for callers whose ETA or position match selected criteria.

The screen below shows an example of a queued call flow that uses a condition to test the value of $POS for the queued caller.

- When the caller is in queue positions 1 to 4, they are passed to a **Queue Position** action and hear their queue position before returning to the queue.
- When the caller is in queue position 5, they are asked to leave a message.
- Instead of using a **Leave Mail** action, the caller could be taken through a **Voice Question** or **Campaign** action to collect required information and the caller's responses could be saved as a message.
4.8 Recording Calls

As well as providing messaging services, Voicemail Pro can provide a call recording service. Call recording can be turned on manually. For more information, see Starting Manual Call Recording. Alternatively, call recording can be configured to take place automatically for specified users, hunt groups, incoming call routes or outgoing calls with account codes. For more information, see Automatic Call Recording: Overview.

- If a conference call is being recorded, recording continues when a new party joins the conference.
- If a call that is being recorded is put on hold or parked, the recording will pause. When the call is reconnected the recording resumes.
- By default, a recording is placed in a user’s own mailbox but this location can be changed.
- A recording by an agent that is intruding on to a call will keep recording after the intruded call has ended. This is to allow the recording to be annotated.

- Conference Capacity
  Call recording uses conferencing capacity and so is subject to the available conferencing capacity of the IP Office system.
- IP Trunks and Extensions
  When the direct media path option is used with IP trunks and or an extension, it is not possible to guarantee call recording.
- Call Recording Warning
  In many locations, it is a local or national requirement to warn those involved in a call that they are being recorded. The Voicemail Pro does this by playing an Advice of Call Recording prompt which can be switched off. On automatically recorded call, some telephones may also display a recording symbol. For more information, see Call Recording Warning.
- Recording Duration
  Call recording is limited to the maximum length of 1 hour. For more information, see Changing the Recording Time.
- Voice Recording Library (VRL)
  Recordings are normally placed into standard mailboxes. VRL operation allows recordings to be transferred to a specialist archiving application. This allows both longer recording and the sorting and searching of recordings. For more information, see Voice Recording Library (VRL).
4.8.1 Call Recording Warning

In many locations, it is a local or national requirement to warn those involved in a call that they are being recorded. One method for doing this is to enable the Advice of Call Recording (AOCR) message provided by the Voicemail Pro server.

- The 'advice of recording' will always be played if the Advice of Call Recording message is enabled.
- It cannot be guaranteed that a caller will hear an 'advice of recording' announcement when the call is using analogue trunks. analogue trunks do not support call status signalling so the 'advice of recording' announcement is played as soon as the trunk is seized even if the call is ringing and has not been answered.
- The Play Advice on Call Recording option is on by default.

The Advice of Call Recording Message

This message is provided in the file aor_00.wav. For each language installed on the Voicemail Pro server, a copy is located in the sub-folders of c:\Program Files\Avaya\IP Office\Voicemail Server\WAVS.

To switch the recording warning on or off:

1. From the Voicemail Pro Client, click or select Administration > Preferences > General.
2. Click Play Advice on Call Recording to switch this option on (checked) or off (unchecked).
3. Click OK.
4. Click Save & Make Live.

To hide the auto record indication

In addition to the audible advice of call recording prompt, some Avaya terminals display REC to show that the call is being recorded. The display can be suppressed.

1. Open IP Office Manager and load the configuration from IP Office.
2. In the Navigation pane, click System.
3. In the System Configuration window, click the System tab.
4. Check Hide auto recording. The terminal display REC will be suppressed.
5. Save the configuration back to the IP Office system.
4.8.2 Changing the Recording Time

For recordings being placed into a Voicemail Pro mailbox, the maximum recording time is 1 hour.

To change the recording length:

1. Start the Voicemail Pro Client.
2. Click or select **Administration > Preferences > General**.
3. The **Max. VRL Record Length (secs)** setting is used only for calls being recorded to VRL. The maximum record length is 3600 seconds (60 minutes).
4. Click **OK**.
5. Click **Save & Make Live**.

4.8.3 Voice Recording Library (VRL)

Voice Recording Library (VRL) operation allows the Voicemail Pro to transfer specific users who are automatically or manually recording calls to a third-party application. It can also be selected as the destination for calls recorded via a Leave Mail action in a call flow.

Currently this mode of operation is only supported with Avaya IP Office ContactStore. This application provides tools to sort, search and playback recordings. It also supports the archiving of recordings to DVD.

- Installation and configuration of VRL with IP Office ContactStore is documented separately.
- VRL is a licensed feature. It requires entry of a valid **Voice Recording Administrators** license into the IP Office configuration.
- The VRL application must be configured to store recording on a separate partition, drive or PC from the Voicemail Pro. This is necessary to ensure that the long term storage or recording archives and space available for mailbox messages do not conflict.
4.8.4 Manual Call Recording

There are several ways to start manually recording a telephone call.

**Phone Manager Pro**

Users can initiate call recording using Phone Manager Pro when they are working in Agent Mode. The recording feature is active during a telephone call and when call recording is available.

- Press on the toolbar to start recording. Press on the toolbar to stop the recording.
- Select Actions > Start Recording. The call will be recorded. Press Actions > Stop Recording to finish recording the call.

**SoftConsole**

The SoftConsole operator can manually record all or part of a current telephone call.

To manually record a telephone call:

- Press the button on the toolbar. The button acts as a toggle. Press the button again to stop recording.
- Select Actions > Record Call. This action toggles and so is also used to stop recording.
- Press F5 to start recording. Press F5 again to stop the recording.

**4400 Series**

Telephones in the 4400 Series with a Menu key can manually trigger call recording by:

- Press Menu | Menu | Func| Recor.

**Using DSS Keys**

The call record function can be programmed against a DSS key. When a DSS key has been programmed it can be pressed during a call to record the conversation.

**To set a DSS key for manual recording:**

1. Open IP Office Manager and load the configuration from IP Office.
2. In the Navigation pane, click User and select the individual user.
3. Select the Button Programming tab.
4. Select the required DSS key and click Edit.
5. Click browse for the Action. The Button Programming window opens.
6. Select Advanced > Call > CallRecord. Click OK.
7. In the Action Data field, enter a description that will appear on the telephone display.
8. Click OK.
9. Click to save the configuration file.

A call is recorded if the user presses the programmed DSS key during any call. The caller will hear an announcement that the call is being recorded if the mandatory call recording warning is active. For more information, see Call Recording Warning.
Using Short Codes

The short code feature "CallRecord" can be used to trigger recording of calls into the user's designated mailbox. The example short code (*95) can be set up as a user short code or a system shortcode. In either case it will trigger recording

<table>
<thead>
<tr>
<th>Field</th>
<th>Contains...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>*95</td>
</tr>
<tr>
<td>Feature</td>
<td>Call Record</td>
</tr>
<tr>
<td>Telephone Number</td>
<td>[Leave blank]</td>
</tr>
<tr>
<td>Line Group Id</td>
<td>0</td>
</tr>
<tr>
<td>Locale</td>
<td>[Leave blank]</td>
</tr>
<tr>
<td>Force Account Code</td>
<td>[Leave blank]</td>
</tr>
</tbody>
</table>

To use the short code

1. During a call, put the caller on hold.
2. Dial the short code. The call is automatically reconnected and recording begins.

The following is an example short code for recording a call involving a specific extension. You do not have to be in conference with or part of the call. This short code should only be set up as a user short code for trusted users.

<table>
<thead>
<tr>
<th>Field</th>
<th>Contains...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td><em>96</em>N#</td>
</tr>
<tr>
<td>Feature</td>
<td>Call Record</td>
</tr>
<tr>
<td>Telephone Number</td>
<td>N</td>
</tr>
<tr>
<td>Line Group Id</td>
<td>0</td>
</tr>
<tr>
<td>Locale</td>
<td>[Leave blank]</td>
</tr>
<tr>
<td>Force Account Code</td>
<td>[Leave blank]</td>
</tr>
</tbody>
</table>

To use the short code:

1. Check that the extension is in use.
2. Dial the short code with the number of the extension that you want to record. Using the example short code you would dial *96*123# to record a call connected to extension 123.
4.8.4.1 Setting Manual Recording Options

The IP Office Manager can be used to specify where recordings triggered by a user are placed:

**To configure a user’s recording options:**

1. Open IP Office Manager and load the configuration from IP Office.

2. In the Navigation pane, click **User** and select the individual user.

3. Select the **Voice Recording** tab.

4. In **Manual Recording Mailbox**, select from the list the mailbox that is to be used to contain recordings triggered by the user.
   - The **Voice Recording Library** options can be used only if a VRL application has been installed and licensed. For more information, see **Voice Recording Library**.
   - Click **OK**.
   - Click **merge** to merge the configuration change back to the IP Office.
4.8.4.2 Customizing Manual Recording

Normally recording is performed by the Voicemail Pro server as a default task. However, a module named Record can be used to customize the operation of auto-recording.

Notes

- If a Record module is created, it overrides the default record operation. Therefore it must at minimum emulate the default manual recording process of placing recordings into the mailbox of the user who triggered recording. For example, in the module call flow shown below, the Listen action is set to \$UUI.

- Whenever recording is triggered, \$UUI contains the user name of the user who triggered the recording process.

![Module Call Flow Diagram](image)
4.8.5 Automatic Call Recording

The IP Office system can be configured to automatically record calls based on the user, hunt group, incoming call route or account code.

<table>
<thead>
<tr>
<th>Trigger</th>
<th>Incoming</th>
<th>Outgoing</th>
<th>Default Recording Destination</th>
<th>Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incoming Call Route</td>
<td>✔️</td>
<td>✘</td>
<td>None</td>
<td>For the call duration or up to 1 hour.</td>
</tr>
<tr>
<td>Hunt Group</td>
<td>✔️</td>
<td>✘</td>
<td>Hunt group mailbox</td>
<td>Until ended or transferred to a user outside the hunt group or its overflow group.</td>
</tr>
<tr>
<td>User</td>
<td>✔️</td>
<td>✔️</td>
<td>User mailbox</td>
<td>Until the user ends or transfers call.</td>
</tr>
<tr>
<td>Account Code</td>
<td>✘</td>
<td>✔️</td>
<td>User mailbox</td>
<td>Until the user ends or transfers calls.</td>
</tr>
</tbody>
</table>

- Individual calls may match several recording criteria. Where that is the case the following applies:
  - If the destinations for the recordings are different, separate recordings occur with the durations are indicated above.
  - If the destinations for the recordings are the same, a single recording is made using either the incoming call route, hunt group or user duration in that order or priority.
- Multiple recordings of the same call use multiple voicemail channels.
- Time profiles can be used to control when automatic call recording is used.
- For inbound calls recording will not take place if the call goes to normal voicemail.
- Different frequency settings, set in percentage terms, can be applied to the automatic recording of inbound and outbound calls.
- A mandatory setting can be used to return a busy tone when call recording is triggered but no voicemail ports are available.
- Where calls have been answered using a Line appearance button, the call recording goes to the mailbox setting of the original call route destination.
4.8.5.1 Setting Automatic Recording Options

Automatic recording can be configured for:

- Calls received and/or made by a user
- Calls on a specific incoming call route
- Calls to a specific hunt group
- Outgoing calls associated with a specific account code

The calls that are to be auto-recorded are selected through IP Office Manager.

To set automatic call recording for a user:

1. Open IP Office Manager and load the configuration from IP Office.
2. In the Navigation pane, click User.
3. Select the required user.
4. Select the Voice Recording tab.
5. From the Record Inbound and Record Outbound drop-down lists select the recording frequency required.
   - None: Do not record.
   - On: Record all calls if possible.
   - Mandatory: Record all calls. If recording is not possible, return busy tone to the caller.
   - xx%: Record calls at intervals matching the set percentage, eg. for every other call for 50%.
     - For inbound calls, recording will not take place if the call also goes to normal voicemail.
     - Specify the destination for the recordings. By default, this is a user's own mailbox.
   - The Voice Recording Library options can be used only if a VRL application has been installed and licensed. For more information, see Voice Recording Library.
   - Click OK.
   - Click to send the configuration back to the IP Office.
To set automatic call recording for a hunt group:

1. Open IP Office Manager and load the configuration from IP Office.

2. In the Navigation pane, click **HuntGroup**.

3. Select the required hunt group.

4. Select the **Voice Recording** tab.

   - **Record Inbound**: Mandatory
   - **Record Time Profile**: <None>
   - **Recording Mailbox**: [06 Theresa Green]
   - **Use Voice Recording Library**

5. From the **Record Inbound** drop-down lists select the recording frequency required.
   - **None**: Do not record.
   - **On**: Record all calls if possible.
   - **Mandatory**: Record all calls. If recording is not possible, return busy tone to the caller.
   - **xx%**: Record calls at intervals matching the set percentage, eg. for every other call for 50%.

6. Select the **Recording Time Profile** is required. If not set, recording is applied at all times.

7. The **Recording Mailbox** option is available for IP Office 4.1+. For previous releases the destination is always the mailbox of the user making the call.

8. Click **OK**.

9. Click **Pause** to send the configuration back to the IP Office.
To set automatic call recording for an incoming call route:

1. Open IP Office Manager and load the configuration from IP Office.

2. In the Navigation pane, click **Incoming Call Route**.

3. Select the required incoming call route.

4. Select the **Voice Recording** tab.

<table>
<thead>
<tr>
<th>Standard</th>
<th>Voice Recording</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Recording Inbound</td>
<td>Mandatory</td>
</tr>
<tr>
<td>Record Time profile</td>
<td>&lt;None&gt;</td>
</tr>
<tr>
<td>Recording Mailbox</td>
<td>205 Theresa Green</td>
</tr>
<tr>
<td></td>
<td>Voice Recording Library</td>
</tr>
</tbody>
</table>

5. From the **Record Inbound** drop-down lists select the recording frequency required.
   - **None**: Do not record.
   - **On**: Record all calls if possible.
   - **Mandatory**: Record all calls. If recording is not possible, return busy tone to the caller.
   - **xx%**: Record calls at intervals matching the set percentage, eg. for every other call for **50%**.
     - For inbound calls, recording will not take place if the call also goes to normal voicemail.

6. Select the **Recording Time Profile** is required. If not set, recording is applied at all times.

7. Specify the destination for the recordings or select the option to place the recordings in the voice recording library.
   - The **Voice Recording Library** options can be used only if a VRL application has been installed and licensed. For more information, see **Voice Recording Library**.

8. Click **OK**.

9. Click **Send** to send the configuration back to the IP Office.
To set automatic call recording for an outgoing account call:

1. Open IP Office Manager and load the configuration from IP Office.

2. In the Navigation pane, click Account Code.

3. Select the required account code.

4. Select the Voice Recording tab.

5. From the Record Outbound drop-down lists select the recording frequency required.
   - **None**: Do not record.
   - **On**: Record all calls if possible.
   - **Mandatory**: Record all calls. If recording is not possible, return busy tone to the caller.
   - **xx%**: Record calls at intervals matching the set percentage, eg. for every other call for 50%.
     - For inbound calls, recording will not take place if the call also goes to normal voicemail.

6. Select the Recording Time Profile is required. If not set, recording is applied at all times.

7. The Recording Mailbox option is available for IP Office 4.1+. For previous releases the destination is always the mailbox of the user making the call.

8. Select the option to place the recordings in the voice recording library.
   - The Voice Recording Library options can be used only if a VRL application has been installed and licensed. For more information, see Voice Recording Library.

9. Click OK.
4.8.5.2 Customizing Auto Recording

Normally auto-recording is performed by the Voicemail Pro server as a default task. However, a module named AutoRecord can be used to customize the operation of auto-recording. If an AutoRecord module is created, it overrides the default auto-record operation.

Whenever auto recording is triggered, $UUI contains either the account code, user name or hunt group name that triggered the auto recording.

The value of condition Account1 is checked using a Test Condition action.

If found True, the call is recorded using a Listen action, which specifies the mailbox for the recording.

If found False, the next condition test is tried.

The conditions, created within the Condition Editor, compare the variable $UUI against possible account code values.

The final Listen action, used if none of the condition tests are True, has its Mailbox set to $UUI. If $UUI hasn't matched any account code being used for auto recording, then its value will be either the user name or hunt group name that triggered the auto recording.
4.9 Announcements

Announcements can be played when:

- **Callers waiting to be answered or queued against a hunt group**
  With Voicemail Pro, the announcements and actions provided to a caller held in a group’s queue can be customized using the Queued and Still Queued start points for that group. The call can be answered at any stage of the announcement. For more information, see Configuring Announcements.

- **Calls are going to be recorded**
  In many locations, it is a local or national requirement to warn those involved in a call that they are being recorded. For more information, see Call Recording Warning.

- **Calls enter a call flow**
  For more information, see Using the Voicemail Pro Client: Overview.

- **Calls are received**
  A call flow containing an announcement can be created so that all callers hear a mandatory announcement. The announcement is played before the call is answered. For more information, see Mandatory Announcement Example.

- **Calls are queuing against an user’s extension**
  Users can configure their personal announcements. When the user’s extension is busy any new calls are held in a queue against the busy extension until the No Answer Time is reached. The caller will hear the user’s personal announcement before being transferred to voicemail, if available. For more information, see Personal Announcements.

4.9.1 Mandatory Announcement Example

The screen below shows an example of a call flow that plays an announcement to any caller to the sales hunt group. Callers entering at this start point can not bypass the announcement.

The Entry Prompt of the transfer action contains the announcement. After the announcement is played the caller is transferred to the sales hunt group as specified in the Specific tab. For more information, see Transfer Action.

Once the call flow has been created, IP Office needs to be configured so that callers are transferred to the call flow.

In IP Office Manager the destination for the incoming call route is entered as VM:Sales. The incoming call route targets the voicemail module ‘Sales’. As the call flow module name is the same as the hunt group name, if voicemail is unavailable the call will automatically be routed to the hunt group. The calls will not be lost but the callers will not have heard the announcement.

If calls are required to only be answered after they have heard the announcement, make sure that the call flow module name is different from the hunt group name. If voicemail is unavailable the call will not be transferred to the target hunt group.
4.9.2 Personal Announcements

Voicemail Pro 4.0+ supports personal announcements that are played when a caller is queuing against a user's extension number. A call will be held in a queue when the user's extension is busy before passing to voicemail, if voicemail is available. Personal announcements are enabled in the same way as hunt group announcements but using the User | Announcements tab in IP Office Manager. 

- If the user requires announcements only, voicemail should be turned off for the user.

- Start points can be amended to include other actions. Voicemail Pro 4.0+ allows personal announcements to be customized using user Queued and Still Queued start points in the same ways as customizing hunt group announcements. For example, a menu action could be added to the Still Queued start point giving users the option to continue to hold for the caller or to transfer to reception.

- If voicemail is on the announcements are played until the No Answer Time is reached. The caller is then transferred to the user's voicemail. The system default setting for No Answer Time is 15 seconds, however it can be set for individual users.
4.10 Support for Callers with Impaired Hearing

TTY is a method of sending and receiving text messages within the speech path of telephone calls. The text is entered and displayed through a TTY device, such as a text phone, connected in parallel with the user's normal telephone. Due to its widespread usage and support, it has become the standard used by devices for the users with impaired hearing or vision.

Voicemail Pro 1.4 and higher supports the addition of TTY prompts for leaving messages in and collecting messages from Intuity mode mailboxes. Callers with a TTY device can see the TTY prompts and leave TTY format messages. The mailbox user, also with a TTY device, can collect and display those messages by following the prompts that are displayed on the TTY device.

The TTY device and associated analog telephone (linked either by a pass-through port on the TTY device or a telephone splitter) are connected to an analog extension port (POT) on the IP Office system. During calls the TTY can be used to display and send TTY messages. The analog telephone can be used to send dialing digits and provide a speech path during calls.
4.10.1 Installing Voicemail Pro TTY Prompts
You can select TTY prompts from the list of language options when you install Voicemail Pro. For more information, see Installation Overview. When the prompts have been installed, the user settings must be configured so that the IP Office recognizes the TTY device.

There are two ways to configure a user so that they can use a TTY device with Voicemail Pro.

1. The simplest method is to change the user locale in IP Office Manager. This method requires no customization of a user's mailbox. For more information, see Changing User Locale or refer to the IP Office Manager help or User Guide.

2. An alternative to changing the user locale to TTY is to change the language setting in the Voicemail Pro call flows for the user who needs TTY prompts. For more information, see Changing the Language Setting for a Text Phone.

4.10.2 Changing User Locale
The locale setting tty is not actually recognized by IP Office Manager. Therefore all aspects of a user's telephony operation on the IP Office will default to the system's locale setting (System > System > Locale). However, the user locale setting is transferred to the Voicemail Pro server during mailbox access and so will affect the prompts that are provided.

To change the user locale:
1. Open IP Office Manager.
2. In the Navigation pane, click User and select the individual user.
3. Select the User tab.
4. Select the option Teletype (Textphone) in the Locale field.
5. Click OK.
6. Click to merge the configuration change back to the IP Office.

4.10.3 Advice for Mailbox Owners Using a TTY Device
To log into their mailbox with a TTY device, such as a text phone, mailbox owners must dial *17 and then take the analog telephone handset off hook.

When they are connected, users see prompts on the display of the text phone.

For requests such as "Press 1 for ..." users should dial from the keypad of the telephone. For messages followed by GA (go ahead) users are required to type text using their text device.

For more information, refer to the document "User Guide for Audix TTY Interface" (555-300-710).
4.10.4 Changing the Language Setting for a TTY Device

An alternative to setting the user locale as TTY is to change the user’s language setting in the Voicemail Pro call flows for that user. Here are two examples.

An Example of Customizing a Simple Mailbox Call Flow

The Select System Prompt Language action can be used to change the prompt language used by subsequent actions in a call flow. Once the TTY Maintenance Patch has been installed, TTY is one of the selectable languages provided by the action.

In the simplest form, a Select System Prompt Language action set to TTY (Teletype (Textphone)) would be added to the user’s Collect start point and followed by a Get Mail action.

Similarly, a Select System Prompt Language action set to TTY (Teletype (Textphone)), would be added to the user’s Leave start point and followed by a Leave Mail action.
An Example of Customizing a Complex Mailbox Call Flow

If required, more complex call flows can be configured. For example, the call flow below allows callers to press * to receive spoken language prompts or to wait a few seconds for the timeout and then receive TTY prompts.

In this case, messages are left in the same mailbox, but callers can select to have spoken prompts or default to TTY prompts.

For hearing impaired users who cannot handle spoken messages, the call flow for callers who select spoken prompts could have those messages into an alternate mailbox of a hearing user. These could then be collected and transcribed for the user.
Voicemail Pro can be used in a wide range of languages. For external callers, the Voicemail Pro tries to match the Locale setting of the IP Office system. For internal callers, if they have a different user locale in their user setting, Voicemail Pro tries to match that language.

With centralized Voicemail Pro, the default locale is that of the central IP Office. If users on the remote IP Office want different language prompts, each of their user locales must be changed separately.

If prompts for a required language are not installed, Voicemail Pro has a set of rules that it follows to find the best alternate language. For example if prompts are not available for users with their locale set to French Canadian, Voicemail Pro looks for French prompts instead. If French prompts are not installed, it looks for English US and finally English UK. For more information, see Supported Languages.

The language played to a caller can be changed during a call. This is achieved using a Select System Prompt action. For more information, see Changing the Language of System Prompts.

4.11.1 Supported Languages

The voicemail system provides prompts to callers and mailbox users based on the Locale that is set in the System form of IP Office Manager.

If the necessary set of language prompts is not available, the nearest available match is used. The list shows the first choice language prompts that Voicemail Pro will try to use, followed by the second choice and so on. For example, if prompts for users with their locale set to French Canadian are not available, Voicemail Pro looks for French prompts instead, then English US and finally English UK. The abbreviations shown in the table indicate the language prompt folder used in order of precedence.

Voicemail Pro server prompts can be installed in the following languages:

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Turkish: trk &gt; tr &gt; enu &gt; en.</td>
</tr>
</tbody>
</table>

1. Turkish prompts are not provided or installed but the Turkish locale is recognized. English (US) prompts are used if installed, otherwise English (UK). Fallback route added as part of Voicemail Pro 4.2.

- **TTY (Teletype (Textphone))** is included in the list of installable languages even though it is not a language. TTY is a text-based system that is used to provide service to users with impaired hearing or vision. For more information, see Support for Callers with Impaired Hearing:Overview.

Individual users can have their own Locale setting. Voicemail then provides them with the appropriate language prompts if they are available. This is set either through the IP Office Manager User form or through the language choice on some telephones. For more information, see the appropriate telephone User Guide.

The availability of a language in voicemail does not necessarily indicate support for IP Office in a country that uses that language. Contact your local Avaya office for details of which countries support IP Office.
4.11.2 Changing the Language of System Prompts

With the Select System Prompt action you can change the language that is used in a call flow from that of the IP Office system or the mailbox user's locale.

A step by step example that illustrates how to use the Select System Prompt action is provided here.

- The Select System Prompt action changes the default language prompts but not any custom prompts. To change the custom prompts you need to use the $LOC variable in the path to the custom prompt files. For more information, see Changing the Language of Custom Prompts.

Example

In a small hotel, Voicemail Pro is providing mailboxes for rooms. To assist the room users, we want to start message collection by letting them indicate their preferred language for Voicemail Prompts.

1. First a module for language selection was created.

   Modules > Language Select
   - Start Point
   - Menu
     1. US English
     2. Latin Spanish
     3. Canadian French
   - Next
   - Language Select
     - US English
     - Latin Spanish
     - Canadian French
   - Next
   - Get Mail

   The module contains a Menu action with a Select System Prompt action set to the required language for each key press.
   - For the Menu action an Entry Prompt was recorded asking the user to indicate their language choice; "Press 1 for English, 2 por Español, 3 pour Français".
   - The Select System Prompt actions were all connected Module Return actions.

2. Next the default start point for message collection was altered. The Language Select module and a Get Mail action were inserted.

3. The actions for language selection could have been inserted directly into the call flow. However, by doing it as a module the language selection process can be reused in other start points.
4.11.3 Changing the Language of Custom Prompts

Instead of using multiple return points from a Language Select module (one for each language) and linking to separate Get Mail actions (each with an Entry Prompt in the required) language, you can use a single Get Mail action.

To change the language of custom prompts:

1. Through the Get Mail action’s properties, record an Entry Prompt for US English users and save it as `enu\custom\getmail.wav`.

2. Record a similar prompt for French Canadian users and Latin Spanish users. You need to use the same file name each time and save each file in a different language folder.

3. Delete all except one of the entry prompt entries. That this does not delete any of the recorded prompts.

4. For the remaining entries, change the file path by inserting `$LOC` in place of the language folder name, for example `$LOC\custom\getmail.wav`.

```
Properties for Get Mail

Property grid:
Order | Prompt                      | Length [s] |
------|-----------------------------|------------|
1     | `enu\custom\getmail.wav`   | 5.0        |
2     | `frc\custom\getmail.wav`   | 7.0        |
3     | `esm\custom\getmail.wav`   | 6.0        |

☑ Allow prompts to be interrupted by Tones

OK Cancel Help
```

```
Properties for Get Mail

Property grid:
Order | Prompt                      | Length [s] |
------|-----------------------------|------------|
1     | `$LOC\custom\getmail.wav`  | 0.0        |

☑ Allow prompts to be interrupted by Tones

OK Cancel Help
```
4.12 Mobile Twinning

Mobile Twinning is a licensed feature. If Mobile Twinning is enabled in IP Office, a user can send internal and external calls to an external number, for example, their mobile telephone.

- Both the internal and external telephones ring when a call is received. The call can be answered from either telephone.
- If the feature Do Not Disturb (DND) is active for the user, any callers to the internal extension number will hear the busy tone and the external telephone will not ring. If a caller is entered in to the DND exception list, for example using the application Phone Manager, only the internal telephone will ring.
- If any of the forward options are active, both the external and the telephone where the calls are forwarded to will ring.
- If the Follow Me option is active, only the telephone that the calls are forwarded to will ring. The external telephone number will not ring.

Within Voicemail Pro you can administer the mobile twinning features using call flows. Mobile twinning can be turned on or of and the external twinning number entered.

In a call flow the Generic action is used to control Mobile twinning. Within the Generic action details are entered in the specific tab. In the generic 'free format' field, the following syntax can be added.

- **CFG:Set MattR twinning_type Mobile**
  Used to turn the Mobile twinning on for the named extension *MattR*. The extension number can be entered instead of the named extension. If mobile twinning has been previously used and then turned off, the previous mobile twinning number will become active.

- **CFG:Set MattR twinning_type Internal**
  Used to turn the Mobile twinning off for *MattR*.

- **CFG:Set MattR mobile_twinning_number $KEY**
  Used to set the mobile twinning number.
4.12.1 Example Call Flow

This example creates a Voicemail Pro module that allows a user to turn Mobile Twinning on or off. They can also set their mobile number. The example sets the mobile twinning for extension 203.

**Modules > Mobile Twinning**

---

To create the example call flow:

1. Create a new module called **Mobile Twinning**.

2. Add a menu action with the menu options 1, 2 and 3. Add a prompt to tell the caller the options available.

3. The option to turn mobile twinning on needs to be added.
   - Click the **Basic Actions** icon and select **Generic**.
   - Change the token name to **Enable Mobile Twinning**.
   - Click the **Specific** tab.
   - Enter the command `CFG:Set 203 twinning_type Mobile`.
   - Click **OK**.

4. The option to turn mobile twinning off needs to be added.
   - Click the **Basic Actions** icon and select **Generic**.
   - Change the token name to **Disable Mobile Twinning**.
   - Click the **Specific** tab.
   - Enter the command `CFG:Set 203 twinning_type Internal`.
   - Click **OK**.

5. The ability to enter the mobile number needs to be added.
   - Click the **Telephony Actions** icon and select **Alphanumeric Collection**.
   - Change the token name to **Collect New Mobile Twinning No**.
   - Record an Entry Prompt to tell the user to enter their mobile twinning number.
   - Click **OK**.

6. An action needs to be added to set the mobile number.
   - Click the **Basic Actions** icon and select **Generic**.
   - Change the token name to **Set Mobile No**.
   - Click the **specific** tab.
   - Enter the command `CFG:Set 203 mobile_twinning_number_$KEY`.
   - Click **OK**.

7. The actions need to be connected and then the changes need to be made permanent.
Create a short code to test the call flow.

1. In IP Office Manager, add the following short code. This example uses **90** but any short code can be used.

<table>
<thead>
<tr>
<th>Field</th>
<th>Contains...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>*90</td>
</tr>
<tr>
<td>Feature</td>
<td>Voicemail Collect</td>
</tr>
<tr>
<td>Telephone Number</td>
<td>&quot;Mobile Twinning&quot;</td>
</tr>
<tr>
<td>Line Group ID</td>
<td>0</td>
</tr>
<tr>
<td>Locale</td>
<td>[leave blank]</td>
</tr>
<tr>
<td>Force Account Code</td>
<td>[leave blank]</td>
</tr>
</tbody>
</table>

2. Save and merge the configuration to the IP Office unit.

3. Test the short code by dialing **90** from extension 203.
   - Press 1 to turn mobile twinning on for extension 203.
   - Press 2 to enter a new mobile twinning number for extension 203.
   - Press 3 to turn mobile twining off for extension 203.
4.13 Remote Voicemail Notification

A user can be set up to receive notification of new voicemail messages when they are away from their main extension. There are two ways that notification can be implemented.

- **Voicemail Callback**
  A service whereby the Voicemail Pro calls a specified number whenever the user receives a new voicemail message. Callback requires a callback start point to be created in Voicemail Pro and a callback number entered in IP Office Manager. For more information, see [Setting up Callback Overview](#).

- **Voicemail Outcalling**
  A service where voicemail notification can be configured to specific external numbers and the notification escalated if the message is not listened to. Outcalling can be configured by any user of voicemail in Intuity mode. For more information, see [Outcalling Overview](#).

**Note**

- Both the Callback and OutCalling features are separate from voicemail ringback. Ringback alerts the user’s own extension whilst Callback and OutCalling will provide voicemail notification to an external location, for example a mobile telephone or pager.
4.13.1 Callback
Voicemail callback is a service whereby the Voicemail Pro calls a specified number whenever the user receives a new voicemail message. When the callback is answered, the system announces the outbound alert and waits for a key press for confirmation before continuing with the associated call flow. For more information, see Setting Up Voicemail Pro Callback.

This service requires configuration of a callback start point in Voicemail Pro and entry of a callback number through IP Office Manager. For more information, see Using a Play Configuration Menu Action.

4.13.1.1 Setting Up Callback
The call flow created below is a very simple example. In practice you could include a menu that allows the user access to other features. For example access to a Play Configuration Menu action would allow the user to remotely change various mailbox settings including their callback number. For more information, see Using a Play Configuration Menu Action.

To set up the callback:

1. Under Specific Start Points, right-click Users and select Add.
2. In the Name field, enter the user's mailbox name. Select the Callback entry point and select OK.
3. Within select Callback.
4. Add a Get Mail action and under the Specific tab, in Mailbox enter the user's name again or extension number.
   · Important
      Record an entry prompt for the first action in the callback call flow. Experience with connection to some cell phone systems has revealed that this entry prompt may need to be up to 20 seconds in length.
5. Connect the Start Point and the Get Mail action.
6. Click Save and Make Live and select Yes.
The Default Callback Start Point
In the example above a callback call flow was created for an individual users. The Default Callback start point can be used to create a default callback call flow for all users.

If the Default Callback start point is used, it must be designed so that users have to indicate which mailbox they are accessing. In the simple call flow used above, this can be done by entering ? in the Mailbox field of the Get Mail action. The callback number is initially set through IP Office Manager.

To set the user’s callback number:
1. In IP Office Manager, open the system’s configuration.

2. Click User to display a list of existing users.

3. Double-click the user for whom callback is being set up.

4. Select the Voicemail tab.
   · In Voicemail Code, enter a pin code and confirm this in Confirm Voicemail Code.

5. Select the Source Numbers tab. Right-click and select add to add a new number.
   · Callback Number
     Enter P followed by the destination telephone number. If your system requires an external dialing then the prefix must be included, for example P90192355456. If connecting to a cell phone or pager system that expects digits in separate sets, use , (comma) characters to add pauses to the telephone number dialing.

   · Trusted Source
     If calls from the callback number include ICLID, you can set that number as a trusted source. In that case no request for the user’s voicemail code is made following the callback. Enter V followed by the CLI displayed on calls from the callback number, for example V01923555456.

6. Click OK.

7. Click to send the configuration back to the IP Office. If the only changes made were to user settings, select Merge Config.

4.13.1.2 Using a Play Configuration Menu Action
The callback call flow below is more advanced than the previous example. It allows the user to check messages, transfer themselves to another extension and to alter several aspects of their mailbox configuration.

Of main interest to a callback user is the Play Configuration Menu action. This action allows the remote user to alter their extensions forwarding and voicemail operation. Option 9 in the menu played to the caller allows them to change the callback number.

To exit a Get Mail or Play Configuration Menu action and follow the call flow to the next action, the user should press 0 (not supported for Get Mail in Intuity mode).
4.13.2 Outcalling

The Outcalling feature is only available when using Voicemail Pro 4.0+ in Intuity mode.

Voicemail Pro can be configured to send notification that a new message has been received in a user's mailbox. It will call a specified number and when answered, will prompt the user "This is IP Office. <your name>, you have new messages. To access your messages, please enter your extension number and press hash. To avoid further notification of these messages, press * #". If any other action is taken then the outcalling notification attempt is treated as unanswered.

Retries

If an outcalling notification attempt is not answered, the voicemail server can make another attempt. The number of retries, up to 10, and the delay after a failed notification attempt can use either system default or the users own defined settings.

Destinations

The mailbox user can define up to 5 destination numbers to be used with outcalling. The destinations must include any external dialing prefixes required for the IP Office system. For each destination a ring time can also be defined (default 15 seconds) after which the voicemail server disconnects the call.

- Desk.
- Home.
- Mobile.
- Delegate (called Secretary in some locales).
- Other.

Escalation List

The user can choose to use an escalation list, which combines several of their destinations into a sequence that will be tried as part of a single outcalling notification attempt. Up to 9 destinations can be included in the list and the same destination can be used more than once. Use of the escalation list counts as a single outcalling notification attempt.

- For Voicemail Pro 4.2+, users using Phone Manager 4.2+ can specify a delay to be used between the call to each destination in their escalation list.

Configuration Methods

- System Settings
  The Voicemail Pro can be configured with a set of default times for when outcalling is used, the number of retries for outcalling notification and the interval after a failed notification attempt before the next retry. For more information, see Setting the Outcalling Preferences.

- User Mailbox Settings
  Mailbox owners can configure their outcalling options using their telephone, for example, entering the destination telephone numbers. Details on how to configure outcalling for individuals can be found in the Intuity Mailbox guide.

- Phone Manager Control
  For Voicemail Pro 4.2+, users with Phone Manager 4.2+ can configure their own outcalling settings using Phone Manager. This includes setting their own number of retries and the interval before any subsequent retry. When using an escalation list, this interface also allows the user to set a delay to be used between each number in the escalation list.
4.13.2.1 Setting the Outcalling Preferences

The preferences in Voicemail Pro are set for global operation. Mailbox owners can configure their outcalling options from their telephone, for example, create their own time profile. Details on how users can configure outcalling is found in the Intuity Mailbox guide.

To set the global outcalling preferences:

1. Display the main Voicemail Pro window.

2. From the Administration menu, select Preferences > General.

3. Click the Outcalling tab.

4. Select the times that outcalling is active in the System Times section.
   - **Prime Times** - The time period that outcalling is to be active as default for the system.
   - **Peak Times** - The busiest working hours.

5. Set the retry settings in the System Retry Settings section.
   - The **Number of Retries** can be between 0 and 10. If the message is not collected after the last retry, no notification is sent until another new message is delivered in the user's mailbox.
   - The **Retry Interval** are set for each retry attempt. The interval is the length of time between each attempt to ring to targeted number again. The 6th to 10th retries use the default retry interval.

6. Click **OK**.

7. Click **Save and Make Live** and select Yes.

A timeout value can be set by a user. This is how long outcalling will attempt to call a number before giving up. For more information, see the Intuity Mailbox guide.
Chapter 5.
Using the Voicemail Pro Client
5. Using the Voicemail Pro Client

This section describes how you can customize the operation of the Voicemail Pro server using the Voicemail Pro Client. The Voicemail Pro Client enables you to work on several servers remotely. You do not need to visit each one on site. For more information, see Starting the Voicemail Pro Client.

The default operation for Voicemail Pro is to emulate Voicemail Lite by providing voicemail for all users and hunt groups. Voicemail Pro Client is used to program actions for users and hunt groups who require facilities that differ from those provided by a standard mailbox. With Voicemail Pro you can also program a series of voicemail actions triggered by dialing a short code.

The main sections of Voicemail Pro Client are:

- **Actions**
  Individual actions can be used within a Voicemail Pro call flow. For more information, see Voicemail Pro Actions: Overview.

- **Modules**
  Modules are a sequence of pre-programmed actions used to simplify Voicemail Pro programming. For more information, see Creating Modules: Overview.

- **Conditions Editor**
  The Conditions Editor is used to amend voicemail operation according to factors such as the time of day. For more information, see The Condition Editor: Overview.

- **Campaigns**
  Voicemail Pro campaigns can be created that ask callers a series of questions. A caller's response can be recorded, either spoken or through the telephone keypad. For more information, see Creating Campaigns: Overview.

Preferences can be changed using the Voicemail Pro Client. Details about changing the preferences are covered in the Configuring Voicemail Pro section. For more information, see Changing Preferences.
5.1 The Main Voicemail Pro Window

The Voicemail Pro Client is a Windows interface used to customize the Voicemail Pro Server.

The parts of the Voicemail Pro Client window are:

- **Title Bar**
  The title bar indicates the telephony interface that is being used, namely IP Office or Intuity. If you are working offline, the title bar displays *Offline*. If you are working online, the name of the connected server is displayed. For more information, see [Logging in to the Voicemail Pro Server](#).

- **Toolbar**
  The toolbar across the top of the window provides access to the Voicemail Pro options via icons instead of the menus. For more information, see [Toolbar Icons](#).

- **Start Points Navigation Pane**
  The upper left Navigation pane contains an expandable/collapsible list of customizable voicemail start points. For more information, see [Start Points: Overview](#).

- **Modules Navigation Pane**
  The lower left Navigation pane contains a library of voicemail modules. For more information, see [Creating Modules: Overview](#).

- **Details Pane**
  The details pane shows either:
  - Columns of information for the user or group specific start point selected or for the Voicemail Pro Administrator selected. You can click a column heading to sort the content. For more information, see [Start Points: Overview](#).
  - Visual representation of a call flow from either default start points or a module. For more information, see [Creating Modules: Overview](#).
5.2 Toolbar Icons

The Voicemail Pro screen includes the following icons. These may be grayed out according to which area of the Voicemail Pro screen is currently active.

- **Save as.** For more information, see *Saving Changes and Making them Live*.

- **Save & Make Live.** For more information, see *Saving Changes and Making them Live*.

- **Cut:** Removes currently highlighted text and copies it to the Windows clipboard.

- **Copy:** Copies currently highlighted text to the Windows clipboard.

- **Paste:** Pastes the contents of the Windows clipboard to the current cursor position if appropriate.

- **Add Start Point.** For more information, see *Using Start Points*.

- **Edit Start Point.** For more information, see *Using Start Points*.

- **Delete Start Point.** For more information, see *Using Start Points*.

- **Preferences.** For more information, see *Changing Preferences*.

- **User Defined Variables.** For more information, see *User Defined Variables*.

- **Conditions Editor.** For more information, see *The Conditions Editor:Overview*.

- **Campaigns.** For more information, see *Creating Campaigns:Overview*.

- **Connection.** For more information, see *Connections*.

- **Basic Actions.**

- **Mailbox Actions.**

- **Configuration Actions.**

- **Telephony Actions.**

- **Miscellaneous Actions.**

- **Condition Actions.**

- **Database Actions.**

- **Queue Actions.**
5.3 Saving Changes and Making them Live

Voicemail Pro settings, such as call flow details, are stored in a database file (Vmdata.mdb). To be used by the Voicemail Server they must be saved as a Root.vmp in the voicemail server folder. To find out how to set the location of this folder, see Setting the Location of Voicemail System Files.

To save configuration changes without making them live:

1. Choose Save as to save the database as a vmp file with the name that you specify. You can then copy the file to other systems.

To save configuration changes and make them live:

1. Choose Save & Make Live to save the settings in a file called Root.vmp in the voicemail server folder.

If you are working remotely in Offline mode, you are prompted to select whether to save your changes to the local database or to the remote server.

5.4 Importing and Exporting Call Flows

You can import or export all Voicemail Pro settings at once (in database file .mdb file) or as individual modules. A module file (.mod) can contain one or several modules. Importing and exporting might be useful when you are upgrading a system so that you do not need to recreate the settings or modules.

Important
- Importing and exporting does not apply to prompts. Prompts must be moved as separate items or re-recorded.
- When you import a database file the contents of the existing database are replaced.

To export a file:

1. From the File menu, select Import or Export.
2. Select Export call flows.
3. Click Next.
4. Enter the name of the file that you want to export.
   - Alternatively, click Browse, select the type of file to export either the entire database or a module and click Open.
5. Click Next.
6. Module files can contain several modules, select the module required.
7. Click Next.
8. Click Finish. The selected file is exported.
9. Click Close.

To import a file:

1. From the File menu, select Import or Export.
2. Select Import call flows.
3. Click Next.
4. Enter the name of the file that you want to import.
   - Alternatively, click Browse, select the type of file to export either the entire database or a module. If a module of the same name already exists it is overwritten by the imported module.
5. Click Open.
6. Module files can contain several modules, select the module required.
7. Click Next.
8. Click Finish. The selected file is imported.
9. Click Close.
10. Click **Save & Make Live** before you close the Voicemail Pro Client to apply the imported file. The existing database is overwritten and a backup copy is saved in the folder **DB Backup**.

### 5.5 Including Other Files

In some special circumstances it may be necessary to include the settings of an existing .vmp file into the Voicemail Pro settings.

**To include other files:**

1. From the **File menu**, select **Includes**. The Configuration Includes window opens.

   ![Configuration Includes Window](image)

   NB: these file paths are relative to the Voicemail Server directory: "C:\Program Files\Avaya\IP Office\Voicemail Pro\VM1"

2. Click **+**, the **New Include File** opens.

3. Select a file to include.

4. Click **Open**.

5. Click **Update** to update the Voicemail Pro file settings.

**Notes**

- If you use included files, the Voicemail Pro database contains only a pointer to the name and location of the files and not the actual files. Therefore you should not move or rename an included file. It is strongly recommended that before you include a file, you place it in the same folder as **Root.vmp**.

- Click **X** if you need to remove an included file. The highlighted file is removed but not deleted.
5.6 Start Points

Voicemail Pro consists of a number of start points. When the voicemail server receives a call, it looks for a matching start point and if it finds one it then provides a series of actions linked to that start point. If no match is found then it provides standard voicemail functions to the call.

The Navigation pane contains an expandable and collapsible list of start points. These can be start points for individual users, hunt groups, short codes and default start points.

Specific Start Points
This folder contains the start points for users, groups and short codes.

Users
This folder contains start points set up for individual users. When selected a list is shown in the details pane containing the mailbox owners names and the names of any call flows that have been assigned to the selected mailbox. Other details shown include:

- The extension number associated with the mailbox.
- The size of the mailbox measured by the amount of space, in KB, that is taken up by the .wav files in the specified user’s mailbox folder.
- The number of new, old and saved messages in the mailbox.
- The date when anyone last logged into the mailbox.

This is a user who has one or more start points configured. It can be expanded to show the different start points.

- Collect - Used when the user rings voicemail.
- Leave - Used for calls to the user that are redirected to voicemail.
- Callback - Used when voicemail rings a user to inform them of messages in the user’s mailbox. For more information, see Setting up Voicemail Pro Callback.
- Queued & Still Queued - Used when calls to the user are queued. For more information, see Personal Announcements.

Groups
This folder contains start points set up for hunt groups. When selected a list is shown in the details pane containing the mailbox owners names and the names of any call flows that have been assigned to the selected mailbox. Other details shown include:

- The extension number associated with the mailbox.
- The size of the mailbox measured by the amount of space, in KB, that is taken up by the .wav files in the specified user’s mailbox folder.
- The number of new, old and saved messages in the mailbox.
- The date when anyone last logged into the mailbox.
This is a group that has one or more start points configured. It can be expanded to show the different start points.

- **Collect** - Used when someone accesses the group’s mailbox.
- **Leave** - Used when calls to the hunt group are redirected to voicemail.
- **Queued & Still Queued** - Used when calls to the group are queued. For more information, see Customizing a Hunt Group Call Flow.

### Short Codes

This folder contains any start points set up for particular short codes. Short code start points require the Telephone Number entry of the matching short code in the IP Office Manager to be set up in a particular way. For example, if a Start Point for short code *88 is set up, the settings for short code *88 in the IP Office Manager application must be as follows:

- **Short Code**: *88
- **Telephone Number**: *88
- **Feature**: Voicemail Node.

  The above will allow internal callers to access the start point. To allow external callers access, an Incoming Call Route should be set up with the destination *88.

  - An individual short code on the IP Office. This requires a matching special short code to be set up in Manager.

### Default Start Points

Rather than set up individual start points for every user and group, you can also program actions against the default start points. These will then be used for all calls received by the Voicemail Server that don’t match a specific start point. For more information, see Default Start Points.

### Voicemail Pro Administrators

When the Voicemail Pro Administrators folder is selected a list is displayed in the details pane. The list contains the name, type and status of the administrators. Details can be added, amended or deleted. For more information, see Adding an Administrator.

### Modules

Modules are reusable sets of actions. They allow you to create a sequence of actions that you can then use within any other start point's call flow. Any changes to the module will affect all the start points using that module. This simplifies the programming of actions if a number of start points use the same sequence of actions. Using modules also reduces the size of the call flow. For more information, see Creating Modules Overview.
5.6.1 Default Start Points

The default start points can be used to create a sequence of actions that will be applied to all suitable calls unless a specific start point exists.

- **Collect** - Used when a caller attempts to access a mailbox.

- **Leave** - Used when a caller is redirected to voicemail.

- **Callback** - Used when the voicemail calls a user to inform them about messages in a mailbox. For more information, see Setting up Callback.

- **Queued** - Used for callers queuing for a hunt group or user. For more information, see Customizing Queue Announcements.

- **Still Queued** - Used for callers queuing for a hunt group or user. For more information, see Customizing Queue Announcements.

When a default start point is used, the following actions can attempt to recognize who the presumed user is (the internal user calling or being called) and access the matching mailbox for that user (unless the action specifies another mailbox).

- **Get Mail Action.** For more information, see Mailbox Actions, Get Mail Action.

- **Leave Mail Action.** For more information, see Mail Box Actions, Leave Mail Action.

- **Play Configuration Menu.** For more information, see Configuration Actions, Play Configuration Menu.

- **Listen Action.** For more information, see Mailbox Actions, Listen Action.

- **Record Name Action.** For more information, see Configuration Actions, Record Name Action.

- **Edit Play List Action.** For more information, see Configuration Actions, Edit Play List Action.

The following actions will automatically recognize who the presumed user is and then use that user’s voicemail reception settings (unless the action specifies another mailbox).

- **Transfer Action.** For more information, see Telephony Actions, Transfer Action.

- **Assisted Transfer Action.** For more information, see Telephony Actions, Assisted Transfer Action.

- **Whisper Action.** For more information, see Telephony Actions, Whisper Action.
5.6.2 Using Start Points

Start points can be for individual users, hunt groups, short codes or default start points. All start points can be added, edited, renamed or deleted.

To add a start point for a User or Group:

1. Either click Users or Groups and then . The Adding a new window opens.
   - Alternatively, right-click Users or Groups and select Add.
2. Select the name that matches the user or group on the telephone system.
   - To add all users or groups check the option Add all users.
3. Select the types of start points required.
   - The start points Collect, Leave, Callback, Queued and Still Queued are available for both users and groups.
4. Click OK.

To add a start point for a short code:

1. Click Short Codes and then . The Adding a new short code window opens.
   - Alternatively, right-click Short Codes and select Add.
2. Enter the short code. Short code start points require the telephone number entry of the matching short code in the IP Office Manager application to be set in a specific way. For example, if a start point for short code *88 is set up the settings for short code *88 in the manager application must be as shown below. The short code will allow internal callers to access the start point. To allow external callers access, an Incoming Call Route should be setup with the extension *88.
   - Short code: *88
   - Telephone number: *88
   - Feature: Voicemail Node.
3. Click OK.

Any start point can be edited. However, if you de-select an existing start point, you will delete all actions associated with it.

To edit a start point:

1. In the Navigation pane of the main Voicemail Pro window, select the start point to edit and click . The Editing start point window opens.
   - Alternatively, right-click the start point and select Edit.
2. Make the required changes.
3. Click OK.

To delete a start point:

1. In the Navigation pane, select the start point to delete and click .
   - Alternatively, right-click the start point and then select Delete.
2. You are asked if you are sure that you want to delete the selected start point.
   - Click Yes to delete the start point.
   - Click No to cancel the deletion.
To rename a user, group or short code start point:

1. In the Navigation pane, right-click the user, group or short code and select **Rename**. The New start point name window opens.

2. Type the new name.

3. Click **OK**. The start point is renamed.
5.6.3 Viewing Call Flows as Text

For support calls and diagnostic purposes it can be useful to view Voicemail Pro modules and start points as text files. You can then display the contents of the text file on the screen. The file can be changed as you would change any other text file.

To view a start point or module as text:

1. Select File menu > View as Text. A Notepad window opens. The txt file contains information of all Conditions and Campaigns as well as all call flow details.
5.7 Voicemail Pro Actions

When a start point has been added, it can be linked to an action. Each action can have one or several results, depending on the type of action, and each result can be linked to a subsequent action. In this way you can build up a call flow.

Each action can have a number of results (true, false, no answer, busy). The types of results depend on the type of action, most actions having just a ‘Next’ result. Each result can be used as a connection point to another action. For more information, see Connections.

A set of actions and connections can be combined and reused as a module. Modules are reusable sets of actions. They allow you to create a sequence of actions that you can then use within any other start point’s call flow. Changes to the module will affect all start points using that module. This simplifies the programming if a number of start points need the same sequence of actions. For more information, see Creating Modules:Overview.

You can double-click an action to display the properties in a series of tabs. Many actions share the same standard tabs but each usually also has a specific tab that contains options unique to that action’s function.

The standard tabs of an action are:

- **General.** For more information, see General Tab.
- **Entry Prompts.** For more information, see Entry Prompts Tab.
- **Reporting.** For more information, see Reporting Tab.
- **Results.** For more information, see Results Tab.

**To add an action:**

1. Select the start point to which you want to add an action.
2. Click in the Details pane.
3. Click Actions and select the type of action that you want to add from the list, for example Basic Actions.
4. From the submenu, select the required action. For example, if you selected Basic Actions, you might choose Speak Text. The cursor changes to show that you have selected an action to add.
   - Alternatively on the toolbar, click the icon for the required type of action and then select an action from the submenu.
5. Click in the details pane, where you want to place the action. The new action is added. You can now edit the action and add connections to it.

You can change the properties of an action. For example, If you selected the Speak Text action you can specify the actual text to be spoken when an action is taken.

**To edit an action:**

1. Double-click the action in the details pane or right-click it and select Properties. The Properties window opens. Details of the selected action are contained in a set of tabs.
2. Select a tab and change the action properties as required.
3. Click OK when you have finished.

If an action is no longer required, you can delete it from a start point call flow.

**To delete an action:**

1. In the Details pane where the actions are displayed, click the action to delete.
2. From the Edit menu, select Delete or right-click the action and select Delete.
3. The selected action is deleted.

For more information about the actions that are available for use in call flows, see Available Actions:Overview.
5.7.1 Connections
The actions that are added to a start point must be connected before they can be used. The sequence of the connections determines how the call is routed through voicemail.

Each action can have a number of results (True, False, No Answer, Busy). The types of results depend on the type of action. For each result, a connection can be added.

- Most actions only have a Next result, i.e. a single connection to the next action.
- Other actions may have two results, for example True or False. Each of these results represents a connection point for different following actions.
- Some actions may have multiple results. For example, the Assisted Transfer action has results for Next, No Answer and Busy. Each of these results represents a connection point for different following actions.
- If a result occurs, for which no connection to a following action has been set, either the call is disconnected or, if it came from a hunt group queue, it is transferred back to the queue.
- Within modules, all connections should end in another action or in a Module Return action.

To add a connection:
1. Click the icon.
2. Click and drag the cursor from action’s result that triggers the connection to the action that should follow the connection.

To delete a connection:
1. Click the connection to delete. It is displayed in red.
2. Press Delete. The connection is removed. Alternatively, either select Edit and then Delete or right-click and then select Delete.
5.7.2 Available Actions
Once a start point has been added, it can be linked to an action. The available actions are divided into the following groups:

- **Start Point**
  This special action is present by default in all call flows. It is simply the start point for the call flow to which other actions can be linked. While this action has General, Entry Prompts, Reporting and Results tabs they should not be used. Any settings added to those tabs will be ignored and should be applied through the tabs of the first additional action added to the call flow and linked to the Start Point.

### Basic Actions
These actions are chiefly used to control the routing of a call between actions.

- **Generic Action**
  Can be used to simply play a prompt to the caller through its Entry Prompts tab. It can also be used to enter custom commands for the voicemail server.

- **Speak Text Action**
  Allows text to entered and then played to the caller. Requires TTS to be installed and licensed.

- **Menu Action**
  Branch according to touch tone selection.

- **Goto Action**
  Go to another start point.

- **Disconnect Action**
  Disconnect the call.

- **Home Action**
  Return to the start point.

- **Module Return Action**
  Return to the start of a module.

### Mailbox Actions
These actions relate to the leaving and collecting of messages from a mailbox.

- **Get Mail Action**
  Collect messages in a mailbox.

- **Leave Mail Action**
  Leave message in a mailbox.

- **Listen Action**
  Record to a mailbox.

- **Voice Question Action**
  Record response to a prompt.

- **Campaign Action**
  Access a campaign to read or leave messages.

### Configuration Actions
These actions allow a caller to change the settings of a user or hunt group mailbox.

- **Edit Play List Action**
  Re-record a prompt.

- **Record Name Action**
  Re-record a mailbox name.

- **Play Configuration Menu Action**
  Change user or group settings.
• **Select System Prompt Language Action**
  Change the prompt language.

### Telephony Actions

These actions relate to telephony functions such as call transfers.

- **Variable Routing Action**
  Route on a match to a variable such as the caller’s CLI.

- **Route Incoming Call Action**
  Route a call depending on whether the call is internal or external.

- **Route by Call Status**
  Calls route is determined by why the reason the call was routed to voicemail.

- **Transfer Action**
  A blind transfer.

- **Whisper Action**
  Screened transfer.

- **Call List Action**
  Transfer to a user selected choice.

- **Dial by Name Action**
  Select user/group by keypad letters.

- **Conferencing Center**
  Provides a route for callers to enter the conference ID and their conference PIN code. IP Office Conferencing Center needs to be installed.

- **Assisted Transfer Action**
  A transfer with assistance for callers.

- **Alphanumeric Action**
  Allows the caller to input text and numeric values.

### Miscellaneous Actions

- **eMail Action**
  Email a recording.

- **Open Door Action**
  Open and/or close a door relay.

- **Alarm Set Action**
  Set an alarm call time.

- **Clock Action**
  Play the time to the caller.

- **Post Dial Action**
  Play a recording to an extension.

- **VB Script Action**
  Allows Visual Basic to be used to script call flow events.

- **Remote Call Flow**
  Allows call flows developed elsewhere to be included in an existing call flow.

### Condition Actions

These actions are used to create branches in the call routing according to whether a value is true or false.

- **Test Condition Action**
  Test whether a condition is true or false.
Using the Voicemail Pro Client: Voicemail Pro Actions

- **Set User Variable Action**
  Set a variable to a particular value.

- **Test User Variable Action**
  Test the value of a variable.

- **Test Variable Action**
  Check if user dialing matches set digits.

**Database Actions**

These actions relate to retrieving and adding data to a database. The use of database actions with Voicemail Pro requires entry of a VMPro Database Interface license in the IP Office configuration.

- **Database Open Action**
  Open a database.

- **Database Execute Action**
  Perform an action on a database.

- **Database Get Data Action**
  Get information from a database.

- **Database Close Action**
  Close a database.

**Queue Actions**

These actions are associated with hunt group queues and are not available to user and short code start points. The IP Office Manager option *Synchronise calls to announcements* should not be used when using the queue actions.

- **Queue ETA Action**
  Speak the caller’s expected time to answer.

- **Queue Position Action**
  Speak the caller’s queue position.
5.7.3 Standard Action Tabs

5.7.3.1 General

The **General** tab contains the action name. You can also enter notes about the action and protect a call flow by adding an access code.

This tab is shown for the **Start** action in call flows. However it should not be used as settings applied to the Start action are ignored and should instead be applied through the first other added to the call flow.

- **Token Name**
  The name of the action, for example, the token name for the action Menu is 'Menu'. The token name can be changed so the use of the action can be indicated. It could also be confusing having two actions within a module with the same name.

- **Description**
  Use this field to enter notes about why the action is being used or other information that may be needed.

- **Pin**
  Each action can be protected by a PIN number. The PIN number can be the voicemail code of the presumed user. To do this enter a $ symbol. For example, entering $ would force the caller to dial their voicemail code, entering 104$ would force the caller to dial 104 followed by their voicemail code.

![Properties for Generic Screen](image-url)
5.7.3.2 Entry Prompts

The Entry Prompts tab is used to select the prompts to be played before the action performs its main role. Multiple prompts can be added and the order in which they are played adjusted. This tab is shown for the Start action in call flows. However it should not be used as settings applied to the Start action are ignored and should instead be applied through the first other added to the call flow.

The Entry Prompts tab allows you to select the prompts to be played before the action performs its main role. Multiple prompts can be added and the order in which they are played adjusted. This tab is shown for the Start action in call flows. However it should not be used as settings applied to the Start action are ignored and should instead be applied through the first other added to the call flow.

- **Add Prompt**
  Clicking or double-clicking an existing listed prompt starts the Voicemail Pro Wave Editor. This tool allows you to record and play prompts through the Voicemail Pro server PC or through an extension on the IP Office system. The dialogue that appears allows the selection of an existing prompt or the ability to specify a new file name and then record the new prompt. For more information, see Using the Wave Editor.

- **Edit Prompt**
  Edit the details of the currently highlighted prompt.

- **Delete Prompt**
  Delete the currently highlighted prompt from the play list. Note that the actual prompt file is not deleted from the server.

- **Move Prompt**
  Move the position of the currently highlighted prompt in the play list.

- **Allow prompts to be interrupted by Tones**
  Allow the caller to press tone keys to make selections during the playing of the actions entry prompts.

The Edit Play List action can be used in call flows to re-record a specified prompt. This allows the creation of call flow options where the voicemail user can record prompts themselves to reflect changes in operation. For more information, see Edit Play List action.
5.7.3.3 Using the Wave Editor

The Wave Editor is used by Voicemail Pro to select, record and play prompts. It can be used to select existing prompts or to record new prompts.

The Entry Prompts tab of each call flow action allows prompts to be played before the action performs its main role.

Clicking + or double-clicking a listed prompt starts the Voicemail Pro Wave Editor. This tool allows you to record and play prompts through the Voicemail Pro server PC or through an extension on the IP Office system.

![Wave Editor](image)

**To record a new prompt:**

1. Select the media device to use, either **Telephony Handset** or **PC Multimedia**.
   - If **Telephony Handset** is selected, enter the extension of the telephone to be used.
2. Enter a file name for the recording.
3. Click the **record** button to record the message. If the media type selected is Telephony Handset, the telephone extension will ring. When the handset is picked up a message will be heard saying *Record at the tone.*
4. Speak the message, click **stop** button when finished.
5. To listen to the recording, press the **play** button. If there is no media device attached, the recorded message will be heard from the telephone extension.

**To select a prompt.**

There are a large number of standard prompts that can be used. Enter the name of the prompt or use the button to browse to the required file. For a sample listing of these prompts see [US English Intuity Prompts](#) and [English Non-Intuity Prompts](#).

Useful files are:

- en\MC_00 - Plays a bleep.
- en\MC_01 - Plays 1 second of silence.
- Entering 1234.wav will play "one two three four" (unless a file called 1234.wav has been recorded).
Some system variable can be played as prompts. For example:

- **$NAM** - Plays the user name.
- **$CLI** - Speaks the caller’s CLI.
- **$RES** - Plays the current result if it is a .wav file.
- **$VAR** - Plays the variable as a list of digits.
5.7.3.4 Specific
The contents of this tab vary according to the type of action. In some cases this tab may have a different name, for example Touch Tones for the Menu action. Not all actions contain the Specific or Touch Tones tab. Details of the specific tab are covered in the section that describes the available actions.

This tab is shown for the Start action in calls flows. However it should not be used as settings applied to the Start action are ignored and should instead be applied through the first other added to the call flow.

5.7.3.5 Reporting
The Reporting tab provides information that is then used to classify the call details within the reports produced by the CCC products (a separate product from Voicemail Pro).

This tab is shown for the Start action in calls flows. However it should not be used as settings applied to the Start action are ignored and should instead be applied through the first other added to the call flow.

- **Flag the current call has been answered by Voice Mail**
  The system user may not want the CCC to report a call as answered until it has reached a certain action within the sequence of actions. For example, to not regard a call as answered until the caller has left a message, made a selection from a menu or has been transferred to a user or group.

- **Request to call back the current caller**
  If this option is selected, the CCC will keep a record of the caller’s CLI if provided. This is then used within the CCC product to arrange a callback call by an agent.

- **Send reporting information**
  If selected, this option allows information to be associated with the call. The information is set in the Group name, Topic and Annotation fields. The CCC product uses the information within its call reports.

![Properties for Generic dialog box]

*Properties for Generic* dialog box with tabs for General, Entry Prompts, Specific, Reporting, and Results. The Specific tab is active with options to select or deselect the following:

- Flag the current call has been answered by Voice Mail
- Request to call back the current caller
- Send reporting information

Within the Reporting section, fields for Group name, Topic, and Annotation are provided for input.
5.7.3.6 Results

This tab shows the results available from an action. For the majority of actions the results are fixed and appear grayed out, i.e. they cannot be changed. For some actions the results are variable.

This tab is shown for the **Start** action in calls flows. However it should not be used as settings applied to the Start action are ignored and should instead be applied through the first other added to the call flow.

![Properties for Generic window](image)
5.7.4 Basic Actions

5.7.4.1 Generic

The Generic action can be used to play a prompt to the caller. It can also be used to enter custom commands for the voicemail server. The maximum length for the string is 128 characters.

To add a Generic action:

1. Click the Basic Actions icon and select Generic. The Generic action only has a Next result.

Example of playing a prompt

Callers can be given an option to hear a specific message, for example details about the latest sales offer. The Entry Prompts tab is used to record a message or select a pre-recorded message. A looped connection can be added to continually repeat the recording. A connection would be from the result Next back to Generic, as shown in the example.

Voicemail Pro Variables

- **Store a Variable Value**: CP<nn>:<value>
  Enter a value into one of the call parameter stores (CP0 to CP15). For example, CP0:$key stores the current value of $key as $CP0 for the duration of the call within the call flow.

- **Save a Value**: Save:<value>
  The Voicemail Pro system variable normally contains the value of the last saved result in the call flow. This generic command can be used to replace that value with another. For example Save:$KEY or Save:1234.

Message Handling

- **Forward a Message**: FWD:<ext1>#<ext2>##
  This option can be used with a generic action that is proceeded by an action that records a message such as a Voice Question or Edit Play List action. It then forwards the message to another mailbox or mailboxes. Each extension number should be followed by a # plus an additional # at the end of the string.

Twinning Control

- **Enable Mobile Twinning**: CFG:Set <ext> twinning_type Mobile
  Used to set the user's twinning type as Mobile in the IP Office configuration. Enables mobile twinning if the user has a mobile twinning number set in the configuration.

- **Set the Mobile Twinning Destination**: CFG:Set <ext> mobile_twinning_number $KEY
  Used to set the user's mobile twinning number.

- **Enable Internal Twinning**: CFG:Set <ext> twinning_type Internal
  Used to set the user's twinning type as Internal in the IP Office configuration. Enables internal twinning if the user has a twinning handset number set in the configuration.

Absence Text

Absence text can be displayed to internal callers who call a user's extension. The text is displayed on their phone if possible and in Phone Manager and SoftConsole. Have the display of absence text enabled does not change the routing of calls.

- **Select absent message**: CFG:SET "<mailbox name or extension>" absent_msg 0
  Select an absent message between 0 and 11. This does not enable the use of the absence message.

  - 0 = None.
  - 1 = On vacation until.
  - 2 = Will be back.
  - 3 = At lunch until.
  - 4 = Meeting until.
  - 5 = Please call.
  - 6 = Dont disturb until.
  - 7 = With visitors until.
  - 8 = With cust. til.
  - 9 = Back soon.
  - 10 = Back tomorrow.
  - 11 = Custom.

- **Add absence text**: CFG:SET "<mailbox name or extension>" absent_text "<text>"
  The total length of an absence text message, including the standard message part selected above, is 128 characters. However the length displayed will depend on the device being used by callers.

- **Set absent message on**: CFG:SET "<mailbox name or extension>" absent_set 1
  Enable the display of absence text to internal callers.
- **Set absent message off:** `CFG:SET "<mailbox name or extension>" absent_set 0`
  Disable the display of absence text to internal callers.
Example of a Custom String

For example, using the command `FWD:201#202#203#204#205##` a message can be forwarded to multiple mailboxes. The message is recorded by a preceding **Voice Question** or **Edit Play List Action**. The 128 character length limit restricts a single generic action to 31 three-digits extensions, 24 four-digits extensions and so on. However multiple generic actions can be connected in a chain to bypass this limitation.

A voice message can also be sent to multiple mailboxes by creating a Personal Distribution List or to each member of a hunt group by using the broadcast feature. For more information, see [Configuring Group Broadcast](#).

For examples of the action being used in a call flow, see

- [Example Call Flow for Mobile Twinning](#)
- [IVR Database Connection Example, Entering Details in to the Database](#)
5.7.4.2 Speak Text

The Speak text action allows any text to be spoken to the caller. To be able to use the **Speak Text** action you require TTS (Text to Speech) to be installed and licensed. For more information, see Text to Speech: Overview.

**To add a Speak Text action:**

1. Click the **Basic Actions** icon and select **Speak Text**.
2. Select the **Specific** tab.
3. Enter the text to be spoken in the **Text to speak** field.

   - The text can include System Variables such as **$CLI** and variables obtained by database actions such as **$DBD[1]**. In the example, the contents of the database query field are spoken. The action has additional text added so that the currency can be spoken. In this example pounds are used.
   - The text can include SAPI XML tags to modify how it is spoken, see TTS SAPI Controls.

The Speak Text action only has the result Next which needs to be connected to a suitable action. For example, the text spoken could confirm an option choice. The next action could be a Return action to take the caller to another call flow. For more information, see **Return Action**.

For examples of the action in a call flow, see:

- Entering Details into the Database
- Returning Data from the Database
5.7.4.3 Menu

The Menu action allows you to specify DTMF tones for which you want to create connections to following actions. For example, a menu can be created that gives callers a choice of transfer locations. Each Menu action supports a maximum of 15 branch options.

To add a Menu action:

1. Click the Basic Actions icon and select Menu.

Settings

For Menu actions, the Specific tab is replaced with the Touch Tones tab.

- **0-9, *, #**
  Use the dialing digits check boxes to indicate the DTMF tones for which connections are required.

- **Add**
  The icon allows you to add custom sequences of dialing digits. In addition to the standard dialing digits (0 to 9, *, #) the following special digits can be used. If a sequence is added, ensure that the associated box is checked before you select OK. The sequence must be unique. For example, if 5 is selected, no other sequence that begins with 5 can be used.

  - **? = Any Digit**
    The ? character can be used to represent any digit (except * and #). For example **123??** can be used for any six digit string starting with 123. See Example Call Flow: SelfSelect Module.

  - **$ = Any Sequence of Digits**
    The $ character can be used to match any sequence of digits for which there is no other match. Key press entry is ended either by the caller pressing # or 5 seconds after the last digit dialed.

  - **F = For Fax Calls**
    The F letter can be used to automatically detect any incoming fax calls. Once detected the calls can be routed to another number. See Routing Fax Calls Using a Menu Action.

- **Delete**
  Use this icon to delete the currently selected custom dialing sequence.

- **Invalid Input Handling**
  The following options can be used if the caller does not dial or dials an invalid digit.
• **No of Retries (Voicemail Pro 4.2+)**
  This option allows you to specify the number of retries a caller is allowed if they make an invalid entry or the timeout occurs.

• **Timeout**
  If selected, the Voicemail Pro will wait for the specified number of seconds for a valid digit. If the timeout expires the Voicemail Pro will either allow a retry or if the No of Retries has been reach, it will follow the Timeout result connection within the call flow.

• **Invalid Entry (Voicemail Pro 4.2+)**
  If selected, if the caller enters an invalid digit, the Voicemail Pro will either allow a retry or if the No of Retries has been reach, it will follow the Timeout result connection within the call flow.

• **Prompt (Voicemail Pro 4.2+)**
  You can associate a prompt with the Timeout and or Invalid Entry options. If a prompt is specified, before allowing a retry the Voicemail Pro will play that prompt. Use the [ ] to access the Wave Editor.

In the example the transfer options 1 and 2 were selected. The results 1 and 2 need to be connected to suitable transfer locations.

• **Timeout**
  This result is used to connect to a following call flow action if the caller does not make an entry within the specified number of seconds on their last retry.

• **Invalid**
  This result is used to connect to a following call flow action if the caller makes an invalid entry on their last retry.

• **Others**
  A result for connection to a following call flow action is shown for each select dialing digit sequence.

For examples of the action being used in a call flow, see:

- Using a Play Configuration Menu Action
- Example Call Flow for Mobile Twinning
- Routing Calls to Voicemail, Example Call Flow
- Changing the Language of System Prompts
- Changing the Language Setting for a TTY Device
5.7.4.4 Goto

The GoTo action will transfer the caller to another start point.

To add a Goto action:

1. Click the Basic Actions icon and select GoTo.

The GoTo action needs to contain details of where to transfer the caller to.

1. Select the Specific tab.

   ![Specific tab](image)

2. In the field Please select a node to go to, click to browse to select a start point, module or system defined variable. For short codes, the browse method does not work. Instead enter "Short Codes.xxx" where xxx is the short code key sequence.

   - Select the option Start point or module. Select from the available options.
     - Users - all the users with specific start points are listed.
     - Groups - all the Groups with specific start points are listed.
     - Any default start point.
     - Any available modules.

   - Select the option System defined variables to browse the available call variables. You can also type the name of the start point directly.

When details of the transfer location, the GoTo action does not need to be connected to another connection. If you do connect this action to a following action, the connection will not be used.
5.7.4.5 Disconnect

The Disconnect action disconnects the caller.

To add a Disconnect action:

1. Click the Basic Actions icon and select Disconnect.

![Disconnect]

The caller will be disconnected when they reach this point of a call flow.

5.7.4.6 Home

The Home action returns the caller to the start point of the calls entry into voicemail. The PIN option in the General tab is not used for this action.

To add a Home action:

1. Click the Basic Actions icon and select Home.

![Home]

Connect an action to the Home action. The caller will be returned to the start point of the call entry into the voicemail. For an example of the action being used in a call flow, see Using a Play Configuration Menu Action.

5.7.4.7 Module Return

The Module Return action is used within modules only. It creates a connection point from the module to subsequent actions within any call flow that uses the module. A module can use several Module Return actions if necessary. The Module Return action has no properties.

To add a Module Return action:

1. Click the Basic Actions icon and select Module Return.

![Module Return]

Connect an action result to the Module Return action. For examples of the action being used in a call flow, see Changing the Language of System Prompts and User Defined Variables.
5.7.5 Mailbox Actions

5.7.5.1 Get Mail

The Get Mail action allows access to the messages in the caller’s mailbox or a specified mailbox. The caller then has access to the standard mailbox features setup for that mailbox. If the extension is a trusted extension, the user does not have to enter their mailbox number and code. For more information, see Creating a Trusted Location.

To add a Get Mail action:

1. Click the Mailbox Actions icon and select Get Mail.
2. The Specific tab is used to select either the caller’s mailbox or mailbox option.
   - Caller’s mailbox: The mailbox matching the start point of the call.
   - Mailbox: Select or enter the name of the target mailbox. If ? is entered, Voicemail will prompt caller’s to enter the mailbox number required.

The Get Mail action has a Next result. Add a connection from the Next result to another action.

For examples of the action being used in a call flow, see:

- Using a Play Configuration Menu Action
- Setting Up Callback
- Changing the Language of Custom Prompts
- Changing the Language of System Prompts
- Enabling Access to Hunt Group Voicemail
- Changing the Language Setting for a TTY Device

The following conditions apply, based on which mailbox mode the Voicemail Pro server is using.

- **IP Office mode**
  Users who press 0 while they are logged into their mailbox will be routed to the Next result.

- **Intuity mode**
  Users who press *0 whilst in their mailbox will be routed to their Voicemail Reception number if set. The Next result is not used.
5.7.5.2 Leave Mail

The Leave Mail action allows the caller to leave a message in the start point's mailbox or in a specified mailbox.

To add a Leave Mail action:

1. Click the Mailbox Actions icon and select Leave Mail.
2. The Specific tab is used to select either the Caller's mailbox, Mailbox or VRL option.
   - **Caller's Mailbox:** The mailbox matching the start point of the call.
   - **Mailbox:** Select or enter the name of the target mailbox.
   - **VRL:** If selected, specifies that the message should be transferred to a third-party Voice Recording Library (VRL) application. For more information, see Voice Recording Library.

The Leave Mail action has Success and Failure results. The use of these depends on which mailbox mode the Voicemail Pro server is using.

**IP Office mode:** Callers in the mailbox follow the Failure or Success results depending on whether they press 0 before or after the leave a message tone respectively. This overrides the mailbox user's Voicemail Reception setting set in the IP Office configuration.

**Intuity mode:** The results cannot be accessed. Callers pressing 0 will always follow the mailbox user's Voicemail Reception setting set in the IP Office configuration.

For examples of the action in a call flow, see:
- Routing Calls to Voicemail, Example Call Flow
- Hunt Group Queuing, Example Call Flow using $POS.
- Changing the Language Setting for a TTY Device
- Example Call Flow: Dial by Name.
5.7.5.3 Listen

The Listen action allows the caller to leave a message in the start point's mailbox or in a specified mailbox. The caller can only leave a message and cannot access any other mailbox features.

To add a Listen action:

1. Click the Mailbox Actions icon and select Listen.
2. In the Specific tab, select either the Caller's mailbox or Mailbox option.
   - Caller’s Mailbox: The mailbox matching the start point of the call.
   - Mailbox: Select or enter the name of the target mailbox.
3. Make any changes as required to the General, Entry Prompts, Reporting and Results tab pages.
4. Click OK. The Listen action is updated.

Connect the result Next to a relevant action. For examples of the action in a call flow, see Customizing Manual Recording and Customizing Auto Recording.
5.7.5.4 Voice Question

The Voice Question action allows you to create a play list where the caller hears a sequence of prompts and their responses are recorded.

If the play list is completed, a single file containing the recorded responses is created. That file can then be placed into a specified mailbox or passed to an eMail action.

To add a Voice Question action:

1. Click the Mailbox Actions icon and select Voice Question.

2. In the Specific tab questions need to be added to the play list.

3. Click Add a Prompt. The Wave Editor window opens.
   - (Optional) Specify a new file name and then record the new prompt. For more information, see Wave Editor.
   - (Optional) Select an existing prompt.

4. Click Close. You return to the Specific tab.

5. Click Record a Response. The New action name window opens.

6. Specify the length in seconds of the recorded response.

7. Click OK. You return to the Specific tab.
   - A mailbox needs to be specified into which the recorded file of responses are stored. If no mailbox is specified the file can be passed to an eMail action.
   - Edit: - Edit the settings of the currently highlighted item.
   - Delete: - Deletes the currently highlighted item from the play list. This does not delete the actual prompt file.
   - Shuffle: - Move the currently highlighted item within the play list.

8. Click OK. The action is updated.

The Next result needs to be connected to an eMail action if no mailbox is selected in the Specific tab.
5.7.5.5 Campaign

The Campaign action can be used to either route a caller into a campaign or to allow an agent to access any messages left for a campaign. See Voicemail Pro Campaigns.

To add a campaign action:

1. Click the Mailbox Actions icon and select Campaign.
2. You need to enter the campaign and select whether to leave or collect campaign information in the Specific tab.

- In the Please select a campaign field, enter the campaign that you want to use.
- Select either:
  - Leave campaign information (e.g. customers)
    Select if the action should start the campaign to collect the caller's responses.
  - Pick up campaign information (e.g. agent)
    Select if the action should start playing back the response left by callers to the campaign.

Connect the result Next to a relevant action.
5.7.6 Configuration Actions

5.7.6.1 Edit Play List

With the Edit Play List action a caller can record a specified prompt file held on the voicemail server PC. This means that they can re-record prompts other than those for their own mailbox.

To add a Edit Play List action:

1. Click the Configuration Actions icon and select Edit Play List.
2. In the Specific tab, select the prompt file held on the voicemail server.

- File Path
  This path is relative to the WAVS folder defined for the voicemail server.
  - To browse to a file location click ... The Wave editor window opens. Select an existing prompt or define and record a new one.
  - For announcements, the formats [GREETING]\<name>_Queued and [GREETING]\<name>_StillQueued can be used, where <name> is replaced by the hunt group or user name.

3. Click OK. The action is updated.

Results

Connect the result Next to a relevant action.

5.7.6.2 Record Name

The Record Name action is used to allow the caller to record the mailbox name of their mailbox or a specified mailbox. An example of a call flow using the Record Name action is given in the Voicemail Pro Dial by Name section.

To add a Record Name action:

1. Click the Configuration Actions icon and select Record Name.
2. In the Specific tab the mailbox to record that the name is to be recorded for is selected.
   - Caller's mailbox
     The mailbox matching the start point of the call.
   - Mailbox
     Select or enter the name of the target mailbox.

Connect the result Next to a relevant action. For an example of the action in a call flow, see Adding a Record Name Module.
5.7.6.3 Play Configuration Menu

The Play Configuration action allows various users or hunt group settings to be altered. Because of the nature of this action it should always be protected by a PIN code in its General tab. An example of a call flow using the Play Configuration Menu action is given in the Remote Voicemail Notification section.

The options given when a caller accesses this action are:

For a user:
1. Edit forwarding number.
2. Edit follow me number.
3. Set call forwarding.
4. Set voicemail on/off.
5. Set do not disturb.
7. Edit voicemail reception.
8. Set voicemail email mode.
9. Edit voicemail callback number.

For a hunt group:
1. Set voicemail on/off.
2. Edit voicemail code.
3. Set voicemail email mode.
4. Set service mode.

Any changes made using this type of action are written to a file called "AuditTrail.txt" on the Voicemail Server PC. The file includes the time, date, details of the change and the CLI of the caller making the change.

To add a Play Configuration Menu action:

1. Click the Configuration Actions icon and select Play Configuration Menu.
2. In the Specific tab, select the mailbox to play the configuration menu for:
   - Caller's Mailbox: The mailbox matching the start point of the call.
   - Mailbox: Select or enter the name of the target mailbox.
3. In the General tab, enter a PIN code in the PIN field. Connect the result Next to a relevant action. For an example of the action being used in a call flow, see Using a Play Configuration Menu Action.
5.7.6.4 Select System Prompt Language

The Select System Prompt Language action is supported on Voicemail Pro 1.2.6 or higher. It allows the system to alter the language spoken during a call flow. An example of a call flow using the Select System Prompt Language action is given in the Changing the Language used by Voicemail Pro section.

To add a select system prompt language action:

1. Click the "Configuration Actions" icon and select "Select System Prompt Language".

2. In the "Specific" tab select the language that the system prompts are to be played in. If a language is selected which is not loaded on the Server, the system will automatically select the most appropriate language.

   - **Possible system prompts**
     List of all prompt languages that could be installed on the system.

   - **Installed on the Server**
     Displays if the prompts for a particular language are installed on the server.

   Connect the result Next to a relevant action. For examples of the action being used in a call flow, see Changing the Language of System Prompts and Changing the Language Setting for a TTY Device.
5.7.7 Telephony Actions

5.7.7.1 Variable Routing

This action routes calls based on whether a selected variable associated with the call matches any of the specified numbers. This action replaces the previous CLI Routing action but can perform the same function using the $CLI

variable.

The selected variable is checked for a match against all strings. Where multiple matches occur, the one with the most matching digits (excluding wildcards) is used. If several equal length matches are found, the first one in the list is used.

Variable Routing action:

1. Click the Telephony Actions icon and select Variable Routing.
2. Select the Specific tab.

- Select a Variable
  This drop down is used to select the Voicemail Pro system variable against which the values are checked for a match.

- Does the Variable match any of the following numbers
  The area below lists the numbers against which the selected variable will be selected for a possible match. If the variable matched multiple numbers in the list, the routing for the match nearest the top of the list is used.
    - Add a new number to the list of numbers. Numbers can include a ? wildcard to represent any single digit, with multiple ?'s to represent a matching number of any digits. Numbers can include a * wildcard to match any digits including multiple digits. Some examples are listed in the results section below.
    - Edit an existing selected number.
    - Delete an existing selected number.
    - Move the position of the currently highlighted string.
The results includes a separate result for each number match string entered on the action's Specific tab plus a No Match result. Examples are:

- **01707364725** will only match that number exactly.
- **01707** will match any number beginning with 01707.
- ***4625** will match any number ending in 4625.
- ***4329** any number containing 4329.
- **01707???????** will match any 11 digit number beginning with 01707.
- **????????4625** will match any 11 digit number ending in 4625.
- **??7** will match any number with 7 as the third digit.
5.7.7.2 Route Incoming Call

The Route Incoming Call action has two results for which connections to following actions can be made. The results are Internal or External.

To add a Route Incoming Call action:

1. Click the Telephony Actions icon and select Route Incoming Call. There is no specific tab for this action.

   The Route Incoming Call action results for a match and no match need to be connected to relevant actions.

5.7.7.3 Route by Call Status

The Route by Call Status action has four results for which connections to following actions can be made.

To add a CLI Routing action:

1. Click the Telephony Actions icon and select Route by Call Status.

There is no specific tab for this action.

   The Route by Call Status action results No Answer, Busy, Out of Hours and Default need to be connected to a relevant action.

   The result route used is determined by why the reason the call was routed to voicemail. For example, calls to a hunt group follow either the No Answer route or, when in night service, the Out of Hours route. Calls to users would follow either the No Answer or Busy routes.

Where the cause for the call being routed to voicemail cannot be determined or does not fit the criteria above, the Default route is used.
5.7.7.4 Transfer

The Transfer action transfers the caller to the extension that matches the mailbox selected. This is a blind transfer; if the call returns to the voicemail server again, for example if unanswered, it will be treated as a new call. More advanced transfers are done using either a Call List Action or Assisted Transfer Action.

To add a Transfer action:

1. Click the Telephony Actions icon and select Transfer.
2. Select the Specific tab, type of select the target extension or group that you want to ring in the destination field.

- **Destination**: Enter the number of the destination for the transfer. This can include IP Office short codes or numbers specified by the current value of a Voicemail Pro system variable such as $KEY.

- **Source of transfer (displayed on phone)**: Voicemail Pro 4.1+. The number to display on the destination phone if internal.

- **Description (displayed on phone)**: Voicemail Pro 4.1+. The text description to display on the destination phone if internal. Call data tagging can also be used to pass information to MS-CRM, see Assisted Transfer.

- **Notify caller of transfer to target**: Voicemail Pro 4.1+. If enabled, the caller hears "Transferring to" followed by the associated mailbox name of the destination if available or otherwise the destination number. This follows any prompts selected in the Entry Prompts list above.

**Results**

A Transfer action normally has no results.
5.7.7.5 Whisper

The Whisper action plays a recording to an extension. That extension can then either accept or reject the call. Normally the recording played is the result of a preceding Voice Question action though a Listen action can also be used.

To add a Transfer action:

1. Click the Telephony Actions icon and select Whisper.
2. Select the Specific tab.

   ![Image of Telephony Actions settings]

3. Enter details in the fields:
   - **Play recording to**: Enter the extension that is rung with the caller's recording.
   - **Source of transfer**: Select the number to display on the target phone.
   - **Description**: Enter a call description to display on the target phone.
   - **No answer timeout**: Select how long the voice mail server should wait for an answer before following the No Answer connection. The whisper action will not go to the target extension voicemail.
   - **Prompts played before the recording and Prompts played after the recording**: Click on the Wave Editor. The Wave Editor window opens. Select the prompts that are to be played to the target extension when they answer the call. The prompts played after the caller's recording should include the instruction "Press 1 to accept or hang up to reject".

The Whisper action can be connected to a number of following actions according to whether the call is answered, rejected, gets busy or no answer tones.
5.7.7.6 Call List

With the Call List action a caller can indicate the extension to which they want to be transferred. If selected the caller can be restricted to selecting an extension within a particular group. The transfer in this case is not blind, if unanswered the action can link to actions for no answer, busy and no answer timeout.

To add a Call List action:

1. Click the Telephony Actions icon and select Call List.
2. Select the Specific tab. Complete the fields with relevant details.

- In the Transfer to group field enter a group name if you want to restrict the caller to a particular group.
- Check the Prompt user with a list of group members option if you want the voicemail server to list the group members for the caller.
- In the Source of transfer field, select the number to display on the target telephone.
- In the Description field, enter a call description to be displayed on the target telephone.
- Set the No answer timeout value. The value selected is how long the voicemail server waits for an answer before following the No Answer connection.

The Call List action results need to be connected to relevant actions.
5.7.7.7 Dial by Name

The Dial by Name action enables callers to enter the name of the person and/or group they want to contact by dialing on a keypad with ITU standard alphabet markings. The caller is then played a list of available name matches from which they can select. An example of a call flow using the Dial by Name action is given in the Voicemail Pro Dial by Name section.

The action should prompt the caller to dial the name they require and then press #. Callers can also press *# to exit without making a selection.

- If no matches are found, the caller is given the option to retry.
- If 10 or less matches are found, the matching mailbox name greetings are played as part of a selection list, i.e. "Press 1 for ..., press 2 for ..., ...".
- If more then 10 matches are found, the caller is prompted to either press # to hear the first 10 or to dial more characters to reduce the number of matches. If they select to play the list, after each set of 10 matches they can either make a selection or follow the prompts for other options.

For a user to be included in the dial by name list, they must:

- Have recorded a mailbox name.
- Not be marked as ex-directory.

To add a Dial by Name action:

1. Click the Telephony Actions icon and select Dial by Name.

2. In the Specific tab you can select from three types of names that will be included in the list. Users set to ex-directory through the Manager application are not included. You can also select how the names will be sorted.

   The action has True and False connection results. If the caller does not make a selection, the False result connection is used. If the caller does make a selection, the selection is stored as the $KEY variable and the True result connection is used. $KEY should be entered in the mailbox field of the following action. This method allows a Dial by Name action to be used to set the destination for a following action such as Get Mail, Leave Mail, Listen, etc.

   For an example of the action in a call flow, see Example Call Flow: Dial by Name.
5.7.7.8 Conferencing Center

The Conferencing Center action is used in conjunction with the Avaya IP Office Conferencing Center if installed. It provides a route for callers to enter the conference ID and their conference PIN code.

To add a Conferencing Center action:

1. Click the Telephony Actions icon and select Conferencing Center.
2. Select the Specific tab.

![Specific tab]

- If the caller is to be asked for conference ID and then the PIN, check the option Gather conference and pin information before validation. The results are collected and then verified. If either entry is invalid the caller is notified but not told which entry is incorrect. If this option is not selected then the entries are validated as they are entered.

- The number of times that a conference ID can be entered is controlled by the option Allow the delegate to try and enter the conference ID a total of. Up to 10 re-tries can be allowed. If the ID is entered incorrectly the result failure is returned.

The action also provides a number of results which act as failure options if conference access is unsuccessful. These are Invalid Conference or Password, Conference Not Started, Conference Finished, Conference Full, and Failure.

<table>
<thead>
<tr>
<th>Conference Center</th>
<th>Invalid Conference or Password</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conference Not Started</td>
<td></td>
</tr>
<tr>
<td>Conference Finished</td>
<td></td>
</tr>
<tr>
<td>Conference Full</td>
<td></td>
</tr>
<tr>
<td>Failure</td>
<td></td>
</tr>
</tbody>
</table>
5.7.7.9 Assisted Transfer

The Assisted Transfer action transfers the caller to the specified number which can include IP Office short codes. The caller hears either silence or music on hold if installed. The transfer is not blind, if the call receives busy or no answer then it returns to follow the appropriate connection.

- For Voicemail Pro 4.1+, the Transfer and Assisted Transfer actions can use the Notify caller of transfer to target option on the actions Entry Prompts tab.

To add an Assisted Transfer action:

1. Click the Telephony Actions icon and select Assisted Transfer.
2. Select the Specific tab.

- **Destination**
  Enter the number of the destination for the transfer. This can include IP Office short codes or numbers specified by the current value of a Voicemail Pro system variable such as $KEY.

- **Source of transfer (displayed on phone)**
  The number to display on the destination phone if internal.

- **Description (displayed on phone)**
  The text description to display on the destination phone if internal.

- **No answer timeout**
  Sets how long in seconds the voicemail server should wait for the transferred call to be answered before following the No Answer results connection.

- **Notify caller of transfer to target: Voicemail Pro 4.1+**
  If enabled, the caller hears “Transferring to” followed by the associated mailbox name of the destination if available or otherwise the destination number. This follows any prompts selected in the Entry Prompts list above.
Using the Voicemail Pro Client: Voicemail Pro Actions

Results

The action has several possible results, used if the call is not answered at the transfer destination.

MS-CRM Call Data Tagging

Call Data Tags enable advanced scenarios to be built around your Microsoft CRM 3.0 and Avaya Microsoft CRM Integration Solution. In situations where CLI/ANI matching is not sufficient, you can add screening and specific data collection interactions with your customers using the Voicemail Pro. The Voicemail Pro assisted transfer action can be used to pass data to users and pop matching records based on that data.

Based on your solutions requirements, you could obtain and verify the data collected, and then transfer the call with a data tag, that will utilize your specific criteria to lookup the required, account, contact or case, once the call is offered.

The tags are conformant xml fragments, they are comprised of an element `AV_M` and two attributes the Microsoft CRM entity (account, contact or incident) and the schema name of the field to match on, in this example ‘contactid’ and the data is the record key.

For example:

- `<AV_M O="contact" S="contactid">{e44e6dbf-bd2a-da11-badb-505054503030}</AV_M>

where

- `<AV_M` = element name.
- `O="contact"` = crm entity.
- `S="contactid"` = attribute to search on.
- `>` = end of element attributes
- `{e44e6dbf-bd2a-da11-badb-505054503030}` = the data to match on, this should be unique.
- `</AV_M>` - Closing tag.

The xml element name, attributes names and Microsoft CRM entity and schema names are case sensitive.

Additional Examples

- Account – Account Number: `<AV_M O="account" S="accountnumber">TL00001</AV_M>

- Case – Ticket Number: `<AV_M O="incident" S="ticketnumber">CAS-01001</AV_M>`
The Alphanumeric action allows the caller to input text and numeric values directly from the telephone keypad with ITU standard alphabet markings. The action following the DTMF Data result can use $KEY to access the alphanumeric characters.

Users enter data by pressing the key marked with the character required. For keys with multiple marking several key presses are required. For example, to enter C the user must press the 2 key three times. After each key press, the associated letter or number is spoken.

To move on to entering the next character, the user should press whichever other key is marked with the required character or first press # if the required character is on the key just used.

Controls available are:

#  - Accept last character and begin entry of next character if the required character is on the key just used.
*1  - Hear characters entered so far.
*2  - Delete all characters entered so far.
*3  - Delete last character entered.
*#  - Accept the set of characters entered and go to next call flow action.
To add an Alphanumeric action:

1. Click the **Telephony Actions** icon and select **Alphanumeric**.
2. Select the **Specific** tab.

   - Check the option **Play Help** if you want instruction to be given to the caller explaining how to enter information.
   - If you want to use a timeout result from the action, check the option **Wait for a key press for up to** and set the number of seconds for the timeout period.

The Alphanumeric Collection action has three results that can be connected to relevant actions.

- **Timeout**
  This result connection is used if no key press occurs within the period specified by the action. If the option **Wait for a key press for up to** in the Specific tab is not selected the Timeout result is not available.

- **DTMF Data**
  This result connection is used if the caller enters some data (ending each character with #) and then presses *#.

- **No DTMF Data**
  This result connection is used if the caller presses *# without entering any data.

For an example of the action being used in a call flow, see **Example Call Flow for Mobile Twinning**.
5.7.8 Miscellaneous Actions

5.7.8.1 eMail

The eMail action is used to send a recording to a specific email address.

To add an eMail action:

1. Click the Miscellaneous Actions icon and select eMail.
2. Select the Specific tab. Complete the fields with relevant details.

- **Send e-mail to** field, type the email address of the recipient.
- **Subject** field, type the subject line for the email.
- **Content** field, type the text to be placed in the email.
- **Attach file to email** field, the recorded file to be attached to the email needs to be selected. If just $ is entered then the action will use the recording collected by a preceding Leave Mail action or Voice Question action. For more information, see Leave Mail Action and Voice Question Action.

NB Path is assumed to be on the Voicemail Server

Connect the result Next to a relevant action.
5.7.8.2 Open Door

The Open Door action activates either of the door entry relays provided on the IP Office Control Unit.

To add a Open Door action:

1. Click the Miscellaneous Actions icon and select Open Door.
2. In the Specific tab, check either of the two door relay options.

Connect the result Next to a relevant action.
5.7.8.3 Alarm Set

The Alarm Set action prompts the caller to specify the time at which they want an alarm call and to record a message for the alarm call. The voicemail server will then call the user at that time. A user can set up multiple alarms to occur at different times. Once an alarm has occurred it is deleted.

To add an Alarm Set action:

1. Click the **Miscellaneous Actions** icon and select **Alarm Set**.
2. You need to record a message for the alarm call in the **Entry Prompts** tab.

   ![Alarm Set](image)

   Connect the result Next to a relevant action.

5.7.8.4 Clock

The Clock action plays the current time on the Voicemail Server PC. A short code can then be used to have this action replace users making external calls to a 'speaking clock' service.

To add a Clock action:

1. Click the **Miscellaneous Actions** icon and select **Clock**.

   ![Clock](image)

   Connect the result **Next** to a relevant action.
5.7.8.5 Post Dial

The Post Dial action can be used to connect another extension to a specified call flow start point or to play a recording to that extension.

To add a Post Dial action:

1. Click the Miscellaneous Actions icon and select Post Dial.
2. In the Specific tab, complete the fields with relevant details.

- **Post wave file**
  Plays a selected wav file. When Post wave file is selected there are two options which can be selected.
  - **Play out a looped wave file**
    The wav file will be played in a continuous loop.
  - **Delete the wave file after completion**
    The wav file will be deleted after it has been played.

- **Post the following action**
  Enter the name of the required start point or use the browse button to select the start point. To play a recording, enter `c:\mywavs\hello.wav` (substitute the appropriate file path and file name for the .wav file you want played).

- **To extension**
  Enter or select the extension to which the call should be made. The voicemail server will attempt to make the call every 5 minutes for the next hour until successful.

- **Page Calls**
  The Post Dial action can be used to page a .wav file to an extension number, including group extension numbers. This is done by entering `PAGE:` followed by the target extension number. In this case the wav file will not loop if selected.

Connect the result **Next** to a relevant action.
5.7.8.6 VB Script

The VB Script action allows an administrator to construct additional call flow logic using VBScript commands. A number of predefined methods and system variables are available. Any scripting added can be verified by pressing the Syntax Check button. Details of the properties and methods supported are given in the VBScript section. For more information, see VBScript Properties:Overview.

- Use of VBScript requires entry of a valid VM Pro VBScript license in the IP Office configuration.

To add a VB Script action:

1. Click the Miscellaneous Actions icon and select VB Script.
2. Select the Specific tab.

- Enter VBScript
  In the Script area enter the VBScript as required. Details of the System variables and COM methods that are supported are accessible by right clicking in the VBScript area. This script can contain a maximum of 1000 characters.

- Expand
  Check Expand to view a larger script area.

- Syntax Check
  Click the Syntax Check button to check your input for any errors.

This action has two results for which connections to following actions can be made. The results are based on the Scripting entered in the Specific tab.
5.7.8.7 Remote Call Flow

The Remote Call Flow action allows a call flow, in the form of a .vmp file, developed elsewhere to be included in an existing call flow. The aim of this action is to allow call flows developed by other applications, such as the IP Office Wizard, to be placed on the Voicemail Pro server and included in its customized call flows.

To add a Remote Call Flow action:

1. Click the **Miscellaneous Actions** icon and select **Remote Call Flow**.

2. In the **Specific** tab, the field **Remote Call Flow** will show a list of remote call flow files downloaded to the Voicemail Pro server.

   ![Remote Call Flow](image)

   The Remote Call Flow action has no results. Any follow on call handling is determined by the actions in the remote call flow.
5.7.9 Condition Actions
5.7.9.1 Test Condition

The Test Condition action has following connections for true and false. Conditions are set through the Conditions Editor. For more information, see The Condition Editor:Overview.

To add a Test Condition action:

- Click the Conditions Actions icon and select Test Condition.
- In the Specific tab, complete the fields with relevant details.

![Test Condition action settings](image)

- **Return the results of the following condition**
  Allows a selection to be made from the conditions currently setup.

  ![Test Condition options](image)

Enter the connections for the results. For examples of the Test Condition action in a call flow, see:

- Customizing a Hunt Group Call Flow
- User Defined Variables
The Set User Variable action sets a variable to a particular value. Other call flows may then use the Test User Variable action to check whether the variable has a particular value.

- The variable must first be created using the User Defined Variable menu.

To add an Set User Variable action:

- Click the Conditions Actions icon and select Set User Variable.
- Select the Specific tab. Complete the fields with relevant details.

- **Assign the following user variable**
  The name for the user variable.

- **With the following value**
  The value of the variable.

We strongly recommend that this action type is followed by another action (if necessary a Disconnect action), whose entry prompt confirms to the caller that the value has been set. In some situations, such as where the Set User Variable action is accessed by the user dialing a short code, if the user hangs-up too quickly the variable may not actually be set. Having a following action with a confirmation message encourages users not to hang up too quickly.

For an example of the action in a call flow, see User Defined Variables.
5.7.9.3 Test User Variable

The Test User Variable action has true and false connections that are followed according to whether a user variable matches a particular value. The Set User Variable action can be used in other calls to set the value of the variable.

To add a Test User Variable action:

1. Click the Conditions Actions icon and select Test User Variable.
2. In the Specific tab, complete the fields with relevant details.

- **This action will return "TRUE" if the following variable**
  The name of the user variable to be checked.

- **Matches the value below**
  The value of the variable that will return a true result.

This action has two results for which connections to following actions can be made. For an example of the action in a call flow, see User Defined Variables.
5.7.9.4 Test Variable

For Voicemail Pro 4.2+, the Test Variable action has been added and replaces the previous Check Digits action. It allows calls to be routed based on matching the value of a system variable to a specified value.

To add a Test Variable action:

1. Click the Conditions Actions icon and select Test Variable.

Settings

The following controls are available on the Specific tab of this action.

- **Select the variable to Match**
  This drop-down list is used to select which Voicemail Pro system variable should be checked for a match. Note that with $KEY the timeout is used and additional dialing is accepted if no immediate match occurs.

- **Select the parameter(s) to test the variable against**
  Select the types of values that should be checked for a match and if necessary entry the value. If several options are selected, the Voicemail Pro check for a match starting from the top and working down until a match occurs.

  - **Variable**
    Check for a match against the value of another selected system variable.

  - **Specific**
    Check for a match against the value entered in the adjacent field.

  - **Extn**
    Check for a match against valid extensions on the IP Office.

  - **Hunt Group**
    Check for a match against hunt group extension numbers.

  - **Mailbox**
    Check for a match against mailboxes.

- **Timeout after**
  The timeout value is used only if $KEY is selected as the variable to match. In that case, if no immediate match occurs on the existing value of $KEY, the Voicemail Pro will wait for the specified timeout period for the caller to dial a new value of $KEY.
The action will have results for connection to following actions in the call flow based on the selected option on the Specific tab plus the following:

- **No Match**
  This result is used if no match is found.

- **Timeout**
  This result is used when $KEY is specified as the variable to match and no match occurs within the specified timeout period.
5.7.10 Database Actions

5.7.10.1 Database Open

The Database Open action opens a link to a third party database. If connection to the database succeeds, the result is OK, otherwise the result is FAIL. If there is a connection to the database already then the current connection is closed and the new one requested will be opened.

To add a Database Open action:

1. Click the Database Actions icon and select Database Open.
2. Select the Specific tab. The connection string to open the database can be entered directly into the field. For help on constructing the connection string, click the Data Link Properties window opens.
   - Provider Tab
     Select the OLE DB Provider of the data that is to be connected to. Click Next to move to the Connection Tab.
   - Connection Tab
     Specific information relating the Database provider needs to be completed. Help of the information required for each of the fields can be obtained by clicking the Help button. Fields available will be dependant on the type of provider. Test that the information entered will allow entry into the database, click the Test Connection button. A message TestConnection Succeeded will show if successfully connected to the database.
   - Advanced Tab
     Network Settings & other settings e.g. Access permissions. Fields showing will be dependant on the type of provider selected. Click help for specific information about any of the fields.
   - All
     The properties that have been selected on the previous tabs are shown in the All Tab. Amendments can be made as required by selecting the Name and click Edit Value.

The Database Open action results can only be Success or Failure. Add connections to relevant actions. For an example of the action in a call flow, see IVR Database Connection Example, Retrieving Data From the Database.

5.7.10.2 Database Execute

The Database Execute action performs an SQL query on a database opened on a preceding Database Open action. An SQL query that is generated by the Database Execute Action does not support spaces in field or table names. To avoid problems in a Microsoft Access database, it is advisable to avoid using a field name that has the same name as its field type. For example, you should avoid using the name Number for a number field.

To add a Database Execute action:

1. Click the Database Actions icon and select Database Execute.
2. Select the Specific tab. The SQL Wizard window opens. Use the wizard to construct the SQL query.

The Database Execute action results can only be Success or Failure. Add connections to relevant actions. For an example of the action in a call flow, see IVR Database Connection Example, Retrieving Data From the Database and Entering Details in to the Database.
5.7.10.3 Database Get Data

Once a query has been made against a database (see Database Execute Action), either a single result or a set of results are returned. The Database Get Data action will allow access to the data items if a set of results are returned.

**To add a Database Get Data action:**

1. Click the Database Actions icon and select Database Get Data.
2. Select the Specific tab. Select the way to retrieve the data.

   - **Retrieve the next item in the list**
     Allows the call flow to facilitate the stepping through of a list of results returned by the Database Execute action.

   - **Retrieve the previous item in the list**
     Allows the call flow to facilitate the stepping through of a list of results returned by the Database Execute action.

   - **Retrieve the first item in the list**
     Allows the call flow to facilitate jumping to the start of the list therefore returning all the items in the list.

   - **Retrieve the last item in the list**
     Allows the call flow to facilitate jumping to the end of the list therefore returning all the items in the list.

The Database Get Data action has four results.

- **Success**
  The current record has successfully been assigned to the $DBD variable.

- **At End**
  You have reached the end of the list, the $DBD variable contains no information.

- **Empty**
  The execute method returned no data, the $DBD variable contains no information.

- **Failure**
  There was a problem trying to retrieve the next data record, the $DBD variable contains no information.

Examples of using the database actions are given in the IVR database Connection section. For an example of the action in a call flow, see IVR Database Connection Example, Retrieving Data From the Database.

5.7.10.4 Database Close

The Database Close action will close the current database connection. If the database is open when a call terminates then a Database Close action is run automatically.

**To add a Database Close action:**

1. Click the Database Actions icon and select Database Close.
2. There is no specific tab.

The Database Close action results can only be Success or Failure. Add connections to relevant actions.
5.7.11 Queue Actions

5.7.11.1 Queue ETA

The Queue ETA action plays the estimated time to answer (ETA) in minutes to a queued caller. The ETA is calculated based on the queued time in the previous hour of the last 5 queued and answered calls. The ETA is always rounded up to the nearest minute. For an example, see Customizing Queuing.

The ETA is calculated and supplied by the IP Office when it requests a queue or still queued message is played to a caller.

- **In Incoming Call Route ‘Priority’**
  - The IP Office supports a configurable Priority setting (1, 2 or 3) on Incoming Call Routes. Calls assigned a high priority are moved up any call queue ahead of those with a lower priority. The use of this feature is not compatible with Queue ETA and Queue Position messages as the spoken queue positions and ETA are for some callers may be overridden by calls with a higher priority.
  - The IP Office Manager option **Synchronize calls to announcements** should not be used when using actions other than just playing prompts.

**To add a Queue ETA action:**

1. Click the **Queue Actions** icon and select **Queue ETA**.
2. Select the **Specific** tab. This tab may include any further prompts to be played to the caller after they hear their ETA.

   - **Queue (estimated time to answer)**
     - The prompts will be played in the following order:
       1. Any items defined in the Entry Prompt page
       2. The estimated time of answer
       3. Any prompts defined below

   - **Order** | **Prompt** | **Length (s)**
     - 1 | Other Way | 0.0

3. The **Entry Prompts** tab should include any prompts to play to the caller before they hear their ETA. For more information, see **Entry Prompts Tab**.

   - Connect the result Next to a relevant action.
5.7.11.2 Queue Position

The Queue Position action plays the caller their position within the queue of calls for the group. The queue position is supplied by the IP Office when it requests a queue or still queued message is played to a caller.

- **In Incoming Call Route 'Priority'**

The IP Office supports a configurable Priority setting (1, 2 or 3) on Incoming Call Routes. Calls assigned a high priority are moved up any call queue ahead of those with a lower priority. The use of this feature is not compatible with Queue ETA and Queue Position messages as the spoken queue positions and ETA are for some callers may be overridden by calls with a higher priority.

- The IP Office Manager option **Synchronize calls to announcements** should not be used when using actions other than just playing prompts.

**To add a Queue ETA action:**

1. Click the **Queue Actions** icon and select **Queue Position**.
2. The **Entry Prompts** tab should include any prompts to play to the caller before they hear their position. For more information, see Entry Prompts Tab.
3. Select the **Specific** tab. This tab may include any further prompts to be played to the caller after they hear their position.

The prompts will be played in the following order:

1. Any items defined in the Entry Prompt page
2. The current position
3. Any prompts defined below

Connect the result Next to a relevant action. For an example of the Queue Position action in a call flow, see Customizing a Hunt Group Callflow.
5.8 System Variables

A number of system variables exist which can be used to perform tasks. For example, $NAM can be used to speak the user’s name within an action’s entry prompt. System variables can also be checked by the compare element in a condition and then branch the call flow according to the variables value.

Unless otherwise stated, variables are session based. This means that the data is specific to a particular call within Voicemail Pro and does not persist between calls, including calls transferred from the Voicemail Pro which then return. Also unless otherwise stated the values are ‘read-only’.

Speaking Variables to Callers
System variables can be entered in the place of a wav file name in the Wav Editor. The value of the system variable will then be spoken. This applies to $NAM, $POS and $QTIM in queuing call flows and to any variable that contains numeric values. Numbers are spoken as a series of single digits, for example 123 is spoken as "one two three". To speak 123 as "one hundred and twenty-three" requires TTS to be installed and a Speak Text action used.

Some system variables can be played as prompts, for example:

- $NAM - Plays the user name.
- $CLI - Speaks the caller's CLI.
- $RES - Plays the current result if it is a .wav file.
- $VAR - Plays the variable as a list of digits.

Variable Length
The length of the value stored within a variable is limited. For Voicemail Pro 4.2+ this limit has been increased from 64 characters to 512 characters.
Available Variables

- $CLI
  Holds the CLI of the caller if available.

- $CP
  The 16 variables $CP0 to $CP15 are used to store values (call parameters) for the duration of a call within the call flow. Values can be written into these variables using the Generic action command CPx:<value> where x is 0 to 15 and <value> is the value to be stored.

- $DBD
  A set of 6 system variables $DBD[0] to $DBD[5]. These represent the fields of the currently selected database record in a call flow where database actions are being used.

- $DDI: IP Office 4.1+ and Voicemail Pro 4.1+.
  Holds the DDI of the call if available.

- $ETA
  Holds the expected time to answer in seconds for a queued caller. This time is based on the last 5 queued and answered calls for the same target in the last hour. The variable can be used to speak the value as a prompt or to test the value in a condition. Only available when using Queued and Still Queued start points.

- $KEY
  Holds the last DTMF key series entered. For more information, see Example Call Flow.

- $LOC
  Holds the current locale setting of the IP Office system or the user if different. For more information, see Changing the Language of Custom Prompts.

- $NAM
  Holds the name of the mailbox user (blank for short codes).

- $RES
  Holds the value of the result of the previous action. For example when a call flow has been branched by an action that has True and False results, on one branch the value of $RES is "True", on the other "False".

- $POS
  Holds the position of a queued caller. Can be used to speak the position as a prompt or test the value in a condition. Only available when using Queued and Still Queued start points.

- $QTIM
  The same as the $ETA above but returns the estimated time to answer rounded up to the nearest minute. This variable can be used to speak the value as a prompt or to test the value in a condition.

- $SAV
  Holds the last saved result. This can be entered using the following entry in a Generic action, Save:<value>, for example Save:$KEY or Save:1234.

- $TARGET: Voicemail Pro 4.2+.
  This variable contains the original target of a call received by the IP Office system, eg. the destination set by the IP Office’s incoming call route.

- $TimeQueued: IP Office 4.1+ and Voicemail Pro 4.1+.
  Holds the length of time, in seconds, that the call has been part of a particular hunt group queue. Only available when using Queued and Still Queued start points.

  Holds the length of time, in seconds, since the call was presented to the IP Office system. Only available when using Queued and Still Queued start points.

- $UUI
  Available when a recording is triggered by auto-recording. Holds the user name, hunt group name or account code that triggered the auto-recording process. For more information, see Customizing Auto Recording.

- $VAR
  A general variable which can hold amongst other things DTMF key sequences.
5.8.1 User Defined Variables

You can create user variables, the value of which can be set using a Set User Variable action within a call flow. For more information, see Set User Variable Action. The options presented to a caller can also be branched using a Test User Variable action to check the current value of the variable. For more information, see Test User Variable Action.

To add a user defined variable:

1. Click or press F8. The User defined variables window opens.

2. Click . The Add user defined variable window opens.

3. Type a name for your new variable.

4. Click OK. The new variable is added to the list.
Example:

1. Add a variable called **Reception**.

2. Two start points need to be created, one for indicating when the reception is open, the other for when the reception is closed. When completed the call flows will look similar to the examples shown.
   - Create a start point called **ReceptionOpen** and connect it to a **Set User Variable** action. The Set User Variable action needs to have the user variable Reception assigned with the value Open.

   ![ReceptionOpen Diagram](image)

   3. Create a start point called **ReceptionClosed** and connect it to a **Set User Variable** action. The Set User Variable action needs to have the user variable Reception assigned with the value Closed.

   ![ReceptionClosed Diagram](image)

   4. Create the matching short codes on the telephone system.

   5. For calls using another start point, you can now use the **Test User Variable** action to test whether the value of **reception** is **open**. The action has **true** and **false** results which you can link to the appropriate following actions, for example transferring calls to the reception desk or to a mailbox.

   ![OpenHours Diagram](image)
5.9 Creating Modules

Modules are reusable sets of actions. They allow you to create a sequence of actions that can be reused in another call flow.

Any changes to a module will affect all other start points that are using that module. This simplifies the programming of actions if a number of start points use the same sequence of actions. Using modules also reduces the size of a call flow.

- To create connections from a module to other actions you must use the Module Return action within the module, see Module Return Action.

To create a module:

1. Click Modules and then . The Adding a new start point window opens.
   - Alternatively, right-click Modules and select Add.
2. Enter a name for the module. This should not match any user or group name on the IP Office.
3. Click OK. You can now add actions and connections to the module in the same way as for any start point.

To add a module to a start point:

1. Select the start point to which you want to add the module action and then click the right-hand panel.
2. Click and drag the module required from the Navigation pane to the Details pane.

For support calls and diagnostic purposes it can be useful to view Voicemail Pro modules and start points as text files. For more information, see Viewing Call Flows as Text.

5.9.1 Running a Module

Modules can be run internally using short codes or can be configured for external calls.

Run a module from a short code

You can use modules directly in conjunction with short codes. The short code must call the name of the module. This example short code will run the module called Special when a user dials *97. The service that the user receives will depend on the actions in the module.

- **Short code:** For example *97
- **Telephone Number:** "Special" (include quotation marks)
- **Line Group ID:** 0
- **Feature:** Voicemail Collect

Run a module for an external call

A module can be applied directly to an incoming (external) call from within the IP Office Manager application. Within the appropriate IncomingCallRoute entry, set the Destination to the module name prefixed with "VM:"

For example, enter VM:AutoAttend to route a call to a module called AutoAttend. Note that the maximum entry length is 15 characters. This means that the module name is limited to 12 characters.

- If there is a hunt group on the system whose name matches the module name, calls will be routed to that group when the voicemail server is not running.
5.10 The Conditions Editor

Conditions are constructed from a set of basic elements. These elements can be combined within a single condition to create complex rules. For example, the week planner can be used to define a company’s standard working hours, and then combined with the calendar to define exception days such as public holidays.

Within the voicemail call flow, conditions can be checked by a test condition action and, according to whether the condition is currently true or false, callers can be routed to different actions. For more information, see Test Condition Action.

Logic settings can be applied to both the whole condition and to the elements in a condition. These can alter when a condition is true or false.

- **AND**
  The condition is true when all the elements are true, for example both A and B are true.

- **OR**
  The condition is true when either element is true, for example if the day is Monday or Tuesday.

- **NOT**
  This logic element can be used to reverse the value (e.g. return false when true) of individual elements or of the whole condition.
5.10.1 Using the Condition Editor

You can add elements to existing conditions, change the logic of a condition and delete elements and conditions.

To start the Condition Editor:

1. Click the icon. You can also open the Condition Editor by pressing F6 or click Administration > Condition Editor.
2. When the Condition Editor is started, any existing conditions are shown. In the example there are no conditions.

To add a new condition:

1. Click the icon in the toolbar. The New Condition window opens.
2. Enter the name for the condition and then click OK.
3. The new condition is placed in the Condition Editor window. The condition is represented by the icon followed by the condition name.
When a condition has been created, elements can be added and altered. A condition can consist of multiple elements, including several elements of the same type. In the example there are conditions added complete with elements.

To add elements to a condition:

1. Click the **Element List** icon in the toolbar.
2. Click the type of element required.
   - **Calendar** - For more information, see Calendar.
   - **Week Planner** - For more information, see Week Planner.
   - **Compare** - For more information, see Compare.
   - **Condition** - For more information, see Condition.
3. Click **Condition Name** in the Condition Editor window. The element icon is added.
4. You can now edit the element's settings.

To edit elements:

1. Select the element, click **Edit** icon in the toolbar. The element’s properties window opens.
   Alternatively, double click the element to open the properties window.
2. Make any changes.
3. Click **OK** to save the changes and close the properties window.
To change the logic setting of a condition:
1. Click  Logic icon in the toolbar.
2. Select the required logic.
   - x|| (OR)
   - x+ (AND)
   - x! (NOT).
3. In the Condition Editor window, click the element to apply the logic to. The logic indicator changes.

By default the logical x+ (AND) setting is applied to new condition elements. For the week planner and calendar elements, if more than one day is set this will never return true. Therefore we recommend that the x|| (OR) logical setting is applied to all week planner and calendar elements.

To change the name of a condition:
1. Select the condition, click Edit icon in the toolbar. The Rename condition window opens.
2. Amend the condition's name.
3. Click OK.

To delete elements and conditions:
1. Select the condition or element to be deleted.
2. Click icon in the toolbar. The selected condition or element is deleted.
5.10.2 Calendar

The Calendar element is used to indicate which days of the year return true. Double-click a day to select or deselect the day.

Selected days are shown with a shaded background, e.g. 17. Note that 22 indicates weekend days but not whether the day is selected. The element returns 'true' if the current day is a selected day.

- **Apply Logical OR X|| if more than one day selected**

By default the logical **AND X=** is applied to this condition element. If more than one day is selected then element cannot return true. For example it cannot be the 3rd March and the 4th March at the same time. When multiple days are selected the **OR X||** settings should be applied. In our example the element will then be true if it is the 3rd March or 4th March.

**To add a calendar element:**

1. Click the **Element List** icon in the toolbar.
2. Click **Calendar**.

**Example:**
The conditions for a call flow can be altered so that calendar dates such as public holidays can be accounted for.

1. Click the **Conditions Editor** icon. The Conditions Editor window opens.
2. Click the **New Condition** icon in the toolbar. The New Condition window opens.
3. Type a name for the new condition.
4. Click **OK**. The icon **Condition Name** is placed in the Condition Editor window.
5. Click the **Elements** icon. Select **Calendar**.
6. Click **Holidays** in the Condition Editor window. The Calendar icon is added.
7. Double-click the **Calendar** to open the Calendar window.
8. To set a date as being a holiday, double-click the date. If the date chosen is the 17th, the date will be highlighted, similar to 17 indicating it as a holiday.
9. Click **OK**. The condition can be added to a Test Condition action. For more information, see **Test Condition Action**.
5.10.3 Week Planner

The **Week Planner** element is used to set which time periods during a normal week return 'true'. It consists of an entry for each day of the week and a start and end time for the 'true' period on each day.

- **Apply Logical OR X|| if more than one day selected**

By default the logical **AND X=** is applied to this condition element. If more than one day is selected then element cannot return true. For example it cannot be the Monday and Tuesday at the same time. When multiple days are selected the **OR X||** settings should be applied. In our example the element will then be true if it is Monday or Tuesday.

To add a Week Planner element:

1. Click the ![Element List](image) icon in the toolbar.
2. Click ![Week Planner](image).

**Example:**
The conditions for a call flow can be altered so that calls received between 09:00 and 18:00, Monday to Friday are treated differently to calls received outside of these hours.

1. Click the ![Conditions Editor](image) icon. The Conditions Editor window opens.
2. Click the ![New Condition](image) icon in the toolbar. The New Condition window opens.
3. Type a name for the new condition.
4. Click **OK**. The icon ![Condition Name](image) is placed in the Condition Editor window.
5. Click the ![Elements](image) icon, select ![Week Planner](image).
6. Click ![Condition Name](image) in the Condition Editor window. The Week Planner icon is added.
7. Double-click the ![Week Planner](image) to open the Week Planner window.
8. Check the days **Monday** through to **Friday**. The start and end times for the days do not need to be changed.
9. Click **OK**. The symbol ![before the condition Week Planner indicates the logic 'AND' is used. Working hours are Monday or Tuesday or ... or Friday so the logic needs to be changed to 'OR'.

   - Click the ![Logic](image) icon in the toolbar, select ![OR](image).
   - Click the condition ![Week Planner](image) in the Condition Editor window. The logic setting to is changed to ![representing the logic 'OR'.
10. Click **OK**. The condition can be added to a Test Condition action. For more information, see [Test Condition Action](image).
5.10.4 Condition

The **Condition** element is used to combine the value of an already existing condition. For example, using the week planner a working week is created, the week being 09:00 to 18:00, Monday to Friday every week. The condition element can be used to alter the condition so that we can account for calendar dates such as public holidays by combining the week planner element and the calendar element.

When selected the element displays a list of the other conditions from which to select.

**To add a condition element:**

1. Click the **Element List** icon in the toolbar.
2. Click **Condition**.
3. Click the condition in the Condition Editor window.
4. Open the properties of the condition element by double-clicking.
5. Select the condition result that you want to include.
6. Click **OK**.

**Example:**

Two conditions have been created:

- Using the week planner element a condition is created so that calls received between 09:00 and 18:00, Monday to Friday are treated differently to calls received outside of these hours. For more information, see the example for the **Week Planner condition element**.
- Using the Calendar element a condition is created so that calendar dates such as public holidays can be accounted for. For more information, see the example for the **Calendar condition element**.

The two conditions need to be combined so that the call flow treats calls during working hours differently to calls received outside working hours and on bank holidays.

1. Click the **Element List** icon in the toolbar.
2. Click **Condition**.
3. Click the Week Planner in the Condition Editor window. The condition is placed in the Condition Editor window.
4. Open the properties of the condition element by double-clicking.
5. Select the Calendar condition result.
6. Click **logic options and select a NOT action. Click Condition to apply the logical option.**
7. Click **OK**. The condition is now true when it is between 09:00 and 18:00, Monday to Friday and not a holiday.

5.10.5 Compare

The **Compare** element is used to add a variable that will be used to determine the call flow to be presented to the caller. You can compare Voicemail Pro system variables, for example $POS or $ETA, against each other or against a value you enter.
Chapter 6.
Prompts
6. Prompts
6.1 US English Intuity Prompts

The following is a list of the numbered .wav files used by Voicemail Pro for US English. These are predominately, though not exclusively, used for Intuity mailbox features.

All files are Microsoft WAVE file format (.wav) 8kHz, 16 bit mono.

**Important**
- It is important to note that the corresponding .wav file in other languages is not the same prompt.

<table>
<thead>
<tr>
<th>WAV File</th>
<th>Intuity Prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>&quot;at&quot;.</td>
</tr>
<tr>
<td>4</td>
<td>&quot;Not private&quot;.</td>
</tr>
<tr>
<td>8</td>
<td>&quot;To record a new message press 4&quot;.</td>
</tr>
<tr>
<td>13</td>
<td>&quot;To record press 1 after recording press 1 again&quot;.</td>
</tr>
<tr>
<td>14</td>
<td>&quot;To make private press 1, to make public press 2&quot;.</td>
</tr>
<tr>
<td>15</td>
<td>&quot;And is&quot;.</td>
</tr>
<tr>
<td>18</td>
<td>&quot;To forward with comment press 2&quot;.</td>
</tr>
<tr>
<td>19</td>
<td>&quot;To review from beginning press *1, if finished press *#&quot;.</td>
</tr>
<tr>
<td>21</td>
<td>&quot;To listen press 0&quot;.</td>
</tr>
<tr>
<td>24</td>
<td>&quot;To delete press *D&quot;.</td>
</tr>
<tr>
<td>27</td>
<td>&quot;To attach original, press y for yes or n for no.&quot;.</td>
</tr>
<tr>
<td>30</td>
<td>&quot;To change press 1&quot;.</td>
</tr>
<tr>
<td>35</td>
<td>&quot;Login incorrect&quot;.</td>
</tr>
<tr>
<td>41</td>
<td>&quot;To forward message with comment at beginning, press 2&quot;.</td>
</tr>
<tr>
<td>43</td>
<td>&quot;Your call is being answered by IP Office&quot;.</td>
</tr>
<tr>
<td>44</td>
<td>&quot;Is not available to leave a message wait for the tone&quot;.</td>
</tr>
<tr>
<td>45</td>
<td>&quot;Is busy, to leave a message wait for the tone&quot;.</td>
</tr>
<tr>
<td>46</td>
<td>&quot;To access your mailbox press *R&quot;.</td>
</tr>
<tr>
<td>49</td>
<td>&quot;No operator defined&quot;.</td>
</tr>
<tr>
<td>56</td>
<td>&quot;Thank you for leaving you message&quot;.</td>
</tr>
<tr>
<td>58</td>
<td>&quot;For name addressing press *A&quot;.</td>
</tr>
<tr>
<td>60</td>
<td>&quot;Changed&quot;.</td>
</tr>
<tr>
<td>61</td>
<td>&quot;To modify status, press 9 for yes, or 6 for no&quot;.</td>
</tr>
<tr>
<td>63</td>
<td>&quot;New&quot;.</td>
</tr>
<tr>
<td>65</td>
<td>&quot;Contains&quot;.</td>
</tr>
<tr>
<td>67</td>
<td>&quot;To create another list&quot;.</td>
</tr>
<tr>
<td>70</td>
<td>&quot;Unopened&quot;.</td>
</tr>
<tr>
<td>71</td>
<td>&quot;To leave a message wait for the tone&quot;.</td>
</tr>
<tr>
<td>73</td>
<td>&quot;You have&quot;.</td>
</tr>
<tr>
<td>74</td>
<td>&quot;Deleted&quot;.</td>
</tr>
<tr>
<td>75</td>
<td>&quot;To skip press # to delete press *D&quot;.</td>
</tr>
<tr>
<td>77</td>
<td>&quot;Deleted&quot;.</td>
</tr>
<tr>
<td>80</td>
<td>&quot;To have system wait press *W if finished please hang up or to disconnected IP Office press **X&quot;.</td>
</tr>
<tr>
<td>84</td>
<td>&quot;Entry&quot;.</td>
</tr>
<tr>
<td>85</td>
<td>&quot;Erased&quot;.</td>
</tr>
<tr>
<td>86</td>
<td>&quot;Extension&quot;.</td>
</tr>
<tr>
<td>87</td>
<td>&quot;This call is experiencing difficulties&quot;.</td>
</tr>
<tr>
<td>88</td>
<td>&quot;Cannot use the guest password&quot;.</td>
</tr>
<tr>
<td>89</td>
<td>&quot;First message&quot;.</td>
</tr>
<tr>
<td>91</td>
<td>&quot;At end&quot;.</td>
</tr>
<tr>
<td>94</td>
<td>&quot;Goodbye&quot;.</td>
</tr>
<tr>
<td>95</td>
<td>&quot;Please disconnect&quot;.</td>
</tr>
<tr>
<td>96</td>
<td>&quot;For help press *H&quot;.</td>
</tr>
<tr>
<td>97</td>
<td>&quot;For help at anytime press *H&quot;.</td>
</tr>
<tr>
<td>100</td>
<td>&quot;Invalid entry&quot;.</td>
</tr>
<tr>
<td>WAV File</td>
<td>Intuity Prompt</td>
</tr>
<tr>
<td>----------</td>
<td>----------------</td>
</tr>
<tr>
<td>105</td>
<td>&quot;To restart at the activity menu press *R&quot;.</td>
</tr>
<tr>
<td>108</td>
<td>&quot;You are recording a message&quot;.</td>
</tr>
<tr>
<td>109</td>
<td>&quot;Later&quot;.</td>
</tr>
<tr>
<td>110</td>
<td>&quot;List&quot;.</td>
</tr>
<tr>
<td>111</td>
<td>&quot;Please enter list ID&quot;.</td>
</tr>
<tr>
<td>112</td>
<td>&quot;Otherwise for assistance press Zero now&quot;.</td>
</tr>
<tr>
<td>113</td>
<td>&quot;You already have a list&quot;.</td>
</tr>
<tr>
<td>114</td>
<td>&quot;To replace list renter ID and # sign, to create a new list enter new list ID&quot;.</td>
</tr>
<tr>
<td>115</td>
<td>&quot;To transfer using names instead press *2&quot;.</td>
</tr>
<tr>
<td>117</td>
<td>&quot;To reach the covering extension press *Zero&quot;.</td>
</tr>
<tr>
<td>118</td>
<td>&quot;Enter last name&quot;.</td>
</tr>
<tr>
<td>119</td>
<td>&quot;You wish to call&quot;.</td>
</tr>
<tr>
<td>120</td>
<td>&quot;Too large to include&quot;.</td>
</tr>
<tr>
<td>124</td>
<td>&quot;No more list space&quot;.</td>
</tr>
<tr>
<td>125</td>
<td>&quot;Must be six or fewer numerals&quot;.</td>
</tr>
<tr>
<td>126</td>
<td>&quot;To forward message with comment at end press 3&quot;.</td>
</tr>
<tr>
<td>127</td>
<td>&quot;Return to previous activity&quot;.</td>
</tr>
<tr>
<td>130</td>
<td>&quot;Because there were no entries&quot;.</td>
</tr>
<tr>
<td>134</td>
<td>&quot;You can store your list or delete members but you cannot add members&quot;.</td>
</tr>
<tr>
<td>141</td>
<td>&quot;No more lists&quot;.</td>
</tr>
<tr>
<td>142</td>
<td>&quot;To list to the header press 3&quot;.</td>
</tr>
<tr>
<td>143</td>
<td>&quot;To set back again press 2&quot;.</td>
</tr>
<tr>
<td>145</td>
<td>&quot;List has no entries&quot;.</td>
</tr>
<tr>
<td>146</td>
<td>&quot;To continue press #&quot;.</td>
</tr>
<tr>
<td>147</td>
<td>&quot;Review completed&quot;.</td>
</tr>
<tr>
<td>148</td>
<td>&quot;For extension addressing press *2&quot;.</td>
</tr>
<tr>
<td>150</td>
<td>&quot;Members&quot;.</td>
</tr>
<tr>
<td>156</td>
<td>&quot;Maximum length recorded&quot;.</td>
</tr>
<tr>
<td>159</td>
<td>&quot;Member&quot;.</td>
</tr>
<tr>
<td>160</td>
<td>&quot;Message&quot;.</td>
</tr>
<tr>
<td>161</td>
<td>&quot;Midnight&quot;.</td>
</tr>
<tr>
<td>163</td>
<td>&quot;To call sender press zero&quot;.</td>
</tr>
<tr>
<td>164</td>
<td>&quot;Category&quot;.</td>
</tr>
<tr>
<td>165</td>
<td>&quot;Returned to getting messages&quot;.</td>
</tr>
<tr>
<td>166</td>
<td>&quot;At end to play back press 23&quot;.</td>
</tr>
<tr>
<td>167</td>
<td>&quot;To approve press #, to record from here press 1, to play back press 23&quot;.</td>
</tr>
<tr>
<td>168</td>
<td>&quot;Messages&quot;.</td>
</tr>
<tr>
<td>170</td>
<td>&quot;Delivery scheduled&quot;.</td>
</tr>
<tr>
<td>173</td>
<td>&quot;Please enter new password&quot;.</td>
</tr>
<tr>
<td>175</td>
<td>&quot;Please note only IP Office subscribers can be specified by name&quot;.</td>
</tr>
<tr>
<td>178</td>
<td>&quot;No addresses identified&quot;.</td>
</tr>
<tr>
<td>180</td>
<td>&quot;Nothing to approve&quot;.</td>
</tr>
<tr>
<td>182</td>
<td>&quot;Nothing to delete&quot;.</td>
</tr>
<tr>
<td>185</td>
<td>&quot;Not found&quot;.</td>
</tr>
<tr>
<td>188</td>
<td>&quot;Passwords do not match, please re-enter new password&quot;.</td>
</tr>
<tr>
<td>191</td>
<td>&quot;No more messages&quot;.</td>
</tr>
<tr>
<td>192</td>
<td>&quot;No messages&quot;.</td>
</tr>
<tr>
<td>193</td>
<td>&quot;No name recorded&quot;.</td>
</tr>
<tr>
<td>194</td>
<td>&quot;No new messages&quot;.</td>
</tr>
<tr>
<td>197</td>
<td>&quot;Cannot step back&quot;.</td>
</tr>
<tr>
<td>198</td>
<td>&quot;Partial name deleted&quot;.</td>
</tr>
<tr>
<td>201</td>
<td>&quot;Noon&quot;.</td>
</tr>
<tr>
<td>202</td>
<td>&quot;Not valid&quot;.</td>
</tr>
<tr>
<td>208</td>
<td>&quot;Is not a public list&quot;.</td>
</tr>
<tr>
<td>WAV File</td>
<td>Intuity Prompt</td>
</tr>
<tr>
<td>----------</td>
<td>----------------</td>
</tr>
<tr>
<td>209</td>
<td>&quot;Cannot modify another subscriber’s list&quot;.</td>
</tr>
<tr>
<td>210</td>
<td>&quot;Please enter a new password&quot;.</td>
</tr>
<tr>
<td>211</td>
<td>&quot;To 15 digits&quot;.</td>
</tr>
<tr>
<td>212</td>
<td>&quot;Please enter password again for confirmation, to delete the password you just entered press *D&quot;.</td>
</tr>
<tr>
<td>213</td>
<td>&quot;Re-enter password&quot;.</td>
</tr>
<tr>
<td>214</td>
<td>&quot;Approved&quot;.</td>
</tr>
<tr>
<td>215</td>
<td>&quot;Owned by&quot;.</td>
</tr>
<tr>
<td>216</td>
<td>&quot;Enter password&quot;.</td>
</tr>
<tr>
<td>217</td>
<td>&quot;Cannot modify another subscriber’s list&quot;.</td>
</tr>
<tr>
<td>218</td>
<td>&quot;Please enter a new password&quot;.</td>
</tr>
<tr>
<td>219</td>
<td>&quot;To 15 digits&quot;.</td>
</tr>
<tr>
<td>220</td>
<td>&quot;Please enter password again for confirmation, to delete the password you just entered press *D&quot;.</td>
</tr>
<tr>
<td>221</td>
<td>&quot;Re-enter password&quot;.</td>
</tr>
<tr>
<td>222</td>
<td>&quot;Approved&quot;.</td>
</tr>
<tr>
<td>223</td>
<td>&quot;Owned by&quot;.</td>
</tr>
<tr>
<td>224</td>
<td>&quot;Enter password&quot;.</td>
</tr>
<tr>
<td>225</td>
<td>&quot;Cannot enter extension&quot;.</td>
</tr>
<tr>
<td>226</td>
<td>&quot;And # sign&quot;.</td>
</tr>
<tr>
<td>227</td>
<td>&quot;Private&quot;.</td>
</tr>
<tr>
<td>228</td>
<td>&quot;Public&quot;.</td>
</tr>
<tr>
<td>229</td>
<td>&quot;Record at the tone&quot;.</td>
</tr>
<tr>
<td>230</td>
<td>&quot;Recording stopped&quot;.</td>
</tr>
<tr>
<td>231</td>
<td>&quot;Previous login incorrect please re-enter extension&quot;.</td>
</tr>
<tr>
<td>232</td>
<td>&quot;To respond or forward press 1&quot;.</td>
</tr>
<tr>
<td>233</td>
<td>&quot;To restart at the activity menu press *R, to transfer to another extension press *T&quot;.</td>
</tr>
<tr>
<td>234</td>
<td>&quot;Try again&quot;.</td>
</tr>
<tr>
<td>235</td>
<td>&quot;To review another list&quot;.</td>
</tr>
<tr>
<td>236</td>
<td>&quot;To skip press # to listen press zero&quot;.</td>
</tr>
<tr>
<td>237</td>
<td>&quot;Returned to the&quot;.</td>
</tr>
<tr>
<td>238</td>
<td>&quot;Rewound&quot;.</td>
</tr>
<tr>
<td>239</td>
<td>&quot;Rewound to previous message&quot;.</td>
</tr>
<tr>
<td>240</td>
<td>&quot;To respond to this message press 1&quot;.</td>
</tr>
<tr>
<td>241</td>
<td>&quot;Please enter month, day&quot;.</td>
</tr>
<tr>
<td>242</td>
<td>&quot;To delete this message press *D&quot;.</td>
</tr>
<tr>
<td>243</td>
<td>&quot;At beginning to re-record press 1 to playback press 23&quot;.</td>
</tr>
<tr>
<td>244</td>
<td>&quot;Received&quot;.</td>
</tr>
<tr>
<td>245</td>
<td>&quot;Contact administrator for help&quot;.</td>
</tr>
<tr>
<td>246</td>
<td>&quot;Please make entry soon or be disconnected&quot;.</td>
</tr>
<tr>
<td>247</td>
<td>&quot;Cannot get your messages now due to multiple logins to your mailbox&quot;.</td>
</tr>
<tr>
<td>248</td>
<td>&quot;To exit directory press #&quot;.</td>
</tr>
<tr>
<td>249</td>
<td>&quot;To have system wait press *W, to access the names or numbers directory press **N. If finished please hang up or to disconnect IP Office press **X&quot;.</td>
</tr>
<tr>
<td>250</td>
<td>&quot;To add a member enter extension&quot;.</td>
</tr>
<tr>
<td>251</td>
<td>&quot;To add a member enter last name&quot;.</td>
</tr>
<tr>
<td>252</td>
<td>&quot;Welcome to IP Office&quot;.</td>
</tr>
<tr>
<td>253</td>
<td>&quot;You are in the main directory. To find a subscriber’s extension, enter the last name followed by the # sign. To enter the letter Q press 7, for z press 9. To lookup by extension instead press *2&quot;.</td>
</tr>
<tr>
<td>254</td>
<td>&quot;If you wish to specify a non IP Office subscriber, first change to extension addressing by pressing *A&quot;.</td>
</tr>
<tr>
<td>255</td>
<td>&quot;To transfer to another extension press *T&quot;.</td>
</tr>
<tr>
<td>256</td>
<td>&quot;Louder press 4, softer press 7, faster press 9, slower press 8&quot;.</td>
</tr>
<tr>
<td>257</td>
<td>&quot;To add entries press 1&quot;.</td>
</tr>
<tr>
<td>258</td>
<td>&quot;To renter list press *5&quot;.</td>
</tr>
<tr>
<td>259</td>
<td>&quot;To specify owner by name press *2&quot;.</td>
</tr>
<tr>
<td>260</td>
<td>&quot;AM&quot;.</td>
</tr>
<tr>
<td>261</td>
<td>&quot;PM&quot;.</td>
</tr>
<tr>
<td>262</td>
<td>&quot;You are at the activity menu&quot;.</td>
</tr>
<tr>
<td>263</td>
<td>&quot;You are changing your password&quot;.</td>
</tr>
<tr>
<td>264</td>
<td>&quot;January&quot;.</td>
</tr>
<tr>
<td>265</td>
<td>&quot;February&quot;.</td>
</tr>
<tr>
<td>266</td>
<td>&quot;March&quot;.</td>
</tr>
<tr>
<td>267</td>
<td>&quot;April&quot;.</td>
</tr>
<tr>
<td>268</td>
<td>&quot;May&quot;.</td>
</tr>
</tbody>
</table>
315 "June".
316 "July".
317 "August".
318 "September".
319 "October".
320 "November".
321 "December".
322 "You are in the numbers directory. To find a subscriber's name, enter the extension followed by the # sign. To lookup by name instead press *2.".
323 "You are responding to a piece of incoming mail".
325 "You are administering your lists. To create a mailing list press 1, to play a summary of all your lists press 2, to review a particular list press 3".
327 "You are creating a mailing list".
328 "To delete the previous entry, press *3. To add a mailing list you have already created or a public list owned by others, press *5. To review or modify the list you are creating, press *1. To approve the list you are creating and move on to the next step, press #".
329 "You have not yet entered enough characters to identify a specific subscriber. To enter the letter Q press 7, for Z press 9".
330 "Or enter just the # sign if it is your phone".
332 "System greeting used".
333 "To add entries to the list or to change status of the list press 1".
334 "When finished addressing press #".
335 "When finished press #".
339 "To replay the last few seconds press 5, to advance a few seconds press 6".
347 "You are adding a list".
348 "You are specifying a mailing list to review".
350 "Sunday".
351 "Monday".
352 "Tuesday".
353 "Wednesday".
354 "Thursday".
355 "Friday".
356 "Saturday".
357 "You are choosing between subscribers whose names match your entry. To indicate no subscribers match, delete entry by pressing *3. To change to extension addressing and delete your entry press *2".
358 "You are identifying a list as private or public".
360 "You are scanning mailing lists, to review list members press 0, to rewind to previous list press 2, to continue scanning lists press 3".
361 "To skip to next list press #, to delete list press *3".
362 "If you own the list press #, if some else owns the list".
363 "To approve the list you are creating press #".
364 "Enter owner's extension".
367 "To specify a different owner by name press *3".
368 "You are entering the number for a new list. Please enter a number up to 6 digits long".
369 "To replace an existing list, enter that list's number".
370 "These are entries in your list".
371 "To rewind to current entry press 2, to rewind to previous entry press 2 as many times as necessary, to continue playback of list press 3".
372 "To skip to next entry press #, to delete current entry press *D".
373 "You are choosing whether to attach a copy of original message to your reply. To include the original press y for yes, to send only your reply press n for no".
376 "To skip the next header press the # sign to listen to the header rewind by pressing 2 then play by pressing 3 to skip to the next category press *#".
377 "To delete message press *D".
380 "Please wait".
381 "To listen to the message press 0, to re-record message before delivery press 1".
<table>
<thead>
<tr>
<th>WAV File</th>
<th>Intuity Prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td>388</td>
<td>&quot;To skip press the # key&quot;.</td>
</tr>
<tr>
<td>390</td>
<td>&quot;O&quot; (Oh)</td>
</tr>
<tr>
<td>391 - 450</td>
<td>&quot;One&quot; to &quot;sixty&quot;. For zero see 585.wav</td>
</tr>
<tr>
<td>451</td>
<td>&quot;Seventy&quot;.</td>
</tr>
<tr>
<td>452</td>
<td>&quot;Eighty&quot;.</td>
</tr>
<tr>
<td>453</td>
<td>&quot;Ninety&quot;.</td>
</tr>
<tr>
<td>454</td>
<td>&quot;Hundred&quot;.</td>
</tr>
<tr>
<td>455</td>
<td>&quot;Thousand&quot;.</td>
</tr>
<tr>
<td>456</td>
<td>&quot;Million&quot;.</td>
</tr>
<tr>
<td>464</td>
<td>&quot;Enter extensions&quot;.</td>
</tr>
<tr>
<td>468</td>
<td>&quot;To continue playing press 3&quot;.</td>
</tr>
<tr>
<td>471</td>
<td>&quot;If it's your list press #&quot;.</td>
</tr>
<tr>
<td>472</td>
<td>&quot;To approve press #, to record from here press 1&quot;.</td>
</tr>
<tr>
<td>477</td>
<td>&quot;Press 1 to select&quot;.</td>
</tr>
<tr>
<td>478</td>
<td>&quot;2 to select&quot;.</td>
</tr>
<tr>
<td>479</td>
<td>&quot;3 to select&quot;.</td>
</tr>
<tr>
<td>484</td>
<td>&quot;Enter more characters followed by the # sign. If you just completed entering the last name enter the first name&quot;.</td>
</tr>
<tr>
<td>485</td>
<td>&quot;Has&quot;.</td>
</tr>
<tr>
<td>486</td>
<td>&quot;To reply to sender by voicemail press 1&quot;.</td>
</tr>
<tr>
<td>493</td>
<td>&quot;You are requesting a transfer&quot;.</td>
</tr>
<tr>
<td>499</td>
<td>&quot;When finished recording press # to approve or 1 to edit your message&quot;.</td>
</tr>
<tr>
<td>556</td>
<td>&quot;To exit press *# now&quot;.</td>
</tr>
<tr>
<td>561</td>
<td>&quot;You addressing your message&quot;.</td>
</tr>
<tr>
<td>562</td>
<td>&quot;Enter the&quot;.</td>
</tr>
<tr>
<td>563</td>
<td>&quot;Digit extension&quot;.</td>
</tr>
<tr>
<td>569</td>
<td>&quot;To modify press 1, if finished press *#&quot;.</td>
</tr>
<tr>
<td>577</td>
<td>&quot;To hold the message in its current category press **H&quot;.</td>
</tr>
<tr>
<td>578</td>
<td>&quot;To skip to the next category press *#&quot;.</td>
</tr>
<tr>
<td>579</td>
<td>&quot;Password must be&quot;.</td>
</tr>
<tr>
<td>585</td>
<td>&quot;Zero&quot;.</td>
</tr>
<tr>
<td>587</td>
<td>&quot;You are reviewing a list&quot;.</td>
</tr>
<tr>
<td>601</td>
<td>&quot;Priority&quot;.</td>
</tr>
<tr>
<td>604</td>
<td>&quot;As you use IP Office, your name will be included in system announcements that you and other people will hear. Press 1 and at the tone please speak your name. After speaking your name press 1 again&quot;.</td>
</tr>
<tr>
<td>606</td>
<td>&quot;To re-record you name press 1, to approve press #&quot;.</td>
</tr>
<tr>
<td>608</td>
<td>&quot;At the tone please speak your name. After speaking your name press 1&quot;.</td>
</tr>
<tr>
<td>610</td>
<td>&quot;You are recording your name. After you record your name, you can access other IP Office features. As you use IP Office your name will be included in system announcements that you and other people will hear. Press 1 and at the tone please speak your first and last name as you would like others to hear it. After speaking your name press 1 again&quot;.</td>
</tr>
<tr>
<td>611</td>
<td>&quot;You are recording your name. To record your name, press 1. After recording press 1 again. To play back name press 23, to approve press #&quot;.</td>
</tr>
<tr>
<td>612</td>
<td>&quot;To make private press 1&quot;.</td>
</tr>
<tr>
<td>613</td>
<td>&quot;To make priority press 2&quot;.</td>
</tr>
<tr>
<td>617</td>
<td>&quot;To remove private status press 1&quot;.</td>
</tr>
<tr>
<td>618</td>
<td>&quot;To remove priority status press 2&quot;.</td>
</tr>
<tr>
<td>622</td>
<td>&quot;Not priority&quot;.</td>
</tr>
<tr>
<td>643</td>
<td>&quot;You are choosing options for this message there are no options currently set&quot;.</td>
</tr>
<tr>
<td>644</td>
<td>&quot;You are choosing options for this message with the current settings&quot;.</td>
</tr>
<tr>
<td>645</td>
<td>&quot;Private messages cannot be forwarded by the recipients&quot;.</td>
</tr>
<tr>
<td>646</td>
<td>&quot;A priority message will be delivered before other messages and will be flagged for special attention in the recipients mailbox&quot;.</td>
</tr>
<tr>
<td>647</td>
<td>&quot;The message will be private&quot;.</td>
</tr>
<tr>
<td>648</td>
<td>&quot;The message will be priority&quot;.</td>
</tr>
<tr>
<td>WAV File</td>
<td>Intuity Prompt</td>
</tr>
<tr>
<td>----------</td>
<td>----------------</td>
</tr>
<tr>
<td>651</td>
<td>&quot;The message will be private and priority&quot;.</td>
</tr>
<tr>
<td>681</td>
<td>&quot;Sorry cannot leave a message now because this users mailbox is full&quot;.</td>
</tr>
<tr>
<td>700</td>
<td>&quot;To administer mailing lists press 1&quot;.</td>
</tr>
<tr>
<td>701</td>
<td>&quot;To change your password press 4&quot;.</td>
</tr>
<tr>
<td>702</td>
<td>&quot;To record your name press 5&quot;.</td>
</tr>
<tr>
<td>703</td>
<td>&quot;You are at subscriber administration&quot;.</td>
</tr>
<tr>
<td>704</td>
<td>&quot;To create lists press 1, to scan lists press 2, to review and modify lists press 3&quot;.</td>
</tr>
<tr>
<td>707</td>
<td>&quot;If finished press *#&quot;.</td>
</tr>
<tr>
<td>708</td>
<td>&quot;If finished adding entries press #&quot;.</td>
</tr>
<tr>
<td>736</td>
<td>&quot;You are recording your name. As you use IP office your name will be included in system announcements that you and other people will hear&quot;.</td>
</tr>
<tr>
<td>744</td>
<td>&quot;For all calls&quot;.</td>
</tr>
<tr>
<td>745</td>
<td>&quot;Active&quot;.</td>
</tr>
<tr>
<td>747</td>
<td>&quot;For internal calls&quot;.</td>
</tr>
<tr>
<td>748</td>
<td>&quot;For external calls&quot;.</td>
</tr>
<tr>
<td>749</td>
<td>&quot;For busy calls&quot;.</td>
</tr>
<tr>
<td>750</td>
<td>&quot;For no answer&quot;.</td>
</tr>
<tr>
<td>751</td>
<td>&quot;For out of hours calls&quot;.</td>
</tr>
<tr>
<td>752</td>
<td>&quot;To listen to a greeting press 0, to create change or delete a greeting press 1, to scan all your greetings press 2, to activate a greeting press 3, to administer call types press 4, if finished press #&quot;.</td>
</tr>
<tr>
<td>753</td>
<td>&quot;Enter greeting number&quot;.</td>
</tr>
<tr>
<td>754</td>
<td>&quot;Greeting&quot;.</td>
</tr>
<tr>
<td>755</td>
<td>&quot;Not recorded&quot;.</td>
</tr>
<tr>
<td>756</td>
<td>&quot;To listen to greeting&quot;.</td>
</tr>
<tr>
<td>757</td>
<td>&quot;To re-record, press 1&quot;.</td>
</tr>
<tr>
<td>759</td>
<td>&quot;To review status, press 2&quot;.</td>
</tr>
<tr>
<td>760</td>
<td>&quot;Press 0&quot;.</td>
</tr>
<tr>
<td>764</td>
<td>&quot;To use this greeting for all calls press 0, for internal calls press 1, for external calls press 2&quot;.</td>
</tr>
<tr>
<td>765</td>
<td>&quot;Recorded but not active&quot;.</td>
</tr>
<tr>
<td>766</td>
<td>&quot;To use this greeting for all calls press 1&quot;.</td>
</tr>
<tr>
<td>767</td>
<td>&quot;To use this greeting for all calls press 0, for busy calls press 1, for no answer calls press 2&quot;.</td>
</tr>
<tr>
<td>770</td>
<td>&quot;Recorded and active&quot;.</td>
</tr>
<tr>
<td>771</td>
<td>&quot;Approved and active&quot;.</td>
</tr>
<tr>
<td>772</td>
<td>&quot;Again&quot;.</td>
</tr>
<tr>
<td>773</td>
<td>&quot;To activate for out of hours call press 3&quot;.</td>
</tr>
<tr>
<td>775</td>
<td>&quot;To record messages press 1 to get messages press 2 to administer personal greetings press 3&quot;.</td>
</tr>
<tr>
<td>776</td>
<td>&quot;The system greeting&quot;.</td>
</tr>
<tr>
<td>777</td>
<td>&quot;Cannot listen to system greeting&quot;.</td>
</tr>
<tr>
<td>778</td>
<td>&quot;Cannot modify system greeting&quot;.</td>
</tr>
<tr>
<td>779</td>
<td>&quot;No greetings recorded&quot;.</td>
</tr>
<tr>
<td>780</td>
<td>&quot;Personal greetings review completed&quot;.</td>
</tr>
<tr>
<td>781</td>
<td>&quot;To skip to the next greeting press the # sign&quot;.</td>
</tr>
<tr>
<td>782</td>
<td>&quot;To activate a greeting enter greeting number, to de-activate a greeting activate a different greeting in its place&quot;.</td>
</tr>
<tr>
<td>783</td>
<td>&quot;To activate another greeting enter greeting number to de-activate a greeting activate a different greeting in its place&quot;.</td>
</tr>
<tr>
<td>784</td>
<td>&quot;To activate system greeting enter 0&quot;.</td>
</tr>
<tr>
<td>785</td>
<td>&quot;Same greeting used for all calls&quot;.</td>
</tr>
<tr>
<td>786</td>
<td>&quot;To identify calls as internal and external press 1&quot;.</td>
</tr>
<tr>
<td>787</td>
<td>&quot;To identify calls as busy and no answer press 2&quot;.</td>
</tr>
<tr>
<td>788</td>
<td>&quot;To identify calls as out of hours press 3&quot;.</td>
</tr>
<tr>
<td>790</td>
<td>&quot;Calls identified as internal and external&quot;.</td>
</tr>
<tr>
<td>791</td>
<td>&quot;Calls identified as busy and no answer&quot;.</td>
</tr>
<tr>
<td>792</td>
<td>&quot;Calls identified as out of hours&quot;.</td>
</tr>
<tr>
<td>793</td>
<td>&quot;Calls not identified as out of hours&quot;.</td>
</tr>
<tr>
<td>WAV File</td>
<td>Intuity Prompt</td>
</tr>
<tr>
<td>----------</td>
<td>---------------</td>
</tr>
<tr>
<td>797</td>
<td>&quot;To use the same greeting for all calls press 5&quot;.</td>
</tr>
<tr>
<td>810</td>
<td>&quot;External&quot;.</td>
</tr>
<tr>
<td>812</td>
<td>&quot;No answer&quot;.</td>
</tr>
<tr>
<td>814</td>
<td>&quot;Calls&quot;.</td>
</tr>
<tr>
<td>815</td>
<td>&quot;You are administering your personal greetings&quot;.</td>
</tr>
<tr>
<td>816</td>
<td>&quot;You are listening to a personal greeting&quot;.</td>
</tr>
<tr>
<td>817</td>
<td>&quot;You are recording a personal greeting&quot;.</td>
</tr>
<tr>
<td>818</td>
<td>&quot;You have just recorded&quot;.</td>
</tr>
<tr>
<td>819</td>
<td>&quot;You are scanning your personal greetings&quot;.</td>
</tr>
<tr>
<td>820</td>
<td>&quot;You are selecting which greeting to activate&quot;.</td>
</tr>
<tr>
<td>821</td>
<td>&quot;You administering call types&quot;.</td>
</tr>
<tr>
<td>822</td>
<td>&quot;As you use IP Office, your name will be included in system announcements that you and other people will hear. At the tone please speak your name, after speaking your name press 1&quot;.</td>
</tr>
<tr>
<td>823</td>
<td>&quot;For all calls&quot;.</td>
</tr>
<tr>
<td>825</td>
<td>&quot;For internal&quot;.</td>
</tr>
<tr>
<td>826</td>
<td>&quot;For external&quot;.</td>
</tr>
<tr>
<td>827</td>
<td>&quot;For busy&quot;.</td>
</tr>
<tr>
<td>828</td>
<td>&quot;For no answer&quot;.</td>
</tr>
<tr>
<td>829</td>
<td>&quot;For out of hours&quot;.</td>
</tr>
<tr>
<td>830</td>
<td>&quot;You must approve your recording&quot;.</td>
</tr>
<tr>
<td>832</td>
<td>&quot;Please enter extension and # sign&quot;.</td>
</tr>
<tr>
<td>839</td>
<td>&quot;To rewind to the previous greeting press 2&quot;.</td>
</tr>
<tr>
<td>843</td>
<td>&quot;To scan headers and messages press 1, to scan headers only press 2, to scan messages only press 3&quot;.</td>
</tr>
<tr>
<td>844</td>
<td>&quot;End of message&quot;.</td>
</tr>
<tr>
<td>845</td>
<td>&quot;Next message&quot;.</td>
</tr>
<tr>
<td>846</td>
<td>&quot;You are selecting an option for automatic message scan&quot;.</td>
</tr>
<tr>
<td>847</td>
<td>&quot;You are automatically scanning your incoming messages. To listen to the message press 0, to respond to or forward the message press 1&quot;.</td>
</tr>
<tr>
<td>848</td>
<td>&quot;You are automatically scanning your incoming messages. To listen to the message press 0 to respond to the message press 1&quot;.</td>
</tr>
<tr>
<td>849</td>
<td>&quot;To skip the next message press the # sign, to listen to the header rewind by pressing 2, then play by pressing 3, to skip to the next category press *#&quot;.</td>
</tr>
<tr>
<td>850</td>
<td>&quot;Broadcast and login message services are not available&quot;.</td>
</tr>
<tr>
<td>852</td>
<td>&quot;To rewind to the current entry press 2, to rewind to previous entry press 2 as many times as necessary&quot;.</td>
</tr>
<tr>
<td>868</td>
<td>&quot;Mailbox id must be less than or equal to less than 16 digits&quot;.</td>
</tr>
<tr>
<td>869</td>
<td>&quot;If the extension entered belongs to a casual subscriber you will be prompted for a mailbox id&quot;.</td>
</tr>
<tr>
<td>905</td>
<td>Short silence.</td>
</tr>
<tr>
<td>907</td>
<td>2 seconds of silence.</td>
</tr>
<tr>
<td>913</td>
<td>&quot;If finished press &quot;.</td>
</tr>
<tr>
<td>915</td>
<td>&quot;No options menu available&quot;.</td>
</tr>
<tr>
<td>916</td>
<td>&quot;To send message press # or enter an option to hear a list of options press 0&quot;.</td>
</tr>
<tr>
<td>924</td>
<td>&quot;Seconds&quot;.</td>
</tr>
<tr>
<td>925</td>
<td>&quot;Minutes&quot;.</td>
</tr>
<tr>
<td>926</td>
<td>Beep</td>
</tr>
<tr>
<td>928</td>
<td>&quot;New messages&quot;.</td>
</tr>
<tr>
<td>929</td>
<td>&quot;Old messages&quot;.</td>
</tr>
<tr>
<td>935</td>
<td>&quot;Unopened messages&quot;.</td>
</tr>
<tr>
<td>936</td>
<td>&quot;Partial entry deleted&quot;.</td>
</tr>
<tr>
<td>937</td>
<td>&quot;Sorry you are having difficulty please get help and try again later&quot;.</td>
</tr>
<tr>
<td>938 - 968</td>
<td>Ordinal numbers &quot;1st&quot; to &quot;31st&quot;.</td>
</tr>
<tr>
<td>971</td>
<td>&quot;To send press &quot;.</td>
</tr>
<tr>
<td>972</td>
<td>&quot;To reach the covering extension press Zero&quot;.</td>
</tr>
<tr>
<td>973</td>
<td>&quot;If you are finished please hang up or press **X&quot;.</td>
</tr>
<tr>
<td>WAV File</td>
<td>Intuity Prompt</td>
</tr>
<tr>
<td>----------</td>
<td>---------------</td>
</tr>
<tr>
<td>977</td>
<td>&quot;Name not found&quot;.</td>
</tr>
<tr>
<td>987</td>
<td>&quot;Enter last name of the person&quot;.</td>
</tr>
<tr>
<td>990</td>
<td>&quot;To record and send voicemail messages press 1&quot;.</td>
</tr>
<tr>
<td>992</td>
<td>&quot;To get messages press 2&quot;.</td>
</tr>
<tr>
<td>1001</td>
<td>&quot;To scan incoming messages automatically press 7, to relogin press **R&quot;.</td>
</tr>
<tr>
<td>1006</td>
<td>&quot;To record or change the greeting heard by callers press 3&quot;.</td>
</tr>
<tr>
<td>1010</td>
<td>&quot;With priority&quot;.</td>
</tr>
<tr>
<td>1011</td>
<td>&quot;With fax&quot;.</td>
</tr>
<tr>
<td>1020</td>
<td>&quot;No message to send&quot;.</td>
</tr>
<tr>
<td>1028</td>
<td>&quot;Page&quot;.</td>
</tr>
<tr>
<td>1029</td>
<td>&quot;Pages&quot;.</td>
</tr>
<tr>
<td>1041</td>
<td>&quot;There are no new faxes&quot;.</td>
</tr>
<tr>
<td>1048</td>
<td>&quot;Nothing to print&quot;.</td>
</tr>
<tr>
<td>1052</td>
<td>&quot;To specify your fax preferences press 3&quot;.</td>
</tr>
<tr>
<td>1061</td>
<td>&quot;Your default print destination is...&quot;.</td>
</tr>
<tr>
<td>1071</td>
<td>&quot;Fax message from...&quot;.</td>
</tr>
<tr>
<td>1073</td>
<td>&quot;To print press *1&quot;.</td>
</tr>
<tr>
<td>1075</td>
<td>&quot;To change the default print destination press 1&quot;.</td>
</tr>
<tr>
<td>1087</td>
<td>&quot;To print to destination&quot;.</td>
</tr>
<tr>
<td>1088</td>
<td>&quot;Press #&quot;.</td>
</tr>
<tr>
<td>1089</td>
<td>&quot;To specify destination, enter digits followed by the # key&quot;.</td>
</tr>
<tr>
<td>1091</td>
<td>&quot;You are specifying where your documents will be printed&quot;.</td>
</tr>
<tr>
<td>1092</td>
<td>&quot;A default print destination has not been assigned&quot;.</td>
</tr>
<tr>
<td>1093</td>
<td>&quot;To assign a default print destination press *7 then 53&quot;.</td>
</tr>
<tr>
<td>1098</td>
<td>&quot;To approve press #&quot;.</td>
</tr>
<tr>
<td>1118</td>
<td>&quot;You are specifying the default print destination for fax items&quot;.</td>
</tr>
<tr>
<td>1141</td>
<td>&quot;When finished recording press # for more options&quot;.</td>
</tr>
<tr>
<td>1144</td>
<td>&quot;To specify whether a message can be addressed before it is recorded press 6&quot;.</td>
</tr>
<tr>
<td>1145</td>
<td>&quot;To administer call answer options press 7&quot;.</td>
</tr>
<tr>
<td>1152</td>
<td>&quot;Address before record turned on&quot;.</td>
</tr>
<tr>
<td>1153</td>
<td>&quot;To turn off press 1&quot;.</td>
</tr>
<tr>
<td>1154</td>
<td>&quot;Address before record turned off&quot;.</td>
</tr>
<tr>
<td>1155</td>
<td>&quot;To turn on press 1&quot;.</td>
</tr>
<tr>
<td>1157</td>
<td>&quot;You are administering addressing options&quot;.</td>
</tr>
<tr>
<td>1158</td>
<td>&quot;To prevent callers from leaving messages press 1&quot;.</td>
</tr>
<tr>
<td>1159</td>
<td>&quot;Call answer messages will not be accepted&quot;.</td>
</tr>
<tr>
<td>1160</td>
<td>&quot;To allow callers to leave messages press 1&quot;.</td>
</tr>
<tr>
<td>1161</td>
<td>&quot;You are administering call answer options&quot;.</td>
</tr>
<tr>
<td>1162</td>
<td>&quot;Sorry the mailbox you have reached is not accepting messages at this time&quot;.</td>
</tr>
<tr>
<td>1163</td>
<td>&quot;Is not available&quot;.</td>
</tr>
<tr>
<td>1164</td>
<td>&quot;Call answer messages will be accepted&quot;.</td>
</tr>
<tr>
<td>1219</td>
<td>&quot;To review or change your reach options press 7&quot;.</td>
</tr>
<tr>
<td>1305</td>
<td>&quot;Please enter an outcalling option to hear a list of options press 0&quot;.</td>
</tr>
<tr>
<td>1430</td>
<td>&quot;To following message was restored&quot;.</td>
</tr>
<tr>
<td>1431</td>
<td>&quot;No message to restore&quot;.</td>
</tr>
<tr>
<td>1432</td>
<td>&quot;To undelete last deleted message press **U&quot;.</td>
</tr>
<tr>
<td>1434</td>
<td>&quot;To return to getting messages press #&quot;.</td>
</tr>
<tr>
<td>1440</td>
<td>Beep</td>
</tr>
<tr>
<td>1443</td>
<td>&quot;Voice file system is out of space&quot;.</td>
</tr>
<tr>
<td>1444</td>
<td>&quot;Please contact the administrator&quot;.</td>
</tr>
<tr>
<td>1457</td>
<td>&quot;Old and new passwords cannot be the same&quot;.</td>
</tr>
<tr>
<td>1461</td>
<td>&quot;You are getting your incoming messages&quot;.</td>
</tr>
<tr>
<td>1462</td>
<td>&quot;To listen to the message press Zero&quot;.</td>
</tr>
<tr>
<td>1463</td>
<td>&quot;To reply to sender by voicemail press 17&quot;.</td>
</tr>
<tr>
<td>WAV File</td>
<td>Intuity Prompt</td>
</tr>
<tr>
<td>----------</td>
<td>----------------</td>
</tr>
<tr>
<td>1464</td>
<td>&quot;To forward with comments press 12&quot;.</td>
</tr>
<tr>
<td>1465</td>
<td>&quot;To record a new message press 14&quot;.</td>
</tr>
<tr>
<td>1466</td>
<td>&quot;To respond to or forward the message press 1&quot;.</td>
</tr>
<tr>
<td>1467</td>
<td>&quot;The return address for this message is not a mailbox on this system&quot;.</td>
</tr>
<tr>
<td>1469</td>
<td>&quot;To reply to sender by voicemail press 7&quot;.</td>
</tr>
<tr>
<td>1964</td>
<td>&quot;The ability for callers to leave messages in your mailbox is turned off&quot;.</td>
</tr>
<tr>
<td>1965</td>
<td>&quot;To allow callers to leave messages press 571&quot;.</td>
</tr>
<tr>
<td>1970</td>
<td>&quot;Invalid password please enter new password and # sign&quot;.</td>
</tr>
<tr>
<td>2007</td>
<td>&quot;With text&quot;.</td>
</tr>
<tr>
<td>2008</td>
<td>&quot;With other media&quot;.</td>
</tr>
<tr>
<td>2010</td>
<td>&quot;Zero&quot;.</td>
</tr>
<tr>
<td>2011</td>
<td>&quot;bytes&quot;.</td>
</tr>
<tr>
<td>2012</td>
<td>&quot;Byte&quot;.</td>
</tr>
<tr>
<td>2013</td>
<td>&quot;Kilobyte&quot;.</td>
</tr>
<tr>
<td>2014</td>
<td>&quot;Kilobytes&quot;.</td>
</tr>
<tr>
<td>2015</td>
<td>&quot;Megabyte&quot;.</td>
</tr>
<tr>
<td>2016</td>
<td>&quot;Megabytes&quot;.</td>
</tr>
<tr>
<td>2018</td>
<td>&quot;And&quot;.</td>
</tr>
<tr>
<td>2019</td>
<td>&quot;Message from&quot;.</td>
</tr>
<tr>
<td>2021</td>
<td>&quot;Private&quot;.</td>
</tr>
<tr>
<td>2022</td>
<td>&quot;Private priority&quot;.</td>
</tr>
<tr>
<td>2023</td>
<td>&quot;Priority&quot;.</td>
</tr>
<tr>
<td>2025</td>
<td>&quot;Call from&quot;.</td>
</tr>
<tr>
<td>2026</td>
<td>&quot;Call received&quot;.</td>
</tr>
<tr>
<td>2029</td>
<td>&quot;This is a &quot;.</td>
</tr>
<tr>
<td>2030</td>
<td>&quot;Voice&quot;.</td>
</tr>
<tr>
<td>2031</td>
<td>&quot;Fax&quot;.</td>
</tr>
<tr>
<td>2032</td>
<td>&quot;Text&quot;.</td>
</tr>
<tr>
<td>2033</td>
<td>&quot;Attached file&quot;.</td>
</tr>
<tr>
<td>2035</td>
<td>&quot;To advance to the end of the message press *6&quot;.</td>
</tr>
<tr>
<td>2038</td>
<td>&quot;Rewound&quot;.</td>
</tr>
<tr>
<td>2039</td>
<td>&quot;Component&quot;.</td>
</tr>
<tr>
<td>2040</td>
<td>&quot;To listen press 3&quot;.</td>
</tr>
<tr>
<td>2041</td>
<td>&quot;To customize your mailbox, for example to create or edit your mailing lists or change your password, press 5&quot;.</td>
</tr>
<tr>
<td>2042</td>
<td>&quot;To administer your media preference for sorting messages, press 8&quot;.</td>
</tr>
<tr>
<td>2043</td>
<td>&quot;You are administering your preferred media type for sorting incoming messages. Messages with a primary media type matching your preference will be presented before other messages, regardless of the order in which they have been received&quot;.</td>
</tr>
<tr>
<td>2044</td>
<td>&quot;No media preference for sorting incoming messages has been specified&quot;.</td>
</tr>
<tr>
<td>2045</td>
<td>&quot;For voice press 1, for fax press 2, for text press 3, for binary files press 4&quot;.</td>
</tr>
<tr>
<td>2046</td>
<td>&quot;To retain your current preference press the # key&quot;.</td>
</tr>
<tr>
<td>2047</td>
<td>&quot;You media preference for sorting incoming messages is&quot;.</td>
</tr>
<tr>
<td>2048</td>
<td>&quot;For no preference press zero&quot;.</td>
</tr>
<tr>
<td>2049</td>
<td>&quot;Will be your preferred media type&quot;.</td>
</tr>
<tr>
<td>2051</td>
<td>&quot;Your password cannot be the same as your extension number consecutive digits or a single repeated digit. Please enter new password and the # key&quot;.</td>
</tr>
<tr>
<td>2052</td>
<td>&quot;At beginning of message to step back to previous message press *2 to listen press Zero&quot;.</td>
</tr>
<tr>
<td>2053</td>
<td>&quot;Approximately&quot;.</td>
</tr>
<tr>
<td>2057</td>
<td>&quot;At beginning of message&quot;.</td>
</tr>
<tr>
<td>2061</td>
<td>&quot;To enter the telephone number of a fax machine press **5&quot;.</td>
</tr>
<tr>
<td>2063</td>
<td>&quot;Enter the telephone number of a fax machine followed by the # sign&quot;.</td>
</tr>
<tr>
<td>2065</td>
<td>&quot;The telephone number of a fax machine should be entered as it would be dialed from the location of your messaging system. It can contain a maximum of 23 digits including trunk access, long distance or international access codes if necessary and is subject to administrator restrictions&quot;.</td>
</tr>
<tr>
<td>WAV File</td>
<td>Intuity Prompt</td>
</tr>
<tr>
<td>----------</td>
<td>----------------</td>
</tr>
<tr>
<td>2071</td>
<td>&quot;You are specifying the telephone number of a fax machine&quot;.</td>
</tr>
<tr>
<td>4409 - 4434</td>
<td>Alphabetic characters &quot;A&quot; to &quot;Z&quot;.</td>
</tr>
<tr>
<td>G0000 - G0009</td>
<td>&quot;Press zero&quot; through to &quot;Press 9&quot;.</td>
</tr>
<tr>
<td>G0010 - G0019</td>
<td>&quot;Press *zero&quot; through to &quot;Press *9&quot;.</td>
</tr>
<tr>
<td>G0020</td>
<td>&quot;Press ** zero&quot;.</td>
</tr>
<tr>
<td>G0029</td>
<td>&quot;Press **9&quot;.</td>
</tr>
<tr>
<td>G0031</td>
<td>&quot;Press the # key&quot;.</td>
</tr>
<tr>
<td>G0032</td>
<td>&quot;Press #&quot;.</td>
</tr>
<tr>
<td>G0040</td>
<td>&quot;You are changing your Outcalling options&quot;.</td>
</tr>
<tr>
<td>G0041</td>
<td>&quot;System not administered for Outcalling&quot;.</td>
</tr>
<tr>
<td>G0042</td>
<td>&quot;You are not authorised for Outcalling&quot;.</td>
</tr>
<tr>
<td>G0043</td>
<td>&quot;When finished please hang up or &quot;.*</td>
</tr>
<tr>
<td>G0044</td>
<td>&quot;You are selecting which messages will receive out calls&quot;.</td>
</tr>
<tr>
<td>G0045</td>
<td>&quot;For instructions on entering your outcalling number&quot;.</td>
</tr>
<tr>
<td>G0046</td>
<td>&quot;For instruction on configuring outcalling&quot;.</td>
</tr>
<tr>
<td>G0047</td>
<td>&quot;You are not authorised to input a number&quot;.</td>
</tr>
<tr>
<td>G0051</td>
<td>&quot;To return to the activity menu&quot;.</td>
</tr>
<tr>
<td>G0052</td>
<td>&quot;Subject to administrator restrictions&quot;.</td>
</tr>
<tr>
<td>G0053</td>
<td>&quot;To change times&quot;.</td>
</tr>
<tr>
<td>G0054</td>
<td>&quot;To turn off&quot;</td>
</tr>
<tr>
<td>G0055</td>
<td>&quot;To turn on&quot;</td>
</tr>
<tr>
<td>G0061</td>
<td>&quot;To de-activate&quot;.</td>
</tr>
<tr>
<td>G0062</td>
<td>&quot;To activate&quot;.</td>
</tr>
<tr>
<td>G0063</td>
<td>&quot;To activate for all calls&quot;.</td>
</tr>
<tr>
<td>G0064</td>
<td>&quot;To activate for external calls only&quot;.</td>
</tr>
<tr>
<td>G0065</td>
<td>&quot;To activate for internal calls only&quot;.</td>
</tr>
<tr>
<td>G0071</td>
<td>&quot;For all calls&quot;.</td>
</tr>
<tr>
<td>G0072</td>
<td>&quot;For internal calls&quot;.</td>
</tr>
<tr>
<td>G0073</td>
<td>&quot;For internal calls only&quot;.</td>
</tr>
<tr>
<td>G0074</td>
<td>&quot;For external calls&quot;.</td>
</tr>
<tr>
<td>G0075</td>
<td>&quot;For external calls only&quot;.</td>
</tr>
<tr>
<td>G0076</td>
<td>&quot;For other calls&quot;.</td>
</tr>
<tr>
<td>G0080</td>
<td>&quot;To use this greeting&quot;.</td>
</tr>
<tr>
<td>G0081</td>
<td>&quot;For the temporary greeting&quot;</td>
</tr>
<tr>
<td>G0082</td>
<td>&quot;For number engaged calls&quot;</td>
</tr>
<tr>
<td>G0083</td>
<td>&quot;For no reply calls&quot;.</td>
</tr>
<tr>
<td>G0084</td>
<td>&quot;For the default greeting&quot;.</td>
</tr>
<tr>
<td>G0085</td>
<td>&quot;When finished&quot;.</td>
</tr>
<tr>
<td>G0086</td>
<td>&quot;Please enter a number between&quot;.</td>
</tr>
<tr>
<td>G0087</td>
<td>&quot;Where zero will set the temporary greeting to not expire&quot;.</td>
</tr>
<tr>
<td>G0088</td>
<td>&quot;Please enter the number of days you wish this greeting to be active for&quot;.</td>
</tr>
<tr>
<td>G0089</td>
<td>&quot;Your temporary greeting&quot;.</td>
</tr>
<tr>
<td>G0090</td>
<td>&quot;For the next&quot;.</td>
</tr>
<tr>
<td>G0091</td>
<td>&quot;Days&quot;.</td>
</tr>
<tr>
<td>G0092</td>
<td>&quot;For today&quot;.</td>
</tr>
<tr>
<td>G0099</td>
<td>&quot;Not configured&quot;.</td>
</tr>
<tr>
<td>G0100</td>
<td>&quot;Turned off&quot;.</td>
</tr>
<tr>
<td>G0101</td>
<td>&quot;Inactive&quot;.</td>
</tr>
<tr>
<td>G0102</td>
<td>&quot;Desk&quot;.</td>
</tr>
<tr>
<td>G0103</td>
<td>&quot;Home&quot;.</td>
</tr>
<tr>
<td>G0104</td>
<td>&quot;Mobile&quot;.</td>
</tr>
<tr>
<td>G0105</td>
<td>&quot;Temporary&quot;.</td>
</tr>
<tr>
<td>G0106</td>
<td>&quot;Delegate&quot;.</td>
</tr>
<tr>
<td>G0107</td>
<td>&quot;Secretary&quot;.</td>
</tr>
<tr>
<td>WAV File</td>
<td>Intuity Prompt</td>
</tr>
<tr>
<td>----------</td>
<td>---------------</td>
</tr>
<tr>
<td>G0108</td>
<td>&quot;Other&quot;.</td>
</tr>
<tr>
<td>G0109</td>
<td>&quot;SMS&quot;.</td>
</tr>
<tr>
<td>G0110</td>
<td>&quot;Voicemail&quot;.</td>
</tr>
<tr>
<td>G0111</td>
<td>&quot;Escalation&quot;.</td>
</tr>
<tr>
<td>G0112</td>
<td>&quot;An escalation list&quot;.</td>
</tr>
<tr>
<td>G0113</td>
<td>&quot;Extension&quot;.</td>
</tr>
<tr>
<td>G0120</td>
<td>&quot;For none&quot;.</td>
</tr>
<tr>
<td>G0121</td>
<td>&quot;For internal&quot;.</td>
</tr>
<tr>
<td>G0122</td>
<td>&quot;For desk&quot;.</td>
</tr>
<tr>
<td>G0123</td>
<td>&quot;For home&quot;.</td>
</tr>
<tr>
<td>G0124</td>
<td>&quot;For mobile&quot;.</td>
</tr>
<tr>
<td>G0125</td>
<td>&quot;For temporary&quot;.</td>
</tr>
<tr>
<td>G0126</td>
<td>&quot;For delegate&quot;.</td>
</tr>
<tr>
<td>G0127</td>
<td>&quot;For secretary&quot;.</td>
</tr>
<tr>
<td>G0128</td>
<td>&quot;For other&quot;.</td>
</tr>
<tr>
<td>G0129</td>
<td>&quot;For SMS&quot;.</td>
</tr>
<tr>
<td>G0130</td>
<td>&quot;For voicemail&quot;.</td>
</tr>
<tr>
<td>G0131</td>
<td>&quot;For escalation&quot;.</td>
</tr>
<tr>
<td>G0140</td>
<td>&quot;Currently&quot;.</td>
</tr>
<tr>
<td>G0141</td>
<td>&quot;For help&quot;.</td>
</tr>
<tr>
<td>G0142</td>
<td>&quot;For help at any time&quot;.</td>
</tr>
<tr>
<td>G0143</td>
<td>&quot;To leave&quot;.</td>
</tr>
<tr>
<td>G0144</td>
<td>&quot;To change&quot;.</td>
</tr>
<tr>
<td>G0145</td>
<td>&quot;To reject&quot;.</td>
</tr>
<tr>
<td>G0147</td>
<td>&quot;Time&quot;.</td>
</tr>
<tr>
<td>G0148</td>
<td>&quot;The time out is&quot;.</td>
</tr>
<tr>
<td>G0149</td>
<td>&quot;To change the time out&quot;.</td>
</tr>
<tr>
<td>G0150</td>
<td>&quot;To configure outcalling&quot;.</td>
</tr>
<tr>
<td>G0151</td>
<td>&quot;Your escalations have not been configured&quot;.</td>
</tr>
<tr>
<td>G0152</td>
<td>&quot;Your escalations are configured to call the following locations in the listed order&quot;.</td>
</tr>
<tr>
<td>G0153</td>
<td>&quot;To repeat list&quot;.</td>
</tr>
<tr>
<td>G0154</td>
<td>&quot;To repeat list with numbers&quot;.</td>
</tr>
<tr>
<td>G0155</td>
<td>&quot;To review the list&quot;.</td>
</tr>
<tr>
<td>G0156</td>
<td>&quot;You are selecting locations for the escalation list&quot;.</td>
</tr>
<tr>
<td>G0157</td>
<td>&quot;To input the list again&quot;.</td>
</tr>
<tr>
<td>G0158</td>
<td>&quot;You have completed inputting the escalation list&quot;.</td>
</tr>
<tr>
<td>G0159</td>
<td>&quot;To select a destination&quot;.</td>
</tr>
<tr>
<td>G0160</td>
<td>&quot;Where the following destinations will be called in order&quot;.</td>
</tr>
<tr>
<td>G0161</td>
<td>&quot;To configure escalations&quot;.</td>
</tr>
<tr>
<td>G0162</td>
<td>&quot;Please input your&quot;.</td>
</tr>
<tr>
<td>G0163</td>
<td>&quot;Location&quot;.</td>
</tr>
<tr>
<td>G0185</td>
<td>&quot;To&quot;.</td>
</tr>
<tr>
<td>G0186</td>
<td>&quot;Where&quot;.</td>
</tr>
<tr>
<td>G0187</td>
<td>&quot;Between&quot;.</td>
</tr>
<tr>
<td>G0188</td>
<td>&quot;Invalid time&quot;.</td>
</tr>
<tr>
<td>G0191</td>
<td>&quot;Is active&quot;.</td>
</tr>
<tr>
<td>G0192</td>
<td>&quot;Is inactive&quot;.</td>
</tr>
<tr>
<td>G0193</td>
<td>&quot;Is set to&quot;.</td>
</tr>
<tr>
<td>G0194</td>
<td>&quot;Is not set&quot;.</td>
</tr>
<tr>
<td>G0195</td>
<td>&quot;To repeat&quot;.</td>
</tr>
<tr>
<td>G0200</td>
<td>&quot;And&quot;.</td>
</tr>
<tr>
<td>G0201</td>
<td>&quot;Your outcalling is&quot;.</td>
</tr>
<tr>
<td>G0202</td>
<td>&quot;Your outcalling is set&quot;.</td>
</tr>
<tr>
<td>G0203</td>
<td>&quot;Your outcalling destination is set to&quot;.</td>
</tr>
<tr>
<td>WAV File</td>
<td>Intuity Prompt</td>
</tr>
<tr>
<td>----------</td>
<td>---------------</td>
</tr>
<tr>
<td>G0204</td>
<td>&quot;The number is&quot;.</td>
</tr>
<tr>
<td>G0205</td>
<td>&quot;Number is&quot;.</td>
</tr>
<tr>
<td>G0206</td>
<td>&quot;Number&quot;.</td>
</tr>
<tr>
<td>G0207</td>
<td>&quot;To change numbers&quot;.</td>
</tr>
<tr>
<td>G0208</td>
<td>&quot;To input a number&quot;.</td>
</tr>
<tr>
<td>G0209</td>
<td>&quot;For instructions on entering your outcalling number&quot;.</td>
</tr>
<tr>
<td>G0210</td>
<td>&quot;For instructions on configuring outcalling&quot;.</td>
</tr>
<tr>
<td>G0211</td>
<td>&quot;To change the number&quot;.</td>
</tr>
<tr>
<td>G0212</td>
<td>&quot;There is no number defined for the selected destination&quot;.</td>
</tr>
<tr>
<td>G0213</td>
<td>&quot;You are configuring outcalling destination&quot;.</td>
</tr>
<tr>
<td>G0214</td>
<td>&quot;To configure outcalling&quot;.</td>
</tr>
<tr>
<td>G0215</td>
<td>&quot;To re-configure outcalling&quot;.</td>
</tr>
<tr>
<td>G0216</td>
<td>&quot;To change outcalling&quot;.</td>
</tr>
<tr>
<td>G0217</td>
<td>&quot;To change outcalling destination&quot;.</td>
</tr>
<tr>
<td>G0218</td>
<td>&quot;To change destination&quot;.</td>
</tr>
<tr>
<td>G0219</td>
<td>&quot;To change&quot;.</td>
</tr>
<tr>
<td>G0220</td>
<td>&quot;Destination&quot;.</td>
</tr>
<tr>
<td>G0221</td>
<td>&quot;You have selected&quot;.</td>
</tr>
<tr>
<td>G0222</td>
<td>&quot;There is no number defined&quot;.</td>
</tr>
<tr>
<td>G0223</td>
<td>&quot;To select an alternate destination&quot;.</td>
</tr>
<tr>
<td>G0224</td>
<td>&quot;To select another location&quot;.</td>
</tr>
<tr>
<td>G0225</td>
<td>&quot;You have selected the option to configure your telephone numbers&quot;.</td>
</tr>
<tr>
<td>G0226</td>
<td>&quot;To exit&quot;.</td>
</tr>
<tr>
<td>G0227</td>
<td>&quot;To accept&quot;.</td>
</tr>
<tr>
<td>G0228</td>
<td>&quot;To disable&quot;.</td>
</tr>
<tr>
<td>G0229</td>
<td>&quot;To enable&quot;.</td>
</tr>
<tr>
<td>G0230</td>
<td>&quot;To turn outcalling off&quot;.</td>
</tr>
<tr>
<td>G0231</td>
<td>&quot;To turn outcalling on&quot;.</td>
</tr>
<tr>
<td>G0232</td>
<td>&quot;To turn outcalling on for all new messages&quot;.</td>
</tr>
<tr>
<td>G0233</td>
<td>&quot;To turn outcalling on for new priority messages only&quot;.</td>
</tr>
<tr>
<td>G0234</td>
<td>&quot;To turn outcalling on for new private messages only&quot;.</td>
</tr>
<tr>
<td>G0235</td>
<td>&quot;To turn outcalling on for new priority private messages only&quot;.</td>
</tr>
<tr>
<td>G0236</td>
<td>&quot;The destination is set to&quot;.</td>
</tr>
<tr>
<td>G0237</td>
<td>&quot;To change the destination&quot;.</td>
</tr>
<tr>
<td>G0238</td>
<td>&quot;To set a number&quot;.</td>
</tr>
<tr>
<td>G0240</td>
<td>&quot;Outcalling is turned off&quot;.</td>
</tr>
<tr>
<td>G0241</td>
<td>&quot;Outcalling is turned on&quot;.</td>
</tr>
<tr>
<td>G0242</td>
<td>&quot;Outcalling is turned on for all new messages&quot;.</td>
</tr>
<tr>
<td>G0243</td>
<td>&quot;Outcalling is turned on for new priority messages&quot;.</td>
</tr>
<tr>
<td>G0244</td>
<td>&quot;Outcalling is turned on for new private messages&quot;.</td>
</tr>
<tr>
<td>G0245</td>
<td>&quot;Outcalling is turned on for new priority private messages&quot;.</td>
</tr>
<tr>
<td>G0251</td>
<td>&quot;Outcalling is turned on between&quot;.</td>
</tr>
<tr>
<td>G0252</td>
<td>&quot;Outcalling is turned on for all new messages between&quot;.</td>
</tr>
<tr>
<td>G0253</td>
<td>&quot;Outcalling is turned on for new priority messages between&quot;.</td>
</tr>
<tr>
<td>G0254</td>
<td>&quot;Outcalling is turned on for new private messages between&quot;.</td>
</tr>
<tr>
<td>G0255</td>
<td>&quot;Outcalling is turned on for new priority private messages between&quot;.</td>
</tr>
<tr>
<td>G0260</td>
<td>&quot;Outcalling is turned off&quot;.</td>
</tr>
<tr>
<td>G0261</td>
<td>&quot;Outcalling is turned on&quot;.</td>
</tr>
<tr>
<td>G0262</td>
<td>&quot;Outcalling is turned on for all new messages&quot;.</td>
</tr>
<tr>
<td>G0263</td>
<td>&quot;Outcalling is turned on for new priority messages&quot;.</td>
</tr>
<tr>
<td>G0264</td>
<td>&quot;Outcalling is turned on for new private messages&quot;.</td>
</tr>
<tr>
<td>G0265</td>
<td>&quot;Outcalling is turned on for new priority private messages&quot;.</td>
</tr>
<tr>
<td>G0272</td>
<td>&quot;For all new messages&quot;.</td>
</tr>
<tr>
<td>G0273</td>
<td>&quot;For all new priority messages&quot;.</td>
</tr>
<tr>
<td>WAV File</td>
<td>Intuity Prompt</td>
</tr>
<tr>
<td>----------</td>
<td>---------------</td>
</tr>
<tr>
<td>G0274</td>
<td>&quot;For all new private messages&quot;.</td>
</tr>
<tr>
<td>G0275</td>
<td>&quot;For all new priority private messages&quot;.</td>
</tr>
<tr>
<td>G0278</td>
<td>&quot;Enter the time in second and #&quot;.</td>
</tr>
<tr>
<td>G0279</td>
<td>&quot;Enter the new number and #&quot;.</td>
</tr>
<tr>
<td>G0280</td>
<td>&quot;To input a new number&quot;.</td>
</tr>
<tr>
<td>G0281</td>
<td>&quot;To input an outcalling number&quot;.</td>
</tr>
<tr>
<td>G0282</td>
<td>&quot;Enter the number followed by #&quot;.</td>
</tr>
<tr>
<td>G0283</td>
<td>&quot;Anything entered will be interpreted as part of the called number&quot;.</td>
</tr>
<tr>
<td>G0284</td>
<td>&quot;No global commands, such as *4 will be accepted at this time&quot;.</td>
</tr>
<tr>
<td>G0285</td>
<td>&quot;A * or # entered as the first character will result in the * or # being output&quot;.</td>
</tr>
<tr>
<td>G0286</td>
<td>&quot;A * entered as part of the digit string will be interpreted as a pause of one and a half seconds.</td>
</tr>
<tr>
<td>G0287</td>
<td>&quot;If a longer pause is required, use multiple stars in a row&quot;.</td>
</tr>
<tr>
<td>G0288</td>
<td>&quot;To return to outcalling administration&quot;.</td>
</tr>
<tr>
<td>G0289</td>
<td>&quot;Enter outcalling number and #&quot;.</td>
</tr>
<tr>
<td>G0290</td>
<td>&quot;To exit press * # now&quot;.</td>
</tr>
<tr>
<td>G0301</td>
<td>&quot;Your destination is currently configured to&quot;.</td>
</tr>
<tr>
<td>G0306</td>
<td>&quot;For system outcalling schedules&quot;.</td>
</tr>
<tr>
<td>G0307</td>
<td>&quot;You are specifying your outcalling time period&quot;.</td>
</tr>
<tr>
<td>G0308</td>
<td>&quot;For outcalling during peak time&quot;.</td>
</tr>
<tr>
<td>G0309</td>
<td>&quot;If not press *3 and re-enter time&quot;.</td>
</tr>
<tr>
<td>G0310</td>
<td>&quot;To specify your times&quot;.</td>
</tr>
<tr>
<td>G0311</td>
<td>&quot;To delete own time&quot;.</td>
</tr>
<tr>
<td>G0312</td>
<td>&quot;Peak time is&quot;.</td>
</tr>
<tr>
<td>G0313</td>
<td>&quot;For outcalling ant time press 1&quot;.</td>
</tr>
<tr>
<td>G0314</td>
<td>&quot;The time you specify will be restricted by the times allowed by the system administrator&quot;.</td>
</tr>
<tr>
<td>G0315</td>
<td>&quot;Outcalling specified to any time subject to administrator restrictions&quot;.</td>
</tr>
<tr>
<td>G0316</td>
<td>&quot;For outcalling during prime time press 2&quot;.</td>
</tr>
<tr>
<td>G0317</td>
<td>&quot;The system allows outcalls from&quot;.</td>
</tr>
<tr>
<td>G0318</td>
<td>&quot;To change outcalling information press 6.</td>
</tr>
<tr>
<td>G0319</td>
<td>&quot;Outcalling specified for&quot;.</td>
</tr>
<tr>
<td>G0320</td>
<td>&quot;If correct press #&quot;.</td>
</tr>
<tr>
<td>G0321</td>
<td>&quot;From time&quot;.</td>
</tr>
<tr>
<td>G0322</td>
<td>&quot;To time&quot;.</td>
</tr>
<tr>
<td>G0350</td>
<td>&quot;There is a message for&quot;.</td>
</tr>
<tr>
<td>G0351</td>
<td>&quot;Based on an outcalling time profile which is currently configured as follows&quot;.</td>
</tr>
<tr>
<td>G0352</td>
<td>&quot;Your outcalling time profile is currently configured as follows&quot;.</td>
</tr>
<tr>
<td>G0353</td>
<td>&quot;Your outcalling time profile is not configured&quot;.</td>
</tr>
<tr>
<td>G0360</td>
<td>&quot;You are specifying the time for outcalling time profile&quot;.</td>
</tr>
<tr>
<td>G0361</td>
<td>&quot;To leave the current time profile&quot;.</td>
</tr>
<tr>
<td>G0362</td>
<td>&quot;To change the time profile&quot;.</td>
</tr>
<tr>
<td>G0363</td>
<td>&quot;Is set to&quot;.</td>
</tr>
<tr>
<td>G0364</td>
<td>&quot;Please enter the time&quot;.</td>
</tr>
<tr>
<td>G0365</td>
<td>&quot;The time should be entered as follows: hour, hour, minute, minute, where the hours are given in 24 hour format. For example, 5 past 1 in the afternoon would be entered as 1305&quot;.</td>
</tr>
<tr>
<td>G0366</td>
<td>&quot;You are configuring outcalling time profile&quot;.</td>
</tr>
<tr>
<td>G0367</td>
<td>&quot;The end time should be greater than the start time&quot;.</td>
</tr>
<tr>
<td>G0400</td>
<td>&quot;You are modifying your personal settings&quot;.</td>
</tr>
<tr>
<td>G0401</td>
<td>&quot;You are modifying your callback options&quot;.</td>
</tr>
<tr>
<td>G0402</td>
<td>&quot;You are modifying your do not disturb options&quot;.</td>
</tr>
<tr>
<td>G0403</td>
<td>&quot;You are modifying your email mode options&quot;.</td>
</tr>
<tr>
<td>G0404</td>
<td>&quot;You are modifying your follow me forward options&quot;.</td>
</tr>
<tr>
<td>G0405</td>
<td>&quot;You are modifying your mobile twinning options&quot;.</td>
</tr>
<tr>
<td>G0406</td>
<td>&quot;You are modifying your voicemail transfer options&quot;.</td>
</tr>
<tr>
<td>G0410</td>
<td>&quot;To modify your personal settings&quot;.</td>
</tr>
</tbody>
</table>
### 6.2 English Non-Intuity Prompts

Here is a list of the named .wav files used by Voicemail Lite and Voicemail Pro for US and UK English. These are predominately, though not exclusively, used for IP Office mode mailbox features and Voicemail Pro custom call flow actions.

All files are Microsoft WAVE file format (.wav) 8kHz, 16 bit mono.

<table>
<thead>
<tr>
<th>WAV File</th>
<th>Non-Intuity Prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td>a60</td>
<td>&quot;Please enter extension and # sign&quot;.</td>
</tr>
<tr>
<td>aa_01</td>
<td>&quot;Good morning and thank you for calling. Please key in the required extension number or hold the line for other options&quot;.</td>
</tr>
<tr>
<td>aa_02</td>
<td>&quot;Good afternoon and thank you for calling. Please key in the required extension number or hold the line for other options&quot;.</td>
</tr>
<tr>
<td>WAV File</td>
<td>Non-Intuity Prompt</td>
</tr>
<tr>
<td>---------</td>
<td>--------------------</td>
</tr>
<tr>
<td>aa_03</td>
<td>&quot;Good evening and thank you for calling. Please key in the required extension number or hold the line for other options&quot;.</td>
</tr>
<tr>
<td>aa_04</td>
<td>&quot;Please hold while we try to connect you&quot;.</td>
</tr>
<tr>
<td>aa_05</td>
<td>&quot;An operator is currently unavailable&quot;.</td>
</tr>
<tr>
<td>aa_06</td>
<td>&quot;Please key in the extension number you would like to leave a message for&quot;.</td>
</tr>
<tr>
<td>aa_07</td>
<td>&quot;Good bye and thank you for calling&quot;.</td>
</tr>
<tr>
<td>alpha_01</td>
<td>&quot;Press # to accepted data, *1 to hear the data, *2 to delete the data, *3 to delete the last character, *# to accept the data and continue&quot;.</td>
</tr>
<tr>
<td>alpha_02</td>
<td>&quot;Data has been deleted&quot;.</td>
</tr>
<tr>
<td>alrm_1</td>
<td>&quot;You have an alarm call set for&quot;.</td>
</tr>
<tr>
<td>alrm_2</td>
<td>&quot;Alarm has been deleted press 1 to continue or * to quit&quot;.</td>
</tr>
<tr>
<td>alrm_3</td>
<td>&quot;Please enter the time for the alarm call in 24 hour clock notation&quot;.</td>
</tr>
<tr>
<td>alrm_4</td>
<td>&quot;You have set an alarm call for&quot;.</td>
</tr>
<tr>
<td>alrm_5</td>
<td>&quot;Press 1 to validate press 2 to add a message to the end press # to cancel&quot;.</td>
</tr>
<tr>
<td>alrm_6</td>
<td>&quot;Your alarm has now been set&quot;.</td>
</tr>
<tr>
<td>alrm_7</td>
<td>&quot;Press 1 to verify this alarm or press 2 to delete it&quot;.</td>
</tr>
<tr>
<td>alrm_8</td>
<td>&quot;This time is invalid please try again&quot;.</td>
</tr>
<tr>
<td>alrm_9</td>
<td>&quot;This is an alarm call please hang up&quot;.</td>
</tr>
<tr>
<td>AM</td>
<td>&quot;AM&quot;.</td>
</tr>
<tr>
<td>aor_00</td>
<td>&quot;Warning: your call is being recorded&quot;.</td>
</tr>
<tr>
<td>cmp_01</td>
<td>&quot;The current campaign message has been marked as deleted&quot;.</td>
</tr>
<tr>
<td>cmp_02</td>
<td>&quot;The current campaign message has been marked as completed&quot;.</td>
</tr>
<tr>
<td>cmp_03</td>
<td>&quot;The current campaign message has been abandoned&quot;.</td>
</tr>
<tr>
<td>cmp_04</td>
<td>&quot;Press 1 to start again, press 2 to rewind, press 3 to abandon, press 4 to delete, press 5 to complete, press 7 for previous field, press 8 for start of current field, press 9 for next field, press # to forward, press 0 to pause, press * to rewind&quot;.</td>
</tr>
<tr>
<td>conf_01</td>
<td>&quot;A conference is not currently scheduled&quot;.</td>
</tr>
<tr>
<td>conf_02</td>
<td>&quot;There was a problem transferring you into the conference&quot;.</td>
</tr>
<tr>
<td>conf_03</td>
<td>&quot;Please enter your conference id and press # to finish&quot;.</td>
</tr>
<tr>
<td>conf_04</td>
<td>&quot;Please enter your PIN and press # to finish&quot;.</td>
</tr>
<tr>
<td>conf_05</td>
<td>&quot;Your conference ID or PIN is not valid&quot;.</td>
</tr>
<tr>
<td>conf_06</td>
<td>&quot;Your conference ID is not valid&quot;.</td>
</tr>
<tr>
<td>conf_07</td>
<td>&quot;Your PIN is not valid&quot;.</td>
</tr>
<tr>
<td>conf_08</td>
<td>&quot;Please try again&quot;.</td>
</tr>
<tr>
<td>conf_09</td>
<td>&quot;To be announced into the conference please speak your name and press # when you have finished&quot;.</td>
</tr>
<tr>
<td>conf_10</td>
<td>&quot;Your name is too short please try again&quot;.</td>
</tr>
<tr>
<td>conf_11</td>
<td>&quot;Has invited&quot;.</td>
</tr>
<tr>
<td>conf_12</td>
<td>&quot;To join them in an immediate conference press 1 to accept, 2 to decline and 3 if the delegate is not available&quot;.</td>
</tr>
<tr>
<td>conf_13</td>
<td>&quot;Has requested&quot;.</td>
</tr>
<tr>
<td>conf_14</td>
<td>&quot;To join in an ad-hoc conference press 1 to accept, 2 to decline and 3 if the delegate is not available&quot;.</td>
</tr>
<tr>
<td>conf_15</td>
<td>&quot;Has declined the offer to attend the conference&quot;.</td>
</tr>
<tr>
<td>conf_16</td>
<td>&quot;Is not available&quot;.</td>
</tr>
<tr>
<td>conf_17</td>
<td>&quot;Has just entered the conference&quot;.</td>
</tr>
<tr>
<td>conf_18</td>
<td>&quot;Has just left the conference&quot;.</td>
</tr>
<tr>
<td>conf_19</td>
<td>&quot;An unknown caller&quot;.</td>
</tr>
<tr>
<td>conf_20</td>
<td>&quot;Has been invited&quot;.</td>
</tr>
<tr>
<td>conf_21</td>
<td>&quot;No conference selected, thank you and good bye&quot;.</td>
</tr>
<tr>
<td>conf_22</td>
<td>&quot;Transferring you to the conference now&quot;.</td>
</tr>
<tr>
<td>conf_23</td>
<td>&quot;Conference not accessible&quot;.</td>
</tr>
<tr>
<td>conf_24</td>
<td>&quot;You have been invited to a conference&quot;.</td>
</tr>
<tr>
<td>dbn_01</td>
<td>&quot;There are&quot;.</td>
</tr>
<tr>
<td>dbn_02</td>
<td>&quot;Press # to play list&quot;.</td>
</tr>
<tr>
<td>WAV File</td>
<td>Non-Intuity Prompt</td>
</tr>
<tr>
<td>----------</td>
<td>--------------------</td>
</tr>
<tr>
<td>dbn_03</td>
<td>&quot;To select&quot;.</td>
</tr>
<tr>
<td>dbn_04</td>
<td>&quot;# for next&quot;.</td>
</tr>
<tr>
<td>dbn_05</td>
<td>&quot;**# for previous&quot;.</td>
</tr>
<tr>
<td>dbn_06</td>
<td>&quot;And #&quot;.</td>
</tr>
<tr>
<td>dbn_07</td>
<td>&quot;Press **2&quot;.</td>
</tr>
<tr>
<td>dbn_10</td>
<td>&quot;For selection by group&quot;.</td>
</tr>
<tr>
<td>dbn_11</td>
<td>&quot;For selection by first name&quot;.</td>
</tr>
<tr>
<td>dbn_12</td>
<td>&quot;For selection by last name&quot;.</td>
</tr>
<tr>
<td>dbn_13</td>
<td>&quot;For selection by extension&quot;.</td>
</tr>
<tr>
<td>dbn_14</td>
<td>&quot;Entries that match your selection&quot;.</td>
</tr>
<tr>
<td>dbn_15</td>
<td>&quot;**3 to clear the list and restart&quot;.</td>
</tr>
<tr>
<td>dbn_16</td>
<td>&quot;Or enter more characters followed by a # to reduce the size of the list&quot;.</td>
</tr>
<tr>
<td>dbn_17</td>
<td>&quot;To change name format entry to&quot;.</td>
</tr>
<tr>
<td>dbn_18</td>
<td>&quot;First name last name&quot;.</td>
</tr>
<tr>
<td>dbn_19</td>
<td>&quot;Last name first name&quot;.</td>
</tr>
<tr>
<td>dbn_20</td>
<td>&quot;Enter group name&quot;.</td>
</tr>
<tr>
<td>dbn_21</td>
<td>&quot;Enter first name&quot;.</td>
</tr>
<tr>
<td>dbn_22</td>
<td>&quot;Enter last name&quot;.</td>
</tr>
<tr>
<td>dbn_23</td>
<td>&quot;Enter extension&quot;.</td>
</tr>
<tr>
<td>dom_01.wav...</td>
<td>Day of month ordinal numbers &quot;1st&quot; to &quot;31st&quot;.</td>
</tr>
<tr>
<td>dow_01</td>
<td>&quot;Sunday&quot;.</td>
</tr>
<tr>
<td>dow_02</td>
<td>&quot;Monday&quot;.</td>
</tr>
<tr>
<td>dow_03</td>
<td>&quot;Tuesday&quot;.</td>
</tr>
<tr>
<td>dow_04</td>
<td>&quot;Wednesday&quot;.</td>
</tr>
<tr>
<td>dow_05</td>
<td>&quot;Thursday&quot;.</td>
</tr>
<tr>
<td>dow_06</td>
<td>&quot;Friday&quot;.</td>
</tr>
<tr>
<td>dow_07</td>
<td>&quot;Saturday&quot;.</td>
</tr>
<tr>
<td>EOC_1</td>
<td>&quot;Warning, your conference will end in&quot;.</td>
</tr>
<tr>
<td>EOC_2</td>
<td>&quot;Your conference will end in&quot;.</td>
</tr>
<tr>
<td>int_na</td>
<td>&quot;Service not supported&quot;.</td>
</tr>
<tr>
<td>ivr_01</td>
<td>&quot;The time according to the IVR server is&quot;.</td>
</tr>
<tr>
<td>ivr_02</td>
<td>&quot;Directory wave table. Enter the number of the caller you want to edit&quot;.</td>
</tr>
<tr>
<td>ivr_03</td>
<td>&quot;Name wave table. Enter the number of the extension you want to edit&quot;.</td>
</tr>
<tr>
<td>ivr_04</td>
<td>&quot;Enter form entries with the # sign to terminate each line. Press # at the end to complete the form&quot;.</td>
</tr>
<tr>
<td>ivr_05</td>
<td>&quot;Form verified&quot;.</td>
</tr>
<tr>
<td>ivr_06</td>
<td>&quot;Form entry is complete&quot;.</td>
</tr>
<tr>
<td>ivr_07</td>
<td>&quot;Press * to abort # to accept or 0 to listen again&quot;.</td>
</tr>
<tr>
<td>ivr_08</td>
<td>&quot;Do not disturb&quot;.</td>
</tr>
<tr>
<td>ivr_09</td>
<td>&quot;Voicemail mode&quot;.</td>
</tr>
<tr>
<td>ivr_10</td>
<td>&quot;Call forwarding&quot;.</td>
</tr>
<tr>
<td>ivr_11</td>
<td>&quot;Forward number is set to&quot;.</td>
</tr>
<tr>
<td>ivr_12</td>
<td>&quot;Follow me number is set to&quot;.</td>
</tr>
<tr>
<td>ivr_13</td>
<td>&quot;Voicemail reception number is set to&quot;.</td>
</tr>
<tr>
<td>ivr_15</td>
<td>&quot;Parameter is set to&quot;.</td>
</tr>
<tr>
<td>ivr_16</td>
<td>&quot;Parameter is enabled&quot;.</td>
</tr>
<tr>
<td>ivr_17</td>
<td>&quot;Parameter is disabled press 1 to enable&quot;.</td>
</tr>
<tr>
<td>ivr_18</td>
<td>&quot;Parameter is disabled&quot;.</td>
</tr>
<tr>
<td>ivr_19</td>
<td>&quot;Parameter is enabled press 2 to disable&quot;.</td>
</tr>
<tr>
<td>ivr_20</td>
<td>&quot;Press 1 to change press # to cancel&quot;.</td>
</tr>
<tr>
<td>ivr_21</td>
<td>&quot;Enter new number after the tone&quot;.</td>
</tr>
<tr>
<td>ivr_22</td>
<td>&quot;Repeat new number after the tone&quot;.</td>
</tr>
<tr>
<td>ivr_23</td>
<td>&quot;Sorry the numbers you have entered are different&quot;.</td>
</tr>
<tr>
<td>WAV File</td>
<td>Non-Intuity Prompt</td>
</tr>
<tr>
<td>----------</td>
<td>-------------------</td>
</tr>
<tr>
<td>ivr_24</td>
<td>&quot;Email options&quot;.</td>
</tr>
<tr>
<td>ivr_25</td>
<td>&quot;Alert email on incoming message&quot;.</td>
</tr>
<tr>
<td>ivr_26</td>
<td>&quot;Copy messages to email&quot;.</td>
</tr>
<tr>
<td>ivr_27</td>
<td>&quot;Forward messages to email&quot;.</td>
</tr>
<tr>
<td>ivr_28</td>
<td>&quot;Email turned off&quot;.</td>
</tr>
<tr>
<td>ivr_29</td>
<td>&quot;Service mode&quot;.</td>
</tr>
<tr>
<td>ivr_30</td>
<td>&quot;In service&quot;.</td>
</tr>
<tr>
<td>ivr_31</td>
<td>&quot;Out of service&quot;.</td>
</tr>
<tr>
<td>ivr_32</td>
<td>&quot;Night service&quot;.</td>
</tr>
<tr>
<td>mc_00</td>
<td>Beep.</td>
</tr>
<tr>
<td>mc_01</td>
<td>Short silence.</td>
</tr>
<tr>
<td>mc_02</td>
<td>One seconds silence.</td>
</tr>
<tr>
<td>misc_24</td>
<td>&quot;Is on holiday until&quot;.</td>
</tr>
<tr>
<td>misc_25</td>
<td>&quot;Is unavailable until&quot;.</td>
</tr>
<tr>
<td>misc_26</td>
<td>&quot;Is at lunch until&quot;.</td>
</tr>
<tr>
<td>misc_27</td>
<td>&quot;Is away on business until&quot;.</td>
</tr>
<tr>
<td>misc_28</td>
<td>&quot;And will be picking up messages regularly&quot;.</td>
</tr>
<tr>
<td>misc_29</td>
<td>&quot;And will not be contactable until their return&quot;.</td>
</tr>
<tr>
<td>misc_30</td>
<td>&quot;List length exceeded&quot;.</td>
</tr>
<tr>
<td>misc_31</td>
<td>&quot;*, cannot access private list&quot;.</td>
</tr>
<tr>
<td>misc_32</td>
<td>&quot;*, list length exceeded&quot;.</td>
</tr>
<tr>
<td>mnu_1</td>
<td>&quot;You have four greeting options. For standard greeting press 1, for after hours greeting press 2, for you are in a queue greeting press 3, for you are still in a queue greeting press 4&quot;.</td>
</tr>
<tr>
<td>mnu_2</td>
<td>&quot;To hear your greeting message press 1, to change your greeting message press 2, to save your greeting message press 3, to save your message for playing as a continuous loop press 4&quot;.</td>
</tr>
<tr>
<td>mnu_2a</td>
<td>&quot;To hear your greeting message press 1, to change your greeting message press 2, to save your greeting message press 3, to save your message for playing as a continuous loop press 4, to return to the previous menu press 8&quot;.</td>
</tr>
<tr>
<td>mnu_3</td>
<td>&quot;When playing a message to delete the message press 4, to save the message press 5, to forward the message to email press 6, to repeat the message press 7, to skip the message press 9, at the end of your messages to play old messages press 1, to play saved messages press 2, to edit your greeting press 3, to direct all messages to email press *01, to send email notifications press *02, to turn off email functions press *03, to change your access code press *04&quot;.</td>
</tr>
<tr>
<td>mnu_4</td>
<td>&quot;When playing a message to delete the message press 4, to save the message press 5, for forwarding options press 6, to repeat the message press 7, to skip the message press 9, to call back the sender press ** at the end of your messages, to play old messages press 1, to play saved messages press 2, to edit your greeting press 3, to direct all messages to email press *01, to send email notifications press *02, to turn off email functions press *03, to change your access code press *04&quot;.</td>
</tr>
<tr>
<td>mnu_5</td>
<td>&quot;To forward message to email press 1, to forward message to other extensions press 2, to add a header message press 3, to send message into your saved messages list press 4, to skip this forwarding press &quot;.</td>
</tr>
<tr>
<td>mnu_6</td>
<td>&quot;User configure options. To edit forwarding number press 1, to edit follow me number press 2, to set call forwarding press 3, to set voicemail press 4, to set do not disturb press 5, to edit voicemail access code press 6, to edit voicemail reception press 7, to set voicemail email mode press 8, to edit voicemail call back number press 9&quot;.</td>
</tr>
<tr>
<td>mnu_7</td>
<td>&quot;Hunt group configure options. To set voicemail press 1, to edit voicemail access code press 2, to set voicemail email mode press 3, to set service mode press 4&quot;.</td>
</tr>
<tr>
<td>mnu_8</td>
<td>&quot;Invalid entry please try again&quot;.</td>
</tr>
<tr>
<td>mnu_9</td>
<td>&quot;That destination is unavailable&quot;.</td>
</tr>
<tr>
<td>MNU_10</td>
<td>&quot;To play your old messages, press 1. To play your saved messages, press 2. To edit your greeting, press 3. To delete the current message, press 4. To save the current message, press 5. To change your access code, press *04. For help at any time, press *4&quot;.</td>
</tr>
<tr>
<td>mo_01</td>
<td>&quot;January&quot;</td>
</tr>
<tr>
<td>mo_02</td>
<td>&quot;February&quot;</td>
</tr>
<tr>
<td>mo_03</td>
<td>&quot;March&quot;</td>
</tr>
<tr>
<td>mo_04</td>
<td>&quot;April&quot;</td>
</tr>
<tr>
<td>mo_05</td>
<td>&quot;May&quot;</td>
</tr>
<tr>
<td>mo_06</td>
<td>&quot;June&quot;</td>
</tr>
<tr>
<td>mo_07</td>
<td>&quot;July&quot;</td>
</tr>
<tr>
<td>WAV File</td>
<td>Non-Intuity Prompt</td>
</tr>
<tr>
<td>-----------</td>
<td>--------------------</td>
</tr>
<tr>
<td>mo_08</td>
<td>&quot;August&quot;</td>
</tr>
<tr>
<td>mo_09</td>
<td>&quot;September&quot;</td>
</tr>
<tr>
<td>mo_10</td>
<td>&quot;October&quot;</td>
</tr>
<tr>
<td>mo_11</td>
<td>&quot;November&quot;</td>
</tr>
<tr>
<td>mo_12</td>
<td>&quot;December&quot;</td>
</tr>
<tr>
<td>no_00.wav</td>
<td>&quot;Zero&quot; to &quot;Fifty-nine&quot;.</td>
</tr>
<tr>
<td>no_24p</td>
<td>&quot;More than 24&quot;.</td>
</tr>
<tr>
<td>noon</td>
<td>&quot;Noon&quot;.</td>
</tr>
<tr>
<td>out_01</td>
<td>&quot;To administer Outlook based greetings, press 5&quot;.</td>
</tr>
<tr>
<td>out_02</td>
<td>&quot;You are administering Outlook based greetings&quot;.</td>
</tr>
<tr>
<td>out_03</td>
<td>&quot;Outlook based greetings are active for all calls&quot;.</td>
</tr>
<tr>
<td>out_04</td>
<td>&quot;Outlook based greetings are used for the following call types&quot;.</td>
</tr>
<tr>
<td>out_05</td>
<td>&quot;Outlook based greetings are currently inactive&quot;.</td>
</tr>
<tr>
<td>out_06</td>
<td>&quot;To deactivate Outlook based greetings&quot;.</td>
</tr>
<tr>
<td>out_07</td>
<td>&quot;To activate Outlook based greetings&quot;.</td>
</tr>
<tr>
<td>out_08</td>
<td>&quot;They will be out of the office until&quot;.</td>
</tr>
<tr>
<td>out_09</td>
<td>&quot;They will be busy until&quot;.</td>
</tr>
<tr>
<td>out_10</td>
<td>&quot;Due to&quot;.</td>
</tr>
<tr>
<td>outb_01</td>
<td>&quot;This is an IP Office outbound alert&quot;.</td>
</tr>
<tr>
<td>outb_04</td>
<td>&quot;Press any key to accept&quot;.</td>
</tr>
<tr>
<td>pg_0001</td>
<td>&quot;To use this greeting for all calls press 1&quot;.</td>
</tr>
<tr>
<td>pg_0002</td>
<td>&quot;To use this greeting for all calls press 0&quot;.</td>
</tr>
<tr>
<td>pg_0003</td>
<td>&quot;For internal calls press 1&quot;.</td>
</tr>
<tr>
<td>pg_0004</td>
<td>&quot;For external calls press 2&quot;.</td>
</tr>
<tr>
<td>pg_0005</td>
<td>&quot;To activate for out of hours call press 3&quot;.</td>
</tr>
<tr>
<td>pg_0006</td>
<td>&quot;If the number is busy press 4&quot;.</td>
</tr>
<tr>
<td>pg_0007</td>
<td>&quot;For no reply calls press 5&quot;.</td>
</tr>
<tr>
<td>pin_01</td>
<td>&quot;Enter your current access code after the tone&quot;.</td>
</tr>
<tr>
<td>pin_02</td>
<td>&quot;Now enter your new access code after the tone&quot;.</td>
</tr>
<tr>
<td>pin_03</td>
<td>&quot;Now repeat your new access code after the tone&quot;.</td>
</tr>
<tr>
<td>pin_04</td>
<td>&quot;Your access code has now been changed&quot;.</td>
</tr>
<tr>
<td>pin_05</td>
<td>&quot;It has been possible to change your access code at this time&quot;.</td>
</tr>
<tr>
<td>pin_06</td>
<td>&quot;Press # when you have finished&quot;.</td>
</tr>
<tr>
<td>pin_07</td>
<td>&quot;Access code must contain 4 or more digits&quot;.</td>
</tr>
<tr>
<td>PM</td>
<td>&quot;PM&quot;.</td>
</tr>
<tr>
<td>que_01</td>
<td>&quot;You are at queue position&quot;.</td>
</tr>
<tr>
<td>que_02</td>
<td>&quot;In the queue&quot;.</td>
</tr>
<tr>
<td>que_03</td>
<td>&quot;Call per&quot;.</td>
</tr>
<tr>
<td>que_04</td>
<td>&quot;Estimated time to answer is&quot;.</td>
</tr>
<tr>
<td>que_05</td>
<td>&quot;Your call will be answered in&quot;.</td>
</tr>
<tr>
<td>rec_01</td>
<td>&quot;Warning: this call is being recorded&quot;.</td>
</tr>
<tr>
<td>RECNAM_01</td>
<td>&quot;As you use IP Office, your name will be included in system announcements that you and other people will hear. At the tone please say your name. After saying your name, press 1&quot;.</td>
</tr>
<tr>
<td>RECNAM_02</td>
<td>&quot;To re-record your name press 1, to confirm press #&quot;.</td>
</tr>
<tr>
<td>RECNAM_03</td>
<td>&quot;Record at the tone&quot;.</td>
</tr>
<tr>
<td>PressHash</td>
<td>&quot;To continue, press #&quot;.</td>
</tr>
<tr>
<td>sac_01</td>
<td>&quot;Cannot retrieve your messages now due to multiple logins to your mailbox&quot;.</td>
</tr>
<tr>
<td>sac_02</td>
<td>&quot;Please disconnect&quot;.</td>
</tr>
<tr>
<td>seconds</td>
<td>&quot;Seconds&quot;.</td>
</tr>
<tr>
<td>ssb_00</td>
<td>&quot;O&quot; (Oh).</td>
</tr>
<tr>
<td>ssb_01</td>
<td>&quot;O’Clock&quot;.</td>
</tr>
<tr>
<td>ssb_02</td>
<td>&quot;No&quot;.</td>
</tr>
<tr>
<td>WAV File</td>
<td>Non-Intuity Prompt</td>
</tr>
<tr>
<td>----------</td>
<td>-------------------</td>
</tr>
<tr>
<td>ssb_03</td>
<td>&quot;None&quot;.</td>
</tr>
<tr>
<td>ssb_04</td>
<td>&quot;Midnight&quot;.</td>
</tr>
<tr>
<td>ssb_05</td>
<td>&quot;And&quot;.</td>
</tr>
<tr>
<td>ssb_06</td>
<td>&quot;Date&quot;.</td>
</tr>
<tr>
<td>ssb_07</td>
<td>&quot;Deleted&quot;.</td>
</tr>
<tr>
<td>ssb_08</td>
<td>&quot;T number&quot;.</td>
</tr>
<tr>
<td>ssb_09</td>
<td>&quot;For&quot;.</td>
</tr>
<tr>
<td>ssb_10</td>
<td>&quot;Forwarded&quot;.</td>
</tr>
<tr>
<td>ssb_11</td>
<td>&quot;Item&quot;.</td>
</tr>
<tr>
<td>ssb_12</td>
<td>&quot;Press&quot;.</td>
</tr>
<tr>
<td>ssb_13</td>
<td>&quot;Quantity&quot;.</td>
</tr>
<tr>
<td>ssb_14</td>
<td>&quot;Saved&quot;.</td>
</tr>
<tr>
<td>ssb_15</td>
<td>&quot;Yesterday&quot;.</td>
</tr>
<tr>
<td>ssb_16</td>
<td>&quot;Hundred&quot;.</td>
</tr>
<tr>
<td>ssb_17</td>
<td>&quot;Hour&quot;.</td>
</tr>
<tr>
<td>ssb_18</td>
<td>&quot;O&quot; (oh).</td>
</tr>
<tr>
<td>ssb_19</td>
<td>&quot;At&quot;.</td>
</tr>
<tr>
<td>ssb_20</td>
<td>&quot;1&quot; (Down tone).</td>
</tr>
<tr>
<td>ssb_21</td>
<td>&quot;1&quot; (Up Tone).</td>
</tr>
<tr>
<td>ssb_22</td>
<td>&quot;1&quot; (Level Tone).</td>
</tr>
<tr>
<td>ssb_23</td>
<td>&quot;Function failed to complete&quot;.</td>
</tr>
<tr>
<td>ssb_29</td>
<td>&quot;Minutes&quot;.</td>
</tr>
<tr>
<td>svm_02</td>
<td>&quot;Calls have been forwarded to email. New calls will also be forwarded to email until turned off&quot;.</td>
</tr>
<tr>
<td>svm_03</td>
<td>&quot;Caller was&quot;.</td>
</tr>
<tr>
<td>svm_04</td>
<td>&quot;Thank you for leaving a message. Mailbox has now stopped recording&quot;.</td>
</tr>
<tr>
<td>svm_05</td>
<td>&quot;Please enter your mailbox number&quot;.</td>
</tr>
<tr>
<td>svm_06</td>
<td>&quot;Please enter your access code&quot;.</td>
</tr>
<tr>
<td>svm_07</td>
<td>&quot;There is no one available to take your call at the moment so please leave a message after the tone&quot;.</td>
</tr>
<tr>
<td>svm_08</td>
<td>&quot;For help at anytime press 8&quot;.</td>
</tr>
<tr>
<td>svm_09</td>
<td>&quot;That was the last message&quot;.</td>
</tr>
<tr>
<td>svm_10</td>
<td>&quot;New message&quot;.</td>
</tr>
<tr>
<td>svm_11</td>
<td>&quot;New messages&quot;.</td>
</tr>
<tr>
<td>svm_12</td>
<td>&quot;Old message&quot;.</td>
</tr>
<tr>
<td>svm_13</td>
<td>&quot;Old messages&quot;.</td>
</tr>
<tr>
<td>svm_14</td>
<td>&quot;Saved message&quot;.</td>
</tr>
<tr>
<td>svm_15</td>
<td>&quot;Saved messages&quot;.</td>
</tr>
<tr>
<td>svm_16</td>
<td>&quot;Remote access is not configured on this mailbox&quot;.</td>
</tr>
<tr>
<td>svm_17</td>
<td>&quot;Email is not enabled on this mailbox&quot;.</td>
</tr>
<tr>
<td>svm_18</td>
<td>&quot;I am afraid all the operators are busy at the moment but please hold and you will be transferred when somebody becomes available&quot;.</td>
</tr>
<tr>
<td>svm_19</td>
<td>&quot;Message was recorded&quot;.</td>
</tr>
<tr>
<td>svm_20</td>
<td>&quot;You're being transferred&quot;.</td>
</tr>
<tr>
<td>svm_21</td>
<td>&quot;You have&quot;.</td>
</tr>
<tr>
<td>svm_22</td>
<td>&quot;Unknown caller&quot;.</td>
</tr>
<tr>
<td>svm_23</td>
<td>&quot;Forwarding to email is now turned off&quot;.</td>
</tr>
<tr>
<td>svm_24</td>
<td>&quot;Start speaking after the tone and your message will be inserted before the message prior to forwarding&quot;.</td>
</tr>
<tr>
<td>svm_25</td>
<td>&quot;To hear the recording press 1, to change the recording press 2, to save the recording press 3&quot;.</td>
</tr>
<tr>
<td>svm_26</td>
<td>&quot;Enter the extension to which you wish this message to be forwarded, separating each extension using the # sign. Press # at the end to complete the list&quot;.</td>
</tr>
<tr>
<td>svm_27</td>
<td>&quot;Message has not yet been recorded&quot;.</td>
</tr>
<tr>
<td>svm_28</td>
<td>&quot;Start speaking after the tone and press 2 when you have finished recording&quot;.</td>
</tr>
<tr>
<td>svm_29</td>
<td>&quot;There are no messages&quot;.</td>
</tr>
<tr>
<td>tim_m00</td>
<td>&quot;Minute&quot;.</td>
</tr>
<tr>
<td>WAV File</td>
<td>Non-Intuity Prompt</td>
</tr>
<tr>
<td>----------</td>
<td>--------------------</td>
</tr>
<tr>
<td>tim_m01</td>
<td>&quot;One minute&quot;.</td>
</tr>
<tr>
<td>tim_m02</td>
<td>&quot;Minutes&quot;.</td>
</tr>
</tbody>
</table>
Chapter 7.
Voicemail Pro Examples
7. Voicemail Pro Examples
7.1 Using VB Script

The VB Script action allows an administrator to construct additional call flow logic using VBScript commands. A number of predefined methods and system variables are available. Any scripting added can be verified by pressing the Syntax Check button. Details of the properties and methods supported are given in the VBScript section. For more information, see VBScript Properties:Overview.

- Use of VBScript requires entry of a valid VM Pro VBScript license in the IP Office configuration.

To add a VB Script action:

1. Click the Miscellaneous Actions icon and select VB Script.
2. Select the Specific tab.

- Enter VBScript
  In the Script area enter the VBScript as required. Details of the System variables and COM methods that are supported are accessible by right clicking in the VBScript area. This script can contain a maximum of 1000 characters.

- Expand
  Check Expand to view a larger script area.

- Syntax Check
  Click the Syntax Check button to check your input for any errors.

This action has two results for which connections to following actions can be made. The results are based on the Scripting entered in the Specific tab.
7.1.1 VBScript Properties

7.1.1.1 Overview
The following properties can be accessed within VBScripts. Note that unless otherwise stated they are session based. The data is specific to a particular Voicemail Pro call and does not persist between calls.

Voicemail contains various state variables that are associated with a specific interaction with voicemail. The system variables listed map to properties associated with the object:

- `$NAM` – (read-only). For more information, see Name Property.
- `$CLI` – (read-only). For more information, see CallingParty Property.
- `$RES` – (read-write). For more information, see Result Property.
- `$VAR` – (read-write). For more information, see Variable Property.
- `$SAV` – (read-write). For more information, see SavedResult Property.
- `$LOC` – (read-write). For more information, see Locale Property.

The following properties are specific to queued and still queued call flows only.

- `$QPOS` – (read-only). For more information, see PositionInQueue Property.
- `$QTIM` – (read-only). For more information, see EstimatedAnswer Property.

The following properties are related to the messages within the mailbox.

- **NewMsgs Property** – Returns the count of new messages within the session’s mailbox. For more information, see NewMsgs Property.
- **OldMsgs Property** – Returns the count of old messages within the session’s mailbox. For more information, see OldMsgs Property.
- **SavedMsgs Property** – Returns the count of saved messages within the session’s mailbox. For more information, see SavedMsgs Property.
- **LastAccessedMsg Property** – Returns the name of the last recorded or accessed message. For more information, see LastAccessedMsg Property.

**Note:** VB Scripting will only support variant types.

**Internal Variables**
Some of the variables that exist within Voicemail Pro can be split into smaller sections using a delimiter.

**Example:**
A CLI contains the number 01707364143. If the call flow references the variable as CLI@0,4 then the value 01707 will be returned as they are the first five numbers.
7.1.1.2 CallingParty Property
The CallingParty property returns the caller id associated with the voicemail session used for VBS interaction with Voicemail (equivalent to $CLI system variable).

- **Owning object:** vmprov5.voicescript

- **String:**
  - **Set:** This property is read-only.
  - **Get:** A String object containing the name of the calling party (or $CLI). For example: String = Voice.CallingParty

- **Remarks:** The CallingParty property is only valid for the current session to Voicemail.

- **Example**
  ```vbscript
  Sub Main (dlgid)
  dim registration
  Set Voice = CreateObject("vmprov5.voicescript")
  registration = Voice.Register(dlgid)
  if registration Then
    dim callerid
    callerid = Voice.CallingParty
  end if
  End Sub
  ```

7.1.1.3 EstimatedAnswer Property
The EstimatedAnswer property returns the $QTIM voicemail system variable. This is the user’s estimated time to answer within the queue in minutes and is only available for queued and still queued call flows.

- **Owning object:** vmprov5.voicescript

- **String:**
  - **Set:** This property is read-only.
  - **Get:** A long containing the current value for $QTIM. For example: Long = Voice.EstimatedAnswer
7.1.1.4 LastAccessedMsg Property
The LastAccessedMsg property returns the name of the last recorded message. If the IP Office TUI is used then this will also contain the name of the last played message.

- **Owning object:** vmprov5.voicescript
- **String:**
  - **Set:** This property is read-only.
  - **Get:** A string object containing the fully qualified name of the last played or recorded message. For example: $String = Voice.LastAccessedMsg

7.1.1.5 Locale Property
The Locale property gets and sets the $LOC voicemail system variable.

- **Owning object:** vmprov5.voicescript
- **String:**
  - **Set:** A string object that contains the new value for the $LOC variable. For example: $Voice.Locale = String
  - **Get:** A string object containing the current value for $LOC. For example: $String = Voice.Locale

**Example**

```vbscript
Sub Main (dlgid)
  Dim registration
  Dim Voice = CreateObject("vmprov5.voicescript")
  registration = Voice.Register(dlgid)
  If registration Then
    Dim locale
    Do Some Processing.
    locale = Voice.Locale
    Rem NOW SET LOCATE TO FRENCH
    Voice.Locale = "fr"
    Do Some Processing.
    Rem NOW SET LOCATE BACK TO WHAT IT WAS
    Voice.Locale = locale
  End If
End Sub
```
7.1.1.6 Name Property
The Name property returns the name of the mailbox associated with the voicemail session used for VBScript interaction with Voicemail (equivalent to $NAM system variable).

- **Owning object**: vmprov5.voicescript
- **String**:
  - **Set**: This property is read-only.
  - **Get**: A String object containing the name of the associated voice mailbox. For example:
    - String = Voice.Name

7.1.1.7 NewMsgs Property
The NewMsgs property returns the number of new messages contained within the session mailbox.

- **Owning object**: vmprov5.voicescript
- **String**:
  - **Set**: This property is read-only.
  - **Get**: The number of new messages within the mailbox. For example: Number = Voice.NewMsgs

7.1.1.8 OldMsgs Property
The OldMsgs property returns the number of old messages contained within the session mailbox.

- **Owning object**: vmprov5.voicescript
- **String**:
  - **Set**: This property is read-only.
  - **Get**: The number of old messages within the mailbox. For example: Number = Voice.OldMsgs
7.1.1.9 PositionInQueue Property

The **PositionInQueue** property returns the $QPOS voicemail system variable. This is the user’s current position in the queue and is only available for queued and still queued call flows.

- **Owning object:** vmprov5.voicescript
- **String:**
  - **Set:** This property is read-only.
  - **Get:** A string object containing the current value for $QPOS. For example: `String = Voice.PositionInQueue`

7.1.1.10 Result Property

The **Result** property gets and sets the $RES voicemail system variable. The $RES variable contains the result property of a call flow action. The result is action-specific, for example OK, FAILED, BUSY and so on. The call flow action is able to use the variable to determine logic to be based upon the Result of a preceding Action, or as a temporary variable in the VB-Script. However the variable will be overwritten after the VB Action is completed. If the values from the VB action icon need to be passed to subsequent actions, it is advisable to use user variables.

- **Owning object:** vmprov5.voicescript
- **String:**
  - **Set:** A string object that contains the new value for the $RES variable. For example: `Voice.Result = String`
  - **Get:** A string object containing the current value for $RES. For example: `String = Voice.Result`

**Example**

```vbnet
Sub Main (dlgid)
    dim registration
    Set Voice = CreateObject("vmprov5.voicescript")
    registration = Voice.Register(dlgid)
    if registration Then
        dim result
        dim success
        DO SOME PROCESSING.
        if success Then
            Voice.Result = TRUE
        else
            Voice.Result = FALSE
        end if
    End Sub
```
7.1.1.11 SavedMsgs Property
The SavedMsgs property returns the number of saved messages contained within the session mailbox.

- **Owning object:** vmprov5.voicescript
- **String:**
  - **Set:** This property is read-only.
  - **Get:** The number of saved messages within the mailbox. For example: `Number = Voice.SavedMsgs`

7.1.1.12 SavedResult Property
The SavedResult property gets and sets the $SAV voicemail system variable.

- **Owning object:** vmprov5.voicescript
- **String:**
  - **Set:** A string object that contains the new value for the $SAV variable. For example: `Voice.SavedResult = String`
  - **Get:** A string object containing the current value for $SAV. For example: `String = Voice.SavedResult`

7.1.1.13 Variable Property
The Variable property gets and sets the $VAR voicemail system variable.

- **Owning object:** vmprov5.voicescript
- **String:**
  - **Set:** A string object that contains the new value for the $VAR variable. For example: `Voice.Variable = String`
  - **Get:** A string object containing the current value for $VAR. For example: `String = Voice.Variable`
7.1.2 VBScript Methods

7.1.2.1 ForwardMsg Method
The **ForwardMsg** method is used to forward a file or message to other mailboxes.

```vbscript
Voice.ForwardMsg(
    file As String,
    mailboxes As String,
    ident As String
)
```

- **Parameters**
  - `file` - This contains the name of the message file to be forwarded. The following formats are allowable:
    - **[GREETING]\greeting**
      Forwards the greeting stored within the greetings directory (the .WAV extension is automatically appended).
    - **[ACCOUNTS]\mailbox\message**
      Forwards the message stored within the specified mailbox (the .WAV extension is automatically appended).
    - **[CAMPAIGN]\campaign\message**
      Forwards a campaign message stored within the specified campaign (the .WAV extension is automatically appended).
    - If the fully qualified path is specified (drive:\path\file) then the full specified pathname is used otherwise the file is relative to the WAVS directory.
  - `mailboxes` - The list of mailboxes to forward the message to (separated by non digits, e.g. 202 203 204).
  - `ident` - The CLI to be associated with the message.

- **Return Value**
  This method does not return a value.

7.1.2.2 ForwardMsgToMailbox Method
The **ForwardMsgToMailbox** method is used to forward a file or message to another mailbox.

```vbscript
Voice.ForwardMsgToMailbox(
    file As String,
    mailbox As String,
    ident As String
) As String
```

- **Parameters**
  - `file` - This contains the name of the message file to be forwarded. The following formats are allowable:
    - **[GREETING]\greeting**
      Forwards the greeting stored within the greetings directory (the .WAV extension is automatically appended).
    - **[ACCOUNTS]\mailbox\message**
      Forwards the message stored within the specified mailbox (the .WAV extension is automatically appended).
    - **[CAMPAIGN]\campaign\message**
      Forwards a campaign message stored within the specified campaign (the .WAV extension is automatically appended).
    - If the fully qualified path is specified (drive:\path\file) then the full specified pathname is used otherwise the file is relative to the WAVS directory.
  - `mailbox` - The mailbox to forward the message to.
  - `ident` - The CLI to be associated with the message.

- **Return Value**
  The name of the new message.
### 7.1.2.3 FullFilename Method

The **FullFilename** method is used to translate the shortcut filename to the equivalent fully qualified pathname for the file.

```vba
Voice.FullFilename(
    file As String
) As String
```

#### Parameters

- **file** - This contains the name of the file to be translated:
  
  - **[GREETING]\greeting**
    The file is relative to the greetings directory.
  
  - **[ACCOUNTS]\mailbox\message**
    The file is relative to the accounts directory.
  
  - **[CAMPAIGN]\campaign\message**
    The file is relative to the campaigns directory.
  
  - If the fully qualified path is specified (drive:\path\file) then the full specified path name is used otherwise the file is relative to the specified locale within the WAVS directory.

#### Return Value

The equivalent fully qualified path name for the specified file.

### 7.1.2.4 GetCallingParty Method

The **GetCallingParty** method is used to obtain the $CLI session variable.

```vba
Voice.GetCallingParty(
    [dlgid As Long = 0]
) As String
```

#### Parameters

- **dlgid** - The connection ID as passed in to the script.

#### Return Value

The value of the $CLI session variable associated with the specified voicemail session.
7.1.2.5 GetDTMF Method

The **GetDTMF** method is used to return user's DTMF input.

```vbscript
Voice.GetDTMF(
    [digits As Long = 1],
    [timeout As Long = 30],
    [dlgId As Long = 0]
) As String
```

**Parameters**

- **digits** - The maximum number of DTMF digits to capture.
- **timeout** - The maximum time to wait for DTMF input.
- **dlgId** - The connection ID as passed in to the script.

**Return Value**
The DTMF keys that were pressed.

7.1.2.6 GetEstimatedAnswer Method

The **GetEstimatedAnswer** method is used to obtain the $QTIM session variable.

```vbscript
Voice.GetEstimatedAnswer (dlgId As Long = 0)
```

**Parameters**

- **dlgId** - The connection ID as passed in to the script.

**Return Value**
The value of the $QTIM session variable associated with the specified voicemail session.
7.1.2.7 GetExtension Method
The GetExtension method is used to obtain an extension.

```vbnet
Voice.GetExtension(
   index As Long,
) As String
```

- **Parameters**
  - `index` - The extension to return. **Note**: The actual extension number should not be entered as index refers to the offset number of the extension in the listing.

- **Return Value**
The extension at that position within the list (an empty string if end of list).

- **Example**
  ```vbnet
  Sub Main (dlgid)
  dim registration
  Set Voice = CreateObject("vmprov5.voicescript")
  registration = Voice.Register(dlgid)
  if registration Then
      dim index
      dim ext
      index = 0
      Do
         ext = Voice.GetExtension(index)
         index = index + 1
      Loop Until Len(ext) = 0
  end if
  End Sub
  ```

7.1.2.8 GetLocale Method
The GetLocale method is used to obtain the $LOC session variable.

```vbnet
Voice.GetLocale(
   [dlgid As Long = 0]
) As String
```

- **Parameters**
  - `dlgid` - The connection ID as passed in to the script.

- **Return Value**
The value of the $LOC session variable associated with the specified voicemail session.

7.1.2.9 GetMailbox Method
The GetMailbox method is used to obtain a mailbox.

```vbnet
Voice.GetMailbox(
   index As Long,
) As String
```

- **Parameters**
  - `index` - The mailbox to return.
    
    The actual mailbox number should not be entered as index refers to the offset number of the mailbox in the listing.

- **Return Value**
The mailbox at that position within the list (an empty string if end of list).
7.1.2.10 GetMailboxMessage Method
The GetMailboxMessage method is used to obtain a message within a mailbox.

```vbscript
Voice.GetMailboxMessage(
    mailbox As String,
    msgtype As String,
    index As Long,
) As String
```

- **Parameters**
  - *mailbox* - The mailbox to return messages for.
  - *msgtype* - The type of messages to return.
    
      This can start with an **N** for new messages, **O** for old messages and **S** for saved messages.
  - *index* - The message to return.

- **Return Value**
  The message at that position within the list (an empty string if end of list).

7.1.2.11 GetMailboxMessages Method
The GetMailboxMessages method is used to obtain the count of specific messages within a mailbox.

```vbscript
Voice.GetMailboxMessages(
    mailbox As String,
    msgtype As String
) As Long
```

- **Parameters**
  - *mailbox* - The mailbox to return message counts for.
  - *msgtype* - The type of messages to return counts for.
    
      This can start with an **N** to obtain the number of new messages, **O** for old messages and **S** for saved messages.

- **Return Value**
  The number of messages of a particular type within the mailbox.
7.1.2.12 GetMessagePriority Method
The **GetMessagePriority** method is used to determine whether the message was left with priority.

```vbnet
Voice.GetMessagePriority(
    mailbox As String,
    message As String
) As Boolean
```

- **Parameters**
  - `mailbox` - The mailbox that the message belongs to.
  - `message` - The message to query.

- **Return Value**
  True if the message was left with priority, otherwise False.

7.1.2.13 GetMessagePrivate Method
The **GetMessagePrivate** method is used to determine whether the message was left with privacy.

```vbnet
Voice.GetMessagePrivate(
    mailbox As String,
    message As String
) As Boolean
```

- **Parameters**
  - `mailbox` - The mailbox that the message belongs to.
  - `message` - The message to query.

- **Return Value**
  True if the message was left with privacy, otherwise False.

7.1.2.14 GetMessageStatus Method
The **GetMessageStatus** method is used to obtain the state of the message within a mailbox.

```vbnet
Voice.GetMessageStatus(
    mailbox As String,
    message As String
) As String
```

- **Parameters**
  - `mailbox` - The mailbox that the message belongs to.
  - `message` - The message to query.

  The message name format should be `[Accounts]\mailbox\message`. for example, `[Accounts]\Extn247\MSG00004`.

- **Return Value**
  The state of the message within the mailbox. **N** for new, **O** for old, **S** for saved.
7.1.2.15 GetName Method
The **GetName** method is used to obtain the $NAM session variable.

```
Voice.GetName(
    [dlgId As Long = 0]
) As String
```

- **Parameters**
  - `dlgId` - The connection ID as passed in to the script.

- **Return Value**
The value of the $NAM session variable associated with the specified voicemail session.

7.1.2.16 GetNewMsgs Method
The **GetNewMsgs** method is used to obtain the number of new messages contained within the session’s mailbox.

```
Voice.GetNewMsgs (
    [dlgId As Long = 0]
) As Long
```

- **Parameters**
  - `dlgId` - The connection ID as passed in to the script.

- **Return Value**
The number of new messages contained within the session’s mailbox.

7.1.2.17 GetOldMsgs Method
The **GetOldMsgs** method is used to obtain the number of old messages contained within the session’s mailbox.

```
Voice.GetOldMsgs (
    [dlgId As Long = 0]
) As Long
```

- **Parameters**
  - `dlgId` - The connection ID as passed in to the script.

- **Return Value**
The number of old messages contained within the session’s mailbox.
7.1.2.18 GetPositionInQueue Method
The `GetPositionInQueue` method is used to obtain the $QPOS session variable.

```vba
Voice.GetPositionInQueue (dlgid As Long = 0) As String
```

- **Parameters**
  - `dlgid` - The connection ID as passed in to the script.

- **Return Value**
The value of the $QPOS session variable associated with the specified voicemail session.

7.1.2.19 GetRegister Method
The `GetRegister` method is used to retrieve a string stored in one of the session sixteen data variables. ($CP0 to $CP15).

```vba
Voice.GetRegister (regnum As Long, 
                   [dlgid As Long = 0]) As String
```

- **Parameters**
  - `regnum` - Data register to use for storage (0-15).
  - `dlgid` - The connection ID as passed in to the script.

- **Return Value**
The data stored within the specified register.

7.1.2.20 GetResult Method
The `GetResult` method is used to obtain the $RES session variable.

```vba
Voice.GetResult ( [dlgid As Long = 0]) As String
```

- **Parameters**
  - `dlgid` - The connection ID as passed in to the script.

- **Return Value**
The value of the $RES session variable associated with the specified voicemail session.
7.1.2.21 GetSavedMsgs Method
The GetSavedMsgs method is used to obtain the number of saved messages contained within the session’s mailbox.

```
Voice.GetSavedMsgs (
    dlgid As Long = 0
) As Long
```

- **Parameters**
  - `dlgid` - The connection ID as passed in to the script.

- **Return Value**
  The number of saved messages contained within the session’s mailbox.

7.1.2.22 GetSavedResult Method
The GetSavedResult method is used to obtain the $SAV session variable.

```
Voice.GetSavedResult (dlgid As Long = 0)
```

- **Parameters**
  - `dlgid` - The connection ID as passed in to the script.

- **Return Value**
  The value of the $SAV session variable associated with the specified voicemail session.

7.1.2.23 GetVariable Method
The GetVariable method is used to obtain the $VAR session variable.

```
Voice.GetVariable (dlgid As Long = 0)
```

- **Parameters**
  - `dlgid` - The connection ID as passed in to the script.

- **Return Value**
  The value of the $VAR session variable associated with the specified voicemail session.
7.1.2.24 MessageCLI Method
The MessageCLI method is used to obtain the CLI of the caller that left the message within a mailbox.

    Voice.MessageCLI(        
        mailbox As String,   
        message As String  
    ) As String

- **Parameters**
  - `mailbox` - The mailbox that the message belongs to.
  - `message` - The message to query.

- **Return Value**
The CLI of the caller that left the message.

7.1.2.25 MessageDisplay Method
The MessageDisplay method is used to obtain the display field associated with the message within a mailbox.

    Voice.MessageDisplay(     
        mailbox As String,   
        message As String    
    ) As String

- **Parameters**
  - `mailbox` - The mailbox that the message belongs to.
  - `message` - The message to query.

- **Return Value**
The display string associated with the message.

7.1.2.26 MessageLength Method
The MessageLength method is used to obtain the length of a message within a mailbox.

    Voice.MessageLength(     
        mailbox As String,   
        message As String    
    ) As Long

- **Parameters**
  - `mailbox` - The mailbox that the message belongs to.
  - `message` - The message to query.

- **Return Value**
The length of the message in milliseconds.
7.1.2.27 MessageTime Method

The MessageTime method is used to obtain the date and time the message was left within a mailbox.

```vbs
Voice.MessageTime(
    mailbox As String,
    message As String
) As String
```

- **Parameters**
  - `mailbox` - The mailbox that the message belongs to.
  - `message` - The message to query.

- **Return Value**
  The time the message was left in the format: YEAR/MONTH/DAY HOUR:MINUTE. For example 2003/09/23 13:26.

7.1.2.28 PlayDigits Method

The PlayDigits method is used to play the digits specified through voicemail to the active connection.

```vbs
Voice.PlayDigits(
    digits As String,
    [wait As Boolean = True],
    [interruptables As String = "Any"],
    [dlgid As Long = 0]
) As String
```

- **Parameters**
  - `digits` - This contains the digits to be played (e.g. “12345” plays “one two three four five”).
  - `wait` - This is an optional parameter specifying whether voicemail should return immediately or wait until the digits have been played first.
  - `interruptables` - This is for future development and should be left as default.
  - `dlgid` - The connection ID as passed in to the script.

- **Return Value**
  The key press that was used to terminate the playback.

- **Example**
  ```vbs
  Sub Main (dlgid)
  dim registration
  Set Voice = CreateObject("vmprov5.voicescript")
  registration = Voice.Register(dlgid)
  if registration Then
    dim key
    key = Voice.PlayDigits("12345");
  end if
  End Sub
  ```
7.1.2.29 PlayLocaleWav Method

The **PlayLocaleWav** method is used to play a wave file through voicemail to the active connection taking into account the system locale.

```vbnet
Voice.PlayLocaleWav(
    wav As String,
    [wait As Boolean = True],
    [interruptables As String = "Any"],
    [dlgid As Long = 0]
) As String
```

**Parameters**

- **wav** - This contains the name of the wave file to be played and is of the following format:
  - **[GREETING]\greeting**
    Plays out the greeting stored within the greetings directory (the .WAV extension is automatically appended).
  - **[ACCOUNTS]\mailbox\message**
    Plays out the message stored within the specified mailbox (the .WAV extension is automatically appended).
  - **[CAMPAIGN]\campaign\message**
    Plays out a campaign message stored within the specified campaign (the .WAV extension is automatically appended).
  - If the fully qualified path is specified (drive:\path\file) then the full specified path name is used otherwise the file is relative to the specified locale within the WAVS directory.

- **wait** - This is an optional parameter specifying whether voicemail should return immediately or wait until the wave file has been played first.

- **interruptables** - This is for future development and should be left as default.

- **dlgid** - The connection ID as passed in to the script.

**Return Value**
The key press that was used to terminate the playback.
7.1.2.30 PlayWav Method

The **PlayWav** method is used to play a wave file through voicemail to the active connection.

```vbscript
Voice.PlayWav(
    wav As String,
    [wait As Boolean = True],
    [interruptables As String = "Any"],
    [dlgid As Long = 0]
) As String
```

- **Parameters**

  - **wav** - This contains the name of the wave file to be played or the name of a system parameter to be spoken. The following formats are allowable:
    
    - **$NAM**
      Plays the recorded name for the mailbox if one has been recorded. If a name has not been recorded then optional TTS can be used (providing it has been licensed).
    
    - **$TIME:hh[:mm[:ss]] [ Y][ dd[/mm[/yy]]]**
      Plays out the specified time and date. The hours to speak must always be specified and optional the number of minutes, seconds, day, month and year.
      
      For example:

      - **$TIME:11**
        Speaks AT ELEVEN HOUR HUNDRED
      
      - **$TIME:11:55**
        Speaks AT ELEVEN HOUR FIFTY FIVE
      
      - **$TIME:11:55:13**
        Speaks AT ELEVEN HOUR FIFTY FIVE
      
      - **$TIME:11:55 Y**
        Speaks YESTERDAY AT ELEVEN HOUR FIFTY FIVE
      
      - **$TIME:11:55:13 Y**
        Speaks YESTERDAY AT ELEVEN HOUR FIFTY FIVE
      
      - **$TIME:11:55 21/09/03**
        Speaks AT ELEVEN HOUR FIFTY FIVE [1SEC PAUSE] DATE TWENTY FIRST SEPTEMBER
    
    - **$QPOS [:position]**
      This plays out “You are at queue position” position “in the queue”.
    
    - **$QTIM [:eta]**
      This plays out “Estimated time to answer is” eta “minutes”.
    
    - **$MSGN:msgs**
      Plays out the specified number of old messages (e.g. $MSGN:10 = “You have ten new messages”.
    
    - **$MSGO:msgs**
      Plays out the specified number of old messages (e.g. $MSGN:0 = “You have no old messages”.
    
    - **$MSGS:msgs**
      Plays out the specified number of old messages (e.g. $MSGS:5 = “You have five saved messages”.
    
    - **$CID, $CLI, $CP, $DATE, $DBD, $DLG, $ETA, $KEY, $LOC, $POS, $SAV, $TIME, $UUI, $VAR**
      Plays out the contents on one of the system variables.
    
    - **If the string just contains numbers, then the digits are played, for example 12345 plays “one two three four five”.
      
      - **[GREETING]\greeting**
        Plays out the greeting stored within the greetings directory (the .WAV extension is automatically appended).
    
    - **[ACCOUNTS]\mailbox\message**
      Plays out the message stored within the specified mailbox (the .WAV extension is automatically appended).
    
    - **[CAMPAIGN]\campaign\message**
      Plays out a campaign message stored within the specified campaign (the .WAV extension is automatically appended).
    
      If the fully qualified path is specified (drive:\path\file) then the full specified pathname is used otherwise the file is relative to the WAVS directory.
    
    - **wait** - This is an optional parameter specifying whether voicemail should return immediately or wait until the wave file has been played first.
    
    - **interruptables** - This is for future development and should be left as default.
    
    - **dlgid** - The connection ID as passed in to the script.

- **Return Value**
  The key press that was used to terminate the playback.

- **Example**
Sub Main (dlgid)
    dim registration
    Set Voice = CreateObject("vmprov5.voicescript")
    registration = Voice.Register(dlgid)
    if registration Then
        dim key
        key = Voice.PlayWav("test", True, "Any", dlgid);
    end if
End Sub
### 7.1.2.31 RecordMsg Method

The **RecordMsg** method is used to record a user’s speech input to the specified file.

```vbscript
Voice.RecordMsg(
    recording As String,
    maxtime As Long,
    [interruptables As String = "Any"],
    [appendtofile As Boolean = False],
    [dlgid As Long = 0],
    [playbeep As Boolean = False]
) As String
```

- **Parameters**
  - **recording** - This contains the name of the file for the recording to be stored to and can be in the following formats:
    - [GREETING]\greeting Stores the recording in the specified file within the greetings directory.
    - [ACCOUNTS]\mailbox\message Stores to the specified message within the specified mailbox.
    - [CAMPAIGN]\campaign\message Stores to the specified message within the specified campaign.
  - **maxtime** - The maximum recording length specified in seconds.
  - **interruptables** - This is for future development and should be left as default.
  - **appendtofile** - Set to true if the recording should be appended to the file, false to clear the file first.
  - **dlgid** - The connection ID as passed in to the script.
  - **playbeep** - This flag sets whether a beep is played before the start of recording.

- **Return Value**
  The key press that was used to terminate the recording.

### 7.1.2.32 RecordRegister Method

The **RecordRegister** method is used to record a user’s speech input to the specified file stored in the specified register.

```vbscript
Voice.RecordRegister(
    regnum As Long,
    [maxtime As Long = 60],
    [interruptables As String = "-1"],
    [dlgid As Long = 0],
    [playbeep As Boolean = False]
) As String
```

- **Parameters**
  - **regnum** - Data register containing file to store recording to.
  - **maxtime** - The maximum recording length specified in seconds.
  - **interruptables** - This is for future development and should be left as default.
  - **dlgid** - The connection ID as passed in to the script.
  - **playbeep** - This flag sets whether a beep is played before the start of recording.

- **Return Value**
  The key press that was used to terminate the recording.
7.1.2.33 Register Method

The Register method is used to determine whether the voicemail session that was used to launch the VB script is still active.

```vbscript
Voice.Register(
    dlgid As Long
) As Boolean
```

- **Parameters**
  - `dlgid` - An ID that is associated with the Voicemail connection. This is passed as a parameter to the VB script.

- **Return Value**
  A Boolean variable indicating whether the specified voicemail session is still active.

- **Example**

```vbscript
Sub Main (dlgid)
    dim registration
    Set Voice = CreateObject("vmprov5.voicescript")
    registration = Voice.Register(dlgid)
    if registration Then
        do something.
    end if
End Sub
```

7.1.2.34 SetLocale Method

The SetLocale method is used to set the $LOC session variable.

```vbscript
Voice.SetLocale(
    locale As String,
    [dlgid As Long = 0]
)
```

- **Parameters**
  - `locale` - The new value for the $LOC variable.
  - `dlgid` - The connection ID as passed in to the script.

- **Return Value**
  This method does not return a value.
7.1.2.35 SetMailboxMessage Method
The **SetMailboxMessage** method is used to modify a message within a mailbox.

```
    Voice.SetMailboxMessage(
        mailbox As String,
        message As String,
        msgtype As String
    )
```

- **Parameters**
  - **mailbox** - The mailbox that the return message belongs to.
  - **message** - The message to modify. The message name format should be **[Accounts]\mailbox\message**. For example **[Accounts]\Extn247\MSG00004**.
  - **msgtype** - The new status type for the message. This can start with an **N** for new, **O** for old and **S** for saved.

- **Return Value**
  This method does not return a value.

7.1.2.36 SetRegister Method
The **SetRegister** method is used to store a string in one of the sixteen session data variables ($CP0 to $CP15).

```
    Voice.SetRegister(
        regnum As Long,
        data As String,
        [dlgid As Long = 0]
    )
```

- **Parameters**
  - **regnum** - Data register to use for storage (0-15).
  - **data** - The data to store within this register.
  - **dlgid** - The connection ID as passed in to the script.

- **Return Value**
  This method does not return a value.
### 7.1.2.37 SetResult Method

The **SetResult** method is used to set the $RES session variable.

```vba
Voice.SetResult(
    result As String,
    [dlgid As Long = 0]
)
```

- **Parameters**
  - `result` - The new value for the $RES variable.
  - `dlgid` - The connection ID as passed in to the script.

- **Return Value**
  This method does not return a value.

### 7.1.2.38 SetSavedResult Method

The **SetSavedResult** method is used to set the $SAV session variable.

```vba
Voice.SetSavedResult(
    result As String,
    [dlgid As Long = 0]
)
```

- **Parameters**
  - `result` - The new value for the $SAV variable.
  - `dlgid` - The connection ID as passed in to the script.

- **Return Value**
  This method does not return a value.

### 7.1.2.39 SetVariable Method

The **SetVariable** method is used to set the $VAR session variable.

```vba
Voice.SetVariable(
    variable As String,
    [dlgid As Long = 0]
)
```

- **Parameters**
  - `variable` - The new value for the $VAR variable.
  - `dlgid` - The connection ID as passed in to the script.

- **Return Value**
  This method does not return a value.
7.1.2.40 Speak Method

The **Speak** method is used to speak out the specified speech provided TTS has been licensed.

```vbnet
Voice.Speak{
    text As String,
    [wait As Boolean = True],
    [interruptables As String = "Any"],
    [digid As Long = 0]
} As String
```

- **Parameters**
  - **text** - This contains the text to be spoken.
  - **wait** - This is an optional parameter specifying whether voicemail should return immediately or wait until the wave file has been played first.
  - **interruptables** - This is for future development and should be left as default.
  - **digid** - The connection ID as passed in to the script.

- **Return Value**
  The key press that was used to terminate the playback.
7.2 IVR: Connecting Voicemail Pro to a Database

Voicemail Pro call flows can interact, read and write data, with almost any Windows database that supports ODBC (Open Database Connectivity) and SQL (Structured Query Language) format.

- **Requirements for Voicemail Pro Database Operation**
  To use the Database actions within Voicemail Pro, a [VM Pro Database Interface](#) must be added to the IP Office configuration.

The [Database Actions](#) that can be used in a call flow are:

- **Database Open**
  Opens the required database, including any necessary permissions and security options.

- **Database Execute**
  Defines a SQL query to either read matching records from the database or to write data to the database. Up to 6 fields can be defined to be returned in matching database records.

- **Database Get Data**
  Selects the current record from the matches returned by the preceding Database Execute action. The record fields are then placed into Voicemail Pro variables `DBD[0]` to `DBD[5]`. The Database Get Data allows selection of the first, next, previous or last record.

- **Database Close**
  Closes the database connection. This also occurs automatically if the caller disconnects.
7.2.1 Example
7.2.1.1 Database Scenario
In this call flow example, an auto-attendant has been created to allow callers to order books. The book details are held within a Microsoft Access database. Callers will be able to enter either the ISBN or Author's name. The title and cost of the item will be looked up allowing the caller to purchase the item if they wish to. If the caller purchases the book they will be able to enter their credit card details and a contact number.

Example of the database used in the call flow.

<table>
<thead>
<tr>
<th>ISBN</th>
<th>Author</th>
<th>Title</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>1001</td>
<td>James Herbert</td>
<td>The Fog</td>
<td>£4.30</td>
</tr>
<tr>
<td>1002</td>
<td>James Herbert</td>
<td>The Rats</td>
<td>£2.50</td>
</tr>
<tr>
<td>6666</td>
<td>J D Salinger</td>
<td>The Catcher in the Rye</td>
<td>£3.10</td>
</tr>
<tr>
<td>6757</td>
<td>J K Rowling</td>
<td>The Harry Potter Books</td>
<td>£3.50</td>
</tr>
<tr>
<td>7777</td>
<td>A A Milne</td>
<td>Winnie the Poo</td>
<td>£2.80</td>
</tr>
<tr>
<td>8888</td>
<td>Rudyard Kipling</td>
<td>The Jungle Books</td>
<td>£3.40</td>
</tr>
<tr>
<td>9999</td>
<td>Jonathan Swift</td>
<td>Gulliver's Travels</td>
<td>£2.30</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>£0.00</td>
</tr>
</tbody>
</table>
7.2.1.2 Retrieving Data from the Database

The **Bookshop_Welcome** module allows callers to choose to search the database by either the books ISBN number or the author's name. The screen below shows the call flow module used when a search by ISBN is selected. The database actions that have been used are shown below the call flow diagram, with details on the following pages.
Database Open Action

The Database Open Action is used to link to the bookshop database.

The specific tab of the action contains the location of the database. Click the browse button to view the Data Link Properties dialog. The details entered into these screens will depend upon the type of database used. This example uses a Microsoft Access Database. The example shown below shows the connection to the database. If the database is available the callers move through the call flow to a menu action that will capture the ISBN number entered.
Database Execute Action

The Database Execute Action contains a query against the open database, in this example it concerns the ISBN captured in the previous menu action.

If the sequence of numbers entered by the caller matches an ISBN entry in the database, then the Author’s name, cost, ISBN and book title details are captured. This query is entered into the Database Execute Action via the specific tab.

When entering information into the specific tab for the first time you are taken through a series of steps.

1. Select the Database Open Icon required. In this example the 'Make sure Database still active' icon was selected.
2. At the SQL Function window the option to 'Select ...From' was chosen as information from the database is required.
3. Details are then entered into the SQL Wizard, as shown below.
4. When the query has been entered the SQL wizard is closed. The specific tab of the action will contain the entered query, see example shown below.

**Database Get Data Action**

The Database Get Data Action is used to return details of any matching entries following a search against a database.

To retrieve the results an option is selected on the specific tab to select how the data is retrieved from the database. In this example the option 'retrieve the next item in the list' was selected to allow the caller to step through the results, if more than one match ISBN occurred.

If a matching ISBN has been found the call flow is routed to another module called 'Bookshop_CurrentBookSpeakDetails'.
7.2.1.3 Returning Data from the Database

The *Bookshop_CurrentBookSpeakDetails* module tells the caller the book title, the author's name and the cost of the book matching the ISBN that they entered.

The information from the database is conveyed to the caller using the 'Speak Text Action'.

- To use the **Speak Action**, the IP Office must be licensed for and have installed Text to Speech.
**Speak Book Title**

The Speak Book Title action is used to tell the caller the book title associated with the ISBN that was entered.

The fields selected in the 'Request ISBN from DB' action contain the information retrieved from the bookshop database. The fields selected were Author, Cost, ISBN and Title.

Any fields selected in a query will appear in alphabetical order.

- $DBD[0]$ would return details from the field Author
- $DBD[1]$ would return details from the field Cost
- $DBD[3]$ would return details from the field Title.

Each **Speak Text** action in the call flow returns the values from a different field selected within the database query. The 'Speak Book Cost' action has additional text added so that the currency can be spoken. In this example pounds are used.
7.2.1.4 Entering Details into the Database

The caller is given an option to buy the book. If they select to buy the book, the call flow module *Bookshop_CurrentBookBuy* operates. The call flow immediately checks that access to the bookshop database is still available via a Database Open action.

**Confirm Book Details**

Generic actions are used to store the ISBN number and cost. The example below shows how the ISBN number is stored in the system variable *CPO*.

When the details have been stored the book title and cost are spoken to the caller using a Speak Text action. See the example below.
Collect Callers Details
Details can be entered into a database by a caller. In this example we collect the caller's credit card number, expiry date and telephone number. All these details are collected and then the database is updated. The example below shows the specific tab entry used to collect the caller's telephone number and assign it to the system variable CP4.

![Properties for Store Telephone Number](image)

When all the details have been collected, the database needs to be updated. The database Execute Action is used. When entering information into the specific tab for the first time you are taken through a series of steps.

1. Select the Database Execute icon.

2. At the SQL Function window the option to 'Insert ...values' was chosen as information needs to be added to the database.

3. Details are then entered into the SQL Wizard, as shown below. When the Database table is selected, the list of fields contained within the table is inserted.

![SQL Wizard](image)

4. When the details have been entered the SQL wizard is closed. The specific tab of the action will contain the command to execute, see example shown below.

![Properties for Database Execute](image)

```sql
INSERT INTO OrderDetails
(ContactTelephone, Cost, CreditCardExpary, CreditCardNumber, ISBN )
VALUES ("$CP4", "$DBD[1]", "$CP3", "$CP2", "$DBD[2]" );
```
7.3 Dial by Name

The Dial by Name action allows callers to indicate the user or group that they require by dialing the name on their telephone keypad and then making a selection from the matches found.

To use this feature the caller must use a telephone with DTMF dialing and with ITU alphabet letter keys as shown here.

![DTMF keypad diagram]

The main pre-requisites before a Dial by Name action can be used are:

1. User Names
   The user names are set through the IP Office Manager. Either the user's Name or Full Name field can be used for Dial by Name. If the Full Name field is set then it takes precedence over the Name field.

   - Changing Names
     Voicemail Pro mailboxes are created to match existing user Name's. If a user Name is changed, Voicemail Pro will create a new mailbox to match the new Name. Therefore care must be taken to ensure that Name field entries are as accurate as possible when first setting up users. Using the Full Name field for Dial by Name is recommended as the Full Name entry can be changed without affecting the existing mailbox entries.

2. User Name Recordings
   Each mailbox to be included by the Dial by Name action needs to have had a user name recorded. This can be done in two ways:

   - Intuity Mailbox Mode
     By default when the user first enters their mailbox, they will be asked to set their voicemail code password and then to record their name.

   - IP Office Mailbox Mode
     In this mode you need to set up a call flow that allows users to record their name. In this document we have included an example module that can be used for that purpose. The same module can also be used by Intuity mode mailbox systems to let users re-record their names. For more information, see Adding a Record Name Module.
7.3.1 Example Call Flow

In this example, after selecting a name using the Dial by Name service, the caller is transferred to the matching extension. If that extension doesn't answer or is busy the caller is transferred to leave a message.

1. In Voicemail Pro a new module was added called Dial by Name.

2. From Telephony Actions the Dial by name action was added.

3. From Telephony Actions an Assisted Transfer action was also added. In its properties Specific tab the Mailbox was set as $KEY.

4. The Dial by name action's True result was connected to the Assisted Transfer action.

5. From Mailbox Actions a Leave Mail action was added.
   Again in its Specific tab the Mailbox was set as $KEY. Links were added from the Assisted Transfer action's No Answer and Busy results to this action.

To add a short code:

1. In IP Office Manager, a new system short code was added. For this example we chose *75 and then entered the details as shown below.

<table>
<thead>
<tr>
<th>Field</th>
<th>Contains...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>*75</td>
</tr>
<tr>
<td>Feature</td>
<td>Voicemail Collect</td>
</tr>
<tr>
<td>Telephone Number</td>
<td>&quot;Dial by Name&quot;</td>
</tr>
<tr>
<td>Line Group Id</td>
<td>0</td>
</tr>
<tr>
<td>Locale</td>
<td>[Leave blank]</td>
</tr>
<tr>
<td>Force Account Code</td>
<td>[Leave blank]</td>
</tr>
</tbody>
</table>

2. After merging this back into the IP Office, users can dial *75 to access dial by name. They can also transfer callers to this call flow.

3. The short code can be added a SoftConsole or DSS button. In addition, an Incoming Call Route could be used to direct specific external calls direct to the function, for example if you had a specific external number used by employees to ring in when off site.
7.3.2 Adding a Record Name Module

This module allows users to record/re-record their mailbox name. This, or a similar module, is necessary if Voicemail Pro is using IP Office mailbox mode. However, it is still useful if the Voicemail Pro is using Intuity mailbox mode as it gives users quick access to re-record their name.

1. In Voicemail Pro, a new module called Record Name was added.
2. A Record Name action was added.
3. In the General tab of the Record Name action’s properties we set the Pin as $. The $ means that caller's must enter their voicemail code in order to use the action.

4. The Specific tab was left set to the Caller’s Mailbox.
5. The module was saved and made live.

To add a Shortcode:

1. In IP Office Manager, a new system short code was added. In this example, we chose *74 and then entered the details as shown in the table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Contains...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>*74</td>
</tr>
<tr>
<td>Feature</td>
<td>Voicemail Collect</td>
</tr>
<tr>
<td>Telephone Number</td>
<td>&quot;Record Name&quot;</td>
</tr>
<tr>
<td>Line Group Id</td>
<td>0</td>
</tr>
<tr>
<td>Locale</td>
<td>[Leave blank]</td>
</tr>
<tr>
<td>Force Account Code</td>
<td>[Leave blank]</td>
</tr>
</tbody>
</table>

2. After merging this back into the IP Office, users can dial *74 at their extension to record their mailbox name.
7.3.3 Using the Name Table

It is possible to create a service that will allow access to re-record the name of any mailbox. The NameWavsTable does this by requesting an extension number and then allowing you to play, re-record and submit a name recording for that extension. It then allows another extension number to be entered and so on.

Naturally if this option is used it should be behind suitable PIN code and other security protection as it allows the recording of names for any mailbox.

To use the Name table:

1. In Voicemail Pro, create a new module.
2. Add a Goto action and open its properties.
3. In the General tab, enter a unique number in the Pin.
4. In the Specific tab, in Please select a node to go to enter NameWavsTable.
5. Click OK.
6. Using a short code or other method, create a route to the new module.

7.3.4 Changing Full Names

Users with DS port display phones can set and change the way in which their full name is displayed through their telephone. This name will then be used for the text matching part of Dial by Name.

To changing your name using a telephone with a menu Key:

1. Press Menu twice.
2. Press and select ProgA.
3. Press and select Name.
4. Enter the new name. Use the dialing keys and Rotat to enter characters. For example, to enter an L, press the 5 key and then press Rotat until an L is displayed. You can use the top-left display key to backspace.
5. When the text is as you require, press Done.
6. Press Exit.
7.4 Campaigns

A campaign is a series of questions and answers. Callers to a campaign hear the questions and give their responses, either by speaking or using the telephone keypad.

Call processing agents can access a campaign to hear caller answers which they can then transcribe into a database or other records. For more information, see Granting Access to a Campaign.

- The directory in which campaign files should be stored is specified in the system preferences directory tab. For more information, see Setting the Location of Voicemail System Folders.

A Web Campaign Component is installed as part of a typical Voicemail Pro installation. If the Web Campaign was not installed it can be added by doing a custom installation. For more information, see Installing Typical Voicemail Pro Server and Client or Installing Custom Voicemail Pro Server and Client.
7.4.1 Managing Campaigns

A Campaign Wizard is used to manage campaigns. You can create new campaigns, modify existing campaigns and delete campaigns.

To start the campaign Wizard:

1. Press F7 or click Campaign Editor. The Campaign Wizard Introduction window opens.
2. Select the required activity.
   - **Create a new Campaign**
     This option takes you through a series of campaign wizard menus to set the campaigns settings. For more information, see To create a new campaign.
   - **Modify an existing Campaign**
     This option displays a list of existing campaigns from which you can select the one you wish to modify. You will then be taken through the campaign wizard menus for the campaign settings. For more information, see To modify a campaign.
   - **Delete an Existing Campaign**
     This option displays a list of existing campaign from which you can then select the campaign to delete. For more information, see To delete a campaign.

To create a new campaign:

1. Select the option **Create a new Campaign** from the Campaign Wizard Introduction page.
2. Click Next. The Campaign Wizard Customer Prompts window opens.
   - Click . The Please Edit the Campaign action window opens. For more information, see Customer Prompts.
3. Click OK when you have entered the customer prompts. You return to the Campaign Wizard Customer Prompts window.
4. Adjust the prompts as required.
   - **Edit action:** Edit the currently highlighted campaign action.
   - **Delete action:** Delete the currently highlighted campaign action.
   - **Move action:** Move the position of an action in the sequence of campaign actions.
5. Click Next. The Campaign Wizard Customer Menu window opens.
   - Select which options are available after the prompt is played. For more information, see Customer Menu.
6. Click Next. The Campaign Wizard Campaign Identification window opens.
   - Enter the details on identifying the campaign. For more information, see Campaign Identification.
7. Click Next. The last campaign wizard window opens confirming that a new campaign will now be produced.
8. Click Finish to create the campaign.

To modify a campaign:

1. Select the option **Modify an existing Campaign** from the Campaign Wizard Introduction page.
2. Click Next. The Campaign Wizard Select an existing Campaign to modify window opens.
3. Click the required campaign and click Next. The Campaign Wizard Customer Prompts window opens.
   - Amend the prompts as required. For more information, see Customer Prompts.
4. Click Next. The Campaign Wizard Customer Menu window opens.
   - Amend which options are available as required. For more information, see Customer Menu.
5. Click Next. The Campaign Wizard Campaign Identification window opens.
   - Amend any details on identifying the campaign. For more information, see Campaign Identification.
6. Click Next. The last campaign wizard window opens confirming that the campaign will now be updated.
7. Click Finish to update the campaign.

To delete a campaign:

1. Select the option **Delete an existing Campaign** from the Campaign Wizard Introduction page.
2. Click **Next**. The Campaign Wizard Select an existing Campaign to delete window opens.

3. Click the required campaign and click **Next**. The last campaign wizard window opens confirming that the selected campaign will be deleted.

4. Click **Finish** to delete the selected campaign.
7.4.2 Customer Prompts

The Customer Prompt window of the Campaign Wizard is used to set the sequence of questions that are played to callers and to record their responses.

- **Add action**
  To add a new campaign action, click **Add action**. The **Please edit the Campaign action** window opens.

- **Edit action**
  Select the prompt or recording to edit then click **Edit action**. The **Please edit the Campaign action** window opens.

The **Please edit the Campaign action** window can be completed with the following information.

- **Play a prompt to the customer**
  Select this option to play a prompt to the caller. Click to specify which prompt to play or create a new prompt in the Wave Editor window. For more information, see Using the Wave Editor.

- **Allow the customer to input information**
  Select this option if you want the action to record the caller's response.

  - **What type of input do you want**
    This option sets whether the voicemail server should **Record voice** or **Record key presses**.

  - **Please enter the maximum recording length** or **Please enter the maximum number of key presses**.
    The field name depends on the type of input chosen. The time specified in seconds sets the maximum length of recording or the maximum number of key presses to record before the next action.

  - **Please enter a unique name that will describe the input**
    A name to associate with the action. The name should be a single word with no spaces.

  - **The following prompt will be played to an agent when the above data is reviewed**
    This option allows you to select or create a prompt that is played to agents before hearing the caller's response. Click to specify which prompt to play or create a new prompt in the Wave Editor window. For more information, see Using the Wave Editor.
7.4.3 Customer Menu

After completing the sequence of questions and responses, the caller can be offered a menu of options. The Customer Menu window of the Campaign Wizard is used to select the options available.

- **Please select the prompt to be played after the customer has made their recordings**
  You can select or create a prompt that is then played to callers after completing the sequence of questions and answers. The prompt should inform the customer of which actions selected from the list they can use. Click to specify which prompt to play or create a new prompt in the Wave Editor window. For more information, see Using the Wave Editor.

- **Please select which options will be available to the customer after the above prompt has played**
  Check the boxes to select the options that will be available to the customer. The customer then needs to press the corresponding key.
  
  - **Save the Campaign (and then quit)**
    Saves caller responses and then disconnects the caller.
  
  - **Play back response to the Campaign**
    Plays back the customers responses to them and then repeats this customer menu.
  
  - **Restart the whole Campaign**
    Deletes the customers responses and restarts the sequence of questions and answers.
  
  - **Quit the Campaign (without saving)**
    Disconnects the customer without saving their responses.

- **Move options**
  You can move the currently highlighted option so that the key presses associated with the options differ.

- **Timeout**
  Sets how long the voicemail server should wait for an answer before following the No Answer connection.
7.4.4 Campaign Identification
The Campaign Identification window of the Campaign Wizard is used to set a park location for the campaign and to name the campaign.

- **Where should this Campaign be parked**
  Enter a park slot number for the campaign. This number can be programmed under a DSS key. That key can then be used by agents to access the campaign. If the DSS key also incorporates a BLF lamp, that lamp is lit when new campaign messages are left.

- **The name of the Campaign is**
  Enter a name for the campaign.

7.4.5 Granting Access to a Campaign
A campaign can be accessed by:

- **Using the Campaign Action**
  The Campaign action is used to route calls into a campaign after those calls have been routed to an appropriate start point on the voicemail server. The action's properties set whether the call is treated as a caller to the campaign or an agent processing the campaign messages. For more information, see Campaign Action.

- **Using the Park Slot number**
  Through a Web Browser. For more information, see Using the Web Campaign.

When an agent accesses the messages waiting in a campaign using either if the first two methods, they have a number of telephone controls available.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Go to the start of the call.</td>
</tr>
<tr>
<td>2</td>
<td>Rewind.</td>
</tr>
<tr>
<td>3</td>
<td>Stop processing the message.</td>
</tr>
<tr>
<td>4</td>
<td>Mark call as processed and delete.</td>
</tr>
<tr>
<td>5</td>
<td>Mark call as processed and save.</td>
</tr>
<tr>
<td>7</td>
<td>Previous response.</td>
</tr>
<tr>
<td>8</td>
<td>Start of response.</td>
</tr>
<tr>
<td>9</td>
<td>Next response.</td>
</tr>
<tr>
<td>0</td>
<td>Pause.</td>
</tr>
<tr>
<td>#</td>
<td>Fast forward.</td>
</tr>
<tr>
<td>*</td>
<td>Rewind.</td>
</tr>
</tbody>
</table>
The Park Slot number assigned to the Campaign can be used with programmable buttons. The advantage is that if the telephone has a message waiting lamp, the lamp will be lit when there are campaign messages waiting to be processed.

- Phone Manager park slot keys cannot be used for this function.

**To assign a campaign to a programmable button:**

1. In IP Office Manager, receive the IP Office configuration.
2. Open the required **User** form.
3. Select the **Button Programming** tab.
4. Select a free button
   - Right-click in the **Action** field.
   - Select **Emulation > Call Park**.
   - Right-click in the **Action Data** field. Enter the campaign's park slot number.
5. Save the configuration back to the IP Office and reboot.
6. Wait until voicemail services have restarted.
7. The programmable button on the user's telephone will flashing red when there are new messages in the campaigns park slot.
   - Press the button to display the campaign name and number of messages.
   - Press the button again to start processing those messages.

The UnPark Call function can also be used to collect the calls, but this method does not provide any visual feedback when messages are present.

**To use the UnPark Call function:**

1. Select a free programmable button
2. Right-click in the **Action** field.
3. Select **Advanced > Call > UnPark Call**.
7.4.6 Using the Web Campaign

The Web Campaign Component allows access to play and change the status of campaign messages through a Web browser.

- Anyone who wants to use the web campaigns must have Microsoft Internet Explorer 5.0 or higher (not Netscape). Their PC must also have multimedia sound capabilities. The Web campaign user must also have a voicemail mailbox. The name of their mailbox is requested when the user browses the campaign messages.

- During installation of the Campaign Web Component, the root address of the web server is requested. A folder called campaign is then added to that root. The web address for browsing will normally be set up as a link from a page within a company intranet rather than typed directly by users.

- Access must be via http: and not network file routing.

To view open the Campaign Web Campaign:

1. Open your internet browser.

2. Type the address http://<server address>/campaign/campcgi.html. The log in window opens.

3. (Optional) To change the language click the language Continue button. A menu containing the countries flag is shown.
   - If you place your mouse cursor over a flag, the language that it represents in indicated.
   - Click the required flag to change the language.

4. (Optional) To change the sound preferences click the Sound Prefs Continue button.
   - Select the playback type of either the browser default or as background. The option background is the default selection.
   - Click Back to continue.

5. Enter your mailbox box name in the User Name field.
6. Click **Continue**. The Campaign Web interface opens.

7. Select the campaign results that you want to view.

8. Select the type of results that you want to view.
9. Click **Submit** to view the results. The details are listed in the main part of the window.

### Sales Catalogue

<table>
<thead>
<tr>
<th>Ident</th>
<th>State</th>
<th>Date Time</th>
<th>CLI</th>
<th>Customer Name</th>
<th>Customer Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>New</td>
<td>20/11/2006 17:14</td>
<td>207</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>New</td>
<td>20/11/2006 17:15</td>
<td>207</td>
<td></td>
<td>00:09</td>
</tr>
<tr>
<td>7</td>
<td>New</td>
<td>20/11/2006 17:15</td>
<td>209</td>
<td></td>
<td>00:02</td>
</tr>
<tr>
<td>9</td>
<td>New</td>
<td>20/11/2006 17:19</td>
<td>209</td>
<td></td>
<td>00:01</td>
</tr>
<tr>
<td>10</td>
<td>New</td>
<td>21/11/2006 10:23</td>
<td>209</td>
<td></td>
<td>00:13</td>
</tr>
<tr>
<td>11</td>
<td>New</td>
<td>21/11/2006 11:29</td>
<td>207</td>
<td></td>
<td>00:09</td>
</tr>
<tr>
<td>12</td>
<td>New</td>
<td>21/11/2006 13:46</td>
<td>209</td>
<td></td>
<td>00:00</td>
</tr>
</tbody>
</table>
Chapter 8.
Appendix
8. Appendix

8.1 Installing IMS

Integrated Messaging Service (IMS) is an addition component to Voicemail Pro. It allows users to deal with voicemail messages through their normal email interface (Microsoft Outlook or Exchange). Voicemail messages can still be handled conventionally using just the telephone.

With IMS, voicemail messages are presented with a special icon in the user’s email inbox. When a voicemail is opened, a special form appears which enables the user to play back the message on their telephone. The voicemail message itself remains on the voicemail server.

When a voicemail is read, forwarded or deleted, either from the email or by using the phone, its status is reflected in both the mailbox and the email inbox.

- **Playing Messages Through the PC**
  Normally IMS plays the voicemail messages through the PC user’s telephone. IMS can be set up to send the voicemail messages as wav files which are played using the PC’s sound capabilities. However, this creates a heavy load on the network and servers and so is not recommended. Typically, one minute of speech requires the transfer of a 1MB file across the network.

- **Required Network and Exchange Server Knowledge**
  Installation of IMS requires access to the customer’s Exchange server and to other critical components of their network. The installation should be performed only by an installer with good knowledge of Exchange Server and Microsoft network setup. The installation should also be performed only in conjunction with the customer’s network manager.
8.1.1 IMS Limitations
IMS is designed to work in a system that comprises one IP Office and one Microsoft Exchange Server. It can be used in a system with more than one telephone system as long as that system has centralized voicemail using just one voicemail server.

IMS cannot be used to:
- Compose a new voicemail.
- Reply to a voicemail.
- Add comments to a forwarded voicemail.
- Mark a voicemail as urgent.
- Voicemails should not be placed in Public Folders.
- Clients that do not use TCP/IP are not supported.
- When it starts up, IMS only scans the root inbox for new messages.
- IMS does not distinguish between normal messages and those marked as private or priority.
IMS consists of the following components.

- **Voicemail Pro**
  Provides voicemail services to the IP Office users.

- **IMS Server**
  This consists of two services installed on the Voicemail Pro Server PC:
  - **IMS Voice Service**
    Handles the delivery of messages when the user selects to play a message from Outlook.
  - **IMS Gateway Service**
    Interacts with the Voicemail Pro Server, the Exchange Server and the IMS Clients. Stores the current known status of voicemail messages and mirrors that status in both user's email and voicemail mailboxes.

- **Microsoft Exchange Server**
  The customer’s MS Exchange server.

- **IMS Administration Tool**
  This tool is used to maintain the association of voicemail mailboxes to email mailboxes.

The following components are required on the user PCs.

- **Microsoft Exchange or Outlook**
  Microsoft Exchange Client or Outlook 97 or higher. Outlook 2003 (Cache Mode off)

- **IMS Client**
  Installed on each email user's PC. This provides a voicemail interface within the user's Microsoft Exchange or Outlook program.
8.1.3 IMS Client PC Requirements
These are the general requirement for a user PC to run the IMS Client application.

1. **Minimum PC specification for an IMS Client PC**
   These are minimum specifications and in most cases will not meet the customer's expectations for acceptable performance. The end user's PC should be a newer PC to meet the customer's expectations and will far exceed the minimum specs listed above.

<table>
<thead>
<tr>
<th>RAM</th>
<th>HD</th>
<th>Pentium</th>
<th>Celeron</th>
<th>AMD</th>
<th>XP Pro</th>
<th>2000 Pro</th>
<th>2003</th>
</tr>
</thead>
<tbody>
<tr>
<td>64MB</td>
<td>160Mb</td>
<td>800MHz</td>
<td>Celeron 3 800MHz</td>
<td>Althon B 650Mhz</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>

2. The client must use TCP/IP networking.
3. Users must be members of the same Domain as the IMS/Voicemail Pro Server.
4. The supported email services are MS Exchange 2000 and 2003.
5. The IMS client is supported with Microsoft Outlook 2000/2003 with cache mode off.
6. If you are the installer or system administrator, you must log on to the Client PC as the person who is going to be using the IMS software and you must have Administrator rights for that PC to install the software.
7. Outlook must already be installed and configured on the user's PC. Test this by using Outlook to send a test message.
8.1.4 IMS Server PC Requirements

In addition to the Voicemail Pro server requirements, IMS requires the following.

- The voicemail server to use MAPI.
- Access to a Microsoft Exchange 5.5, 2000 or 2003 (SP1 and SP4) server.
- An Exchange User account for user IMS.
- A list equating Exchange User account names with voicemail box users.
- Use of the Large Fonts setting is not supported. Use of this option may cause options on some screens to become inaccessible.

Operating System Support

Voicemail Pro with IMS is only supported on the following Windows operating systems:

- Windows 2000 Server with SP2.
- Windows 64-bit versions of the above are not supported.
- Variants of the above such as Windows SBC and Windows DataCenter are supported.
- No other operating systems are supported.

Network Requirements

- 100Mbps network card.
- The server PC should be configured and tested for TCP/IP networking.
- We strongly recommend that the voicemail server PC is connected to the IP Office Control Unit directly. If this is not possible it should be connected via a LAN switch rather than a LAN hub.
- If directly connected to the IP Office control unit, change the settings of the PC network card to match the IP Office control unit as listed in the table below.
- All IP Office LAN ports are 10Mbps/100Mbps auto sensing but it is recommended that the settings of the LAN switch port or network card connected to the IP Office are set as listed in the table below.

<table>
<thead>
<tr>
<th>IP Office Control Unit</th>
<th>Use Port</th>
<th>Speed</th>
<th>Duplex</th>
</tr>
</thead>
<tbody>
<tr>
<td>Small Office Edition</td>
<td>Any LAN port</td>
<td>100Mbps</td>
<td>Full duplex</td>
</tr>
<tr>
<td>IP406 V2</td>
<td>Any LAN port</td>
<td>100Mbps</td>
<td>Full duplex</td>
</tr>
<tr>
<td>IP412</td>
<td>LAN1</td>
<td>100Mbps</td>
<td>Half duplex</td>
</tr>
<tr>
<td>IP Office 500</td>
<td>LAN</td>
<td>100Mbps</td>
<td>Full duplex</td>
</tr>
</tbody>
</table>

- The PC should have a fixed IP address. Although PCs in a DHCP network may retain the same IP address between reboots this is not guaranteed.
- If the IP Office is acting as the DHCP server, it defaults to using 192.168.42.2 to 192.168.42.201 for DHCP clients. This leaves 192.168.42.202 to 192.168.42.254 for devices that require fixed IP addresses.

Disk Space Requirements

A Voicemail Pro installation including VPNM and IMS requires the following free hard disk space.

- Up to 2GB of disk space for the software and language prompts
- An additional 1MB of disk space per minute for messages and other recordings.
- For Avaya IP Office Small Office Edition, you can expect to require at least 200 minutes of message recording space which is 200MB.
- For a busy environment you can expect to require at least 1000 minutes of message recording space, that is 1GB.
8.1.5 IMS Server Installation

8.1.5.1 Installation Checks

Before proceeding with installation ensure that the following requirements are meet:

1. Preparation

   1.1. Read the Documentation in Full
   Ensure that you have read the documentation for IMS Installation in full and have note all the additional
   requirements for the IMS server, domain interaction and IMS client setup.

   1.2. Read the IP Office Technical Bulletins
   Ensure that you have read the IP Office Technical Bulletins relating to the IP Office core software and the Voicemail
   Pro software being installed. These can be obtained from http://support.avaya.com and from

2. Information Required

   2.1. IP Office Feature Key Dongle Serial Number
   This is printed on the Feature Key, prefixed with S/N.

   2.2. IP Office Licenses
   Ensure that the details of the supplied licenses match the Feature Key serial number. The minimum required licenses
   for Voicemail Pro with IMS are:
   · Voicemail Pro (4 ports) license.
   · Integrated Messaging license.
   · Additional Voicemail Pro (ports) licenses may be required depending on the number of simultaneous voicemail
   accesses and users.
   · For IP Office 500 systems an IP500 Upgrade Standard to Professional license is also required.

   2.3. IP Office System Details
   Service User name and password for access to the IP Office system configuration.

   2.4. Network Administration Access
   Contact details of the network and Exchange server administrator.

   2.5. User Details
   Listing linking email accounts and IP Office user names. Also detailing the location and contact information for the
   users.

3. Materials Required

   3.1. IP Office Administration Applications CD.

   3.2. IP Office Voicemail Pro CD.

   3.3. IP Office Application Firewall Batch File
   This file can be obtained from http://marketingtools.avaya.com/knowledgebase/tools/firewall.

4. Only when you have completed the above process should you proceed to Creating the IMS Account.
8.1.5.2 Creating the IMS Account

A domain user and mailbox account must already exist for the account named IMS. For information about creating this account, see Creating and Configuring the IMS Account. The Voicemail Pro software needs to be installed using an account with full administrator rights on the PC. The service subsequently runs under that account. We required that a specific account, IMS is created for this purpose and set so that its password does not expire.

The IMS account must be a member of the administrator’s group on the IM server PC. Note, it is not necessary to be a domain administrator, but must be a member of the administrators group on the PC to be able to start the IMS and Voicemail Pro services.

To create and configure a domain user and mailbox account called IMS:

1. Do not proceed with this process until you have completed the steps in Installation Checks.
2. Working with the network administrator, create an account called IMS on the domain and an associated mailbox on the exchange server. Provide a secure password and ensure User Cannot Change Password and Password Never Expires are checked.
3. Make sure that the server PC that will be running IMS and Voicemail Pro is a member of the same domain as the Exchange server.
   - Log on using an account with administrative permissions on the domain.
   - Right-click My Computer. Select Properties and select the Network Identification Tab.
5. Select Add. From the Look In list select the domain name.
6. In the Name window, highlight the IMS account and click Add. Click OK twice.
7. Log out and log back in with the IMS account.
8. On the desktop, right-click the Outlook icon and select Properties to configure the IMS Account.
10. Check the Microsoft Exchange checkbox and click Next.
12. Select No when asked if you travel with this computer. Click Next.
13. Click Finish.
14. Highlight the MS Exchange Settings and click Properties.
15. Highlight Microsoft Exchange Server and click Properties.
16. Click Check name and ensure the name is resolved.
17. If the name is resolved, select Apply. Click OK twice and then click Close.
18. Do not continue until the name has been correctly resolved with the Exchange Server. If the name is not correctly resolved, check the Exchange and Mail account details with the Exchange Administrator.
19. Open Outlook and select Yes to register Outlook as the Default eMail application.
20. Verify that you can send and receive emails.
21. Only when you have completed the above process should you proceed to IMS Server Preparation.
8.1.5.3 IMS Server Preparation

1. Do not proceed with this process until you have completed the steps in Creating the IMS Account.

2. Log on to the server PC using the IMS account and check the follow requirements.

3. **The Server is a Member of the Domain**
   The IMS Server **MUST** be a member of the customer’s domain.

4. **The Domain Has an User and Email Account IMS**
   A domain user and mailbox account must already exist for the account named IMS. The Voicemail Pro software must be installed using this account with full administrator rights on the PC. The services subsequently run using that account.

5. **The IMS Account Has Admin Rights on the IMS Server**
   The IMS account must be a member of the administrator’s group on the IMS server PC. Note, it is not necessary to be a domain administrator, but must be a member of the administrators group on the PC to be able to start the IMS and Voicemail Pro services.

6. **The Server's Outlook Client is Configured for the IMS Account**
   Check that the Outlook or Exchange client on the server PC is configured to use the same account (IMS).

7. **Test Email Operation**
   Log into the PC with this account (IMS) and verify that you can send and receive emails using this account.

8. **IP Office Manager is Installed**
   A PC with IP Office Manager and Microsoft .NET Framework 2.0 and Enable network COM+ access are installed on the IMS/Voicemail Pro server. If .NET 2.0 is not detected, you will be prompted to install it before the Voicemail Pro installation proceeds.

9. **Check or Disable IP Office Voicemail Email Settings**
   In the IP Office Manager, the Voicemail Email settings under the voicemail/user tab are switched **off** or are set to a different email account then the one you will be using with IMS. This is because the IP Office configuration settings for each user do not apply to IMS. They are usually switched off by default but it is advisable to check before you start the installation. For more information, see the IP Office Manager help. Please note Voicemail to Email can be used in conjunction to IMS for example to send an SMS alert to your SMS enabled cell phone but if set to the same Outlook email account as IMS would result in two emails being delivered to the user, one that synchronized with their voicemail and one that did not.

10. **Disable any Server PC Power Saving Mode**
    Switch off any PC and hard disk sleep, power down, suspend and hibernation modes.
11. **Disable Network Card Power Saving**

Disable any Network Card including the power save options for the NIC card under the properties of the installed network card.

12. If the server PC is directly connected to the IP Office control unit, adjust the NIC port settings to match the IP Office as follows. If connected via a LAN switch, check the LAN switch manufacturers documentation for details of the optimum port settings.

<table>
<thead>
<tr>
<th>IP Office Control Unit</th>
<th>Use Port</th>
<th>Speed</th>
<th>Duplex</th>
</tr>
</thead>
<tbody>
<tr>
<td>Small Office Edition</td>
<td>Any LAN port</td>
<td>100Mbps</td>
<td>Full duplex</td>
</tr>
<tr>
<td>IP406 V2</td>
<td>Any LAN port</td>
<td>100Mbps</td>
<td>Full duplex</td>
</tr>
<tr>
<td>IP412</td>
<td>LAN1</td>
<td>100Mbps</td>
<td>Half duplex</td>
</tr>
<tr>
<td>IP Office 500</td>
<td>LAN</td>
<td>100Mbps</td>
<td>Full duplex</td>
</tr>
</tbody>
</table>

13. Only when you have completed the above process should you proceed to [Entering the IMS Licenses](#).
8.1.5.4 Entering the IMS Licenses

The Voicemail Pro must have licenses for itself, any additional voicemail ports required and for IMS. You must check that these have been entered into the IP Office systems configuration and that they are valid. IP Office 500 systems will also require the **IP500 Upgrade Standard to Professional** license.

Without valid licenses the Voicemail Pro will operate for 2 hours before stopping and IMS will not operate at all.

The licenses supplied must match the serial number of the IP Office Feature Key. This is printed on the Feature Key and in IP Office 4.0+ systems can be checked through the Feature Key Serial Number field on the System | System tab in IP Office Manager.

### Checking Licenses

1. Do not proceed with this process until you have completed the steps in **IMS Server Preparation**.
2. If not already in place, the IP Office Feature Key must be installed.
   1. **USB or Parallel Port Feature Key**
      
      These types of keys can be attached to the same PC as the Voicemail Pro server. The IP Office Feature Key Server application must be installed on the PC also. Check that the application is running and the key recognised before proceeding.
   2. **Serial Port Feature Key**
      
      This type of key is connected directly to the DTE port of the IP Office control unit. It does not require the Feature Key Server software to be installed on any PC.
   3. **IP Office 500 Smart Card Feature Key**
      
      This is the only type of Feature Key supported by IP 500 Office systems. It does not require the Feature Key Server software to be installed on any PC.

5. Start IP Office Manager and receive the current configuration from the IP Office system.

6. On the System | System tab, check that the License Server IP Address is set correctly. For USB and parallel port keys it should be set to the IP address of the PC hosting the key and running the IP Office Feature Key Server software. For the serial port keys it should be set to 0.0.0.0. For IP Office 500 systems the field is not used.

7. Select Licence.

8. If licenses have been entered already, check that their Status is listed as Valid.

9. Click and select License.

10. Enter one of the supplied licenses for Voicemail Pro and IMS.

11. Click OK.

12. Repeat until all the licenses are entered.

13. Click to send the updated configuration back to the IP Office.

14. Reload the configuration again and check that the Status for all licenses is now Valid.

14.1. This screen shot only shows the licenses for Voicemail Pro and IMS. Additional licenses may be present for other Voicemail Pro and IP Office features. Do not remove or alter any licenses.

15. If otherwise do not proceed any further until the issue with license validation is resolved.

16. Only when you have completed the above process should you proceed to **Installing the IMS and Voicemail Pro Software**.
To install the IMS and Voicemail Pro Software:

1. Do not proceed with this process until you have completed the steps in **Entering the IMS Licenses**.

2. Verify that you are logged in with the IMS account and that the account is a member of the Administrator group on PC or is a Domain Admin.

3. Verify that Outlook is installed and setup for the IMS account and that you can send and receive emails.

4. Insert the IP Office Voicemail Pro CD. The installation should auto-start. If it does not auto-start, click **Browse** to locate Setup.exe on the CD and then run it. The **Choose Setup Language** window opens.

5. Select the installation language. This language is used for the installation and for the default language prompts.

6. Click **OK**. Installation preparation begins.

7. If the following window below opens, Voicemail Pro is already installed.

   ![InstallShield Wizard](image)

6. Select **Modify** and click next to see if IMS has already been installed.

   - If IMS and Voicemail Pro have already been installed you will need to upgrade rather than install a new version. For more information, see **Upgrading a Voicemail Pro System**.
   - If Voicemail Pro has been installed but not IMS, backup the call flow as described in **Upgrading a Voicemail Pro System** and then uninstall Voicemail Pro and reboot the PC and proceed with the installation of Voicemail Pro and IMS.

8. In the **Welcome** window, click **Next**. The Customer Information window opens.

9. In the **Customer Information** window, type a user name and the company name or use the default names that are proposed. These settings do not affect Voicemail Pro when it is installed.

10. In the same window choose the option that determines who should be able to use Voicemail Pro when it has been installed. The recommended option is **Anyone who uses this computer (all users)**.

11. In the **Customer Information** window, click **Next**.

12. The **Choose Destination Location** window opens. Unless there are specific reasons for changing the location, the default setting is recommended. Click **Next**.

13. The **Messaging Components** window opens. Select **Voicemail Pro (Full)** and click **Next**.

14. The **Setup Type** window opens. In the **Setup Type** window, select **Custom**.

15. Click **Next**.

16. The **Select Features** window opens so that you can select which additional Voicemail Pro features to install. For IMS ensure that the settings are as follows:
16.1. Voicemail Pro Campaign Web Component is not required for IMS but is installed as part of a typical VoicemailProServer installation. If a web server has already been installed but the Voicemail Pro Campaign Web Component is not required, uncheck it to remove it. If Voicemail Pro Campaign Web Component is required for other use, make sure that it is checked so that it is not removed.

16.2. Ensure that Voicemail Pro Client and Voicemail Pro Service are checked.

16.3. Check any additional languages that are required. It is recommended that either English or English US is always selected (installed by default) in addition to any languages that are required by the customer.

   • Important
   Do not uncheck any other boxes as this will remove the corresponding software features.

16.4. Scroll down and check Integrated Messaging Service. That should automatically select all the components for IMS.

16.5. Click Next.

17. If you have chosen to install the Voicemail Pro Campaign Web Component, the Select the Web Server root directory window opens.

17.1. Type the path to the folder where you would like to save the web campaign web pages. Alternatively, use the default location or click Browse and select a folder to use. Click Next.

17.2. The Select the Destination of the Script directory of Your Web window opens. Type the path to the folder where the web campaign components are to be installed. Alternatively, use the default location or click Browse and select a folder to use. Click Next.

18. The Service Account Name window opens. Details of the default administrator account are already filled in.
19. In the **Service Account Name** window, type the **User Name** and **Password** for the IMS account created previously on the domain and Exchange server.

![](image1.png)

19.1. Alternatively, click **Browse** and select from the list of available network accounts. The IMS account should show up in the list. Verify that you can browse for this account. Make sure the IT manager has not hidden this account for Exchange or has separated this account in Active Directory.

20. Click **Next**.

21. The **Select Program Folder** window opens. It is recommended that you use the default folder, IP Office, which will already be shown. Click **Next**.

22. The **Start Copying Files** window opens. You are presented with a summary of the settings that you have chosen so far. Review the settings to make sure that they are what you expect. In particular, check that the required languages are listed. Scroll down if necessary. The minimum requirements for IMS are listed below. If for any reason the details are not what you expect, click **Back** and make the necessary changes.

22.1. Voicemail Pro
   - Voicemail Pro Client.
   - Voicemail Pro Service.

22.2. Integrated Messaging Service.
   - IMS Client Package.
   - IMS Database Service.
   - IMS Gateway Service.
   - IMS Voice Service.
   - IMS Administration Tool.

23. When you are satisfied that the details are correct, click **Next** to start copying the files. The **Setup Status** window opens to keep you informed while the installation takes place.

24. When the installation is complete, click **Finish** to restart now.

25. An attempt is made to start all services associated with Voicemail Pro and IMS.

![](image2.png)

26. After the services have started, the installation process continues.
27. The **IP Office Voicemail Pro - System Settings** window opens.

28. Select the required logging levels. Logging may be useful for fault diagnostics. You can switch logging off after you have verified that IMS is working correctly. Click **Next**.

29. The **IP Office Voicemail Pro - Path Settings** window opens.

30. Enter the name of the server PC on which Voicemail Pro and IMS have been installed. In most cases the name is detected automatically and filled in for you. If not, click **Browse** and provide the name of the Integrated Message Voice Server. If this fails it is most likely because the IMS Gateway Service is not running.
31. Click Next. The **IP Office Voicemail Pro - Email Settings** window opens.

![IP Office Voicemail Pro - Email Settings](image)

32. In the **Account Details** field, type the name of the account **IMS**. Alternatively, click **Browse** and find the IMS account.

32.1. If wav files of voicemail messages are to be sent in emails rather than left just in the voicemail mailbox check **Transmit Wave Files**. Sending .wav files across a network creates a high loading on the network and network servers. A one minute message requires a 1MB .wav file. Choose either:

- **Attach wave file to message** to allow a recipient to copy a .wav file for use elsewhere.
- **Embed wave file in message** to allow a recipient to embed a file in a message. An embedded file is compressed and therefore smaller than an attached file.

33. Click **Next**. The **IP Office Voicemail Pro - SMTP Email Settings** window opens. Note that IMS uses MAPI so this setting does not pertain to IMS but Voicemail to Email.

34. Click **Finish**. An attempt is made to validate the SMTP email settings. If the attempt to connect with the SMTP server fails, an error message is displayed. This can be ignored if SMTP is not being used (which it is not for IMS services).
8.1.5.6 Check the IMS Services

If Voicemail Pro has been installed successfully, the voicemail service is started automatically. However it is useful to check them and to know how to stop-start the services manually.

To check/restart the Voicemail Pro and IMS Services
1. Do not proceed with this process until you have completed the steps in **Installing the IMS and Voicemail Pro Software**.
2. Open the Windows **Control Panel**.
3. Select **Administrative Tools > Services**.

4. The Voicemail Pro service and IMS services should be visible. Their **Status** should be **Started** and the **Startup Type** should be set to **Automatic**.

5. The details should also show that the services are running under the IMS account.

6. If it necessary to manually restart the services, ensure that the following order is used: **VMProDBService** (if installed), **Voicemail Pro Service**, **IMS(Restart)**, **IMS(Voice)** and finally **IMS(Gateway)**.

7. Close **Services**.

8. Only when you have completed the above process should you proceed to **Initializing the Call Flow**.

Using a Batch File to Start Services

In some instances, certain computers might not respond quickly enough in order to start all of the Avaya services in the correct order. In this circumstance, it can be advisable to create a batch file which will delay the start of these services until the PC is fully running.

Avaya IP Office Services can be started successfully at system start-up using a scheduled task that initiates the batch file below. This batch file ensures that the services will start successfully and in the proper order.

1. Set all Avaya services listed below to **Manual** start. Do not include Key Server.
2. Create the batch file below and save it to `%SYSTEMROOT%`. Only include lines for the services which are installed.

```
@echo off
rem Wait 60 seconds before execute.
timeout /t 60
net start VMProDBService
net start Voicemail Pro Service
net start IMS(Restart)
net start IMS(Voice)
net start IMS(Gateway)
```

3. Create a scheduled task to start the batch file at system start-up.
8.1.5.7 Initializing the Call Flow
This stage will check both that the Voicemail Pro Client can connect to the Voicemail Pro Server, and also initialize the call flows.

**To Initialize the Voicemail Pro Call Flow:**
1. Do not proceed with this process until you have completed the steps in [Check the IMS Services](#).
2. Select **Start** | **Programs** | **IP Office** | **Voicemail Pro Client**.
3. The Voicemail Pro Client should start and display Connecting to the Local Server.
4. Once it has connected the various navigation panes should show content.
5. Click the **Save and Make Live** icon.
6. Select **Yes**.
7. Voicemail operation can now be tested from an extension by dialing *17*.
8. Only when you have completed the above process should you proceed to [Associating Voice Mailboxes with Email Addresses](#).
8.1.5.8 Associating Voice Mailboxes with Email Addresses

When you have installed IMS, started the Voicemail Pro server, you are ready to associate the user voicemail mailboxes with email mailboxes on the Exchange Server. This is done using the IMS Administration tool.

To associate a voice mailbox with an email address

1. Do not proceed with this process until you have completed the steps in Initializing the Call Flow.
2. From the Start menu, select Programs | IP Office | IMS Administration Tool.
3. From the Server menu, if the server is not already populated, select Add. The New Integrated Messaging Server window opens.
4. In the Server field, type the name of the IMS Server or click Browse and select a server. When the server has been added, the name is displayed with a [+] plus icon.
5. Expand the [+] icon to show configurable options.
6. Highlight Integrated Messaging Associations. After a few moments the voice mailboxes are displayed in the right-hand window.
7. Select a voice mailbox to configure and double-click it to see its properties.
8. In the Associated Email Address field, select Change and select the relevant email address of the associated user.
9. If the mail settings need to be different from the default settings, select the User Properties tab and configure as applicable and select OK.
10. In the Primary NT Account field click Select Existing and select the relevant domain user account of the associated user. Note, if the user is opening multiple inbox accounts all have to be added.
11. When complete, click the Synchronize Mailboxes icon to synchronize the mailboxes. Alternatively, click Selecting Mailboxes and Synchronize on the menu bar.
12. Close the IMS Administration Tool.
13. Make a call to one of the users that you have just associated and leave a message in their voicemail mailbox. A short while after hanging up a message should arrive in the user’s mailbox.
14. Only when you have completed the above process should you proceed to IMS Client Requirements.
8.1.6 IMS Client Installation

8.1.6.1 IMS Client Requirements

During installation of the IMS Server, the IMS Client Installer package is copied to C:\Program Files\Avaya\IP Office \Voicemail Pro\IMS\Client and is automatically shared as IMSClient. The installer, called IMSClient.exe is approximately 10.1MB is size. You need to install the IMS Client on the PC of each user who want to use IMS.

- **CRITICAL WARNING**
  Do not install the IMS Client on the same PC as the Voicemail Pro / IMS Server.

1. Do not proceed with this process until you have completed the steps in Associating Voice Mailboxes with Email Addresses.

2. Minimum PC specification for an IMS Client PC

These are minimum specifications and in most cases will not meet the customer’s expectations for acceptable performance. The end user’s PC should be a newer PC to meet the customer’s expectations and will far exceed the minimum specs listed above.

<table>
<thead>
<tr>
<th>RAM</th>
<th>HD</th>
<th>Pentium</th>
<th>Celeron</th>
<th>AMD</th>
<th>XP Pro</th>
<th>2000 Pro</th>
<th>2003</th>
</tr>
</thead>
<tbody>
<tr>
<td>64MB</td>
<td>160Mb</td>
<td>800MHz</td>
<td>Celeron 3 600MHz</td>
<td>Althon B 650Mhz</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

3. If the client PC is a Windows server, it must:
   - Meet minimum hardware and operating system requirements for an IMS server, see IMS Server PC Requirements.
   - Not be a Domain Controller.
   - Not be the Voicemail Pro / IMS Server.

4. Clients must use TCP/IP networking.

5. Users must be members of the same Domain as the IMS/Voicemail Pro Server.

6. The supported email services are MS Exchange 2000 and 2003.

7. The IMS client is supported with Microsoft Outlook 2000/2003 with cache mode off.

8. If you are the installer or system administrator, you must log on to the Client PC as the person who is going to be using the IMS software and you must have Administrator rights for that PC to install the software.

9. Outlook must already be installed and configured on the user’s PC. Test this by using Outlook to send a test message.

10. The Integrated Messaging Server must already be installed and running.

11. Only when you have completed the above process should you proceed to Adjusting DCOM Settings.
8.1.6.2 Adjusting DCOM Settings

Microsoft have significantly increased the security around many operations included application access to functions such as email. The following DCOM changes are therefore essential for support of IMS and must be performed before installing the IMS Client.

The DCOM changes can be done either through a security policy that is then applied to all PC's in the domain, otherwise the individual settings on each client PC must be adjusted.

To set the Client PC's DCOM Settings
1. Do not proceed with this process until you have completed the steps in IMS Client Requirements.

2. Using one of the methods described below, ensure that the DCOM settings of the client PC are adjusted to support interaction with the IMS server.

   B2b. DCOM Settings for a Windows 2000 PC.
   B2c. DCOM Settings for XP Pro and Windows 2003 PC's.

3. Only when you have completed the above process should you proceed to Installing the IMS Client Software.
B2a. Setting the Changes in a DCOM Security Policy

Setting all DCOM security settings for a domain to work with IMS. After setting the DCOM options, this is now a domain wide policy and when the IMS clients are installed and the computer is rebooted and the user logs on, these settings will be pushed to the end user. Doing this as a policy simplifies the installation process for IMS.

1. On the domain controller, open **Active Directory Users and Computers**, right click on the domain to be administered and select **Properties**.

2. Select the **Group Policy** tab.
Appendix: Installing IMS

3. Double click **Default Domain Policy**. Drill down to **Computer | Windows Settings | Security Settings | Local Policies | Security Options**.

4. Search for the **DCOM Machine Access Restrictions** ... entry and double click on that entry.

5. Check **Define this policy setting** and then click **Edit Security**.

6. Add the **Everyone** and **Anonymous Logon** users and set them to **Allow** for remote and local access. Click **OK**.
7. Click OK.

8. Repeat this process for all DCOM entries.
B2b. DCOM Settings for a Windows 2000 PC

This process adjusts the DCOM settings on an individual PC running Windows 2000.

1. Select **Start | Run**.

```
Run

Type the name of a program, folder, document, or Internet resource, and Windows will open it for you.

Open: DCOMCNFG

OK Cancel Browse...
```

2. Enter **DCOMCNFG** and click **OK**.

```
Distributed COM Configuration Properties

Applications Default Properties Default Security Default Protocols

Enable Distributed COM on this computer

The Default Authentication Level specifies security at the packet level.

Default Authentication Level: [None]

The Default Impersonation Level specifies whether applications can determine who is calling them, and whether the application can do operations using the client’s identity.

Default Impersonation Level: [Impersonate]

Provide additional security for reference tracking
```

3. On the **Default Properties** tab, set the following:
   - Enable Distributed COM on this computer.
   - Default Authentication Level set to "NONE"
   - Default Impersonation Level set to "Impersonate".
4. Click on the **Default Security** tab.

5. Click on the **Edit Default** button for **Default Access Permissions**.

6. The **Everyone Group** should have **Allow Access** set. Click **OK**.
7. Click on the **Edit Default** button for **Default Launch Permissions**.

   **Registry Value Permissions**
   
<table>
<thead>
<tr>
<th>Name</th>
<th>Type of Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrators</td>
<td>Allow Launch</td>
</tr>
<tr>
<td>Everyone</td>
<td>Allow Launch</td>
</tr>
<tr>
<td>INTERACTIVE</td>
<td>Allow Launch</td>
</tr>
<tr>
<td>IUSR_EN300D000CSRV1</td>
<td>Allow Launch</td>
</tr>
<tr>
<td>NWAM_EN300D000CSRV1</td>
<td>Allow Launch</td>
</tr>
<tr>
<td>SYSTEM</td>
<td>Allow Launch</td>
</tr>
</tbody>
</table>

   Type of Access: Allow Launch

   - OK
   - Cancel
   - Add
   - Remove
   - Help

8. The **Everyone Group** should have **Allow Launch** set. Click **OK**.

9. Click on **Edit Default** button for **Default Configuration Permissions**.

   **Registry Key Permissions**
   
<table>
<thead>
<tr>
<th>Name</th>
<th>Type of Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrators</td>
<td>Full Control</td>
</tr>
<tr>
<td>CREATOR OWNER</td>
<td>Full Control</td>
</tr>
<tr>
<td>Everyone</td>
<td>Full Control</td>
</tr>
<tr>
<td>Power Users</td>
<td>Special Access</td>
</tr>
<tr>
<td>SYSTEM</td>
<td>Full Control</td>
</tr>
<tr>
<td>TERMINAL SERVER USER</td>
<td>Special Access</td>
</tr>
<tr>
<td>Users</td>
<td>Read</td>
</tr>
</tbody>
</table>

   Type of Access: Full Control

   - OK
   - Cancel
   - Add
   - Remove
   - Help

10. The **Everyone Group** should have **Full Control** set. Click **OK**.

11. Click **Apply**.

12. Click **OK**.

13. Reboot the PC.
**B2c. DCOM Settings for XP Pro SP2 and Windows 2003 SP1 PC's**

This process adjusts the DCOM settings on an individual PC running either Windows XP Pro SP2 or Windows 2003 SP1.

1. Select **Start | Run**.

2. Enter **DCOMCNFG** and click **OK**.

- Windows XP may attempt to block the Microsoft Management Console. Select **Unblock** to continue.

3. Click on **Component Services** and then **Computers**.

4. Right click on **My Computer** and choose **Properties**.
5. Select the **COM Security** tab. Note: Windows XP, Windows XP Service Pack 1 and Windows Server 2003 without SP1 will only have Edit Defaults.
6. Edit the limits for **Access Permissions** and **Launch and Activation Permissions** to allow **Remote Access** and **Remote Launch/Activation** permissions for **Anonymous Logon** and **Everyone**. Note: Windows XP, Windows XP SP1, and Windows 2000 Server grant the **Everyone** all Permissions.
7. On the **Default Properties** tab set the following:

- **Enable Distributed Com** on this computer.
- **Default Authentication Level** set to **NONE**.
- **Default Impersonation Level** set to **Impersonate**.

8. Reboot the PC.
8.1.6.3 Installing the IMS Client Software

To install the IMS Client software:

1. Do not proceed with this process until you have completed the steps in Adjusting DCOM Settings.[87]

2. Copy the IMS Client installer package to a CD or map a network drive to the folder as follows: \VMProIMSPC\IMSClient. This is done automatically when you install IMS on the Voicemail Pro/IMS server.

3. Log on to the user’s PC using the user’s account.

4. Verify that the user has local administrative rights to be able to install the software. Once installed they should not need administrator rights to use the application.

5. Save and close all other applications prior to installing as a reboot will be required.

6. Depending on where it is located, double-click the IMSClient.exe file.

7. Choose the preferred Language and select OK.

8. Click Next until you see the IMS Connection Information window.

9. Enter the following information:

   - **Voicemail Mailbox**
     This is the entry as it appears in the Username field of the IP Office User Profile Screen. This is case-sensitive. If this information is not entered correctly, the IMS client will not connect to the IMS Server.

   - **IMS Server**
     This is the name of the IMS/Voicemail Pro Server.

10. Click Next. The IMS Playback Parameters window opens.

11. Type the extension number of the handset to be used for playing back messages.

12. If required, check Pick Up Automatically for the option to collect messages without the need to pick up the handset. This is supported on analog extensions.

13. When prompted to Restart the PC, click Finish to restart the PC.

   - If you attempt to open Outlook without restarting the computer, you will receive an error to tell you a component has not been installed correctly. It is therefore recommended that you restart the computer when prompted.

14. Typically when starting Outlook if there is a connection error, a message should be received while Outlook is starting, asking for a user name and password.

   - On the Outlook Menu Bar, Select Tools – Integrated Messaging. If the IMS Client has connected you should only have the option to Disconnect. If this is the case you have successfully installed the IMS Client on the workstation.

   - A further indication will be a Telephone Icon in the mail message. If the Client has not been installed, this icon will not be displayed.

15. Only when you have completed the above process should you proceed to Opening the Firewall.[87]
8.1.6.4 Opening the Firewall

It is necessary to create firewall exceptions for the IMS client application after its installation. Even if the user does not have a firewall or uses a firewall other than the default Windows firewall, it is recommended that the process for the Windows firewall is applied.

If the firewall being used is the default Windows Firewall, the necessary exceptions can be setup by running the batch file AvayaFW.bat. This file is available from the http://marketingtools.avaya.com/knowledgebase/tools/firewall. It is recommended that this file is running even if the user is not using the firewall.

1. Do not proceed with this process until you have completed the steps in Installing the IMS Client Software.
2. Unzip AvayaFW.bat from the AvayaFW.zip file.
3. If the path to which applications are being installed is not the default, modify the %ProgramFiles% setting within the file.
4. Run the batch file on the user's PC.

Settings for Other Firewalls

If the user's PC uses a firewall other than the default Windows firewall, the method of setting up the necessary exceptions will vary. For the IMS Client the necessary exceptions are:

- C:\ProgramFiles\Avaya\IMS Client\UMSForm.exe
- UDP Port 67
- UDP Port 69
- TCP Port 135
- TCP Port 2000
- UDP Port 50791
- UDP Port 50799
8.1.6.5 Testing IMS Client Installation

Typically, when starting Outlook if there is a IMS connection error, a message may be received while Outlook is starting, asking for a user name and password. Please recheck the DCOM settings and verify that the Windows Firewall exceptions have been setup properly. Next verify that the IMS client has been installed properly.

1. Do not proceed with this process until you have completed the steps in Opening the Firewall.

2. In Outlook, select Tools > Integrated Messaging.

3. If the IMS Client has connected you should only have the option to Disconnect. If this is the case you have successfully installed the IMS Client on the workstation. If you can not connect:

   3.1. Verify that the mailbox is set properly to the user's Name in Manager.

   3.2. Check that the proper Voicemail Pro machine name was given when installing the client software.

   3.3. Check the DCOM settings or the Windows Firewall settings not being modified.

4. If the Integrated Messaging tab does not show up in Outlook Tools > Integrated Messaging or under Tools>Options>Integrated Messaging, verify that the IMSClient has not been disabled in Outlook.

   4.1. In Outlook click Help> About Microsoft Office Outlook.

   4.2. Click Disabled Items. If the IMS Client is listed, select it and click Enable.
4.3. You will have to close and reopen Outlook for it to appear.

4.4. You should see a **Telephone Icon** in the mail message when you have a voicemail message.

4.5. If the Client has not been installed, or has not been installed correctly, the telephone icon will not be displayed. Try uninstalling rebooting and reinstalling. Alternatively you may have to manually install the form as detailed below.

4.6. Only when you have completed the above process should you proceed to **Observing Exchange Operation**.

---

**Inbox - Microsoft Outlook**

<table>
<thead>
<tr>
<th>From</th>
<th>Subject</th>
<th>Received</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brad Trower</td>
<td>Core switch mins and projects summary</td>
<td>Mon 12/04/04 09:40</td>
</tr>
<tr>
<td>Matthew White</td>
<td>VMGRS\W-8/20 - Urgent Order</td>
<td>Mon 12/04/04 14:40</td>
</tr>
<tr>
<td>Daniel Ballhache</td>
<td>G:\Product\Skopin\12137.vm</td>
<td>Mon 12/04/04 15:19</td>
</tr>
<tr>
<td>Software Licence ...</td>
<td></td>
<td>Tue 13/04/04 12:29</td>
</tr>
<tr>
<td>IMS</td>
<td>Internal voice mail from Alan Jeffries</td>
<td>Tue 13/04/04 16:30</td>
</tr>
<tr>
<td>IMS</td>
<td>Internal voice mail from Alan Jeffries</td>
<td>Tue 13/04/04 17:06</td>
</tr>
<tr>
<td>IMS</td>
<td>Internal voice mail from Jools Smith</td>
<td>Tue 13/04/04 17:14</td>
</tr>
</tbody>
</table>

735 Items, 3 Unread
To Manually Install the Form

1. In Outlook select **Tools | Options**.
2. Select the **Other** tab.
3. Click **Advanced Options**.
4. Click **Custom Forms** and then **Manage Forms**.
5. Click **Install** and browse to and select *C:\Program Files\Avaya\IMS Client\UMSForm.CFG*.
6. The form properties are shown. Select **OK**.
7. The IMS form should now be listed.
8. Click **Close** and then **OK, OK, OK**.
8.1.6.6 Observing Exchange Operation

It is useful to check that the IMS Account has logged onto the Exchange Server correctly.

To check and observe IMS operation:

1. Do not proceed with this process until you have completed the steps in Testing IMS Client Installation.
2. On the Exchange server, open the Exchange Administration Manager.
3. Expand the Server Name and Mailbox Store.
4. Select Logons and locate the IMS account name. Only logged on accounts are displayed.
5. Select Mailboxes to view IMS messages being received and sent.
6. Leave a voicemail message in an IMS user’s voice mailbox.
7. After hanging up you should notice that for a brief time the Total Items field for the IMS mailbox increases by 1. The message is then sent from the IMS mailbox to the user’s mailbox, whose Total Items increases by 1. By default, there should be no messages left in the IMS mailbox.
8.1.7 Maintenance
8.1.7.1 Upgrading

Upgrade from Voicemail Pro below version 3.2

It is important that the settings of an existing Voicemail Pro are exported before any upgrade. Although folders that contain prompts and messages are not affected by the upgrade process, the editable version of a customer call flow is lost.

Make sure you are logged in as the IMS account.

To upgrade from below Voicemail Pro version 3.2 to version 4.0:

1. **Export the Database**
   Before removing Voicemail Pro as part of an upgrade, you must create a backup copy of the call flow database. This will contain any customizations made to the default call flow.
   1.1. Start the Voicemail Pro Client.
   1.2. From the File menu, select the option Import or Export.
   1.3. Select the option Export call flows and click Next.
   1.4. Enter a file path and file name ending in .mdb, for example C:\temp\backup.mdb. Click Next.
   1.5. Click Finish to start the export then click Close to complete the export procedure.
   1.6. Close the Voicemail Pro Client.
   1.7. The next step is to back up the registry so that you do not lose any Voicemail Pro settings from the previous version.

2. **Back up the Registry**
   Any registry settings that are associated with Voicemail Pro need to be backed up.
   3. Insert the Voicemail Pro CD for the new Voicemail Pro and cancel the install wizard that auto runs.
   4. Right-click the CD drive and select Open.
   5. Locate the file backupreg.bat and double-click it to run the application. The registry settings are backed up.
   6. The next step is to remove Voicemail Pro. Verify that the 3 files were created successfully and they have the appropriate data.

7. **Remove Voicemail Pro**
   Any previous versions of Voicemail Pro must be removed before you start to install the new version.
   8. Open the Windows Control Panel.
   9. Select Add/Remove Programs.
   10. Select IP Office Voicemail Pro and click Add/Remove.
   11. From the options offered, select Remove and click Next.
   12. Follow the prompts that you see on the screen during the removal process.
   13. When the process has been completed, select the option Yes, I want to restart my computer now and click Finish.
   14. Please note is it necessary to reboot the server. Do not skip this step.
   15. After the server reboots and you have logged back in as IMS.

16. **Restore the Registry**
   The Voicemail Pro registry that was backed up in step 2 needs to be restored.
   16.1. Right-click the CD drive that contains the Voicemail Pro CD and select Open (reinsert the CD if necessary and cancel the install wizard).
   16.2. Locate the file restaurereg.bat and double-click it to run the application. This restores the registry settings previously associated with Voicemail Pro.
   16.3. Verify that the registry entries have been restored successfully.
   16.4. Start the Voicemail Pro GUI.
   16.5. From the File menu, select the option Import or Export.
   16.6. Select the option Import Call Flows and click Next.
   16.7. Use the Browse button to locate the backup file then click Next.
   16.8. Click Finish to start the import then click Close to complete the import procedure.
17. Install the New Software
The next step is to install the upgrade software. For more information see Installing Voicemail Pro: Overview above and then refer to the sections that relate to the type of Voicemail Pro that you intend to install.

18. Restore the Database
The copy of the call flow database that contained any customizations made to the default call flow needs to be restored.

18.1. Start Voicemail Pro.
18.2. From the File menu, select Import or Export.
18.3. Select Import Call Flows.
18.4. Click Next.
18.5. Click the Browse button and locate the file that contains the backed up call flows.
18.6. Select the file and click Open.
18.7. In the Import or Export Call Flows window, click Next.
18.8. Click Finish to start importing the database.
18.9. Click Close to complete the import process.
18.10. Click Save and Make Live.

19. The new version of Voicemail Pro has been installed. Test that the system is running by dialing *17 from any extension. You should hear the mailbox announcement.

Upgrade from Version 3.2
You can upgrade from IP Office Voicemail Pro 3.2 to IP Office 4.0. If you upgrade you can still use a 3.2 Voicemail Client to update Voicemail Pro 4.0. However, if you want to change any of the new features, for example the Outcalling preferences or to use the start points for Personal Announcements, you will need to use the latest Client version of IP Office Voicemail Pro.

To upgrade from version 3.2:
1. Stop the all Voicemail Pro services running. It would be a good idea to make a backup of the registry and the Call flows and if possible the Voicemail Pro folder before proceeding.
2. Insert the new IP Office Voicemail Pro CD. The installation should auto-start. If it does not auto-start, click Browse to locate Setup.exe on the CD and then run it. The Choose Setup Language window opens.
3. Select the installation language. The language selected is used for the installation.
4. Click OK. You are asked 'This setup will perform an upgrade of IP Office Voicemail Pro'. Do you want to continue?
5. Click Yes. The Upgrading the IP Office Voicemail Pro window opens.
6. Click Next to start the upgrade. The setup status window opens. The progress of the upgrade is indicated by a time bar. When the InstallShield Wizard complete window opens.
7. Click Finish. The Email settings window opens.
8. Enter your email account details and click Next. The IP Office Voicemail Pro Control Panel applet settings window opens.
9. Enter your settings for each form and click OK.
10. Click Yes when asked if you want to start the Voicemail Pro service.
11. Reboot the PC and verify that the services start properly and that the voicemail is fully functional.
12. The new version of Voicemail Pro has been installed. Test that the system is running by dialing *17 from any extension. You should hear the mailbox announcement.
**8.1.7.2 IMS Service Logging**

If IMS is installed the Systems Settings tab is available. You can specify the level of service logging for the IMS Gateway Server service and the IMS Voice Server service. Four levels of logging are available, with increasing level of detail.

Typically logging is required only if IMS problems are being experienced and diagnosis is required. The information is logged in the Event Viewer application.

**To specify the level of IMS service logging:**

1. Open the Windows Control Panel.
2. Select **IP Office Voicemail Pro**. The IP Office Voicemail Pro window opens.
3. Click the **System Settings** tab.

![System Settings Tab](image)

4. In the **Logging Level** boxes, select the level to use for each of the IMS services.
   - **None** - No logging recorded.
   - **Some** - A low level of logging recorded where only errors are logged.
   - **Most** - A medium level of logging where errors and warnings are recorded.
   - **All** - All errors, warnings and information are logged.
5. Click **Check** to validate the changes that you have made.
6. Click **OK**. You are prompted to restart the affected services so that your changes are enabled.
7. Choose **Yes**. The services that are affected by your changes are automatically stopped and restarted.
8.1.7.3 IMS Host Server Name

If IMS is installed the Path Settings tab is available. You need to specify the computer name of the server PC that is hosting the IMS Voice Service. Typically, this is installed on the same server PC as the Voicemail Pro Server.

To specify the name of the host server PC for IMS:

1. Open the Windows Control Panel.
2. Select **IP Office Voicemail Pro**. The IP Office Voicemail Pro window opens.
3. Click the **Path Settings** tab.

   ![Path Settings Tab](image)

4. Type the name of the computer on which the IMS Voice Service has been installed.
   - Alternatively, click **Browse** and select the name of the computer.
5. Click **Check** to validate the changes that you have made.
6. Click **OK**. You are prompted to restart the affected services so that your changes are enabled.
7. Choose **Yes**. The services that are affected by your changes are automatically stopped and restarted.
### 8.1.7.4 IMS Email Settings

You can configure certain email settings such as the account to use for email and the way in which .wav files are transmitted.

**To configure email settings**

1. Open the Windows Control Panel.
2. Select **IP Office Voicemail Pro**. The IP Office Voicemail Pro window opens.
3. Click the **Email Settings** tab.

![IP Office Voicemail Pro window](image)

4. In the **Account Details** box, type the name of the MAPI email account (**IMS**) to use for email messages. Alternatively, select Browse to display a list of available email accounts.
   - For IMS you should be using the IMS account setup previously. If Outlook is installed properly you should be able to browse for this account. If you are able to browse but are not able to see the IMS account, verify that the IT manager has not hidden the account in Exchange.
5. Click **Check** to validate the changes that you have made.
6. The Message Parameters options are only available if you have installed IMS. For IMS you can specify the way in which the .wav files of voicemail messages are to be sent in emails. Sending .wav files across a network creates a high loading on the network and networks servers. A one-minute message requires a 1MB .wav file.
   - To transmit .wav files, check the **Transmit Wave File** box.
   - Choose the option for transmitting the .wav files. Choose either:
     - **Attach wave file to message** to allow a recipient to copy a .wav file for use elsewhere.
     - **Embed wave file in message** to allow a recipient to embed a file in a message. An embedded file is compressed and therefore smaller than an attached file.
7. Click **OK**.
8.1.7.5 Troubleshooting DCOM Issues

Checking both the following options allows DCOM errors to be seen.

- **Enable Auditing**
  When you first set up a Windows server or Workstation, the default setting for system wide audits is "disabled". Turn on failure audits by using the user manager program, again accessing the Policies menu. This time, click on the "Audits" selection. Enable audits and select all of the "failure" check boxes and click OK. At this point, any DCOM security problems will start to show up in the system event log on the system where they occurred.

- **Check Batch Job Permissions**
  The second cause is that the package is configured to run as specific identity, but that identity doesn't have "log in a batch job" permissions. This is far more common and easily distinguished by testing the component with package identity set to 'interactive user'. If the application will start up as the interactive user, but not as the specific identity, then either the identity being used is no longer valid (which generates a security failure log message in the system security log) or the "log in as batch" permission hasn't been granted to that ID (which generates the weird MTS message).

1. In Windows 2000, enable these options as follows:
2. On the Start menu, select **Programs | Administrative Tools | Local Security Policy**.
3. On the left-hand pane, select the Audit Policy entry.
4. On the right-hand pane, select the Audit Policy entry, and note that the right pane contains all audit options, which one is enabled and which one is not. Right-clicking on any of these options allows you to enable or disable them.
5. Enable auditing for success and failure for the following options: Audit logon events, Audit object access, Audit privilege use.

Once you have activated these logging options, test your client again. After you get the error message, use Event Viewer to see if there are any DCOM events. The event may tell you why access was denied. Also, it can tell you who is logged on to the client computer and if this is a domain user or a local user. It can tell you that the protocol requested by the client is not available on the server, and so forth. COM logs are usually added to the system log.
8.1.7.6 Tracing in Debug

Many applications, including Voicemail Pro and IMS, output activity messages that are viewable in Debug View (DbgView). This application can be downloaded from http://marketingtools.avaya.com/tools/debug.

Installation

1. Download the zip file.
2. Unpack the files into a folder such as c:\debug on the server PC.
3. Run DbgView.exe.
4. Events are shown in the DbgView window. These can be logged to a file if required. The level of detail shown can be filtered to show more or less activity.

Logging

1. Run DbgView.exe.
2. Select File | Log Preferences.
3. Set the logging details are required and click OK.
4. While DbgView is running the viewable trace is also copied to the specified file.
5. The debug log files can be opened in programs such as Wordpad.
Filtering

1. Select View | Debug Filters.

2. Select the module for which you want to increase/decrease reporting.

3. In the right hand panel adjust the level of reporting.

4. Close the Configure Debug Filters window.

IMS Tracing

IMS tracing is enabled through a number of registry keys. The IMS server keys are set through HKEY_LOCAL_MACHINE registry values. The IMS client keys are set through HKEY_CURRENT_USER. All the keys are all REG_DWORD values and are disabled if not set or set to 0.

<table>
<thead>
<tr>
<th>IMS</th>
<th>HKEY_LOCAL_MACHINE\SOFTWARE\AVAYA\Integrated Messaging</th>
</tr>
</thead>
<tbody>
<tr>
<td>EnableTracing</td>
<td>This key must be enabled to allow tracing using the other keys below.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Voicemail</th>
<th>HKEY_LOCAL_MACHINE\SOFTWARE\AVAYA\Integrated Messaging</th>
</tr>
</thead>
<tbody>
<tr>
<td>EnableTracing</td>
<td>This key must be enabled to allow tracing using the other keys below.</td>
</tr>
<tr>
<td>ConstructorTracing</td>
<td>This provides some tracing for when certain COM objects are constructed. As a whole it is not required for diagnostics.</td>
</tr>
<tr>
<td>DestructorTracing</td>
<td>This provides some tracing for when certain COM objects are destructed. As a whole it is not required for diagnostics.</td>
</tr>
<tr>
<td>EnableConnectionTracing</td>
<td>Provides diagnostic for when a connection occurs (server to server or client to server).</td>
</tr>
<tr>
<td>EnableRefTracing</td>
<td>This indicates when the reference count for certain COM objects is changed (through AddRef, Release).</td>
</tr>
<tr>
<td>Gateway</td>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\AVAYA\Integrated Messaging\Gateway</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>Debugging</td>
<td>This key must be enabled to allow tracing using the other keys below.</td>
</tr>
<tr>
<td>ChannelEvtSinkTracing</td>
<td>Provide tracing about speech channel events received.</td>
</tr>
<tr>
<td>ConstructorTracing</td>
<td>This provides some tracing for when certain COM objects are constructed. As a whole it is not required for diagnostics.</td>
</tr>
<tr>
<td>DestructorTracing</td>
<td>This provides some tracing for when certain COM objects are destructed. As a whole it is not required for diagnostics.</td>
</tr>
<tr>
<td>EnableConnectionTracing</td>
<td>Provides diagnostic for when a connection occurs (server to server or client to server).</td>
</tr>
<tr>
<td>EnableFunctionTracing</td>
<td>Generally used by the client software to trace out information about the functions that are being executed.</td>
</tr>
<tr>
<td>EnableObjectTracing</td>
<td>Allows certain created COM objects to be traced.</td>
</tr>
<tr>
<td>EnableProxyTracing</td>
<td>When a client connects to a server, it connects through a proxy. This settings allows information from the proxy to be traced.</td>
</tr>
<tr>
<td>EnableRefTracing</td>
<td>This indicates when the reference count for certain COM objects is changed (through AddRef, Release).</td>
</tr>
<tr>
<td>EnableTagTracing</td>
<td>When certain internal objects are created, such as a channel object for speech playback, this information is tracked. Using this setting every minute a trace occurs of the object list.</td>
</tr>
<tr>
<td>FireEventTracing</td>
<td>Provide tracing about events that are sent from the server to its clients.</td>
</tr>
<tr>
<td>MailboxEvtSinkTracing</td>
<td>Provide tracing about mailbox events received.</td>
</tr>
<tr>
<td>MessageEvtSinkTracing</td>
<td>Provide tracing about message events received.</td>
</tr>
<tr>
<td>IMS Client Keys</td>
<td>HKEY_CURRENT_USER\Software\Avaya\Integrated Messaging\Client</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>EnableTracing</td>
<td>This key must be enabled to allow tracing using the other keys below.</td>
</tr>
<tr>
<td>ConstructorTracing</td>
<td>This provides some tracing for when certain COM objects are constructed. As a whole it is not required for diagnostics.</td>
</tr>
<tr>
<td>DestructorTracing</td>
<td>This provides some tracing for when certain COM objects are destructed. As a whole it is not required for diagnostics.</td>
</tr>
<tr>
<td>EnableFunctionTracing</td>
<td>Generally used by the client software to trace out information about the functions that are being executed.</td>
</tr>
<tr>
<td>EnableObjectTracing</td>
<td>Allows certain created COM objects to be traced.</td>
</tr>
<tr>
<td>EnableProxyTracing</td>
<td>When a client connects to a server, it connects through a proxy. This settings allows information from the proxy to be traced.</td>
</tr>
<tr>
<td>EnableRefTracing</td>
<td>This indicates when the reference count for certain COM objects is changed (through AddRef, Release).</td>
</tr>
<tr>
<td>EnableTagTracing</td>
<td>When certain internal objects are created, such as a channel object for speech playback, this information is tracked. Using this setting every minute a trace occurs of the object list.</td>
</tr>
<tr>
<td>MAPIEventTracing</td>
<td>Allow tracing of MAPI events received from MAPI.</td>
</tr>
<tr>
<td>MessageProcessingTracing</td>
<td>Used for tracing what server commands the extension is using.</td>
</tr>
<tr>
<td>UMSEventTracing</td>
<td>Allow tracing of events received from the IMS server.</td>
</tr>
<tr>
<td>TimeAndTrace</td>
<td>Used for tracing how long certain MAPI events took to process.</td>
</tr>
</tbody>
</table>

All the keys are based on the component as follows:

- IMS (Voice) Server – "SOFTWARE\Avaya\Integrated Messaging\Voicemail" (e.g. "HKLM\SOFTWARE\Avaya\Integrated Messaging\Voicemail")
- IMS (Gateway) Server – "SOFTWARE\Avaya\Integrated Messaging\Gateway"
- IMS Administration – "SOFTWARE\Avaya\Integrated Messaging\Admin"
- IMS Client – "SOFTWARE\Avaya\Integrated Messaging\Client" (e.g. "HKCU\SOFTWARE\Avaya\Integrated Messaging\Client").

VM Server Specific

- "CtiNotifyTracing" – Provide tracing to indicate that a Cti event has occurred.
- "VmsNotifyTracing" – Provide tracing to indicate that a VMS API event has occurred.
8.1.7.7 IMS Installation Alternatives

The IMS Server actually consists of two components in addition to the Voicemail Pro service, these are:

- **IMS Gateway Service.**
- **IMS Voice Service.**

Typically both these services are installed on the same server as the Voicemail Pro Service and that is the installation process described in this documentation. However the IMS Gateway Service can be installed on the Exchange Server PC if required. Installation of the IMS Gateway Service onto the Exchange Server PC requires more installation steps.

If the IMS Gateway Service is installed on the Exchange Server PC, IMS needs to access the Exchange server. Exchange must be started before IMS. More specifically, the MSEchangeIS and MSEexchangeMTA services must be started before the IMS Gateway service. If the IMS and Exchange services are configured to start automatically on system boot, there may be a problem. When the system starts, Windows will launch both the IMS and Exchange services but not necessarily in the correct order. It is therefore necessary to force Windows to start the services in the correct order.

This is accomplished by editing the registry as follows:

1. Run regedit32.exe. This is normally located in \WINNT\SYSTEM32.
2. From the Window menu, select the HKEY_LOCAL_MACHINE option.
3. Navigate to the SYSTEM\CurrentControlSet\Services\IMS\Gateway) key.
4. Open the DependOnService value. It should already contain the IMS (Restart)
5. Append the MSEchangeIS and MSEexchangeMTA strings.
6. Note that the value is of type REG_MULTI_SZ, which means that each string should be separated by pressing the enter key.
7. Close regedt32. Restart the machine and verify that IMS starts correctly.
8. Note that it may take a few minutes after a restart for the Exchange and IMS services to be fully operational.
8.1.8 Known Issues

8.1.8.1 Problems Connecting to IMS on a Domain Controller

**Scenario**
Voicemail Pro with IMS will run on a PC running on a Domain Controller. Note however that it is not recommended that IMS be installed on a Domain Controller.

**Problem**
Voicemail Pro and IMS are running on a Domain Controller and IMS clients are having Problems connecting.

**Resolution**
All Domain users who are using the IMS clients must be able to read and write the folder C:\Program Files\Avaya\IP Office\Voicemail Pro\VM\Accounts on the server.

8.1.8.2 Problems Connecting to/Synchronizing with IMS

If you are having problems connecting to the IMS server or having problems synchronizing:

**On the Client PC**
Make sure the mailbox name you entered is EXACTLY what is in the name section of the user form for their mailbox. This is the entry as it appears in the Username field of the IP Office User Profile Screen. This is case-sensitive. Verify that all the user names have been entered correctly and that you are not using illegal characters, only alpha/numeric characters and no punctuation. If this information is entered incorrectly, the IMS client will not connect to the IMS Server.

Voicemail removes spaces at the end of mailbox names. If spaces are left at the end of a mailbox user’s name in IP Office Manager, when the mailboxes are created, the space at the end of the name is dropped. When this occurs the mailbox cannot be found as there is a mismatch between the user name and directory. Verify that there are no spaces at the end of any of the user names in Manager.

Make sure when you installed the client you gave the NAME of the VMP/IMS server. Verify that you can ping the server by it’s name. You may want to put an entry in the hosts and imhosts with the #PRE option in the imhosts.

Remove the client, reboot and reinstall it and verify that these are put in correctly then change the dcomcnfg settings outlined above in Misc Troubleshooting and always run the AvayaFW.bat even if the Windows Firewall is turned off.

**On the Voicemail Pro/IMS Server machine**
Verify that you are using the proper domain account (IMS) to start the IMS services and VMP/IMS service.
On the Server
In dcomcnfg, verify that the Identity of the account that you are using to run the IMS Gateway, IMS Voice, and IMS Restart Services are the same Domain account you are using to start the Voicemail Pro and IMS services.

Make sure the account has at least local admin rights on the PC or local and domain admin rights.

Check the event viewer and stop and start the VMPro and IMS services and see if you get any errors. You must have the logging level set to Most or All.

Go into the control panel and run the IP Office Voicemail Pro Control Panel Applet and run through each tab and verify that all the information is correct and that you can browse for the server and email account. Run the check at the bottom of the applet and make sure it does not come back with an error, then check the event viewer and see if there are any errors. As long as you have the logging level set to most or all you should see errors in the event viewer application logs.

Check to see if you setup the Outlook account correctly and make sure it can send and receive email. You should be logged in with the same domain account you are using to start the Voicemail Pro and IMS services (IMS). Verify that you can send and receive emails.

Run the IMS admin tool and verify that the mailboxes have been setup properly. Un-assign then reassign them and verify that you can browse and find the email and NT login accounts, do not just type them in to avoid typo’s. If you are not receiving the emails and everything else is setup properly, you can enter the SMTP email address (User@domain.com) in the email section but verify that you have typed it correctly. Next run the “synchronize” on the account by right clicking and choosing synchronize. Next go into the event viewer and check for new errors.

Reboot the VMPro/IMS server and make sure it boots up okay and starts all the services and there are no errors in the event viewer under application or system.

Verify that the IMSClient executable has not been run on the VMPro/IMS. Go to add remove programs and verify that the IMS Client is not in the list.

Ask yourself these questions: Are any client machines able to connect? If you have only installed the client on one machine make sure you try it on one or more other machines. Try different Makes and Models and operating systems if available to see if the problem is with a particular installation or build. If none of them can connect problem is most likely a problem on the server. If one or more can connect the problem is most likely on the client machine.

IMPORTANT THINGS TO REMEMBER:
Any time the user interacts with their voicemail-emails they must be connected to the IMS Gateway server on the voicemail PC. They can not work off line or the synchronization will be broken.

- When installing IMS, Windows Messaging (MAPI) must be installed prior to the Voicemail Pro install.
- This includes the connectivity to Microsoft Exchange Server.
- The IMS (Voice) must be installed on the same machine as the Voicemail Server.
- When entering the mailbox for the IMS client from the Integrated Messaging page within the options dialogue in Outlook, the mailbox must be the user’s name and not their extension number.
8.1.8.3 Unspecified Error 80004005

When selecting the handset to playback the message, a dialog box similar to the message below may be received.

![Voice Message Form](image)

This error is typically only seen when selecting the handset as the Output device. If the message is embedded or attached a user can play the message using desktop speakers.

**Cause**

This error message indicates that there may be a problem with permission configuration, thereby preventing the client from being able to establish a connection to the desktop extension.

A common cause for this is misconfiguration of the extension number that the IMS Client must connect to.

**Solution**

To verify and if necessary correct the issue, open Outlook, Select Tools – Options – Integrated Messaging Tab. Insert the correct extension number into the field provided.

Once completed play the message back from the client. This above symptom should now be resolved.
8.1.8.4 Outlook Cached Exchange Mode

Avaya IP Office Integrated Messaging is not supported with Microsoft Outlook using Cached Exchange Mode (provided in Outlook 2003).

Cached Exchange Mode can cause problems with Message Waiting light synchronization with IP Office terminals.

To disable Cached Exchange Mode:
1. Select Start | Settings | Control Panel | Mail.
2. Select Email Accounts.
3. Select View or change existing email Accounts.
4. Select the Microsoft Exchange Server
5. Select Change.
6. Uncheck Use Cached Exchange Mode.
7. Click OK.
8. Close and restart Outlook be apply the change.

Using Cached Mode
IP Office IMS users who want to use Cached Mode when traveling outside of the Office can temporarily enable it operation.
1. Turn on Cached Exchange Mode.
2. Select the Integrated Messaging tab.
3. Select Prompt before connecting to Voicemail Server.
4. Click OK.
5. Close Outlook.

When the user logs in remotely and opens Outlook, they will be prompted by the message "Do you wish to connect to the Integrated Messaging server". They should select No before opening outlook. Outlook will not then try to synchronize voicemail messages in Outlook with Voicemail Pro.

When the user is back in the office, they can then check Cached Exchange Mode, reopen Outlook and connect to the VoicemailPro server for message synchronization.

8.1.8.5 Transferring an IMS Account to a New PC
The voicemail call flows, greetings, IMS user accounts and other user settings can be transferred to a replacement Voicemail Pro server PC with the following steps:
1. Export the Voicemail call flows
2. Back up the Accounts, Names, Greetings Folders, and Custom wav files in a separate directory
3. Navigate to C:\Program Files\Avaya\IP Office\Voicemail Pro, then run Backupreg.bat This will back up the IMS account information entered in the IMS Admin Tool to VMPRO.arf, NETALY.arf, MSGATEWAY.arf. The files are backed up to C:\%WINDIR%\temp. (%WINDIR% is the directory where Windows is installed).
4. Copy the three files to a backup device
5. Install the Voicemail Pro software onto the new PC
6. Stop the Voicemail Pro services and copy the Accounts, Names, Greetings Folders, and Custom wav files from the old PC to the directory on the new PC.
7. Copy the VMPRO.arf, NETALY.arf, and MSGATEWAY.arf files to the new PCs Window’s Temp directory (C:\windowstemp or C:\winnt\temp)
8. Run Restorereg.bat file. This will restore the IMS user’s account information.
9. Start the Voicemail Pro and IMS services.
10. Import the VM Pro database. Save and make Live.
8.1.8.6 IMS Client Not Showing in Outlook Tools

The Integrated Messaging Tab may be disabled and not show in Outlook’s Tool, Options tab. This is caused by outlook disabling the Extension.dll file, which can be caused by the IMS user opening Microsoft Outlook and not being able to synchronize with the Voicemail Pro server; if the user then closes and opens Outlook, they may receive the following error:

![Microsoft Office Outlook](image)

If the user clicks Yes, Outlook will open and the Integrated Messaging client will not be able to synchronize Outlook with the client’s voicemail box - the user will be able to click on an IMS message and play the message, but the message waiting light will not turn off.

To check to see if the extension.dll add-in is disabled:

2. Choose Disabled Items.
3. Outlook will list all the programs that are disabled.
4. Highlight Addin: c:\program files\avaya\ims client\extension.dll.
5. Choose Enable.
6. Click Close.
7. Open and close Outlook and the Integrated Messaging tab will appear in Options | Tools.
8.1.8.7 Firewall Port Settings

Windows users who install and use third party Firewall applications such as MacAfee Personal Firewall may experience problems using the Avaya IP Office Integrated Messaging Service with Outlook if ports that are blocked by the default installation of these products are not opened.

Problems that may be experienced include:

- Message waiting lights not turning off when messages are played.
- Failure to connect to Integrated Messaging Service when Microsoft Outlook is opened.

The following ports will need to be set to allow incoming and outgoing traffic:

- UDP Port 67
- UDP Port 69
- TCP Port 135
- TCP Port 2000
- UDP Port 50791
- UDP Port 50799

8.1.8.8 VMPro Error 0x80004005

When installing Voicemail Pro software, the following error message may be encountered:

```
Failed to browse for an email address.
The following error occurred:
  Unspecified error

Engineering Information
  Error Number:   0x80004005 (-2147467259)
  API Called:     MAP\Initialize
  Function:       GetEmailAccountFromAddressBook
  File:           F:\VMPro_Build\V4Apps\3.0\MS\WmDe\UnifiedMessaging\Common\EmailHelpers.cpp

This error message occurs when clicking browse to add the email account for "Voicemail to Email" or "IMS" Applications, and is due to Voicemail Pro attempting to browse Outlook’s contacts folder for accounts when Outlook is not installed on the Voicemail Pro server.

The account details can be added in manually by typing the full email address into the account details field and selecting apply. (Apply must be selected otherwise the settings will not be saved).
```
8.1.8.9 Windows Update Causes Voicemail Pro to Stop
Voicemail Pro may stop working due to the lack of system resources when a MS Windows patch is downloaded and is waiting to be installed. As a result, Windows XP Professional and Windows 2003 servers should either disable Windows Automatic Update or set it to only Notify.

Windows Updates should be downloaded and installed after peak business hours on a regular basis. This will allow the installation to be done manually and testing of the update software to be done in a controlled fashion.

This can be done by going to Start | Settings | Control Panel | System then selecting the Automatic Updates tab, and choosing either Notify Me or Turn Off.

8.1.8.10 Saving IMS Messages Past Housekeeping
Once read, a Voicemail message will be deleted after a period of time defined by the voicemail system administrator, the default being 30 days (720 hours). IP Office Integrated Messaging Pro clients can save a copy of the message locally by clicking the Floppy disk icon in the embedded Interface.

When the floppy disk icon has a red cross superimposed, this indicated that the message is not saved. The message will be removed automatically by housekeeping. Click the icon to save the message.

When the floppy disk icon has a green tick superimposed, the message is set as saved.
**8.1.8.11 Outlook Delegates Cause IMS to Slow**

IP Office Integrated Messaging Pro (IMS) clients may appear to respond slowly or even lock up where the IMS client user has defined one or more delegates in Microsoft Outlook.

These delegates should be included in IMS User settings in the IMS Administration tool.

![Mailbox Properties](image)

All delegates of an IMS Client’s Outlook should have their domain account and email address added into the permissions field, with “Access” permission selected.

**8.1.8.12 IMS Clients Not Connecting When Outlook Opened**

Avaya IP Office Voicemail Pro IMS Clients not connecting to Voicemail Pro when outlook is opened IMS Clients may experience problems when outlook is opened and the IMS software attempts to connect to the Voicemail Pro Server.

The IMS Client will try to resolve the name of the Voicemail Pro server; this will fail if the Voicemail Pro computer name includes non alphanumeric characters.

The Computer name of the Voicemail Pro server should not include non alphanumeric characters for this reason.

Examples are “Voicemail_Pro” or “machine-001”.

The preferred computer name would be “VoicemailPro” or “machine001”.

In addition, DNS must be setup locally in the network and the clients should have their primary DNS requests pointed to that server.
8.1.8.13 Starting IP Office Services Using a Batch File

In some instances, certain computers might not respond quickly enough in order to start all of the Avaya services in the correct order. In this circumstance, it can be advisable to create a batch file which will delay the start of these services until the PC is fully running.

Avaya IP Office Services can be started successfully at system start-up using a scheduled task that initiates the batch file below. This batch file ensures that the services will start successfully and in the proper order.

To set up the batch file:

1. Set all Avaya services listed below to Manual start. Do not include Key Server.

2. Create the batch file below and save it to %SYSTEMROOT%:

```batch
@echo off
rem Wait 60 seconds before execute.
timeout /t 60
net start CCC Delta Server
net start CCC Reporting
net start VMProDBService
net start Voicemail Pro Service
net start IMS(Restart)
net start IMS(Voice)
net start IMS(Gateway)
```

3. Create a scheduled task to start the batch file at system start-up.

8.1.8.14 Message Waiting Indicators Not Clearing

All user names in a Small Community network using centralized Voicemail must have a completely unique entry in the User’s Name field.

Examples of incorrect user names on the same system include:

- User 1: STEVE SMITH
- User 2: steve smith
- User 3: Steve
- User 4: Steve Smith
- User 5: Steve-Smith

User names must only use alphabetic characters.

These examples may cause one mailbox to be created for the above users. This may prevent message waiting indicators from updating correctly, and Integrated Messaging (IMS) synchronization problems.
8.2 Installing VoiceMail Pro as an ACM Gateway

Complete the steps in this section to install Voicemail Pro as an ACM Gateway. There is only one type of installation for the Voicemail Pro ACM Gateway. Therefore you are not offered the choice of custom, compact or typical during the installation process.

To install the ACM Gateway:

1. Insert the IP Office Voicemail Pro CD. The installation should auto-start. If it does not auto-start, click Browse to locate Setup.exe on the CD and then run it. The Choose Setup Language window opens.
2. Select the installation language. This language is used for the installation and for the default language prompts.
3. Click OK. Installation preparation begins.
4. Voicemail Pro 4.2+ requires Microsoft .NET 2.0 Framework. If this version is not detected, you are prompted to install it. Click Yes to install Microsoft .NET 2.0 Framework and follow the instructions on the screen.

If the following window opens, Voicemail Pro is already installed. You need to upgrade rather than install a new version. For more information, see Upgrading a Voicemail Pro System Otherwise the IP Office Voicemail Pro installation starts and the Welcome window opens.

5. In the Welcome window, click Next. The Customer Information window opens.
6. In the Customer Information window, type a user name and the company name or use the default names that are proposed. These settings do not affect Voicemail Pro when it is installed.
7. In the same window choose the option that determines who should be able to use Voicemail Pro when it has been installed. The recommended option is Anyone who uses this computer (all users).
8. In the Customer Information window, click Next. The Choose Destination Location window opens.
9. In the Choose Destination Location window, click Browse and locate the folder where the Voicemail Pro files are to be installed. Otherwise, click Next to use the proposed folder. The Messaging Components window opens so that you can choose the components that you want to install.
10. In the Messaging Components window, highlight ACM Gateway.
11. Click Next. The Service Account Name window opens. Details of the default administrator account may already be filled in.
12. In the Service Account Name window, type the User Name and Password for the user account under which the Voicemail Pro service should log on and run. This should be the Voicemail account created previously on the domain and Exchange server. Alternatively, click Browse and select from the list of available PC or network accounts or click Next to use the proposed account details. The Select Program Folder window opens.
13. By default, the program folders are created in a folder called IP Office. You can specify a different folder or select one from the list of existing folders. To specify a different folder, type the folder name in the Program Folders box. Alternatively, to use an existing folder, highlight a name in the list of existing folders.
14. Click Next. The account details that you have entered are verified. If you entered a new user name, a message is
displayed to ask if you want to create a new PC user account with the specified name and password. Click Yes.

The Select Program Folder window opens.

15. Select the program folder where you would like the icons for the Voicemail Pro components to be added. By default, the program icons are added to IP Office.

16. Click Next. The Start Copying Files window opens. Before any copying starts, you are presented with a summary of the settings that you have chosen so far.

17. Review the settings to make sure that they are what you expect. Scroll down if necessary.

18. If for any reason the details are not what you expect, click Back and make the necessary changes. When you are satisfied that the details are correct, click Next to start copying the files. The Setup Status window opens to keep you informed while the installation takes place.

19. When the installation is complete you are prompted to restart the computer. Choose Yes I want to restart my computer now.

20. Click Finish to restart now.

21. When the computer restarts, log back in. The IP Office Voicemail Pro - ACM Gateway Settings window opens.

22. In the Mail Server box, type the name of the mail server to use.

23. Choose Message Networking/Interchange to use Interchange or Modular Messaging to use Modular Messaging.

24. Click Next. The IP Office Voicemail Pro SMTP Email Settings window opens.
   - In the Mail Server box, type the name of the SMTP mail server. This should be the fully qualified domain name.
   - In the Port Number box, type the number of the receiving port on the SMTP mail server. The default is 25.
   - In the Mail Drop box, type the name of the destination folder for outgoing emails on the SMTP Server. Alternatively, click the Browse button and select the folder to use.
   - To enforce server authentication, check the Server Requires Authentication box. This is optional. If you check this option you also need to provide the Account Name and Password that need to be entered. You can also choose whether or not to set the Use Challenge Response Authentication option.

25. Click Finish. An attempt is made to validate the email settings. If everything has been installed correctly and the license requirements are met, you are prompted to start the Voicemail service. If the attempt to connect with the SMTP server fails, an error message is displayed. You might need to start the Voicemail service manually. For more information, see Starting the Voicemail Pro Service.

26. Click OK to acknowledge the message. You have now finished installing the Voicemail Pro ACM Gateway software.
8.3 Installing Networked Messaging (VPN姆)

Voicemail Pro Networked Messaging (VPN姆) allows users to forward voicemail to mailboxes on remote voicemail systems. This is done by adding a VPN姆 component to the Voicemail Pro installation.

The messages are transferred between systems using an SMTP/MIME mail format to encode both the voice part of the message and additional message details.

Here is a diagram to illustrate VPN姆 between two IP Office systems.

---

Here is a diagram of a sample VPN姆 configuration between an IP Office and Avaya Interchange. Depending on how your IP Network is set up, the configuration will differ slightly.

---

Up to 2000 mailboxes are supported per VPN姆 server and there is no constraint on the number of VPN姆 servers. However, to distinguish between dial plans you might need to allocate a dial pre-fix to each server. A maximum of 99 pre-fixes are available.

This section summarizes the steps required for installing VPN姆 between two IP Office systems and between an IP Office system and an Intuity Audix system through Avaya Interchange.

The instructions provided here should be read in conjunction with the other Avaya guides, for example "Avaya Interchange Release 5.4, Adding a VPIM System to Your Network". This is because the setup for Interchange VPIM is the same as for VPN姆.
8.3.1 Requirements for VPNM

Check that the following requirements have been before attempting to install VPNM:

- A Voicemail Pro server with VPNM installed connected to each IP Office system. Each system will need a license for both Voicemail Pro and VPNM.

- All systems in the VPNM network need to be tested to ensure that they can communicate across the IP network. It is suggested that you test the following:
  - Ping the IP Addresses.
  - Ping the computer names. If in a domain, ping the fully qualified domain name.

- The VMPro Servers must have an SMTP server installed. This can be done using the SMTP component of Internet Information Service (IIS).
  - To test type "Telnet <the name of the SMTP server> 25".

- Server names, where entered, must be fully qualified domain names.

- Voicemail Pro should not be installed on the same server as Exchange and/or the domain controller.
8.3.2 Installing VoiceMail Pro with VPNM Support

This section describes how to install the Voicemail Pro software with its VPNM component onto the Voicemail Pro server PC.

Before you begin:

1. Using IP Office Manager, check that the correct licenses for Voicemail Pro and IMS are installed and show a status of **Valid**. The licenses required are:
   - **Voicemail Pro (4 ports)** plus Additional Voicemail Pro (X ports) licenses up to the total number of port required or supported by the IP Office control unit.
   - **Networked Messaging** - Enables operation of VPNM with Voicemail Pro.

To install Voicemail Pro Software with VPNM support:

1. Insert the **IP Office Voicemail Pro** CD. The installation should auto-start. If it does not auto-start, click **Browse** to locate **Setup.exe** on the CD and then run it. The Choose Setup Language window opens.
2. Select the installation language. This language is used for the installation and for the default language prompts.
3. Click **OK**. Installation preparation begins.
4. If the following window is displayed, Voicemail Pro is already installed. You need to upgrade rather than install a new version. For more information, see [Upgrading a Voicemail Pro System](#).

If you have already installed basic Voicemail Pro on the PC, and now want to install IMS, the instructions are the same. The difference is that when prompted to Modify, Repair or Remove, you must select **Modify** and check the Integrated Messaging check box later in the installation process. Otherwise the IP Office Voicemail Pro installation starts and the Welcome window opens.

5. In the Welcome window, click **Next**. The Customer Information window opens.
6. In the Customer Information window, type a user name and the company name or use the default names that are proposed. These settings do not affect Voicemail Pro when it is installed.
7. In the same window choose the option that determines who should be able to use Voicemail Pro when it has been installed. The recommended option is **Anyone who uses this computer (all users)**.
8. In the Customer Information window, click **Next**. The Choose Destination Location window opens.
9. In the Choose Destination Location window, click **Browse** and choose the folder where the Voicemail Pro files are to be installed. Otherwise, click **Next** to use the proposed folder. The Messaging Components window opens so that you can choose the components that you want to install.
10. Unless there are specific reasons for changing the location, the default setting is recommended.
11. In the Messaging Components window, highlight **Voicemail Pro (Full)**.
12. Click **Next**. The Setup Type window opens.
13. In the Setup Type window, select Custom.

14. Click Next. The Select Features window opens so that you can select which additional Voicemail Pro features to install.

15. Scroll down and check VPNM.

16. Ensure that the following are selected:
   - The Voicemail Pro Campaign Web Component is not required for VPNM but is installed as part of a typical Voicemail Pro Server installation. If a web server has already been installed but the Voicemail Pro Campaign Web Component is not required, uncheck it to remove it. If Voicemail Pro Campaign Web Component is required for other use, make sure that it is checked so that it is not removed.
   - Voicemail Pro and Voicemail Pro Server Service should be already selected.
   - Ensure that Voicemail Pro Client and Voicemail Pro Service are also checked.
   - Check the boxes for any additional required languages. It is recommended that either English or English US is always selected in addition to any languages that are required by the customer.
   - Important: Do not uncheck any other boxes as this will remove the corresponding software features.
   - Scroll down and check VPNM.

17. Click Next. If you have chosen not to install the Web Campaign Component, the Service Account Name window opens. The Select the Web Server root directory window opens so that you can specify the folder where the web campaign web pages are to be stored.

18. The default folder is C:\inetpub\wwwroot. To use the default folder, click Next. To specify a different folder, type the path to the preferred folder location. Alternatively, click Browse and locate the folder to use.

19. Click Next. The Destination of the Web Script Directory window opens so that you can specify the folder where the web campaign components are to be stored.

20. The default folder is C:\inetpub\scripts. To use the default folder, click Next. To specify a different folder, type the path to the preferred folder location. Alternatively, click Browse and locate the folder to use.

21. The Service Account Name window opens. Details of the default administrator account might already be filled in.

22. In the Service Account Name window, type the User Name and Password for the user account under which the Voicemail Pro service should log on and run. This should be the IMS account created previously on the domain and Exchange server. Alternatively, click Browse and select from the list of available PC or network accounts.

23. Click Next. The Select Program Folder window opens.

24. By default, the program folders are created in a folder called IP Office. You can specify a different folder or select one from the list of existing folders. To specify a different folder, type the folder name in the Program Folders box. Alternatively, to use an existing folder, highlight a name in the list of existing folders.

25. Click Next. The Start Copying Files window opens. Before any copying starts you are presented with a summary of the settings that you have chosen so far.
26. Review the settings to make sure that they are what you expect. In particular, check that the required languages are listed. Scroll down if necessary. When you are satisfied that the details are correct, click **Next** to start copying the files. The Setup Status window opens to keep you informed while the installation takes place.

   - If for any reason the details are not what you expect, click **Back** and make the necessary changes.

27. When the installation is complete you are prompted to restart your computer. Choose **Yes I want to restart my computer now**.

28. Click **Finish** to restart now.

29. When the server PC has restarted, the IP Office Voicemail Pro - Email Settings window is displayed so that you can specify the name of the email account to use for outgoing SMTP e-mails from the Voicemail Pro server.

30. In the Account Details box, type the name of the email account to use. Alternatively, click **Browse** and select an account to use.

31. Click **Next**. IP Office Voicemail Pro - SMTP Email Settings window opens so that you can specify details of the SMTP server to which the Voicemail Pro server should send messages. A proposed server name might already be filled in.

   - In the **Mail Server** box, leave the proposed name unchanged or type the name of the server to use. This should be the fully qualified domain name.
   - In the **Port Number** box, type the number of the receiving port on the SMTP mail server. The default is 25.
   - To enforce server authentication, check the **Server Requires Authentication box**. This is optional. If you check it you also need to provide the Account Name and Password that need to be entered. You can also choose whether or not to set the **Use Challenge Response Authentication** option.

32. Click **Finish**. An attempt is made to validate the email settings. An error message is displayed when the attempt to connect with an SMTP server fails.

33. Click **OK** to acknowledge the message. You have now finished installing the Voicemail Pro Server and VPNM software. The next step is to configure the VPNM accounts.
8.3.3 Configuring VPNM Preferences

This option is active only if VPNM was selected during installation and is licensed. VPNM servers can be added and then users added to the servers.

To open the VPN window:
1. Start the Voicemail Pro Client.
2. From the Administration menu, select Preferences > VPNM. The VPNM window opens.

![VPN window screenshot](image)

To add a VPNM server:
1. In the VPNM Server(s) section, click Add.
2. Enter the fully qualified domain name of the remote VPNM destination (the remote Voicemail Pro server PC or Avaya Interchange).
3. Enter the two digit access prefix, if these are being used.
4. Click OK.

To delete a VPNM server:
1. In the VPNM Server(s) section, select the server that you need to delete.
2. Click Delete. When a server is deleted, all of the users associated with that server are also deleted.
To add a user to VPNM server:

1. In the Users for VPNM Server(s) section, click Add. The Adding a new user window opens.

2. Enter details for the user. All of these details MUST be completed before the user can be added.
   - Select the VPIM server from the listing.
   - Enter the user's full name. The user's full name is used by the local Voicemail Pro's dial by name feature.
   - Enter the user's extension. The local extension number is used as the local mailbox number and so should not conflict with any existing local number.
   - Enter the user's remote extension. The remote extension number should be the user's real extension number. Typically this and the 'local extension number' are kept the same using a unique extension number dial plan for the linked systems.
   - Enter the user's full telephone number. The full telephone number should be a dialable number that is routed to the user's extension or mailbox.

3. Click **OK** to save the details and return to the VPNM configuration window.
To add a group of users:

1. (Optional) Check the option **Enable WildCard**. When this option is selected you can use the question mark symbol (?) to represent any number.

2. In the **Users for VPNM Server(s)** section, click **Add Range**. The Adding a range of users window opens.

3. Enter details for the users. All of these details MUST be completed before the users can be added.
   - Select the VPNM server to which you want to add the users.
   - Enter the start number of the extension range.
   - Enter local prefix.
   - Enter remote prefix.

4. Click **OK** to save the details and return to the VPNM configuration window.

To change details of a VPNM user:

1. In the Users for VPNM Server(s) section, select the name of the user whose details need to be changed.

2. Click Modify. You can change the user’s full name, the local extension number and the full telephone number.
8.3.4 Testing a VPNM Setup
It is advisable to test the VPNM setup.

To test the VPNM setup:

1. Dial into voicemail from one of the systems and record a message.
2. When selecting the target extension, enter an extension from the other system as specified in the VPNM Preferences screen.
3. The message should be delivered to the other systems Voicemail Pro server into C:\Inetpub\mailroot\Drop.
4. The VPNMreceiver Service checks the Drop directory approximately every 30 seconds. When it finds a message in the Drop directory, it will send the message to the relevant extension’s voicemail box on the remote system.
Appendix: Installing Networked Messaging (VPN)

8.4 IP Office to Avaya Interchange

8.4.1 Configuring the Avaya Intuity Audix

This section is based upon the S8100/G600 Intuity Audix. It is assumed that the IP address of the S8100 processor is known. A browser should be available and the Avaya Terminal Emulator or the equivalent to do the necessary configuration.

To configure the Avaya Intuity Audix:

1. Issue a `telnet` command to the S8100/G600, log in and enter "audix" to reach the audix command prompt.
2. Enter `list configuration` and verify that the TCP/IP value is set to at least 1. If not, these ports must be activated through the license process before proceeding.
3. From a PC browser, access the S8100 processor IP address and login.
   - At the S8100 main page, select `Administer System > Audix Networking > Administrative Menu > Network Channel Administration`.
   - Enable each channel in the Channel Configuration Column.
   - Select `Save` when finished.
4. Return to the Audix command prompt screen. Inspect the system for the list of mailboxes that will be eligible to receive messages.
   - Type `change machine`. Note the range of local extensions. `List subscribers` will provide a more specific list. It is best to distinguish mailboxes that are eligible to receive messages for example, call answer mailboxes.
   - On page 2 of the change machine form, ensure that all the update settings are set to `y`.
   - Make sure that Network Turnaround is set to `y`. Select `Enter`.
5. To administer the password for message exchange:
   - From the S8100 home page select `Administer System > Audix Networking > Administrative Menu > Local Machine Administration`.
   - Enter the password to be used for transfer of messages between this system and the Avaya interchange. Select `Change`.
6. To enter the information for connecting to the Interchange:
   - From the S8100 home page select `Administer System > Audix Networking > Administrative Menu > Remote Machine Administration`.
   - Select `Add New Machine`.
   - Enter the Avaya interchange name, IP address and networking password.
   - Define the schedule for exchanging messages.
   - Select `Add` to complete.
7. To administer the parameters associated with the Interchange:
   - Type `change machine <machine name>` from the AUDIX command prompt.
     - If all extensions that are not on the Intuity Audix are configured to be on the Interchange and "Send to non-Administered Recipients" is set to yes, errant messages may be sent. This will waste bandwidth and processing time.
   - The extension Length setting is the dial plan length that has been configured in the Avaya Interchange.
   - Set all the parameters of page 2 to `y`. (Send to non-administered recipients, Updates In, Updates Out and Network Turnaround).
   - Select `F3` to Add the remote machine.
8.4.2 Configuring the Avaya Interchange

For more information about the options that are mentioned in this section, refer to the Interchange documentation which is available from www.support.avaya.com.

To configure the Interchange Intuity interface:

- Log in to the Intuity interchange.
  - To verify that the system is optioned for TCP/IP digital ports, select Customer/Service Administration from the Interchange Main Menu.
  - The VPNM ports will also be required for interfacing to the Voicemail Pro.
- Ensure that the TCP/IP networking is set up so that the machine can communicate to and from the Intuity Audix.
  - From the Main Menu, select Networking Administration > TCP/IP Administration.
  - Make a note of the IP Address, Subnet Mask and default Gateway IP Address. The information will be required later in the setup.
- Make sure that an entry exists with the data that corresponds to the information entered for connecting to the Interchange.
  - From the Main Menu, select Networking Administration > Local Machine Administration.
- To verify that there are equipped TCP/IP ports for the networking to Intuity Audix and to Voicemail Pro:
  - From the Main Menu, select Networking Administration > Networking Channel Administration. The status should be Idle.
- Information corresponding to the Intuity Audix information entered in Step 4 when configuring the Audix needs to be entered under Digital Networking Machine Administration.
  - From the Main Menu, select Networking Administration > Remote Machine Administration > Audix Digital networking Machine Administration.
  - Enter the transmission schedule for sending messages to the Audix System. Select Chg-Keys and then the Add key to enter the form.
- Administer The Intuity Audix parameters in the Interchange.
  - Select Interchange Administration > Remote Machine Administration > Remote Machine Parameters.
  - Select Choices, then the system to be updated.
  - Ensure that the address range corresponds to the mailboxes on the Intuity Audix system that are eligible to receive messages. Set the parameters as shown.
- Avaya Interchange? = n.
- Mailbox ID Length = 5.
- Default Language = us-eng.
- Failed Msg. Notification Priority = n.
- Msg ID? = y.
- Send Message for Warning? = n.
- Default NameNet type = u.
  - Select the Details key to enter the following details:
  - Subscriber Updates Type = dynamic.
  - Updates In? = y.
  - Updates Out? = y.
  - Voiced Names for Dynamic? = y.
  - Network Turnaround? = y.
  - Provide Local Mapped Addresses = n.
  - Dynamic Sub Expiration Days = 90.
  - Select Save, Continue and then Save again.

7. If both systems are set for 5 digit dialing this step can be omitted. If both systems are not then Dial Plan Mapping needs to be used to map the mailbox identification from the Interchange Dial Plan to the Intuity Audix Dial Plan.
  - Select Interchange Administration > Remote Machine > Administration > Dial Plan Mapping. Update the form as required.

Configure the Interchange VPIM Interface to Voicemail Pro

These steps follow the instructions in Avaya Interchange Release 5.4 Adding a VPIM System to Your Network which should be referenced for greater detail on Interchange configuration steps and options.
1. Check that Interchange has available VPNM ports.
   - From the Interchange Main Menu, select **Customer/Service Administration > Feature Options**. Check that there are sufficient current entries for the Maximum Number of Digital Nodes and VPNM ports.
2. Set the Interchange General Parameters.
   - From the Interchange Main Menu, select **System Parameters > General Parameters**. Ensure that the VPNM Port Field is set to 25.
3. Identify the Avaya Voicemail Pro to the interchange system.
   - From the Interchange Main Menu, select **Networking Administration > Remote Machine Administration > VPIM Machine Administration**.
   - Select the name of the machine by telnet to the SMTP port of the Voicemail Pro to see how it identifies itself.
4. Set the IP Office parameters.
   - From the Interchange Main Menu, select **Interchange Administration > Remote Machine Administration > Remote Machine Parameters**.
   - Select **Choices**. Select the Voicemail Pro name as the Remote Machine Name then enter the values as shown.
     - Machine Type = VPIM.
     - Avaya Interchange? = n.
     - Mailbox ID Length = 5.
     - Failed Msg. Notification Priority = n.
     - Msg ID? = y.
     - Send Message for Warning? = n.
   - Select the **Details** key to enter the following details:
     - Subscriber Updates Type = dynamic.
     - Voiced Names for Dynamic? = y.
     - Use DNS? = n.
     - Domain Name = *Enter the domain name*.
5. If the Voicemail Pro Dial Plan length is shorter than the Interchange Dial Plan, select **Interchange Administration > Remote Machine Administration > Dial Plan Mapping**. Follow the instructions in *Avaya Interchange Release 5.4 Adding a VPIM System to Your Network* to map from the shorter length to the longer length dial plan.
6. Add the subscribers for Voicemail Pro. The following is one of several ways that this can be done.
   - Select **Interchange Administration > Remote Machine Administration > Dial Plan Mapping**.
   - Select the Voicemail Pro as the Remote Machine and then select **Options**.
   - Select **Add Subscribers from range**. Only mailboxes that are eligible to receive messages should be included.
   - Subscriber entries can be checked from **Interchange Administration > Subscriber Administration > Subscriber Lists > By Remote Machine Name**. From **Choices** select the Voicemail Pro PC name to see the list of known subscribers.
Directory View in Interchange for Intuity Audix and Voicemail Pro

Setting the directory view specifies which other messaging machines can provide subscriber updates to a particular messaging machine. Each machine listed is associated with a range of mailboxes from which updates can be accepted and whether a voiced name can be accepted.

1. Select **Interchange Administration > Remote Machine Administration > Directory Views**.
2. At the Machine Name prompt, select the Voicemail Pro.
3. Select the **Options** key and then Add all entries.
4. Select **Save**.
5. Repeat these steps for the Avaya Intuity Audix.

Avaya Interchange Enterprise List Administration

This section describes how to configure a list of endpoints in the Interchange. Interchange-based lists are an efficient way to send messages to stable lists of mailboxes. Only one copy of the message is sent from the originating system to the interchange, which takes care of distributing that message to the destination machines and mailboxes.

1. From the Interchange Main Menu, select **Interchange Administration > Enterprise List Administration > System Parameters**. Set or check the address range of the interchange Dial Plan that can be used for lists.
2. From the Interchange Main Menu, select **Interchange Administration > Enterprise List Administration > List Definition**.
   - Choose a unique list id from the list range and assign an owner.
   - In the 'Network Address' grid, enter the list of destination addresses from the Interchange Dial Plan.
   - The 'Remote Address' grid should contain the systems where those destinations reside.
   - The range of mailboxes that have permissions to send through the list is set in the 'permissions' grid.
8.4.3 Configuring a DNS Server

A Domain Name Service Server is not required for the messaging systems, but may be a highly desirable way to centralize the mapping of names to IP addresses. This section briefly describes the setup of DNS server used in this type of configuration.

To configure a DNS Server:

1. From the Start menu of the PC running Microsoft Exchange Server, select Programs > Administrative Tools > DNS. If DNS is not available, DNS needs to be installed from the Operating System CD.
2. Check that there is an entry within the domain for each messaging hosts involved.
3. Configure each PC to use the DNS server to resolve names. This is done in the Internet protocol (TCP/IP Properties form of each LAN interface).

8.4.4 Verification and Troubleshooting

The configuration can be tested by creating a message and forwarding it to the far end of the system. Check that the message is received at the correct destination. If the test fails, one of the following procedures may isolate the problem.

Ping Test
Make sure that you can ping all end points. If DNS is used, ping using the machine name.

SMTP Service Test and Name Determination
Test that the SMTP service of a messaging system is working by using telnet command as follows.

1. From a DOS or UNIX prompt, type `telnet ip-address 25`.
2. At the response, type `Helo`.
3. At the response, type `Quit`.
4. If the response is not as shown below, then the SMTP service is not running on the machine and incoming VPNM messages will not be processed. Check that the required PC services are running.

```
telnet 172.16.254.197 25
220 avaya-8ccy214d3 Microsoft ESMTP MAIL Service, Version 5.0.2195.6713
ready a
Helo 250 avaya-8ccy214d3 Hello [172.16.254.197]
Quit 221 2.0.0.0 avaya-8ccy214d3 Service closing transmission channel
```

Check That the Required PC Services are Running
From the Control Panel, select Administrative Tools > Services. Check that the following services are Started with a Startup type of Automatic.

- SMTP.
- Voicemail Pro Service.
- VPNM Database Service.
- VPNM Server.
- VPNM Receiver.
Check the Voicemail Pro SMTP Settings
From the PC Control Panel, select the Avaya Voicemail Pro icon.

1. Select the SMTP name.
2. Ensure that the Mail Server name is exactly the name of the Voicemail Pro server PC.
3. Select Check to make sure that a successful connection to the SMTP service can be made.

Interchange Basic Tests
From the Interchange Main Menu, select Customer/Services Administration > Diagnostics. Perform the following basic checks.

- TCP/IP Diagnostics.
  Send and receive Test Packets - ping the IP address.
  View Packet Statistics - look for any interface issues for example, collisions.

- Display Message Queue - monitors the contents of the outgoing message queue. If messages cannot be sent e.g. due to administrative errors, then this queue is likely to contain the unsent messages.

- Remote Connection Test - test the basic connection to a remote Audix system.

Audix Browser Status Test
- From the Browser interface to the S8100, select System Administration > AUDIX Networking > Maintenance Menu > Network Snapshot. See the status of connectivity to the Interchange.

S8100 Ping Test
- From the Avaya Terminal Emulator interface to the S8100, select cmd at the Enter Command prompt.
- At the DOS prompt, enter ipconfig to verify the IP address and gateway.
- Ping to test the connection.

Check the Status Through the Intuity Audix Command Line Interface
- To update the Audix with reachable subscribers through the interchange, from the audix command line prompt type get remote-updates machine and Enter where the machine is the name of the interchange system.
- Repeat the command periodically (and cancel out) until the 'Status of Last Update' entry is completed.
- From the command line prompt type display administrator's-log where message delivery failures and reasons can be found.

Message Exchange Test
In general the following capabilities are supported and can be verified.

- Sending Messages to lists or individuals, preserving any combination of Priority and Privacy.
- Replying to the sender.
- Forwarding.

Couldn't Send Message! Warning
The following warning is normally associated with not having specified a fully qualified domain name for the local SMTP server address.

"<CVPIM::bSendMessage>Couldn't send message!Response:550 5.7.1 Unable to relay for "210@avaya2k.test.avaya.com"
Index

A
Access Permissions 359, 361
Access Voicemail 134
   Using Short Codes 133
access works
   mailbox 98
Account Code 165, 166, 170, 236, 255
account code matching 236
Account Details 110, 352, 382
Action Data 161, 335
action following 238
action replaces 228, 242
actions having 201
actions including 61
actions share 201
action-specific 295
Activation 361
Activation Permissions 361
Active Directory 352, 361
Active Directory Users 361
active during 161
Add Administrator window 125
Add comments 343
Add key 410
add pauses 184
Add Prompt 207
Add Start Point 192
Add Touch Tone Sequence window 216
Add/Remove 38, 40, 378
Add/Remove Programs 40
Add/Remove Programs window 40
Additional Voicemail Pro 347, 352
AddRef 84, 384
addressing press 268
administering
   Outlook 268
Administrative 348, 372, 383, 409, 413
administrative rights 372
Administrative Tools 83, 348, 383, 413
Administrator Client 125
Administrator Details
   Changing 126
Administrator rights 345, 360
   use 372
administrator’s 348, 349
administrator’s-log 413
Advanced Options 374
Advanced Tab 251
Advice
   Call Recording 159
   Call Recording Message 159
   enable 159
   Mailbox Users Owners Using 174
   playing 158
Agent Mode 161
Alarm Set 203
   add 242
Alarm Set Action 203, 242
Alarm Threshold 103
Alarm Threshold Level 103
Alarm Threshold Unit
   Choose 103
Alert email 281
All Domain 389
Allow Launch 361
   allow tracing
      MAPI 84, 384
   Allows Visual Basic 203
alpha/numeric 389
Alphanumeric 181, 203, 396
   add 238
Alphanumeric Action 203, 238
Alphanumeric Collection 181, 238
Athlon 345, 360
Although PCs 346
AM 268, 281
AMD 345, 360
Analog Extension Number
   Configuring 118
Analogue 159
   View 118
and/or 234
Annotation 210
Announcements On 152, 172
Anonymous Logon 361
Assisted Transfer 197, 202, 203
   add 236
   result 137
   Telephony Actions 327
Assisted Transfer Action 137, 197, 202, 203, 236, 327
Assisted Transfer action transfers
caller 236
Associated Email Address 359
Associate
   Voice Mailboxes 359
Attach file 110, 268, 352, 382
e-mail 240
Attend… 135
Audit logon 383
Audit Policy
   see 383
   Select 383
Audits 383
AuditTrail.txt 226
audix 174, 413
   configuring 410
   Return 409
Audix Browser Status Test 413
Audix Digital 410
Audix Digital networking 410
Audix Networking 409, 413
Audix System 410, 413
Audix TTY Interface
   User Guide 174
authorised
   Outcalling 268
   Auto Attendant 95, 117
   Auto Recording
      Customizing 170
      auto sensing 346
   AutoAttend 259
   Automated Attendant 59
   Automatic 102, 132, 145, 165, 166, 268, 395, 413
   set 357
   Automatic Message Deletion 102, 145
   Automatic Recording Options
      Setting 166
   Automatic Updates
      selecting 395
   AutoRecord 170
Index

Default Language 178, 352, 410
Default Launch Permissions
  Edit Default button 361
Default NameNet 410
Default Properties 361
Default Recording 165
Default Security 361
Default Settings 103, 172, 352, 383
Default Start Points 135, 178, 195, 197, 218
Default Telephony Interface 98, 129
change 40
Default Collect 135
Default Leave 135
Default Queued 135
Default Still Queued 135
Delegate May 186
Delegates Cause 396
Delete Prompt 207
Delete Start Point 192
Depend On Service
  Open 388
deselect 264
destroyed 84, 384
Destructor Tracing 84, 384
Details into
  Entering 324
details key
  Select 410
DHCP 346
Diagnostics 81, 84, 200, 259, 352, 384, 413
Dial In Source Numbers 93
Dial Plan 409, 410
Dial Plan Mapping 410
DID 112
digit string 268
digit string starting 216
Digital Machine Administration 409
Digital Networking 410
Digital Networking Machine Administration 410
digital Nodes
  Maximum Number 410
digits As String 307
digits including 228, 268
Directories - For 97
directory press 268
directory View 83, 410
Disable IP Office Voicemail Email Settings 349
Disable Mobile Twinning
  name 181
Disable Network Card Power Saving 349
Disabled Items 374, 393
Disconnect Action 203, 219, 247
Disk Space 21
Disk Space Left 103
Disk Space Requirements 346
display Connecting 358
Display Message Queue 413
display string 306
DND 180, 268
DNS 396, 413
DNS Server
  Configuring 413
Do Not Disturb 132, 180, 226, 268, 281
Domain Controller 360, 361
  running 389
Domain Name 110, 111, 348, 410, 413
Domain Name Service Server 413
DOS 413
DS 329
DSS 131, 161, 327, 335
DSS button 327
DSS key 335
  set 161
DSS key during 161
DTE 351
DTMF 2/3 94
DTMF Data
  following 238
DTMF key 255
DTMF signalling received 98, 114
DTMFF 118
DVD 160
DVM 135
Dynamic
  Voiced Names 410
Dynamic Sub Expiration Days 410
E
  Edit Default button
    Default Access Permissions 361
    Default Configuration Permissions 361
    Default Launch Permissions 361
  Edit Defaults 361
  Edit icon 261
  Edit menu 201
  Edit Play List 197, 203, 207, 212
    add 225
  Edit Play List Action 197, 203, 207, 212, 225
  Edit Prompt 207
  Edit Security 361
  Edit Start Point 172, 192, 198
  Edit Value 251
  Edit voicemail 226, 281
  Element List icon 261, 264, 265, 266
  Elements icon 261, 264, 265
  Email Account IMS 349
  email Accounts 39, 91, 147, 349, 378, 389, 394
    existing 392
  eMail Action 56, 203, 223, 240
  Email Gateway 119
  email inbox 66, 342
  Email Messages
    Content 55
  Email Protocol 45, 51
    Select 101
  Email Reading 61, 66
  Email Settings 52, 97, 382
    Configuring 110
  Email Settings window 352
  Email "TTS 66, 101
  Email"
    Voicemail 394
e-mails 86
  Embedded Voicemail 59
  Emph 63
  employing
    TTS 62
  Empty Tags 63
  en/MC_00 208
  en/MC_01 208
  Enable Auditing 383

Voicemail Pro
IP Office

Page 421
15-601063 Issue 20b (11 July 2008)
Enable Distributed Com 361
Enable Distributed Com on 361
Enable Fax Sub-Addressing
  Check 98, 114
Enable Mobile Twinning
  name 181
EnableConnectionTracing 84, 384
EnableFunctionTracing 84, 384
EnableObjectTracing 84, 384
EnableProxyTracing 84, 384
EnableRefTracing 84, 384
EnableTagTracing 84, 384
EnableTracing 84, 384
English Non-Intuitly Prompts 281
Enter Command 413
Enter DCOMCNFG 361
enter greeting 268
Enter greeting number 268
Enter outcalling 268
Enter outalling number 268
Enter VBScript 244, 290
entering matching digits 249
Entering Touch Tones 216
Enterprise List Administration 410
entry press 268
Entry Prompts list 207
Entry Prompts Tab 207
Entry Prompts window 154, 172
enu/custom/getmail.wav 179
EOC_1 281
EOC_2 281
equating
  Exchange User 346
  Equisy Setafax 113, 116
  Error Logging 57
  errormessages.htm 96
  EstimatedAnswer 292
  EstimatedAnswer Property 292
  Event Viewer application 108, 380, 389
Example Call Flow 137, 221, 246, 327
  Mobile 181
Example SAPI XML Tags 63
example Save 255
example Touch 210
example transferring 257
Exchange Administration Manager
  open 377
Exchange Administrator 348
Exchange Connector 113
Exchange Server Knowledge 342
Exchange Server PC 388
Exchange User
  equating 346
Executables 389
Execute Action 324
Existing Campaign
  Delete 331
expandable/collapsible list
  contains 191
Export 38, 193, 378, 392
Export Call Flows window 38, 378
Exporting Call Flows 193
extension 203
  mobile twinning 181
extension press 268, 281
Extension.dll file
  disabling 393
  extension.dll 393
  External Location 143, 183
  external twinning 180
  Extn
    View 118

F
Failed Msg 410
fax board 98, 112, 113, 114, 118
Fax Calls 98, 112, 114, 216
Fax Calls Using
  Routing 117
Fax Configuration 60
Fax Forwarding 116
Fax Server Configuration 113
Fax Sub-Addressing 98, 114
Fax Use 118
faxnumber=>@faxination.com 116
faxnumber=>@faxmaker.com 116
faxnumber=>@rightfax.com 116
faxnumber=>@zfocusconnector.com 116
FaxPress 119
Feature Key 59, 60
  match 347
  type 351
Feature Key Serial Number 347, 351
Feature Key Server 60
  require 351
Feature Key Server PC 60
Feature Options 410
February 268, 281
Fenestrae Faxination 113, 116
file routing 337
files/avaya/ims client/extension.dll 393
finished working 124
FireEventTracing 84, 384
Firewall 394
  Opening 373
  uses 373
Firewall Port Settings 394
First In-First 102
Follow Me 180, 226, 268, 281
For help press 268
Force Account Code 132, 133, 137, 142, 150, 161, 181,
  327, 328
ForwardMsg 297
ForwardMsg Method 297
ForwardMsgToMailbox 297
ForwardMsgToMailbox Method 297
fr* 293
Français 178
Full Control 361
Full Name 96, 326
  Changing 329
FullFilename 298
FullFilename Method 298
Func 161
FWD 212
G
Gateway IP Address 410
General Configuration/system 104, 187
General Configuration/System Preferences 104, 187
General Parameters 410
General Screen 348
General System Preferences
General System Preferences  
Changing 98
Generic Action 180, 203, 212, 255
   includes 149
Generic Text  
   Installing 62
   Speech 62
generic Text To Speech 62
Generic TTS 62
Get Mail Action 175, 178, 179, 184, 197, 203, 220
GetCallingParty 298
GetCallingParty Method 298
GetDTMF 299
GetDTMF Method 299
GetEstimatedAnswer 299
GetEstimatedAnswer Method 299
GetExtension 300
GetExtension Method 300
GetLocale 300
GetLocale Method 300
GetMailbox 300
GetMailbox Method 300
GetMailboxMessage 301
GetMailboxMessage Method 301
GetMailboxMessages 301
GetMailboxMessages Method 301
GetMessagePriority 302
GetMessagePriority Method 302
GetMapping 302
GetMapping Method 302
GetMappingStatus 302
GetMappingStatus Method 302
GetName 303
GetName Method 303
GetNewMsgs 303
GetNewMsgs Method 303
GetOldMsgs 303
GetOldMsgs Method 303
GetPositionInQueue 304
GetPositionInQueue Method 304
GetRegister 304
GetRegister Method 304
getResult 304
GetResult Method 304
GetSavedMsgs 305
GetSavedMsgs Method 305
GetSavedResult 305
GetSavedResult Method 305
GetVariable 305
GetVariable Method 305
Gfi FAXMaker 113, 116
Give Error Messages  
   Using Voicemail 96
Goto 203  
   Add 218, 329
Goto Action 203, 218, 329
Granting  
   Access 335
Greetin... Greetings Folders 392
Group Broadcast  
   Configuring 149
Group Mailbox Names 23
Group Policy  
   Select 361
Group Start Points 135

H  
H<Group Name 93
Help button  
   clicking 251
   help press 268
Highlight Addin 393
Highlight Integrated Messaging Associations 359
Highlight Microsoft Exchange Server 348
Highlight Voicemail Pro 127
HMain 93, 148
Home Action 203, 219
Host Server PC  
   IMS 109, 381
Hours Fallback Group  
   Out 151
Hours Greeting 281  
   Out 151
hours greeting press 281
Hours Operation 151
Housekeeping 102  
   Select 145
Housekeeping tab 102, 145
HTML 66
Hunt Group Call Flow  
   Customizing 156
Hunt Group Configuration 147
Hunt Group Mailbox Owners 155
Hunt Group Queuing 155, 221
Hunt Group Voicemail Indication 93
HuntGroup 147, 149, 152, 155, 166
huntgroupconfiguration.htm 147

I  
ICLID 184
ID 200 134
Ident 297
ident As String 297
Identifying  
   Avaya Voicemail Pro 410
   Voicemail Server PC 90
Identity 383, 389
Idle 102, 145, 410
If used 156
illustrates 178
Impersonate 361
Impersonate™ 361
Import 38, 145, 193, 378, 392
Import Call Flows 38, 378
IMS Account 352, 357, 377, 378, 382
   Configured 349
   Configuring 348
   Creating 348
   Transferring 392
IMS Account Has Admin Rights  
   IMS Server 349
IMS Admin Tool  
   Run 389
   VMPRO.arf 392
IMS Administration 84, 344, 352, 359, 384, 396
IMS Administration Tool 344, 352, 396
Close 359
IMS Client application 345, 373
IMS Client Installation  
   Testing 374
IMS Client Installer 360, 372
IMS Client Keys 84, 384
IMS Client Not 393
IMS Client Not Showing 393
IMS Client Package 352
IMS Client PC 345, 360
IMS Client PC Requirements 345
IMS Client Requirements 360
IMS Client Software Installing 372
IMS Client's Outlook delegates 359, 396
IMS Clients Not Connecting When Outlook Opened 396
IMS Components 344
IMS Connection 372, 374
IMS Connection Information window see 372
IMS Database Service 352
IMS email 102, 145, 382
IMS Email Settings Configuring 382
IMS Exchange Mailbox Operation Observing 377
IMS Gateway 108, 344, 352, 360, 388 run 389
IMS Gateway Server 389 logging 108, 380
IMS Gateway Service 344, 352, 388
IMS Installation 347, 388
IMS Installation Alternatives 388
IMS Licenses Entering 351
IMS Limitations 343
IMS Messages Past Housekeeping Saving 395
IMS Playback Parameters 372
IMS Playback Parameters window 372
IMS Restart Services 389
IMS Server 84, 344, 346, 347, 348, 359, 360, 361, 384, 388
connect 372, 389
IMS Account Has Admin Rights 349
IMS Server MUST 349
IMS Server PC Requirements 346
IMS Server Preparation 349
IMS Service Logging 108, 380
IMS Services 108, 380 Check 357
IMS Tracing 84, 384
IMS User 392, 393, 396
IMS user’s 377 restore 392
IMS Voice 108, 109, 344, 352, 380, 381, 388, 389
IMS Voice Server 108, 380
IMS Voice Service 344, 352, 388 hosting 109, 381
IMS/Voicemail Pro 349
IMS/Voicemail Pro Server 345, 360 name 372
IMS’ Applications 394
IMSClient 360, 374, 389
IMSClient.exe 360, 372
IMSClient.exe file 372
IMSGATEWAY.arf 392
Inactive 98, 125, 126, 127, 128, 268, 281
Inactivity Timeout 98 Changing 128
inactivity timeout reset 128
inbox 343, 359
Incoming Call Route 139, 143, 156, 165, 166, 171, 195, 198, 253, 254, 327
match 134
Voicemail 143
IncomingCallRoute 259 incorporates
BLF 335
increase/decrease want 84, 384
increase/decrease reporting 84, 384
Inetpub/mailroot/Drop 408
Information Required 347
Initialize 358
Initializing Call Flow 358
Voicemail Pro Call Flow 358
Install Voicemail Pro 40, 97, 174, 177, 394
install Voicemail Pro Software 394
Installatio ACM Gateway 398
Installation Compact 25
Custom 31
MAPI 42
SMTP Voicemail Email 41
Typical 28
VoiceMail Pro Client 36
Installation Checks 347
Installation Process 62, 352, 361, 388
Installing VoiceMail Pro 378
Installshield 40
InstallShield Wizard 39, 378
Welcome 40
Integrated Message Voice Server 352
Integrated Messaging 347, 372, 374, 389, 393, 397
Select 392
Integrated Messaging Server 360
Integrated Messaging Service 342, 352
connect 394
Integrated Messaging Tab 391, 393
Interact 81, 113, 316, 344, 389
Interchange 413 connecting 409
Intuity Audix 410 refer 410
Interchange Administration 410
Interchange Basic Tests 413
Interchange Dial Plan
Intuity Audix Dial Plan 410
Interchange General Parameters Set 410
Interchange Intuity 410
Interchange Main Menu 410, 413
Interchange VPIM 410
Interchange VPIM Interface
Voicemail Pro 410
Interchange-based 410
Internal Calls Error Message 96
Internal Variables 291
International 96, 268
International Calls create 96
internet 337, 413
interruptables As String 307, 308, 309, 311, 315
<table>
<thead>
<tr>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Intuity Audix</strong></td>
</tr>
<tr>
<td><strong>Intuity Audix Command Line Interface</strong></td>
</tr>
<tr>
<td><strong>Intuity Audix Dial Plan</strong></td>
</tr>
<tr>
<td><strong>Intuity Emulation Mode</strong></td>
</tr>
<tr>
<td><strong>Intuity Mailbox Mode</strong></td>
</tr>
<tr>
<td><strong>Intuity Mailbox User Guide</strong></td>
</tr>
<tr>
<td><strong>Invalid Conference</strong></td>
</tr>
<tr>
<td><strong>IP 500</strong></td>
</tr>
<tr>
<td><strong>IP 500 Office</strong></td>
</tr>
</tbody>
</table>
Line Group ID  96, 132, 133, 137, 142, 150, 161, 181, 259, 327, 328
List Definition  410
list equating  346
list press  268, 281
Listen Action  164, 170, 197, 203, 222, 232
Listing linking  347
Live  123, 124, 137, 328, 392
Imhosts  389
LOC  178, 179, 255, 291, 293, 300, 309, 312
LOC voicemail  293
LOC/custom/getmail.wav  179
Local Machine Administration  409, 410
Local Policies  361, 383
Local Security Policy  383
Local Security Policy window Close  383
Local Server Connecting  358
Local System Account  81
Local Users  383
Locale  132, 133, 137, 142, 144, 150, 161, 174, 181, 186, 255, 293, 298, 308, 311, 312, 327, 328
match  177
locale As String  312
Locale Property  293
Locked Administrator Login Releasing  127
Log Preferences  84, 384
Logg Errors  57
Logging IMS Gateway Server  108, 380
Out  124
Logging Level  108, 380, 389
Logic icon  261, 265
login  119, 122, 127, 268, 409
logins  268, 281
long distance  268
long outcalling  104, 187
Look In list  348
Loop Until Len  300
M
MacAfee Personal Firewall  394
Machine Administration  410
Machine Type  410
Mail Account  348
Mail Drop  111
Mail Properties  348
Mail Server  111, 413
Mailbox Actions  192, 203
Leave Mail  327
Mailbox Actions icon  220, 221, 222, 223, 224
mailbox As String  297, 301, 302, 306, 307, 313
mailbox follow Failure  221
mailbox greeting  94
Mailbox ID Length  410
Mailbox Main Access  134
Access  133
mailbox matching  220, 221, 222, 225, 226
Mailbox Mode  113, 114, 147, 220, 221
Select  40
Mailbox Operation Mode Changing  129
mailbox press  268
Mailbox Store  377
Mailbox Users Owners Using Advice  174
mailbox/message  297, 298, 302, 308, 309, 311, 313
mailboxes As String  297, 306, 313
MailboxEvtSinkTracing  84, 384
mailing lists  268
Main Menu  410
Main Voicemail Pro Window  98, 100, 101, 102, 103, 104, 127, 129, 187, 191, 198
Main.Collect  135
Main.Leave  135
Maintenance Menu  413
Make Live icon  358
Making them Live  193
Manage Forms  374
Manager application  198, 234
Manager Incoming Call Route  134
Managing Campaigns  331
Mandatory Announcement Example  171
Manual Call Recording Starting  161
Manual Recording Customizing  164
Manual Recording Mailbox  163
Manual Recording Options Setting  163
Manually Install Form  374
MAPI - Email Protocol  45, 51
MAPI email  66, 81, 101, 110, 382
MAPI Email Preferences Setting  101
MAPI Password leave  101
MAPI Profile  101
MAPI-based Voicemail Email Voicemail Pro  66
MAPI-compliant  21
MAPIEventTracing  84, 384
Matching Short Code  195, 198
Creating  137
Materials Required  347
MaxR  180
Max  98, 160
Maximum Number  59, 299, 333
Digital Nodes  410
maxtime  311
maxtime As  311
maxtime As Long  311
mdb  38, 193, 378
mdb file  193
Member Of  147, 148, 150, 212, 345, 348, 349, 352, 360
Menu Action  112, 113, 114, 117, 137, 156, 172, 178, 181, 203, 210, 236, 318
Specific  216
Menu action Touch  117
menu bar Synchronize  359
Menu button  148
Menu key  161, 329
menu press  268, 281
menu provides user  139, 140
Merge Config  184
Index

message As String 302, 306, 307, 313
message counts 301
Message Deletion Times
  Setting 102
Message Exchange Test 413
message housekeeping 102
Message Housekeeping Preferences 102
Message Length 98
Message Parameters 110, 382
Message Parameters options 110, 382
message press 268, 281
message Test Connection Succeeded 251
Message Waiting 392
Message Waiting Indication 146
  Configuring 148
Message Waiting Indicators Not Clearing 397
message\Response 413
MessageCLI 306
MessageCLI Method 306
MessageDisplay 306
MessageDisplay Method 306
MessageEvtSinkTracing 84, 384
MessageLength 306
MessageLength Method 306
MessageProcessingTracing 84, 384
Messages button 139
  use 93
Messages Past Housekeeping 395
Messages Through 337
  Playing 342
  messages/recordings 98
  messages* 309
MessageTime 307
MessageTime Method 307
Messaging Associations 359
Messaging Components 352
Messaging Components window 352
Microsoft .NET Framework 16
Microsoft 3rd 62
Microsoft Access 251, 317, 318
Microsoft Access Database 251, 317
  uses 318
Microsoft Exchange 343, 344, 346, 348, 389, 392, 413
  Microsoft Exchange 5.5
    Access 346
  Microsoft Exchange checkbox
    Check 348
  Microsoft Exchange Client 344
  Microsoft Exchange Server 343, 344, 389, 413
    Select 392
Microsoft IIS Web Server 21
Microsoft Internet Explorer 337
Microsoft Internet Explorer 5.0 337
Microsoft Management Console 361
Microsoft Outlook 342, 345, 359, 360, 392, 394, 396
  opening 393
Microsoft Outlook 2000/2003 345, 360
Microsoft Sam 61, 62
Microsoft SAPI 61, 63
Microsoft Speech SDK 61
Microsoft Speech SDK 5.1
  use 61
Microsoft TTS 61, 62
Microsoft WAVE file 268, 281
Microsoft Windows
  part 61
Mike 61, 62
Minimum PC 345, 360
mins 98
MINUTE 307
minutes* 309
Misc Troubleshooting 389
Miscellaneous Actions icon 240, 241, 242, 243, 244, 245, 290
misconfiguration 391
Mobile 91, 94, 143, 183, 186, 268
  Example Call Flow 181
    turn 180
Mobile Twinning 180
  extension 203 181
mobile twinning feature 268
Mobile Twinning No 181
mobile twinning number 180, 181
Mobile Twinning on 181
mobile twinning options 268
Models 389
Modify Administrator window 126, 127
modify existing campaigns 331
Module Return 178, 202, 203
  add 219
  result 219
  use 259
Module Return Action 202, 203, 219, 259
Module Start Points 135, 137
Modules Navigation 191, 259
Modules Navigation Pane 191, 259
Move Prompt 207
MS Exchange 344, 345, 348, 360
MS Exchange 2000 345, 360
MS Exchange Settings 348
MS Windows 395
MS-CRM 231
  matching 236
MS-CRM Call Data Tagging 236
MSCRM-ACT 236
msec 63
MExchangeIS 388
MExchangeMTA 388
Msg ID 410
MSGN 309
MSGO 309
msgs 148, 309
msgtype 301, 313
msgtype As String 301, 313
MSRM-ACT 236
MTS 383
Multiple Language TTS Support 61
Music 152, 172, 236
Music on Hold 152, 172, 236
MWI 148
mywavs/hello.wav 243
N
Name Action 203, 234, 326, 327
Name Determination 413
Name Directory 59
name greeting 144
name matches 259, 268
Name Property 294
Name Table
  Using 329
Name window 198, 223, 348
Names 109, 193, 236, 381, 392
Observing IMS Exchange Mailbox Operation 377
ODBC 316
OldMsgs 291, 294
OldMsgs Property 291, 294
OLE DB Provider
Select 251
on Component Services 361
on configuring outcalling 268
on identifying
campaign 331
on Incoming 156, 253, 254
on incoming message 281
on outgoing calls 95
on/off 91, 147
Online Mode 123, 130
Open and/or 203
Open Database Connectivity 316
Open Door 203
add 241
Open Door Action 203, 241
Open Voicemail Pro 172, 352
Operating
System Support 346
Operating System CD 413
Options key
Select 410
Other Files
Including 194
Other Firewalls 373
other operating systems 346
out according 192
outcalling administration 268
outcalling destination 268
Outcalling feature 186
OutCalling features 183
outcalling number 268
outcalling option 268
outcalling options 104, 187, 268
Outalling Preferences 39, 378
Setting 104, 187
Outalling tab 104, 187
Outalling window
return 104, 187
outcalls 268
Outgoing
emails 111
Outgoing Group ID 60
Outlook 2003 344, 348, 392
Outlook 2003 uncheck Cache Mode 348
Outlook 97 344
Outlook Cached Exchange Mode 392
Outlook Delegates Cause IMS
Slow 396
outlook disabling 393
Outlook email 349
Outlook Express 47
Outlook icon 348
Outlook Menu Bar 372
Outlook Tools 374, 393
Outlook's 393, 394
Outlook's Tool 393
P
Page Calls 243
Pager 183, 184, 236
Pager->$KEY 236
Parallel Port Feature Key 351
QTIM 291, 292, 299, 309
QTIM voicemail 292
Queue Actions 192, 203
Queue Actions icon 253, 254
Queue ETA 156, 203
add 253, 254
Queue ETA Action 203, 253, 254
queue greeting 281
queue greeting press 281
Queue Length 155
Queue Position 146, 156, 203, 253, 254, 281
Queue Position Action 156, 203, 254
Queued 195, 197
Queued & Still Queued 195
Queued Callers Estimated Time Answer 156
Queued Callers Queue Position 156
Queued Start Point 154, 172
Queued start point giving 172
Queued start point replaces 154
Quit 281, 413
Campaign 334
R
RAM 345, 360
Rate - Change 63
Read Email 66
read matching records 316
REC 159
rec_01 281
receive Test Packets 413
Reception 91, 94, 137, 172, 226, 257, 268, 281
Reception/Breakout 91, 94
ReceptionClosed 257
ReceptionOpen 257
RECNAM_01 281
RECNAM_02 281
RECNAM_03 281
recognised 351
recognize 119, 174, 197
PC 90
Recor 161
Record Call 158, 161
record greeting 96
Record Inbound 166
Record key 333
Record Name 144, 197, 203, 309, 328
add 225
Record Name Action 197, 203, 225, 328
Record Name Module
  Adding 328
Record Outbound 166
record/re-record 320
recorded asking
user 178
recorded name greeting 144
recording As String 311
Recording Library 158, 160, 163, 166, 221
Recording Library options 163, 166
recording press 208, 268, 281
Recording Time 98, 103, 166
Changing 160
Recording Time Profile 166
Recording Warning 158, 159, 161
RecordMsg 311
RecordMsg Method 311
RecordRegister 311
RecordRegister Method 311
REG_DWORD 84, 384
REG_MULTI_SZ 388
Regional 144
Regional Setting 144
Register 304, 311, 312, 313, 348
Register Method 312
Registry 84, 384, 388
  Restore 38, 378
regnum 304, 311, 313
regnum As Long 304, 311, 313
Release 84, 166, 384
  Locked Administrator Login 127
religon 268
religon press 268
rem Wait 60 357, 397
Remote Access 281, 361
Remote Address 410
Remote Call Flow 203
add 245
Remote Campaign Directory 100
Remote Connection Test 413
Remote Launch/Activation 361
Remote Machine 409, 410
Remote Machine Administration 409, 410
Remote Machine Name 410
Remote Machine Parameters 410
Remote System Voicemail Settings Configuring 60
Remote Voicemail Notification 226
Remote Voicemail Pro Clients 125
Remove 38, 66, 194, 352
Remove Voicemail Lite 40
Remove Voicemail Pro 38, 378
removing VoiceMail Pro 378
Rename 194, 198, 261
Report
  Tab 210
Reporting tab 210
Request ISBN 322
required depending
  number 347
required flag
  change 337
required logging levels 352
Required Network 342
Required PC Services
  Check That 413
Requires Authentication 111
Requires TTS 203, 215, 255
RES voicemail 295
Resources 95, 395
restore 268
  Database 38, 378
  IMS user’s 392
  Registry 38, 378
restorerreg.bat 38, 378
Restrictions 58, 59, 268, 361
result As String 314
result occurs 202
Result Property 295
results depending on 94, 221
results includes 228
results represents 202
Results Tab 211
Retries 234
System Preferences  Select  97
System Preferences window  98, 114, 129
System Prompts  178
System Resources  95
System Retry Settings  104, 187
System Settings  97, 102
installed  108, 380
System Settings window  352
System Status Application  
Open  95
see  95
System Support  
Operating  346
System Times  104, 187
System Tool  83
SYSTEM/CurrentControlSet/Services/IMS  
Navigate  388
SYSTEMROOT  357, 397
systems running  147, 150

T

tab gives  list  93
TCP Port  373, 394
TCP Port 2000  373, 394
TCP/IP  343, 345, 346, 360, 409, 413
optioned  410
TCP/IP Administration  410
TCP/IP Diagnostics  413
TCP/IP networking  20, 345, 346, 360, 410
TCP/IP Properties  413
Telephone Icon  372
see  374
telephone number including  93
Telephony Actions  192, 203
Assisted Transfer  327
Dial  327
Telephony Actions icon  181, 228, 230, 231, 232, 233, 234, 235, 236, 238
Telephony Handset  208
Telephony Operation Mode  144
Teletype  174, 175
telnet  413
Issue  409
SMTP  410
telnet 172.16.254.197 25 413
telnet ip-address 25 413
temp/backup.mdb  38, 378
Test Condition  170, 203, 260, 264, 265
add  246
Test Condition Action  170, 203, 246, 260, 264, 265
Test Connection button  251
Test Connection Succeeded  251
Test Email Operation  349
Test Packets  413
Test User Variable  203
add  248
use  247, 257
Test User Variable Action  203, 247, 248, 257
test”  309
Testing  
IMS Client Installation  374
VPNM  408
VPNM Setup  408
text As String  315
text matching  329
text This  63, 315
Text To Speech  21, 61, 62, 63, 66, 101, 215, 322
Textphone  174, 175
TIME  309
Time Check  134
TimeAndTrace  84, 384
TimeCheck  133, 134
timeout As Long  299
TimeQueued  156, 255
TimeSystem  156, 255
Title  129, 191, 317, 318, 322, 324
Title Bar  129, 191
TOC  104, 187
Token Name  181, 206
Tools>Options>Integrated Messaging  374
Total Items  377
Touch  112, 117, 137, 203, 210, 216
Touch Tones  112, 117, 137, 203
Entering  216
Menu  210
tracing  
MAPI  84, 384
Transfer  131, 154, 165, 185, 197, 216, 236, 392
Transfer Action  137, 171, 197, 203, 231, 232
Transfer action transfers
 caller  231
Transmit Wave Files  352
check  110, 382
Troubleshooting  413
DCOM Issues  383
Trusted Location  139
Creating  143
Trusted Source  93, 135, 184
Try uninstalling  374
TTS  62, 63, 215, 255, 309, 315
choose  61
employing  62
includes  61
license  66
start  62
TTS Usages  61
TTY  12, 174, 177
default  175
see  173
set  175
setting  174
use  174
TTY Device  173, 174, 175
TTY Maintenance Patch  175
turn outcalling  268
turn outcalling off  268
turn outcalling on  268
Turn voicemail  132, 144
Turn voicemail ringback  144
txt file  200
type matching  268
Typical  330, 352
Typical Voicemail Pro Server  352

U

UDP Port  373, 394
UDP Port 50791  373, 394
UDP Port 50799  373, 394
UDP Port 67  373, 394
UDP Port 69  373, 394
UK English  281
UMSEventTracing  84, 384
Unable  413
Uncheck Use Cached Exchange Mode 392
Un-check Voicemail On 172
unchecking
Voicemail On 91
un-checking
Voicemail On 147
undelete 268
Under Specific Start Points 184
Under Log 81
uninstall Voicemail Pro 352
Unit Name/IP Address 122
United States 144
UNIX 413
UnPark Call
use 335
Unspecified Error 80004005 391
Unzip AvayaFW.bat 373
Up Callback
  Setting 184
Up Text To Speech
  Setting 66
Up Voicemail Transfer Options
  Setting 94
Updates In 147, 409, 410
Updates Out 409, 410
Upgrade 38, 66, 193, 352
IP Office VoiceMail Pro window 39, 378
Voicemail Pro 38, 40
Voicemail Pro Server 378
US 61, 179, 268
Voicemail Pro 281
US English 179
Voicemail Pro 268
US English Intuity Prompts 268
USB 351
Use Challenge Response Authentication
  set 111
Use DNS 410
Use Port 346, 349
user attempting 135
User Cannot Change Password 348
User Defined Fax Number 116
User Defined Variable menu 247
User Defined Variables 192, 257
User Details 347
User Locale 144, 174, 175, 177, 178
  Changing 174
User Name Recordings 326
user presses 161
User Properties
  select 359
User Source Numbers
  Configuring 93
User Start Points 135
user’s DTMF 299
User’s Name 374, 389, 397
userconfiguration.htm 91
UserID 83
Username 372, 389
Users Access 140, 143, 184
  Giving 142
Users Button Access
  Giving 140
users including users 148
Users Owners 174
User’s PC 344, 345, 360, 372, 373
Users Voicemail Access
  Giving 143
Using Cached Mode 392
Using DSS Keys 161
Using IP Office Manager 62, 66
Using Short Codes 161
  Access Voicemail 133
Using Start Points 198
Using VB Script 244, 290
Using Visual Voice 139
Using VM 134
Using Voicemail 93, 152, 155, 172, 186
  Give Error Messages 96
Using Windows Explorer 40
  utilisation
    view 95
V
VAR 208, 255, 291, 296, 305, 309, 314
VAR voicemail 296
variable As String 314
variable matches 228, 248
Variable Property 296
Variable Routing 228
Variable Routing Action 203, 228
VB Action 295
VB Script Action 203, 244, 290
VB Scripting 291
  add 244, 290
VBS 292
VBScript 294
  enter 244, 290
  Use 244, 290
VB-Script 295
VBScripts 291
VCM 59
verb’>record</partofsp 63
Verification 413
Version 3.2 38, 39, 378
Version 5.0.2195.6713 413
View Packet Statistics 413
Visual Voice
  access 140
Visual Voice Button 140
VM Pro 61, 62, 244, 290, 316, 392
VM Pro Database Interface 316
VM Pro Generic TTS 61
VM Pro ScanSoft TTS 61
VM Pro TTS 62
VM Pro VBScript 244, 290
VM Server Specific 84, 384
VMCol 140
Vmdata.mdb 193
VMLite.exe 40
vmp file 193, 194, 245
VMPro
  start 389
VMPro Database Interface 203
VMPro Error 0x80004005 394
VMPro service 389
VMPro TTS 62
VMPro User Log 83
VMPRO.arf
  Copy 392
IMS Admin Tool 392
VMPro/IMS
  NAME 389
VMProDBService 357, 397
VMProIMSPC/IMSClient 372
VMS API 84, 384
VmsNotifyTracing 84, 384
Voice Mail 210, 232, 281
Voice Mailboxes 294, 377
Associating 359
Voice Messaging 59
Voice Question 156, 203, 232, 240
add 223
preceding 212
Voice Question Action 203, 223, 232, 240
Voice Recording
Select 163, 166
Voice Recording Administrators 160
Voice Recording Library 21, 158, 160, 163, 166, 221
Voiced Names
Dynamic 410
Voicemail
Email settings 54
Voicemail Callback 183, 184
Voicemail Channel Reservations 90, 95
Voicemail Code 90, 91, 93, 139, 140, 142, 143, 147, 148, 151, 184, 206, 326, 328
Add 96
voicemail code For 139
Voicemail Collect 96, 131, 132, 133, 137, 139, 140, 142, 150, 181, 259, 327, 328
Voicemail Collect Button 139, 140
Voicemail Console 81
Voicemail Destination
Leave 90
Set 60
Voicemail Domain Account
Creating 42
Voicemail Email 61, 66, 90, 91, 147, 281, 349
MAPI 101
Voicemail Email Mode
Select 91, 147
Voicemail Email Reading 66, 91
voicemail functions
call 195
Voicemail Help 90, 91, 147
Voicemail IP Address 90
Voicemail Lite 59, 91, 93, 96, 135, 144, 147, 190, 281
close 40
Voicemail 40
Voicemail Pro 38, 40
Voicemail Lite Folders
Move 40
Voicemail Lite Installation Manual 96, 147
Voicemail Lite Manual 91
Voicemail Lite/Pro 90
Voicemail Mailbox 66, 98, 112, 114, 337, 352, 359, 372
Voicemail Message 91, 147, 183, 184, 342, 374, 377, 395
Voicemail Node 133, 135, 195, 198
Voicemail On 90
unchecking 91
un-checking 147
Voicemail Outcalling 183
Voicemail Password
match 98
voicemail PC 389
voicemail PIN
prompted 135
VoiceMail Pro
Features 11
System Overview 7
Voicemail Pro 1.2.6 227, 249
Voicemail Pro 1.4 173
Voicemail Pro 4.0 39, 378
Voicemail Pro Actions 244, 290
Voicemail Pro Administrators 125, 126, 127, 191, 195
Voicemail Pro attempting 394
Voicemail Pro below version 3.2 38
Voicemail Pro Call Flow 190
Initialize 358
Start 33, 79
Voicemail Pro Campaign Web Component
install 352
Voicemail Pro CD
contains 38, 378
Insert 38, 378
Voicemail Pro Client 117, 125, 127, 128, 145, 159, 190, 191, 352, 358
change 97
Close 38, 124, 193, 378
run 122, 123
Start 38, 40, 122, 160, 378
use 98
Voicemail Pro Client Server 125
Voicemail Pro Client window 122
parts 191
Voicemail Pro Database Operation 316
Voicemail Pro detects 112
Voicemail Pro Dial 225, 234, 410
Voicemail Pro Dial Plan 410
Voicemail Pro file 194
Voicemail Pro GUI
Start 38, 378
Voicemail Pro housekeeping 102
Voicemail Pro Installation 62, 330, 346
Voicemail Pro installation includes 62
Voicemail Pro installation including VPNM 346
Voicemail Pro involves 113
Voicemail Pro Licenses 59
Voicemail Pro Login window 122, 123
Voicemail Pro Module 131, 134, 137, 181
Access 133
Voicemail Pro Networked Messaging 111, 145
Voicemail Pro PC 410
Voicemail Pro programming 190
Voicemail Pro SelfSelect 137
Voicemail Pro Server 58, 59, 60, 61, 90, 103, 109, 119, 124, 125, 126, 128, 144, 159, 164, 170, 174, 190, 191, 207, 208, 220, 221, 245, 344, 346, 351, 352, 359, 381, 392, 394, 396, 408, 413
change 97
connect 122, 358
Upgrading 378
Voicemail Pro server during 174
Voicemail Pro Server PC 90, 207, 208, 344, 392, 413
Voicemail Pro Service 39, 101, 352, 357, 388, 397, 413
Locate 81
set 81
Voicemail Pro SMTP Settings
Check 413
Voicemail Pro Software 40, 61, 347, 348, 349, 352, 392
Voicemail Pro Start Points 131, 134, 135
Voicemail Pro System Fax Number 118
Setting 114
Voicemail Pro System Variables 62, 236
winnt/temp 392
Within Voicemail Pro  180, 255, 291, 316
Wizard  38, 40, 251, 331, 378
Wordpad  84, 384
Work  104, 113, 187, 190, 193, 352
Work Group Member
   Email  46
Workstation  122, 372, 374, 383
www.microsoft.com/speech/download/sdk51  61
www.support.avaya.com  410
X
   XML  62
      closing  63
      opening  63
XML Tags
   Entering  63
   XP  81, 345, 360, 361
   XP Pro  345, 360
      DCOM Settings  361
   XP Pro SP2
      DCOM Settings  361
Y
   YEAR/MONTH/DAY HOUR  307
   Yes - Select  123
   Your call  132, 268, 281
   Your estimated  156
   Your Network  410
   Your Password  268
      Changing  130
Performance figures and data quoted in this document are typical, and must be specifically confirmed in writing by Avaya before they become applicable to any particular order or contract. The company reserves the right to make alterations or amendments to the detailed specifications at its discretion. The publication of information in this document does not imply freedom from patent or other protective rights of Avaya or others.

Intellectual property related to this product (including trademarks) and registered to Lucent Technologies have been transferred or licensed to Avaya.

All trademarks identified by the ® or ™ are registered trademarks or trademarks, respectively, of Avaya Inc. All other trademarks are the property of their respective owners.

This document contains proprietary information of Avaya and is not to be disclosed or used except in accordance with applicable agreements.

Any comments or suggestions regarding this document should be sent to "wgctechpubs@avaya.com".

© 2008 Avaya Inc. All rights reserved.
Avaya
Unit 1, Sterling Court
15 - 21 Mundells
Welwyn Garden City
Hertfordshire
AL7 1LZ
England.

Tel: +44 (0) 1707 392200
Fax: +44 (0) 1707 376933

Web: http://www.avaya.com/ipoffice/knowledgebase